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Information in this document is subject to change without notice. No part of this document may be
reproduced or transmitted in any form or by any means, electronic or mechanical, for any purpose, without
the express written permission of:

Sonotron NDT, 4, Pekeris st., Rabin Science Park, Rehovot, Israel, 76702

Covered by the United States patents 5524627, 5952577, 6545681; other US & foreign patents pending
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Sonotron NDT

4, Pekeris str., Rabin Science Park, Rehovot, 76702, Israel
Phone:++972-(0)8-9477701 Fax:++972-(0)8-9477712
http://www.sonotronndt.com

EC Declaration of Conformity

Council Directive 89/336/EEC on Electromagnetic Compatibility, as amended by
Council Directive 92/31/EEC & Council Directive 93/68/EEC

Council Directive 73/23/EEC ( Low Voltage Directive ), as amended by Council
Directive 93/68/EEC

We, Sonotron NDT Ltd., 4 Pekeris Street, Rehovot, 76702 Israel, certify that the product
described is in conformity with the Directives 73/23/EEC and 89/336/EEC as amended

ISONIC 2005 /2020 / STAR

Portable Digital Ultrasonic Flaw Detector and Recorder

The product identified above complies with the requirements of above EU directives by
meeting the following standards:

Safety
EN 61010-1:1993

EMC
EN 61326:1997
EN 61000-3-2:1995 /A1:1998 /A2:1998 /A14:2000
EN 61000-3-3:1995

ISONIC 2005/ 2020 / STAR from Sonotron NDT - Operating Manual — Revision 2.38 - Page 4 of 380



Sonotron NDT

4, Pekeris str., Rabin Science Park, Rehovot, 76702, Israel
Phone:++972-(0)8-9477701 Fax:++972-(0)8-9477712
http://www.sonotronndt.com

Declaration of Compliance

We, Sonotron NDT Ltd., 4 Pekeris Street, Rehovot, 76702 Israel certify that the product
described is in conformity with National and International Codes as amended

ISONIC 2005 /2020 / STAR

Portable Digital Ultrasonic Flaw Detector and Recorder

The product identified above complies with the requirements of following National and
International Codes:

e ASME Section | — Rules for Construction of Power Boilers

e ASME Section VIII, Division 1 — Rules for Construction of Pressure Vessels

e ASME Section VIII, Division 2 — Rules for Construction of Pressure Vessels. Alternative
Rules
ASME Section VIII Article KE-3 — Examination of Welds and Acceptance Criteria
ASME Code Case 2235 Rev 9 — Use of Ultrasonic Examination in Lieu of Radiography
Non-Destructive Examination of Welded Joints — Ultrasonic Examination of Welded
Joints. — British and European Standard BS EN 1714:1998
Non-Destructive Examination of Welds — Ultrasonic Examination — Characterization of
Indications in Welds. — British and European Standard BS EN 1713:1998
Calibration and Setting-Up of the Ultrasonic Time of Flight Diffraction (TOFD)
Technique for the Detection, Location and Sizing of Flaws. — British Standard BS
7706:1993
WI 00121377, Welding — Use Of Time-Of-Flight Diffraction Technique (TOFD) For
Testing Of Welds. — European Committee for Standardization — Document # CEN/TC
121/SC 5/WG 2 N 146, issued Feb, 12, 2003
ASTM E 2373 — 04 — Standard Practice for Use of the Ultrasonic Time of Flight iffraction
(TOFD) Technique
Non-Destructive Testing — Ultrasonic Examination — Part 5: Characterization and Sizing
of Discontinuities. — British and European Standard BS EN 583-5:2001
Non-Destructive Testing — Ultrasonic Examination — Part 2: Sensitivity and Range
Setting. — British and European Standard BS EN 583-2:2001
Manufacture and Testing of Pressure Vessels. Non-Destructive Testing of Welded
Joints. Minimum Requirement for Non-Destructive Testing Methods — Appendix 1 to
AD-Merkblatt HP5/3 (Germany).— Edition July 1989
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FCC Rules

This ISONIC 2005 / 2020 / STAR ultrasonic flaw detector and data recorder (hereinafter called ISONIC 2005 / 2020 / STAR) has been
tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed
to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can
radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio
communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause
harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is
encouraged to try to correct the interference by one or more of the following measures:

. Reorient or relocate the receiving antenna

. Increase the separation between the equipment and receiver

. Connect the equipment into an outlet on a circuit different from that to which the receiver is connected

. Consult the dealer or an experienced radio/TV technician for help

Safety Regulations

Please read this section carefully and observe the regulations in order to ensure your safety and operate the system as intended
Please observe the warnings and notes printed in this manual and on the unit

The ISONIC 2005 / 2020 / STAR has been built and tested according to the regulations specified in EN60950/VDEOQ805. It was in
perfect working condition on leaving the manufacturer's premises

In order to retain this standard and to avoid any risk in operating the equipment, the user must make sure to comply with any hints and
warnings included in this manual

Depending on the power supply the ISONIC 2005 / 2020 / STAR complies with protection class | /protective grounding/, protection class
I, or protection class IlI

Exemption from statutory liability for accidents

The manufacturer shall be exempt from statutory liability for accidents in the case of non-observance of the safety regulations by any
operating person

Limitation of Liability

The manufacturer shall assume no warranty during the warranty period if the equipment is operated without observing the safety
regulations. In any such case, manufacturer shall be exempt from statutory liability for accidents resulting from any operation

Exemption from warranty
The manufacturer shall be exempt from any warranty obligations in case of the non-observance of the safety regulations
The manufacturer will only warrant safety, reliability, and performance of the ISONIC 2005 / 2020 / STAR if the following safety

regulations are closely observed:

. Setting up, expansions, re-adjustments, alterations, and repairs must only be carried out by persons who have been authorized by
manufacturer

e  The electric installations of the room where the equipment is to be set up must be in accordance with IEC requirements

e  The equipment must be operated in accordance with the instructions

e  Any expansions to the equipment must comply with the legal requirements, as well as with the specifications for the unit concerned

. Confirm the rated voltage of your ISONIC 2005 / 2020 / STAR matches the voltage of your power outlet

e  The mains socket must be located close to the system and must be easily accessible

. Use only the power cord furnished with your ISONIC 2005 / 2020 / STAR and a properly grounded outlet /only protection class I/

. Do not connect the ISONIC 2005 / 2020 / STAR to power bar supplying already other devices. Do not use an extension power cord

e Any interruption to the PE conductor, either internally or externally, or removing the earthed conductor will make the system unsafe
to use /only protection class I/

e Any required cable connectors must be screwed to or hooked into the casing

e  The equipment must be disconnected from mains before opening

e To interrupt power supply, simply disconnect from the mains

e Any balancing, maintenance, or repair may only be carried out by manufacturer authorized specialists who are familiar with the

inherent dangers

Both the version and the rated current of any replacement fuse must comply with specifications laid down

. Using any repaired fuses, or short-circuiting the safety holder is illegal

. If the equipment has suffered visible damage or if it has stopped working, it must be assumed that it can no longer be operated
without any danger. In these cases, the system must be switched off and be safeguarded against accidental use

e  Only use the cables supplied by manufacturer or shielded data cable with shielded connectors at either end

. Do not drop small objects, such as paper clips, into the ISONIC 2005 / 2020 / STAR

. Do not put the ISONIC 2005 / 2020 / STAR in direct sunlight, near a heater, or near water. Leave space around the ISONIC 2005 /
2020/ STAR

. Disconnect the power cord whenever a thunderstorm is nearby. Leaving the power cord connected may damage the ISONIC 2005
12020 / STAR or your property
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e  When positioning the equipment, external monitor, external keyboard, and external mouse take into account any local or national
regulations relating to ergonomic requirements. For example, you should ensure that little or no ambient light is reflected off the
external monitor screen as glare, and that the external keyboard is placed in a comfortable position for typing

Do not allow any cables, particularly power cords, to trail across the floor, where they can be snagged by people walking past

The voltage of the External DC Power Supply below 11 V is not allowed for the ISONIC 2005 / 2020 / STAR unit

The voltage of the External DC Power Supply above 16 V is not allowed for the ISONIC 2005 / 2020 / STAR unit

Charge of the battery for the ISONIC 2005 / 2020 / STAR unit is allowed only with use of the AC/DC converters / chargers supplied
along with it or authorized by Sonotron NDT

Remember this before:

balancing

carrying out maintenance work
repairing

exchanging any parts

Please make sure batteries, rechargeable batteries, or a power supply with SELV output supplies power

Software

ISONIC 2005 / 2020 / STAR is a software controlled inspection device. Based on present state of the art, software can never be
completely free of faults. ISONIC 2005 / 2020 / STAR should therefore be checked before and after use in order to ensure that the

necessary functions operate perfectly in the envisaged combination. If you have any questions about solving problems related to use the
ISONIC 2005 / 2020 / STAR, please contact your local Sonotron NDT representative
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ISONIC 2005 / 2020 / STAR uniquely combines functionality and mobility of high performance portable
digital ultrasonic flaw detector with recording, imaging, and data processing capabilities of smart
computerized inspection system

ISONIC 2005 / 2020 / STAR resolves a variability of ultrasonic inspection tasks:

O A-Scan-based inspection using conventional pulse echo, back echo attenuation, and through
transmission techniques

O Straight Line Scanning Record - based inspection:

a

a

Thickness Profile B-Scan imaging and recording, which is performed through continuous
measuring of thickness value along straight line type probe trace

B-Scan cross-sectional imaging and recording of defects for longitudinal and shear wave
inspection, which is performed through continuous measuring of echo amplitudes and reflectors
coordinates along straight line type probe trace

CB-Scan horizontal plane-view imaging and recording of defects for shear, surface, and guided
wave inspection, which is performed through continuous measuring of echo amplitudes and
reflectors coordinates along straight line type probe trace

TOFD Inspection — RF B-Scan and D-Scan Imaging along straight line type probe trace
For Straight Line Scanning records it may be used:

o0 Time-based mode — ISONIC 2005 / 2020 / STAR is equipped with built-
in real time clock

0 True-to-location mode — ISONIC 2005/ 2020 / STAR is equipped with
built-in incremental encoder interface

O XY-Scanning Record - based inspection:

a

a

Thickness Map imaging and recording, which is performed through continuous measuring of
thickness value along probe trace

Flaw Detection — Pulse Echo 3D imaging (C-Scan, B-Scan, D-Scan) and recording of defects
for straight beam inspection, which is performed through continuous measuring of echo
amplitudes and reflectors coordinates along probe trace

Flaw Detection — Through Transmission / Back Echo Attenuation 2D imaging and recording
(C-Scan) which is performed through continuous measuring of signal amplitudes along probe
trace

For XY-Scanning records it is necessary to use optional items such as scanning
mechanism driven either manually or automatically, 2 incremental encoders
built-in into a scanning mechanism, dual axis encoder USB Interface, and
MULTISCAN COMBO S ME inspection software package

For all types of Straight Line Scanning and XY-Scanning records A-Scans are captured for each probe
position along probe trace and may be played back and evaluated off-line at postprocessing stage. This
unique feature makes it possible off-line defect characterization through echo-dynamic pattern

analysis

Thickness Profile B-Scan Data recorded during Straight Line Scanning and Thickness Map data
recorded during XY-Scanning is presented in the format compatible with various Risk Based Inspection and
Maintenance procedures. Off-line measurements and statistical analysis functions also meet the
requirements of said procedures

ISONIC 2005 / 2020 / STAR has practically unlimited capacity for storing of

e Single A-Scans accompanied with corresponding instrument settings

e Ultrasonic signal spectrum graphs (FFT Graphs) accompanied with corresponding RF A-Scans and
instrument settings

e Various A-Scans sequences along with corresponding Thickness Profiles, or B-Scans, or CB-
Scans, or TOFD Maps depending on mode of operation selected accompanied with corresponding
instrument settings

ISONIC 2005 /2020 / STAR from Sonotron NDT - Operating Manual — Revision 2.38 - Page 12 of 380



ISONIC 2005 / 2020 / STAR complies with the requirements of National and International Codes:

ASME Section | — Rules for Construction of Power Boilers

ASME Section VIII, Division 1 — Rules for Construction of Pressure Vessels

ASME Section VIII, Division 2 — Rules for Construction of Pressure Vessels. Alternative Rules

ASME Section VIII Article KE-3 — Examination of Welds and Acceptance Criteria

ASME Code Case 2235 Rev 9 — Use of Ultrasonic Examination in Lieu of Radiography

Non-Destructive Examination of Welded Joints — Ultrasonic Examination of Welded Joints. —

British and European Standard BS EN 1714:1998

O Non-Destructive Examination of Welds — Ultrasonic Examination — Characterization of
Indications in Welds. — British and European Standard BS EN 1713:1998

a Calibration and Setting-Up of the Ultrasonic Time of Flight Diffraction (TOFD) Technique for the
Detection, Location and Sizing of Flaws. — British Standard BS 7706:1993

a WI00121377, Welding — Use Of Time-Of-Flight Diffraction Technique (TOFD) For Testing Of
Welds. — European Committee for Standardization — Document # CEN/TC 121/SC 5/WG 2 N
146, issued Feb, 12, 2003

Q ASTM E 2373 — 04 — Standard Practice for Use of the Ultrasonic Time of Flight Diffraction
(TOFD) Technique

a Non-Destructive Testing — Ultrasonic Examination — Part 5: Characterization and Sizing of
Discontinuities. — British and European Standard BS EN 583-5:2001

a Non-Destructive Testing — Ultrasonic Examination — Part 2: Sensitivity and Range Setting. —
British and European Standard BS EN 583-2:2001

O Manufacture and Testing of Pressure Vessels. Non-Destructive Testing of Welded Joints.

Minimum Requirement for Non-Destructive Testing Methods — Appendix 1 to AD-Merkblatt

HP5/3 (Germany).— Edition July 1989

oy Ny

ISONIC 2005 /2020 / STAR from Sonotron NDT - Operating Manual — Revision 2.38 - Page 13 of 380



2. Technical Data
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2.1. Instruments manufactured on or before Dec 1, 2007

Pulse Type:
Initial Transition:
Pulse Amplitude:

Pulse Duration:

Energy (Spike Pulse):
Modes:

Damping:

Internal Matching Coil —

Probe Impedance Matching:

PRF:

Optional Sync Output /
Input:

Gain:

Advanced Low Noise
Design:

Frequency Band:
Ultrasound Velocity:
Range:

Display Delay:

Probe Angle:

Probe Delay:

Display Modes:

Reject:
DAC/TCG:

DGS:
Gates:
Gate Start and Width:

Gate Threshold:
Measuring Functions —
Digital

Display Readout:

Freeze (A-Scans and
Spectrum Graphs)

Encoder Interface:
Imaging Modes:
Encoding:

Length of one record:
Method of Record:
Region of Interest:

Off-Line Image Analysis:
Data Reporting:

Positive Spike Pulse / Positive Square Wave Pulse

<5 ns (10-90%)

Spike pulse - smoothly tunable (18 levels) 50V ... 400 V into 50 Q at 4 levels of
excitation Energy

Square wave pulse - smoothly tunable (18 levels) 50V ... 400 V into 50 Q
Spike pulse - 10...70 ns for 50 Q2 load depending on Energy and Damping setup
Square wave pulse - 65...600 ns independently controllable in 5 ns step

4 discrete energy values / 40 pJ (min) to 250 pJ (max) — at 400V amplitude
Single / Dual

17 discrete resistances values / 25 Q) min to 1000 Q2 max

16 discrete inductivity values / 2 uH min to 78 pH max

0 — optionally; 15...5000 Hz controllable in 1 Hz resolution
Max +5V, 1 <5 ns, t 2100 ns, Load Impedance > 50 Q

0...120 dB controllable in 0.5 dB resolution
93 pnV peak to peak input referred to 80 dB gain / 35 MHz bandwidth

0.35 ... 35 MHz Wide Band / 34 Sub Bands

300...20000 m/s (11.81...787.4 "/ms) controllable in 1 m/s (0.1 "/ms) resolution
0.5...7000 us controllable in 0.01 ps resolution

0...3200 us controllable in 0.01 us resolution

0...90° controllable in 1° resolution

0 to 70 us controllable in 0.01us resolution - expandable

RF, Rectified (Full Wave / Negative or Positive Half Wave), Signal's Spectrum (FFT
Graph)

0...99 % of screen height controllable in 1% resolution

Theoretical — through keying in dB/mm (dB/") factor

Experimental — through sequential recording echo amplitudes from variously
distanced equal reflectors

46 dB Dynamic Range, Slope < 20 dB/us, Capacity < 40 points

Available for Rectified and RF Display

Standard Library for 18 probes / unlimitedly expandable

2 Independent Gates / unlimitedly expandable

Controllable over whole variety of A-Scan Display Delay and A-Scan Range

in 0.1 mm /// 0.001" resolution

5...95 % of A-Scan height controllable in 1 % resolution

27 automatic functions / expandable; Dual Ultrasound Velocity Measurement Mode
for Multi-Layer Structures; Curved Surface / Thickness / Skip correction for angle
beam probes; Ultrasound velocity and Probe Delay Auto-Calibration for all types of
probes

Freeze All — A-Scans and Spectrum Graphs / Freeze Peak — A-Scans / All
measurements functions, manipulating Gates, and +6dB Gain varying are available
for frozen signals

Built-in interface for incremental mechanical encoder

Thickness Profile B-Scan, Cross-sectional B-Scan, Plane View CB-Scan, TOFD
Time-based (built-in real time clock — 0.02 sec resolution)

True-to-location (incremental encoder — 0.5 mm resolution)

50...20000 mm (2"...800"), automatic scrolling

Complete raw data recording

Controllable over entire Display Delay, Probe Delay, Range, Ultrasound Velocity
and other appropriate instrument settings

A-Scan sequences recovery, Defects sizing, outlining, pattern recognition

Direct printout of Calibration Dumps, A-Scans, Spectrum Graphs, thickness profile
B-Scans, cross-sectional B-Scans, plane view CB-Scans, TOFD maps
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Data Storage Capacity:

Data Logger:

On-Board Computer:
RAM:

Internal Flash Memory -
Quasi HDD:

Outputs:

Screen:

Controls:
Compatibility with the
external devices:
Operating System:

Power:

Housing:
Dimensions:

Weight:

At least 100000 sets including calibration dumps accompanied with A-Scans
and/or Spectrum Graphs; At least 10000 sets including calibration dumps
accompanied with thickness profile B-Scans or cross-sectional B-Scans or plane
view CB-Scans or TOFD maps

Optional — organizes and manages database files capable to store up to 254745
records whereas each record includes complete <Instrument Setup @ A-Scan @
Wall Thickness (Distance) Reading> data

Pentium M 300MHz

128 Megabytes

2 Gigabytes

LAN, USB X 2, PS 2, SVGA

6.5" High Color Resolution (32 bit) SVGA 640x480 pixels 133x98 mm (5.24" x 3.86")
Sun-readable LCD; Maximal A-Scan Size (working area) — 130x92 mm (5.12" x
3.62")

Front Panel Sealed Keyboard, Front Panel Sealed Mouse, Touch Screen

PS 2 Keyboard and Mouse, USB Keyboard and Mouse, USB Flash Memory card,
Printer through USB or LAN, PC through USB or LAN, SVGA External Monitor
Windows™98SE — instrument operation

Fully compatible for networking and / or USB connection and off-line data analysis
and reporting in external PC running under Windows™98SE, Windows™2000,
Windows™XP

Mains - 100...240 VAC, 40...70 Hz, auto-switch; Battery 12V 8AH up to 6 hours
continuous operation

IP 53 rugged aluminum case with carrying handle

265x156x101 mm (10.43"x6.14"x3.98") - without battery

265x156x139 mm (10.43"x6.14"x5.47") - with battery

2.650 kg (5.83 Ibs) - without battery

3.580 kg (7.88 Ibs) - with battery
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2.2. Instruments manufactured after Dec 1, 2007

Pulse Type:
Initial Transition:
Pulse Amplitude:

Pulse Duration:

Energy (Spike Pulse):
Modes:

Damping:

Internal Matching Coil —

Probe Impedance Matching:

PRF:

Optional Sync Output /
Input:

Gain:

Advanced Low Noise
Design:

Frequency Band:
Ultrasound Velocity:
Range:

Display Delay:

Probe Angle:

Probe Delay:

Display Modes:

Reject:
DAC/TCG:

DGS:

Multiple DAC/DGS Curves*:

Gates:
Gate Start and Width:

Gate Threshold:
Measuring Functions —
Digital

Display Readout:

Freeze (A-Scans and
Spectrum Graphs)

Encoder Interface:
Imaging Modes:
Encoding:

Length of one record:
Method of Record:
Region of Interest:

Off-Line Image Analysis:
Data Reporting:

Positive Spike Pulse / Positive Square Wave Pulse

<5 ns (10-90%)

Spike pulse - smoothly tunable (18 levels) 50V ... 400 V into 50 Q at 4 levels of
excitation Energy

Square wave pulse - smoothly tunable (18 levels) 50V ... 400 V into 50 Q
Spike pulse - 10...70 ns for 50 Q2 load depending on Energy and Damping setup
Square wave pulse - 65...600 ns independently controllable in 5 ns step

4 discrete energy values / 40 pJ (min) to 250 uJ (max) — at 400V amplitude
Single / Dual

17 discrete resistances values / 25 Q) min to 1000 Q2 max

16 discrete inductivity values / 2 uH min to 78 pH max

0 — optionally; 15...5000 Hz controllable in 1 Hz resolution
Max +5V, 1 <5 ns, t 2100 ns, Load Impedance > 50 Q

0...120 dB controllable in 0.5 dB resolution
93 pV peak to peak input referred to 80 dB gain / 35 MHz bandwidth

0.35 ... 35 MHz Wide Band / 34 Sub Bands

300...20000 m/s (11.81...787.4 "/ms) controllable in 1 m/s (0.1 "/ms) resolution
0.5...7000 us controllable in 0.01 pus resolution

0...3200 pus controllable in 0.01 ps resolution

0...90° controllable in 1° resolution

0 to 70 us controllable in 0.01pus resolution - expandable

RF, Rectified (Full Wave / Negative or Positive Half Wave), Signal's Spectrum (FFT
Graph)

0...99 % of screen height controllable in 1% resolution

Theoretical — through keying in dB/mm (dB/") factor

Experimental — through sequential recording echo amplitudes from variously
distanced equal reflectors

46 dB Dynamic Range, Slope < 20 dB/us, Capacity < 40 points

Available for Rectified and RF Display

Standard Library for 18 probes / unlimitedly expandable

Main DAC/DGS Curve plus up to 3 (three) curves with individually controllable
levels in £14 dB range

2 Independent Gates / unlimitedly expandable

Controllable over whole variety of A-Scan Display Delay and A-Scan Range

in 0.1 mm /// 0.001" resolution

5...95 % of A-Scan height controllable in 1 % resolution

27 automatic functions / expandable; Dual Ultrasound Velocity Measurement Mode
for Multi-Layer Structures; Curved Surface / Thickness / Skip correction for angle
beam probes; Ultrasound velocity and Probe Delay Auto-Calibration for all types of
probes

Freeze All — A-Scans and Spectrum Graphs / Freeze Peak — A-Scans / All
measurements functions, manipulating Gates, and +6dB Gain varying are available
for frozen signals

Built-in interface for incremental mechanical encoder

Thickness Profile B-Scan, Cross-sectional B-Scan, Plane View CB-Scan, TOFD
Time-based (built-in real time clock — 0.02 sec resolution)

True-to-location (incremental encoder — 0.5 mm resolution)

50...20000 mm (2"...800"), automatic scrolling

Complete raw data recording

Controllable over entire Display Delay, Probe Delay, Range, Ultrasound Velocity
and other appropriate instrument settings

A-Scan sequences recovery, Defects sizing, outlining, pattern recognition

Direct printout of Calibration Dumps, A-Scans, Spectrum Graphs, thickness profile
B-Scans, cross-sectional B-Scans, plane view CB-Scans, TOFD maps
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Data Storage Capacity:

Data Logger:

On-Board Computer:
RAM:

Internal Flash Memory -
Quasi HDD:

Outputs:

Screen:

Controls:
Compatibility with the
external devices:
Operating System:
Power:

Housing:
Dimensions:

Weight:

At least 100000 sets including calibration dumps accompanied with A-Scans
and/or Spectrum Graphs; At least 10000 sets including calibration dumps
accompanied with thickness profile B-Scans or cross-sectional B-Scans or plane
view CB-Scans or TOFD maps

Optional — organizes and manages database files capable to store up to 254745
records whereas each record includes complete <Instrument Setup @ A-Scan @
Wall Thickness (Distance) Reading> data

AMD LX 800 - 500MHz

1 Gigabyte

4 Gigabytes

LAN, USB X 2, PS 2, SVGA

6.5" High Color Resolution (32 bit) SVGA 640x480 pixels 133x98 mm (5.24" x 3.86")
Sun-readable LCD; Maximal A-Scan Size (working area) — 130x92 mm (5.12" x
3.62")

Front Panel Sealed Keyboard, Front Panel Sealed Mouse, Touch Screen

PS 2 Keyboard and Mouse, USB Keyboard and Mouse, USB Flash Memory card,
Printer through USB or LAN, PC through USB or LAN, SVGA External Monitor
Windows™XP Embedded

Mains - 100...240 VAC, 40...70 Hz, auto-switch; Battery 12V 8AH up to 6 hours
continuous operation

IP 53 rugged aluminum case with carrying handle

265x156x101 mm (10.43"x6.14"x3.98") - without battery

265x156x139 mm (10.43"x6.14"x5.47") - with battery

2.650 kg (5.83 Ibs) - without battery

3.580 kg (7.88 Ibs) - with battery
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3. ISONIC 2005/ 2020 / STAR - Scope of
Supply
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Item Order Code (Part Note
#)

ISONIC 2005 / 2020 / STAR — Portable Digital Ultrasonic Flaw Detector SA 80450 Standard Configuration
and Recorder
. ISONIC 2005 / 2020 / STAR Electronic unit — including:
> Internal PC (P-MMX-S - 300 MHz, RAM-1G, Quazi-HDD Flash Memory
Card 4G, active TFT sVGA LCD High Color Sun-Readable Touch Screen,
Built-In Interfaces: 2XUSB; Ethernet; PS/2; Front Panel Sealed Keyboard
and Mouse; sVGA output)
> 100 ... 250 VAC AC/DC converter
> SE 248000 - UDS 3-5 Pulser Receiver Card:
0 Combined “Spike wave — Selectable Energy” / “Square Wave —
Tunable Width” Tunable Firing Level Pulser; Single / Dual Modes of
Operation; Damping: 17 discrete resistances values / 25Q min to 1000Q
max; Internal Matching Coil — Probe Impedance Matching: 16 discrete
inductivity values / 2 pH min to 78 uH max; Special Probe Protection Circuit
to Prevent Probe Damage for Not Properly Adjusted Pulse Width
0 Gain: 0...120 dB controllable in 0.5 dB resolution; Advanced Low
Noise Design: 93uV peak to peak input referred to 80 dB gain / 35 MHz
bandwidth; Ffrequency Band: 0.35 ... 35 MHz Wide Band / 34 Sub Bands
O  Built-In Incremental Encoder Interface

. Software
Q ISONIC 2005/ 2020 / STAR Multi-Functional Package (SWA
99C05200)
¢ A-Scan

= A-Scan (Full Wave / Neg Wave / Pos Wave rectification;
RF)

= DAC, DGS, TCG

= FFT (Frequency Domain Signal Presentation) - additional
feature for the defects evaluation and / or pattern recognition / probes
characterization

= Enhanced Signal Evaluation for the Live and Frozen A-
Scans including Gain Adjustments while in the Freeze Mode

= Dual Ultrasound Velocity Multi-echo Measurements Mode

= Thickness / Skip Distance / Curved Surface Correction
Measurements Mode for Angle Beam Probes

= Probe Delay / Ultrasound Velocity Auto Calibration Mode
for Straight Beam and Angle Beam Probes

= Flank, Top, Flank-First, Top-First Mode of Measurements
for Gated Signals Sequences

= Comprehensive Setup and A-Scan / FFT graph report,
Direct Connection To any Type of USB Windows Printer; Printing through
the LAN

€  Thickness Profile Imaging and Recording (Typical
Application: Corrosion characterization)

= Continuous measuring of the thickness value along the
probe trace

= Time-based (real time clock) and true-to-location (built-in
incremental encoder interface) modes of data recording

= Recording of the complete sequence of A-Scans along
with the thickness profile

= Off-line evaluation of the thickness profile images
featured with:

P Sizing of the thickness damages at any location
along the stored image: remaining thickness, thickness loss, and the
length of the damage

» Play-back and evaluation of the A-Scans obtained
during the thickness profile recording

» Echo Dynamic Pattern Analysis

» Off-line reconstruction of the thickness profile image
for the various Gain / Gate setup

= Comprehensive Setup and Scanning Reporting, Direct
Connection To any Type of USB Windows Printer; Printing through the LAN
€  B-Scan cross-sectional imaging and recording of the
defects for longitudinal and shear wave inspection (Typical Application:
Pulse echo inspection of welds, composites, metals, plastics, and the
like)
= Continuous measuring of the echo amplitudes and
reflectors coordinates along the probe trace
= Time-based (real time clock) and true-to-location (built-in
incremental encoder interface) modes of data recording
= Recording of the complete sequence of A-Scans along
with the B-Scan defects images
= Off-line evaluation of the B-Scan record images featured
with:

P Sizing of the defects at any location along the stored

image — coordinates and projection size

ISONIC 2005/ 2020 / STAR from Sonotron NDT - Operating Manual — Revision 2.38 - Page 20 of 380




Item Order Code (Part
#)

Note

» Play-back and evaluation of the A-Scans obtained
during the B-Scan imaging and recording
» Echo Dynamic Pattern Analysis

» Defects outlining and pattern recognition based on
the A-Scan sequence analysis
» Off-line reconstruction of the B-Scan defects images
for the various Gain / Rejection level setup
» DAC / DGS B-Scan normalization
= Comprehensive Setup and Scanning Reporting, Direct
Connection To any Type of USB Windows Printer; Printing through the LAN
€  CB-Scan horizontal plane-view imaging and recording of
the defects for the shear, surface, and guided wave inspection (Typical
Application: Long range pulse echo and CHIME inspection of the
annular plates and piping, stress corrosion, etc; weld inspection,
surface wave inspection)
= Continuous measuring of the echo amplitudes and
reflectors coordinates along the probe trace
= Time-based (real time clock) and true-to-location (built-in
incremental encoder interface) modes of data recording

= Recording of the complete sequence of A-Scans along
with the CB-Scan defects images

= Off-line evaluation of the CB-Scan record images featured
with:

P Sizing of the defects at any location along the stored
image — coordinates and projection size

P Play-back and evaluation of the A-Scans obtained
during the CB-Scan imaging and recording

» Echo Dynamic Pattern Analysis

» Defects outlining and pattern recognition based on
the A-Scan sequence analysis

»  Off-line reconstruction of the CB-Scan defects
images for the various Gain / Rejection level setup

» DAC /DGS CB-Scan normalization

= Comprehensive Setup and Scanning Reporting, Direct
Connection To any Type of USB Windows Printer; Printring throughthe LAN

€ TOFD Inspection — RF B-Scan and D-Scan Imaging
(Typical Application: weld inspection; CHIME inspection)

= Time-based (real time clock) and true-to-location (built-in
incremental encoder interface) modes of data recording

= Averaging A-Scans whilst recording as per operator's
selection

= Recording of the complete sequence of A-Scans along
with the TOFD map

= Off-line evaluation of the TOFD Map featured with:

» Improvement of the near to surface resolution
through the removal of the lateral wave and back echo records from the
TOFD Map

P Linearization and straightening of the TOFD Map

» Increasing the contrast of the TOFD images through
the varying Gain and rectification

» A-Scan sequence analysis

» Defects pattern recognition and sizing

= Comprehensive Setup and Scanning Reporting, Direct
Connection To any Type of USB Windows Printer; Printring throughthe LAN

. USB Flash Drive for External Data Storage

. 12 months warranty
. Lifetime free software update

Backup Pen-Drive SFD 2005098

Operating Manual on the
Backup Pen-Drive

Silicon Rubber Jacket SK 2005111

Optional item

Rechargeable Battery Ni MH 9 AH / 12V SK 2005102

Optional item

Battery Charger SK 2005103

Optional item
Required for battery charge

Travel Hard Case SK 2005104

Optional item
IAllows safe cargo
transportation

External USB Keyboard SK 2005105

Optional Item
Extremely Useful at
Postprocessing Stage

External USB Optical Mouse SK 2005106

Optional Item
Extremely Useful at

Postprocessing Stage
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Item

Order Code (Part
#)

Note

Postprocessing SW Package for Office PC: IOFFICE 2005 - ISONIC
2005 / 2020 / STAR Office /// comprehensive postprocessing of
inspection results files captured by ISONIC 2005 / 2020 / STAR ///
automatic creating of ISONIC 2005 / 2020 / STAR inspection reports in
MS Word® format

SWA99C0204

Optional Item

10

Postprocessing SW Package for Office PC: D-LINE - ISONIC D-
Spreadsheet Creator /// automatic MS Excel® thickness spreadsheet
creating through conversion of thickness B-Scan files captured by
ISONIC 2005 / 2020 / STAR and ISONIC 2006 using line scanning
mode; compliant with various Risk Based Inspection and Maintenance
procedures

SWAQ99C0212

Optional Item

11

Optional SW Package: ISONIC Data Logger — comprehensive data
recording, on-site and off-site editing, importing, exporting, and
reporting for routine(goint-by-point wall thickness gauging. Thanks to
automatic MS Excel” thickness spreadsheet creating ISONIC Data
Logger is compliant with various Risk Based Inspection and
Maintenance procedures

SWA 99C05280

Optional Item

12

Inspection SW Package: MULTISCAN-COMBO - S ME Immersion Mode
/ Contact Mode Inspection with Straight Beam Single Element or Dual
Ultrasonic Probes for Internal Defects with Tomographical and 3D Data
Presentation and User Defined Mapping Scheme, Complete Raw Data
Capturing
= Support of all A-Scan types (Full Wave / Neg Wave / Pos Wave
rectification; RF) while scanning, recording and imaging defects
= Support of Linear or DAC- , DGS- , TCG- normalized recording
and imaging defects
= FFT (Frequency Domain Signal Presentation) - additional feature
for defects evaluation and / or pattern recognition
= Testing Integrity / Coverage Imaging (Top View of Probe
Manipulation Area) Showing of Actually Implemented Probe Trace
= Pulse Echo Amplitude / Distance C-Scan (Top View of Scanning
Area either Global or Sliced - switcheable)
= Pulse Echo B-Scan (Side View of the Scanning Area either
Global or Sliced - switcheable)
= Pulse Echo D-Scan (End View of the Scanning Area either Global
or Sliced - switcheable)
= B-Scan (Side View - Thickness / Corrosion Profile either Global
or Sliced - switcheable)
= D-Scan (End View - Thickness / Corrosion Profile either Global or
Sliced - switcheable)
= Through Transmission / Back Echo Attenuation Amplitude C-
Scan (Top View of Scanning Area)
= Versatile Color Palette for Defects Imaging
= Postprocessing: Off-line Recovery and Play-Back of A-Scans;
Echo Dynamic Pattern Recognition; Sizing of defects; Gate
Manipulation - Rebuild C-, B-, and D-Scan views for various Gate
Settings; Statistical Analysis; Slicing and Filtering Images
= Comprehensive Setup and Scanning Reporting, Direct
Connection To any Type of USB or LAN Windows Printer

SWA 999806

Optional Item

13

Dual Axis Encoder USB Interface

S 808440

Optional Item

14

Dual Channel TOFD preamplifier package including:

= Dual Channel TOFD preamplifier

= Set of 2 low noise coaxial cables (10 meters length each) for
connection to the signal input of ISONIC instrument

SA 80442

Optional Item

Improves long cable
connection to ultrasonic
probes. Typical applications
are TOFD, Corrosion
Detection, etc performed
with probes fitted into
scanner / crawler frame —
refer to chapter 10 of this

Operating Manual
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# Item Order Code (Part Note
#)
15 ISONIC Alarmer - standard firmware configuration and hardware SE 554780987 |Optional Item

platform including:

= Internal Speaker functioning according to alarm logic settings of
UDS 3-5 Pulser Receiver in the ISONIC 2005 / 2020 / STAR, 2006,
2007 instruments / UDS 3-6 Pulser Receiver of ISONIC 2008
Instrument

= Speaker Volume Control Wheel

= Headphone Connector

=  25-pin programmable Input / Output interface (blank)

= USB port and cable for connecting to ISONIC 2005 / 2020 / STAR,
2006, 2007, 2008 instrument

Refer to paragraph 8.8.5 of
this Operating Manual

16

Ultrasonic probes, fixtures, scanners, cables and other accessories
depending on the inspection tasks to be resolved

Optional Items

Ultrasonic probes, fixtures,
scanners, cables and other
accessories from any

manufacturer may be used
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4. Operating ISONIC 2005/ 2020 / STAR
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Please read the following information before you use ISONIC 2005 / 2020 / STAR. It is essential to read and
understand the following information so that no errors occur during operation, which could lead damaging of
the unit or misinterpretation of inspection results

4.1. Preconditions for ultrasonic testing with ISONIC 2005 /
2020/ STAR

Operator of ISONIC 2005 / 2020 / STAR must be certified as at least Level 2 Ultrasonic Examiner
additionally having the adequate knowledge of

e operating digital ultrasonic flaw detector

e basics of computer operating in the Windows™ environment including turning computer on/off,
keyboard, touch screen and mouse, starting programs, saving and opening files
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4.2. ISONIC 2005/ 2020 / STAR Controls and Terminals

@

PS 2 Port Switch has 2 positions:
Front — Front Panel Keyboard and Mouse active; PS2 Port inactive
Rear — Front Panel Keyboard and Mouse inactive; PS2 Port active
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4.3. Turning On / Off

ISONIC 2005 / 2020 / STAR may be powered from:

O 100...250 VAC through external AC/DC converter
O External 11...16V DC source (12V — typical)
O Rechargeable battery (optionally)

AC Power Supply

O Ensure that power switch is in (@) position before connecting power cords

O Connect one end of AC power cord to AC/DC converter and plug another end into AC mains

O Connect DC power cord with suppression filter outgoing from AC/DC converter to DC Supply
Voltage Input of ISONIC 2005 / 2020 / STAR

External DC Power Supply
O Ensure DC mains do supply voltage between 11 V and 16 V

O Ensure that power switch is in (o) position before connecting power cord
O Connect one end of DC power cord with suppression filter to DC Supply Voltage Input of
ISONIC 2005 / 2020 / STAR and plug another end into DC mains

Battery

O Ensure that power switch is in (@) position
O Plug in battery and fix it using 4 screws

Power-Up and Turn Off

To Power-Up ISONIC 2005 / 2020 / STAR set power switch into | position. An automatic system test
program will then be executed; during this test various texts and information appear followed by the screen

as below while booting up
Instruments manufactured on or before Dec 1, Instruments manufactured after Dec 1, 2007

2007

Sonron NDT

ISONIC Instruments Line

Wait until ISONIC 2005 / 2020 / STAR start screen| becomes active automatically upon boot up is
completed

[1]|operate

[ 2 |settings

[ 3 |Exit To Windows

|4 |shut Down
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= ' -
Click on toree  Jorpress 1 on front panel keyboard or press E| on external keyboard to operate
ISONIC 2005 / 2020 / STAR — refer to Chapters 5 and 6 of this Operating Manual

2 |Settings . i
Click on LJ or press 2 on front panel keyboard or press @ on external keyboard to proceed
with general settings of ISONIC 2005 / 2020 / STAR - refer to Chapters 7 and 8 of this Operating Manual

| 3 |Exit To Windows
Click on —J or press _3 Jon front panel keyboard or press on external keyboard if it is

necessary to fulfill some general purpose Windows procedures such as setting up drivers for external
devices (printers, USB memory card, and the like), connecting to LAN, quasi-disk management, etc — refer
to Chapter 8 of this Operating Manual

= i -
To turn ISONIC 2005 / 2020 / STAR off click on __ """ Jor press on —2__ on front panel keyboard or
press on external keyboard then wait until the screen as below appears:

Instruments manufactured on or before Dec 1, Instruments manufactured after Dec 1, 2007
2007

It's now safe to turn off
the ISONIC

Set power switch into (@) position upon

®

After turning ISONIC 2005 / 2020 / STAR OFF wait at least 10...30 seconds before switching it ON again
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5. UDS 3-5 Pulser Receiver
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5.1. Start Up UDS 3-5 Pulser Receiver

While ISONIC 2005 / 2020 / STAR start screen| is active click on toree Jorpress 1 on the front
panel

[ 1 |operate

[ 2 |settings

[ 3 |Exit To Windows

|4 |shut Down

keyboard or press El on external keyboard

5.2. Main Operating Surface

UDS 3-5 is fully controllable through the main operating surface:

UDS3-5 - ISOMIC Pulser/Receiver

"

05 Gain
145 dB ‘
100 Range
«
5 US YVelocity
5920 mjs ‘
100 Dizplay Delay
0 ps

o By

e By

= By

l
|
|
|
|
|
|
|
|

[en By

(Gl FULSER RECEIVER GATEA Menu "Ds' 3 - 5
GATE B ALARM  DAC/TCG _ MEASURE _ Selection
BERL ]} Value AVC(B i i gle| 2 w
Cloze MI -36 dB Freeze Save | Open | Frnt DGES
Value Box -

Digital Readout
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5.2.1. Main Menu

Main Menu consists of eight topics; each topic is associated with corresponding submenu appearing as
vertical bar showing names for five parameters or modes of operation, their current settings and current
value of increment/decrement for a parameter. The active topic is highlighted

Gain
14 b dB ‘

Range

Cloomn K

I
|
| 100 mm
|
|
|
|
|

UD53-5 - ISONIC Pulser/Receiver

5 U5 Velocity
5920 mjs ‘

100 Dizplay Delay ‘
0 1s

PULSER RECEIVER GATE A Menu
GATE B ALARM DAC/TCG /A MEASURE Selecign

[ [ I
rm| |

: Active Topic : : Main Menu : i Vertical bar — Submenu

H correspondmg to E
To activate a topic the following manipulations are applicable: hlghllghted active tOpIC
* Keyboard -

fa—
B Press ™ J on front panel keyboard or on external keyboard until highlighting required topic
OR
B Press <Alt>+<M> on external keyboard = Menu Selection fore color changes to white - then use

e Mouse / Touch Screen
B Click on topic's name

-

B Click on

e Combined

T »

B Click on Menu Selection = Menu Selection fore color changes to white - then use —/, "=/,

‘ , ‘ / on front panel keyboard orI . . Ion external keyboard
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5.2.2. Sub Menu BASICS

. .
T

v dhdh dh 4 4

R Sk 3 3%

i T N Y NS

To control Gain the following
manipulations are applicable:

e Mouse / Touch Screen

B Click or press and hold on the appropriate

e Keyboard

-
B Press 1 J on front panel keyboard or H or <Alt>+<G> on external keyboard = Gain fore color

changes to white - then use !J '_’J !J !J on front panel keyboard or , , , on

external keyboard

e Combined

B Click on Gain = Gain fore color changes to white - then use !J 2) :J !J on front panel
keyboard or , , on external keyboard

®

Gain setup is also possible through a number of other submenus following the same rules as above
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e

T b | by | o by |

L
0% b
. I /
To control Range the following I
manipulations are applicable: I /
/
e Mouse / Touch Screen ly

B Click or press and hold on the appropriate

e Keyboard

®

-
Press 2 J on front panel keyboard or @ or <Alt>+<A> on external keyboard = Range fore color

changes to white - then use !J _J _J !J on front panel keyboard or , , , on

external keyboard
Combined

Click on Range = Range fore color changes to white - then use !J zj :J ﬂ on front
panel keyboard or , , on external keyboard

Range setup is also possible through a number of other submenus following the same rules as above
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5 US Velocity

5920 mfs
100 Dizplay Delay

0 ps

To control US Velocity the following
manipulations are applicable:

e Mouse / Touch Screen

B Click or press and hold on the appropriate

e Keyboard

F i
B Press 3 J on front panel keyboard or B or <Alt>+<U> on external keyboard = US Velocity fore

color changes to white - then use !J '_’J _J ij on front panel keyboard or , , , on

external keyboard
e Combined

B Click on US Velocity = US Velocity fore color changes to white - then use !J '_’J !J !J
on front panel keyboard or , , on external keyboard
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To control Display Delay the following l
manipulations are applicable:

Iy
Mouse / Touch Screen 1/
4

B Click or press and hold on the appropriate
Keyboard

F
B Press _4 J on front panel keyboard or @ or <Alt>+<E> on external keyboard = Display Delay

fore color changes to white - then use !J '_’J _J !J on front panel keyboard or [, , ,

on external keyboard
Combined

B Click on Display Delay = Display Delay fore color changes to white - then use !J '_’J !J

!J on front panel keyboard or , , , on external keyboard
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F

e, value of Click on this button or press 5
increment/decrement for @
Reject setup, on front panel keyboard or or
o, <Alt>+<5> on external keyboard
to select value of
» N increment/decrement for Reject
\ 100 Range ‘ setting
S 100 mm
N\

\ 5 U5 Yelocity ‘
: Current value of : \\ h920 mfs

: Reject
i % ~

To control Reject the following
manipulations are applicable:

N

I
I
e Mouse / Touch Screen I

B Click or press and hold on the appropriate
e Keyboard

changes to white - then use ' * . , " on front panel keyboard or , , , on

external keyboard

-
B Press' _5__ on front panel keyboard or @ or <Alt>+<E> on external keyboard = Reject fore color

e Combined

LINCIALING &

B Click on Reject = Reject fore color changes to white - then use = ~_/ on front
panel keyboard or , , , on external keyboard

¢ Signals below Reject level (small signals) are suppressed

¢ Signals exceeding Reject level (large signals) are presented on the A-Scan without affecting their
original height

+ Part of large signal wave form below Reject level is suppressed

|

7
.
Y
e
+
.
.
.
+

i
i
!
+ + o+ + o H O+ o+
i

++++++||+-

E N S

¢ Reject level may be applied to rectified signals only (Display Modes Full, NegHalf and PosHalf -
refer to paragraph 5.2.4 of this Operating Manual)
¢ Reject setup is also possible through a number of other submenus following the same rules as above
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5.2.3. Sub Menu PULSER

Amplitude of initial pulse (Firing Level) is controllable through button J appearing on the main operating
surface upon activating submenu PULSER

To activate |Firing Level Control subwindow] click on @
\

Tunin
e
Pulzer Mode
.
Pulze Width
226 nS ‘
D ampin
.
. "I | . 50 PEF ‘

BASICS PULSER GATE A Menu

GATE B ALARM DAC/TCG  MEASURE Selectiof.

T [ RO PPN

Cloze EM| 90 dB Freeze
C
To control Firing Level the following manipulations are applicable: _ <. -~
. -

'~
e Mouse / Touch Screen - z

ln By

L =
-

® Click or press and hold on the appropriate Click on 2L

Firing Level Control popup window upon completing

or on any control outside

¢ Combined

Click on Firing Level = Firing Level fore color changes to white - then use '. , ‘ , ‘ , '.'

ESC En re.r

on front panel keyboard or ﬂ E g @ on external keyboard. Press X" Jor *= on front panel
keyboard or Esc or Enter on an external keyboard upon completing

®

There are 18 grades (1 through 18) for setting Firing Level — amplitude of initial pulse is controlled from
50 V (Firing Level = 1) to 400 V (Firing Level = 18)
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Current value of

Tuning
uH
Pulser Mode
SINGLE
Pulse Width
220 nS
D amping
H}ﬂl‘.} ‘.-'.1 *
4ﬂﬂ Hz *I
& uns 2-5
11
To control Tuning the following 11
manipulations are applicable: 1]
e Mouse / Touch Screen 1]
B Click or press and hold on the appropriate
e Keyboard
rF
B Press _1 J on front panel keyboard or H or <Alt>+<G> on external keyboard = Tuning fore
color changes to white - then use ?_ , ‘ ‘ '.' / on front panel keyboard orI . . Ion
external keyboard
e Combined
B Click on Tuning = Tuning fore color changes to white - then use ?_ ? . , " on front

panel keyboard or I . I on external keyboard

There are 16 (sixteen) matching coils, which may be connected at parallel to ultrasonic probe in
order to obtain best available probe impedance matching / signal to noise ratio. Possible values for

the matching coil inductance are: 2uH, 7uH, 12uH, 17uH, 24uH, 29uH, 34uH, 39uH, 41uH, 46uH,
51pH, 56pH, 63uH, 68uH, 73uH, and 78 uH

Setting the Tuning to "NO" disconnects matching coil
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= By

Iro By

Pulse Width

220 nS ‘
Bl e
R «
& uns :'57’-5

To control Pulser Mode the following

——

=%

o2
vAhAh AR dh 4

iy

manipulations are applicable: | II
|
e Mouse / Touch Screen "
B Click or press and hold on the appropriate
e Keyboard
F

B Press _2 _J on front panel keyboard or @ or <Alt>+<U> on external keyboard = Pulser Mode

fore color changes to white - then use !_ ?/ . , !' on front panel keyboard or , , ,
on external keyboard

e Combined

®

There are two Pulser Modes available: Single and Dual
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Current value of Pulse Width
(Duration of Square Wave
Initial Pulse)

ne Tuning
..................... ot I
~
~ Pulzer Mode
= SINGLE ‘

ﬂl
e «
\_I uM 3-5

To control Pulse Width the following

>~

"'""l""""

Ty | = by [ 1o by | o by [ =y

manipulations are applicable: ' I
e Mouse / Touch Screen l'/l
B Click or press and hold on the appropriate
e Keyboard
B Press ‘Er J on front panel keyboard or B or <Alt>+<E> on external keyboard = Pulse Width
fore color changes to white - then use ' , ‘ ‘ ‘ / on front panel keyboard orl . .

on external keyboard
e Combined

INCINIIR S

B Click on Pulse Width = Pulse Width fore color changes to white - then use
on front panel keyboard or , , , on external keyboard

®

¢ Pulse Width (Duration of Square Wave Initial Pulse) is tunable between 65 ns to 600 ns in 5 ns steps

+ Attempt to decrease Pulse Width below 65 ns switches to excitation of Spike Pulse instead of Square
Wave Pulse. There are 4 (four) energy levels available for the Spike Pulse excitation; said levels are
indicated in the Pulse Width field:

o Spike (250uJ) — spike pulse with the 250 nJ energy of excitation
0 Spike (160uJ) — spike pulse with the 160 pJ energy of excitation
o Spike (90uJ) — spike pulse with the 90 pJ energy of excitation
o Spike (40uJ) — spike pulse with the 40 puJ energy of excitation

¢ The energy of Spike Pulse excitation is controllable through the same controls as Pulse Width

¢ Attempt to increase energy of Spike Pulse excitation above 250 pJ switches to excitation of Square
Wave Pulse instead of Spike Pulse

+ Energy levels of Spike Pulse excitation are calibrated at Firing Level =18
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Current value of
Damping

E 0 ; Tuning
.............. -‘--\-----------1 12 I-IH ‘
N Pulzer Mode
\\ SINGLE ‘

= by

Ina By

S Pulse Width
N

e By

N\ 220 nS

N\ D -
amping
1000 &2 '
i1} FRF
400 Hz

&| uns

4= By

Itn By

To control Damping the following
manipulations are applicable:

\\\w
LS

e Mouse/ Touch Screen /

B Click or press and hold on the appropriate

e Keyboard
F 3
B Press _4 J on front panel keyboard or or <Alt>+<A> on external keyboard = Damping fore
color changes to white - then use !_ ? ‘ , .' on front panel keyboard or , , , on
external keyboard
e Combined
B Click on Damping = Damping fore color changes to white - then use ?_ ? ‘ , '.' on

front panel keyboard or , , , on external keyboard

®

There are 17 (seventeen) discrete damping resistors, which may be connected at parallel to ultrasonic
probe, their resistance values are 25€2, 30€2, 35€2, 40Q2, 45Q), 56Q2, 6502, 7602, 90C2, 115C2, 13012,
15002, 18002, 24002, 320Q2, 50002, and 1000 2
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Pulser Mnde

SINGLE
Pulse YWidth
136 nS
| Ddmping
1000 2
: /
I /
To control PRF the following I /
manipulations are applicable: I /
/
e Mouse / Touch Screen 1/
|4

B Click or press and hold on the appropriate |button|

e Keyboard

-
B Press _5 J on front panel keyboard or @ or <Alt>+<R> on external keyboard = PRF fore color

changes to white - then use !J '_’J :J !J on front panel keyboard or , , , on

external keyboard

e Combined

B Click on PRF = PRF fore color changes to white - then use !J '_’J :J !J on front panel
keyboard or , ,, on external keyboard

®

UDS 3-5 is equipped with a protection circuit preventing probe damage, which may be caused by not proper
setting of Tuning, or Damping, or Pulse Width, or Firing Level, or combination of them. Protection circuit
limits total energy delivered to firing output through automatic reducing of PRF until reaching safe mode of
operation
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5.2.4. Sub Menu RECEIVER

: Current setting of Filter

: representing central frequency :
: of the narrow band (resonant) :
: Filter

MHz ; 05  Gain -
FEREEEREEEEEEEEEEEEEEE -‘-: ------------ 1
~~ 11 dB 1
1| a
2
Frequency o
0.3b-3b HHZ 3
Diszplay * _pl
Full 4
Beject 4
0% ‘ /3
/
To control Filter the following I II
manipulations are applicable: 1y
e Mouse / Touch Screen 1
’

B Click or press and hold on the appropriate

e Keyboard
-

® Press _2 J on front panel keyboard or @ or <Alt>+<L> on external keyboard = Filter fore color

changes to white - then use ?_ , * . " on front panel keyboard or , , , on

external keyboard
e Combined

B Click on Filter = Filter fore color changes to white - then use ?_ ? ‘. '.'

keyboard or , 7 Y on external keyboard D
®

¢ The are 6 (six) narrow bands (resonant) filters with central frequencies as below:
0.5 % 0.15 MHz — recommended for 0.3 ... 0.8 MHz probes

1 * 0.3 MHz — recommended for 0.8 ... 1.5 MHz probes

2 £ 0.6 MHz — recommended for 1.5 ... 3.2 MHz probes

4 * 1.2 MHz — recommended for 3.2 ... 7.5 MHz probes

10 * 3 MHz — recommended for 7.5 ... 12.4 MHz probes

15 * 4.5 MHz — recommended for 12.4 ... 17 MHz probes

000000

¢ The narrow band (resonant) filtering is negated upon setting Filter to BB (Broad Band)

on front panel
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Current Frequency band of
the receiver

MHz
From - To
................. S —
N\
N\ < -
N 1
N\
_
2
_
3
_
4/
LT Beject ﬁ
0% 4
To control receiver's Frequency band ) /
the following manipulations are ! /
applicable: I,
Iy
e Mouse / Touch Screen I/
B Click or press and hold on the appropriate
e Keyboard

-
B Press 2 J on front panel keyboard or @ or <Alt>+<E> on external keyboard = Frequency fore

color changes to white - then use ?_ ? « , '.' on front panel keyboard or , , , on

external keyboard
e Combined

LINCIAAING 4

B Click on Frequency = Frequency fore color changes to white - then use =, 4, 2 on

front panel keyboard or ,, , on external keyboard

®

There are 28 (twenty eight) receiver's Frequency bands:

0.35-35MHz 0.35-19.5MHz 035-13MHz 0.35-52MHz 0.35-26MHz 0.35-1.3MHz 0.35-0.65 MHz
0.7 — 35 MHz 0.7 - 19.5 MHz 0.7 - 13 MHz 0.7 - 5.2 MHz 0.7 — 2.6 MHz 0.7 - 1.3 MHz
1.4 — 35 MHz 1.4 -19.5 MHz 1.4 - 13 MHz 1.4 -5.2 MHz 1.4 - 2.6 MHz
2.8 — 35 MHz 2.8 - 19.5 MHz 2.8 - 13 MHz 2.8 -5.2 MHz
7 — 35 MHz 7 -19.5 MHz 7 -13 MHz
10.5-35MHz 10.5-19.5MHz  10.5-13 MHz
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: Current mode of signal
: presentation (Display)

0.5 Gain
11 dB ‘
Filter
BB ‘
SN o - Frequency
S~ 0.35-3b MHz ‘
S - Display ‘
Full 7
L] Beject
0% /Iae
To select mode of signal presentation ;) Ve
/

(Display) the following manipulations
are applicable:

|u?~l{ b By e by o By =y

/ 7/
/
e Mouse / Touch Screen ly
’

B Click or press and hold on the appropriate

e Keyboard
-
® Press _4_J on front panel keyboard or or <Alt>+<I> on external keyboard = Display fore color

changes to white - then use !_ ?/ . ! on front panel keyboard or , , , on

external keyboard

e Combined

t» &3

B Click on Display = Display fore color changes to white - then use =, '~ =7 = / on front

panel keyboard or , , , on external keyboard
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®

¢ There are four Display modes for time domain signal presentation:

RF —no
rectifying

PosHalf —
positive half
wave
rectifying

NegHalf —
negative half
wave
rectifying

Full — both
waves
rectifying
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¢ Frequency domain signal presentation is available through FFT Display mode. Refer to paragraph 5.2.14
of this Operating Manual for instructions related to frequency domain signal presentation

Time Domain

C
C
fo 4-

BE w— 2| UDS 3-5

v ﬁ‘ ‘I

b
DG5S

=
Open

Close Em | Freeze

Save

Frequency Domain Signal presentation is not possible if:
o DAC is active (refer to paragraph 5.2.9 of this Operating Manual)
0 TCG is active (refer to paragraph 5.2.9 of this Operating Manual)
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5.2.5. Sub Menu GATE A

Current status of Gate A

N 05 Gain
hRN 3d8 &a
Bl e
2 aStart h
26 mm

2 awidth "
8 mm .

10 aThrezhold I
45 2% ‘

7

o iy [ ety oy | |y

To switch Gate A ON / OFF the

|
following manipulations are applicable: I II
e Mouse / Touch Screen Iy
B Click or press and hold on the appropriate

e Keyboard
F
B Press _2 _ on front panel keyboard or @ or <AIt>+<T> on external keyboard = aSwitch fore

color changes to white - then use !_ ?/ « , ! on front panel keyboard or , , , on

external keyboard

e Combined

L INCIRAI NS 4

B Click on aSwitch = aSwitch fore color changes to white - then use =/, ' -~ = = / on front

panel keyboard or , , , on external keyboard
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Gain -
3 dB ‘ L
aSwitch o
~
/
S~ ON 2
~ o
3
a"w'ldth -
8 mm ‘ 4/
aThreshold -,
45 %% * ,d
/
To control delay of Gate A (aStart) | /
the following manipulations are applicable: 1y
11/
e Mouse /Touch Screen 1/

B Click or press and hold on the appropriate

Keyboard

Fd
B Press 3 J on front panel keyboard or @ or <Alt>+<A> on external keyboard = aStart fore color

changes to white - then use !J '_’J !J !J on front panel keyboard or , , , on

external keyboard

Combined

B Click on aStart — aStart fore color changes to white - then use !J '_’J !J !J on front
panel keyboard or I . . I on external keyboard

Drag and Drop (refer to paragraph 5.2.7 of this Operating Manual)

®

+ aStart setup is also possible through a number of other submenus following the same rules as

above
¢ Counting of aStart value starts after finishing of Probe Delay count (refer to paragraphs 5.2.12
and 5.2.13 of this Operating Manual)
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aStart
26 mm

g | 0 By [0 | 1=y

awidth
8 mm ‘ 2
10 aThieshold [§ -

4b 2% ‘ 5
To control duration of Gate A (aWidth) , /
the following manipulations are applicable: I /

/

e Mouse / Touch Screen 1y

B Click or press and hold on the appropriate

e Keyboard
F
B Press _4 J on front panel keyboard or or <Alt>+<W> on external keyboard — aWidth fore

color changes to white - then use !J _J _J !J on front panel keyboard or , , , on

external keyboard

e Combined

B Click on aWidth = aWidth fore color changes to white - then use !J '_’J !J !J on front
panel keyboard or , , , on external keyboard

¢ Drag and Drop (refer to paragraph 5.2.7 of this Operating Manual)
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To control threshold level of Gate A
(aThreshold) the following manipulations
are applicable:

aT hrezhold
45 2% ;

/
/

|

|

|
Mouse / Touch Screen 1/

[ 4

B Click or press and hold on the appropriate

Keyboard

-
B Press'_5 J on front panel keyboard or @ or <Alt>+<E> on external keyboard = aThreshold fore

color changes to white - then use !J '_’J _J !J on front panel keyboard or , , , on

external keyboard

Combined

B Click on aThreshold = aThreshold fore color changes to white - then use !J '_’J !J !J
on front panel keyboard or , , , on external keyboard

Drag and Drop (refer to paragraph 5.2.7 of this Operating Manual)
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5.2.6. Sub Menu GATE B

5.2.6.1. All ISONIC 2005 Instruments Running Under Win98SE and ISONIC 2005,
2020, STAR 2005 Instruments Running Under WinXP Embedded

---------------- -\---------------
N
N
-
1
-
2
2 bStart 1 )
4? 9 mm ‘ 3,
b idth ar
13 2 mm " /A
bThreshold ',
40 % ‘ 5
To switch Gate B ON / OFF the 1,
following manipulations are applicable: 1,
¢ Mouse / Touch Screen Iy
—r

B Click or press and hold on the appropriate |button|

e Keyboard
F

B Press _2 J on front panel keyboard or @ or <Alt>+<T> on external keyboard = bSwitch fore

color changes to white - then use !_ , ‘ « ! on front panel keyboard or , , , on
external keyboard

e Combined

B Click on bSwitch = bSwitch fore color changes to white - then use !_ ?/ « ) ! on front
panel keyboard or , , , on external keyboard
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b witch

ON
2 bS5tart

47 .9 mm

2 bwidth

13.2 mm
10 bThreshold

40 %5

To control delay of Gate B (bStart) (I

the following manipulations are applicable: 1y
11/

e Mouse /Touch Screen 1/

B Click or press and hold on the appropriate

e Keyboard

Fd
B Press 3 J on front panel keyboard or B or <Alt>+<A> on external keyboard = bStart fore color

changes to white - then use !J _J _J !J on front panel keyboard or , , , on

external keyboard

e Combined

B Click on bStart = bStart fore color changes to white - then use !J '_’J !J !J on front
panel keyboard or , , , on external keyboard

e Drag and Drop (refer to paragraph 5.2.7 of this Operating Manual)

®

Counting of bStart value starts after finishing of Probe Delay count (refer to paragraph 5.2.12 and
5.2.13 of this Operating Manual)
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To control duration of Gate B (bWidth)
the following manipulations are applicable:

e Mouse / Touch Screen

B Click or press and hold on the appropriate
e Keyboard

F
B Press _4 J on front panel keyboard or or <Alt>+<W> on external keyboard = bWidth fore

color changes to white - then use !J _J _J !J on front panel keyboard or , , , on

external keyboard

e Combined

B Click on bWidth = bWidth fore color changes to white - then use !J '_’J !J !J on front
panel keyboard or , , , on external keyboard

¢ Drag and Drop (refer to paragraph 5.2.7 of this Operating Manual)

ISONIC 2005 / 2020 / STAR from Sonotron NDT - Operating Manual — Revision 2.38 - Page 55 of 380



2,  bwdth

13.2 mm
bThrezhold

40 %%

To control threshold level of Gate B
(bThreshold) the following manipulations
are applicable:

|
|
|
e Mouse / Touch Screen 1/
[ 4

B Click or press and hold on the appropriate

e Keyboard
-
B Press'_5 J on front panel keyboard or @ or <Alt>+<E> on external keyboard = bThreshold fore

color changes to white - then use !J '_’J _J !J on front panel keyboard or , , , on

external keyboard

e Combined

B Click on bThreshold = bThreshold fore color changes to white - then use !J '_’J !J !J
on front panel keyboard or , , , on external keyboard

¢ Drag and Drop (refer to paragraph 5.2.7 of this Operating Manual)

ISONIC 2005 / 2020 / STAR from Sonotron NDT - Operating Manual — Revision 2.38 - Page 56 of 380



5.2.6.2. ISONIC 2005, 2020, STAR 2005 Instruments Running Under WinXP
Embedded with Software Release Dated June 13, 2011 or Later — Gain per Gate B
adjustment

It is possible to adjust Gain in the — 6dB ... + 12 dB range for the signals matching with Gate B:

Gain per Gate B

. Mode
adjustment

The adjustment is ON
Clicking on .turns to the bAmplifier Gain adjustment:
2 bAmplifier -

+10 dB ‘ ] ’
. 4 0K OFF k

On completion click fonl or press To negate click Jon] or setup
Enter | ESC bAmplifier to 0 dB then press
=1 or \E emd | (€86

=1 or \E

The adjustment is ON

&

Clicking on turns to the bAmplifier Gain adjustment:
2 bAmplifier -
: +10 dB ‘ ] ’
i 4 OK OFF k
On completion click fonl or press To negate click fon] or setup
_;i; or Ezg b;:l:;ﬁlifieritio dB then press

'S

= Jor:
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5.2.7. Drag and Drop: Gate A and Gate B

Gate A and Gate B may be manipulated through Drag and Drop provided that they are visible in the A-
Scan area. [Mouse pointer changes shape| while placing it above appropriate section of a gate

05 Gain
e K
1

Range

oo Ko

100 mm

Alarm Switch
«
Alarm Logic
«
Setup Gate
GATE B

BASICS _ PULSER  RECEIVER  GATE A Menu "D" ? - 5
GATE B PG DAC/TCG  MEASURE  Selection

Cloze MI Freeze Save Print
To manage a gate just press and hold left mouse button or touch screen stylus and drag, then drop through
releasing of left mouse button or touch screen stylus

"

o By

e By

= By

[en By

e
DG5S

=
Open
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5.2.8. Sub Menu ALARM

[ET 05 Gain

Alarm Switch status for  : 5
: selected Gate is shown here : =

Py
 sceced Gato s hown e N ¢
P
P

\ Alarm Switch
v ON

Alarm Logic Alarm Logic

Positive Negative
~ Setup Gate

GATE B

To select a Gate for Alarm Setup the 4 / /
following manipulations are applicable: / p -
I ” -
/ - -
e Mouse / Touch Screen 1, o -
-
m Click or press and hold on the appropriate

e Keyboard

F
B Press _3 _ on front panel keyboard or @ or <Alt>+<T> on external keyboard = Setup Gate fore

color changes to white - then use ?_ ? ‘ , '.' on front panel keyboard or , , , on

external keyboard
e Combined

LINCIRLING 4

B Click on Setup Gate — Setup Gate fore color changes to white - thenuse —/, ' =/, —J, ' T

on front panel keyboard or , , , on external keyboard
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0.5 Gain

3 dB ‘
1 Ra
100mm B

8  Alarm Switch
ON

Alarm Switch

ON

R

Alarm Logic * Alarm Logic
Positive 7 Negative
Setup Gate I y g Sehup Gate
GATE A ‘ y 5 GATEB
L
/
To control Alarm Switch the Iy
following manipulations are Iy
applicable: 1y P
lr <, s
Mouse / Touch Screen llé//
B Click or press and hold on the appropriate
Keyboard
-

B Press 2 J on front panel keyboard or B or <Alt>+<W> on external keyboard = Alarm Switch

fore color changes to white - then use ?_ ? . , " on front panel keyboard or , , ,
on external keyboard

Combined

B Click on Alarm Switch = Alarm Switch fore color changes to white - then use ? ? .

" on front panel keyboard or , , , on external keyboard
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"

A A A A A nn ke . Gai 05 Gain
Alarm Logic : 1 3 dB ‘
- » 1

................................ R al Range
» oo R

Alarm Switch
on K

Alarm Logic Alarm Logic

Positive : Negative
Setup Gale

o By

e By

len g = By

To select Alarm Logic the
following manipulations are applicable:

¢ Mouse / Touch Screen Iy 2
&

B Click or press and hold on the appropriate Ibuttonl

e Keyboard
-
B Press _4 J on front panel keyboard or or <Alt>+<L> on external keyboard = Alarm Logic

fore color changes to white - then use ?_ ? « , '.' on front panel keyboard or , , ,
on external keyboard

e Combined

LRI

B Click on Alarm Logic = Alarm Logic fore color changes to white - thenuse —/, =/, —J, ' T
on front panel keyboard or , , on external keyboard
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®

Alarm Example

= By

vdh dh 4bh 4h 4

05 Gain
e K
1

Range

T

100 mm
Alarm Switch
«
Alarm Logic
«
Setup Gate
GATE A

BASICS PULSER  RECEIVER  GATE A Menu "D" ? - s
GATE B FIFCTTI DAC/TCGE  MEASURE  Selection

|_ Yalue: OFF ﬁ ﬂ & = I L
Cloze b Alarm ~ ~ Freeze Save | Open DGS
o ~ -
— [ T :
: Alarm Indicator for : : Alarm Indicator for :
: Gate A : : Gate B :

¢ There is a pulse matching with Gate A and exceeding its threshold; the Alarm Logic setting for Gate A
is Positive = Alarm Indicator for Gate A is active

¢ There is a pulse matching with Gate B and not exceeding its threshold; the Alarm Logic setting for Gate
B is Negative = Alarm Indicator for the Gate B is active
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5.2.9. Sub Menu DAC/TCG

5.2.9.1. ISONIC 2005 Instruments Running Under Win98SE and ISONIC 2005, 2020,
STAR 2005 Instruments Running Under WinXP Embedded with Software Release

Dated July, 2010 or Earlier

Current status of

DAC/TCG/DGS
Current quantity of
stored echoes \ 2  aStart
composing DAC  :~ 30 mm

Status of DAC
curve P O~ o~

: Show DAL
Curve OFF

To select required mode for I I'
DAC/TCG/DGS the following I
manipulations are applicable: /

e Mouse / Touch Screen 11

B Click or press and hold on the appropriate

e Keyboard
F

B Press _2_ on front panel keyboard or @ or <Alt>+<T> on external keyboard = DAC/TCG/DGS

fore color changes to white - then use ' ‘ ‘ , '.' on front panel keyboard or , , ,

on external keyboard

e Combined
B Click on DAC/TCG/DGS = DAC/TCG/DGS fore color changes to white - then use '
'.' on front panel keyboard or ], , , on external keyboard

®

¢ There are four possible modes for DAC/TCG:
e There are four possible modes for DAC/TCG:

e OFF - DAC Curve switches automatically to OFF while in OFF

DAC - available if quantity of stored echoes is 2 (two) or more. DAC Curve switches
automatically to ON while in DAC mode. Both experimental and theoretical methods for creating
DAC are available

TCG - available if quantity of stored echoes is 2 (two) or more. DAC Curve switches
automatically to OFF while in TCG mode

Update - allows to create/update new/existing DAC. Update of existing DAC performed through
erasing of a number of sequentially recorded echoes, starting from the latest one, and/or
recording of new echoes. The maximal number of echoes recorded into the one DAC is 40
(forty). DAC Curve switches automatically to ON if the number of recorded echoes is 2 (two) or
more and switches automatically to OFF if number of recorded echoes is less than 2 (two) while
in Update mode

¢ ltis possible to Create / Modify / Activate DAC and TCG for all Display modes (RF, Full, Negative, and
Positive)

¢ To create / modify DAC/TCG or DGS refer to paragraphs 5.2.10, 5.2.11 of this Operating Manual
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5.2.9.2. ISONIC 2005, 2020, STAR 2005 Instruments Running Under WinXP
Embedded with Software Release Dated Aug, 2010 or Later
Control of ISONIC 2005, 2020, STAR Instruments running under WinXP Embedded with software release

dated Aug, 2010 or later for DAC / TCG / DGS functions is identical to earlier SW releases except the new
ability of managing up to 3 independently controllable DAC curves in addition to the main one:

UDS 3-5 - ISONIC Pulser/Receiver

ottt AR ]

BASICS PULSER
GATE B ALARM

Main DAC Additional curves (Blue, Level indicators for the of additional curves
Curve (red) : : White, and Violet)) . 3 (Blue, White, and Violet), the levels are
e EEEEE ¢ sessssssmmmEmEEEEEEEEEEEEEEEEEEEEEEE" E indicated in dB reIativer main DAC Curve

To control levels of the additional DAC curves click on one of three indicators as above, for example on

[l
-7 dB

The following screen appears:

UDS 3-5 - ISONIC Pulser/Receiver

N
[&] \
- I
I
I
|
7] |
= I
— /
AT
-2dB |} | -TdB +3 dB

g, . e Ay P e, hs,

e e T —— — |
BASICS PULSER RECEIVER GATE A
GATE B ALARM DAC/TCG MEASURE Il uo‘ 3-5
® L vaie:off [ H = | &
Close Alarm Fr%ze ﬁ ﬂ Sawve || Open || Print I

The level of each additional DAC curve is controlled through clicking on in the corresponding
sliding bar. On completion click on a level indicator
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5.2.10. Create / Modify DAC
5.2.10.1 Theoretical DAC: dB/mm (dB/in)

Theoretical DAC represents pure exponential law for distance amplitude curve; said law is determined by
dB/mm (dB/in) factor and value of Probe Delay - refer to paragraphs 5.2.12, 5.2.13 of this Operating
Manual: at zero material travel distance theoretical DAC has start point at 100% of A-Scan height

Set DAC/TCG/DGS to Update then click

\
UD53-5 - ISONIC Pulser/Beceiver

1 Gain

32 dB ‘
DAC/TCG/DGS

U pdate ‘
aStart

4-

— o} Curve OFF
BASICS PULSER _RECEIVER  GATE A Menu dg;mml "Ds' ? - 5
GATE B ALARM DA MEASURE  Selection

| Value: OFF ‘ i = =)

Close m I Freeze Save Print

= Ty

Mo By

o By

4= By

I By

b
DG5S

=
Open
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Click on this button or press
rF
1 on front panel keyboard or

i dB/mm (dBfin) factor : : increment/decrementfor i keyboard to selectvalue of
: : ! dB/mm (dB/in) factor setting : : increment/decrement for dB/mm
"""""""""""""""" N fveen e 1 (dBiN) factor setting

\

DAC/TICG/DGS

Update
2 aStart

29 ¢ mm

Show DAC
Curve OFF

BASICS PULSER BRECEIVER GATE A !
GATE B ALARM MEASURE Selection

/7

i Theoretical DAC according to P // s
: entered dB/mm (dB/in) factor : /7 7
To control dB/mm (dB/in) factor the following P // 7
manipulations are applicable: P s
e Mouse / Touch Screen P ¢

B Click or press and hold on the appropriate
e Keyboard

B Press '. , ‘ ‘ , ‘ on front panel keyboard or , , , on external keyboard
On completing dB/mm (dB/in) factor setting click on Ok or press =4/ on front panel keyboard

on external keyboard. This will return to main operating surface of UDS 3-5 Pulser Receiver and

dB/mm
activate theoretical DAC. Button becomes green while theoretical DAC is setup; set
DAC/TCG/DGS to DAC to activate theoretical DAC or to TCG if it is necessary to perform time correction of
gain in accordance with theoretical DAC law.

dB/
To modify or switch theoretical DAC off set DAC/TCG/DGS to Update then click on o . Inthe
appeared popup subwindow modify value dB/mm (dB/in) factor as it is described above or click on

OFF then on OK
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5.2.10.2 Experimental DAC: recording signals from variously located reflectors
If theoretical DAC is active then it must be switched off according to paragraph 5.2.10.1 of this Operating
Manual prior to building of experimental DAC. Switch on Gate A then set DAC/TCG/DGS to Update. Place

probe onto DAC calibration block and maximize echo from the reflector closest to the probe (first echo) then
place Gate A over received signal and capture first DAC echo

UD53-5 - ISONIC Pulser/Beceiver |
‘
¢
¢
o -

Show DAC
Curve OFF

BASICS PULSER RECEIVER GATE A Menu
GATE B ALARM DAC/TCG oAl Selection

HE
Cloze m I Freeze

To capture DAC echo the following
manipulations are applicable:

e Mouse/ Touch Screen

m Click fon]

e Keyboard
-
B Press _4 J on front panel keyboard or or <Alt>+<R> on external keyboard = Rec fore color

changes to white - then use ' ‘ ‘ , '.' on front panel keyboard or , , , on

external keyboard

e Combined

T » ol

B Click on Rec = Rec fore color changes to white - then use =/, ' -~ on front panel keyboard or
on external keyboard

will appear

As a result the first DAC echo will be stored and corresponding
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Place probe onto DAC calibration block and maximize echo from next reflector then place Gate A over
received signal and capture next DAC echo. As result next DAC echo will be stored causing appropriate
modifying of [corresponding indications)

1 Gain

= Yy

24 dB

DAC/ICG/DGS
Update ‘
1 aStart
3.3 mm

T «

o By

[ By

= By

Show DAL
Curve ON

len By

+ The highest echo in the Gate A will be stored said echo may either exceed Gate A threshold level or not
¢ Stored echo must be below 100% of A-Scan height

+ Atotal number of 40 echoes may be stored one by one by the same way as described above
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After creating a DAC (2 or more echoes stored) the DAC and / or TCG may be activated.
There are two styles of DAC indication in the DAC mode: Main Curve Only and Main Curve £ N dB, where

IN may be setup either as 2, 4, 6, 8, 10, 12, or 14 dB|. To proceed follow the rules below:
1 Gain
.
DAC/TCG/DGS
-

= by

P By

o2
v Ah A AA 4

= By

RS «
i «

len By

N
= B\

o2
vAhAh A\ 4

Ino By

DAC
1 aSkart
65 .5 mm

= By

Show CALC

o iy

v =T
e Mouse / Touch Screen y‘ = z -
B Click or press and hold on the appropriate
e Keyboard
F

B Press _35__ on front panel keyboard or @ or <Alt>+<H> on external keyboard = Show DAC fore

color changes to white - then use ' , * , . , " on front panel keyboard or , , , on

external keyboard
e Combined

B Click on Show DAC = Show DAC fore color changes to white - then use ' ‘ ‘ , '.'
on front panel keyboard or , , , on external keyboard
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It's possible to erase the last stored echo from the DAC. To proceed set the DAC/TCG/DGS to Update:

To erase the last stored echo from the DAC the following manipulations are applicable:
e Mouse / Touch Screen

B Click Jonj.,

UDS53-5 - ISONIC Pulser/Neceiver
~

= by

DAC/ICG/DGS
Update

e By

Show DAC
Curve ON
BASICS PULSER _RECEIVER  GATE A Menu "D’l 2 - 5
GATE B ALARM DXV MEASURE  Selection
P Value: OFF = “
1 || I
LCloze m Freeze Save | Open DG5S
e Keyboard
F

B Press _4 J on front panel keyboard or or <Alt>+<R> on external keyboard = Rec fore color

changes to white - then use ‘ , ‘ on front panel keyboard or E Q on external keyboard

¢ Combined

B Click on Rec = Rec fore color changes to white - then use ‘ , ‘
Q, { on external keyboard

As a result the last stored echo will be erased causing appropriate modifying of |corresponding indications|

/ on front panel keyboard or

DAC/ICG/DGS
Update

e By

.
.
| Tyl Tl T TrrT T T T
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5.2.11. DGS
DGS A
To setup DGS set Display to Full then click on L= or press ﬂj on front panel keyboard or or

<Alt>+<D> on external keyboard. The following screen appears:

Disk shaped reflector (flat bottom hole - FBH)
: echo amplitude as function of metal travel

Back echo amplitude as function of metal :
travel distance in the reference block for the
selected probe :

distance in the material under test for the
selected probe and FBH diameter

= Ty

Mo By

o By

5 U5 Velocity
3250 mjs ‘
100 Dizplay Delay
982 s ‘
L] Beject
«

sl B r

4= By

e By

DACICC D O O
| DGES Setup: SWB-60-5 f 7.7 mm

~ Pobe | Gan ]

[swB-605 ﬂ 3 dB
B Transfer Loss
| -~ 0dB

Al
v
A
Y
I Materiarattenuation JIY ¢
L
Al
Y

K1 AVgq[1 51 =-165dB Backwall Echo

S
|‘| 0 dB/m
Reference Attenuation

Setup Step
G dB [dE./m] (+ 2 dB [dB/m] — 1 dB [dB/m)

Close |\\ 0 dB/m \\

: Equivalent Diameter :
i (FBH) selection’box: = SR 5
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To activate DGS follow the steps below:

Step 1: Probe Selection

The following manipulations are applicable for the Probe selection:

e Mouse / Touch Screen

B Click on m |Scroll probes list to see the selected onel

MwB-60-2

B Click on |selected probe

e Keyboard
B Press <Alt>+<P> on external keyboard = Probe fore color changes to white — then use L _’_,
| |
f.), !,/ on front panel keyboard or , , , on external keyboard
e Combined
| II |
B Click on Probe = Probe fore color changes to white - then use L _’_, f.) _'.'_/ on front

panel keyboard or , , , on external keyboard
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Step 2: Equivalent Diameter of disk shaped reflector (flat bottom hole — FBH)

The following manipulations are applicable for the selection of the Equivalent Diameter of disk shaped
reflector:

e Mouse / Touch Screen
m Click m  |Scroll diameters list to see the selected on

\

[o.-8 mm—per|

B Click on |selected equivalent diameter|

e Keyboard

B Press <Alt>+<D> on external keyboard = Equivalent Dia fore color changes to white — then use

| | '
!.«, _’_, f.) _'.'_/ on front panel keyboard or , , , on external keyboard

e Combined

’ J

B Click on Equivalent Dia = Equivalent Dia fore color changes to white — then use L )

!,/I on front panel keyboard or , , , on external keyboard

fJ'
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Step 3: Attenuation in the reference block

DG5S Setup: MWB-70-4 /1.5 mm

BTN TR 7
weezos = 125dB ¥ a0
A 1 -
[5em =]l §dB Y ! Y Y

Modify M aterial Attenuation E " \

/ \

Apply | 42 dB/m 1 KZ Avgz=+208 Backwall Echo
)

Close 38 dB/m & dB [dB/m) 2 dB (dB/m) 1 dB [dB/m)

\
The following manipulations are \
applicable: \
\

e Mouse / Touch Screen \

. N
B Click or press and hold on the appropriate |button|

e Keyboard

B Press <Alt>+<N> on external keyboard = Reference Attenuation fore color changes to white -
then use !J '_’J , :J , !J on front panel keyboard or , , , on external keyboard

e Combined

B Click on Reference Attenuation = Reference Attenuation fore color changes to white - then use

!J, 2] , :J , !J on front panel keyboard or , , , on external keyboard
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Step 4: Attenuation in the object under test

DG5S Setup: MWB-70-4 /1.5 mm
Probe

[Mwe704 =]} 12,5 dB
{1.5 mm =] \ & dB

Modity
v 42 dB/m

Close 38 dBim

o - | o - | o e

L=

Transfer Loss

3\
§.£ AVo = +2 dl’ Backgall Echo
Setup Step
& dB [dE/m)] f« 2 dB [dB/m] 1 dB [dB/m)

Apply

\
\
\

e Mouse / Touch Screen \
B Click or press and hold on the appropriate

Keyboard

The following manipulations are
applicable:

B Press <Alt>+<M> on external keyboard = Material Attenuation fore color changes to white - then
use !J '_’J , :J , !J on front panel keyboard or , , , on external keyboard

Combined

B Click on Material Attenuation — Material Attenuation fore color changes to white - then use !J

'_’J , :J , !J on front panel keyboard or , , , on external keyboard
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Step 5: Transfer loss

DG5S Setup: MWB-70-4 /1.5 mm

‘0
4

Iwwe-704 =||\  12.5 dB N
, -
[5em =] " 6dB ¥ il N

Modify ,’ \

\
Apply 42 dB/m K2/ AVgp = +2 dbl Bagkwall Echo

EE—].F <lorcnce Altenuaton § Y
Close 38 dB/m 8B (dB/m] ¥ dB [dB/m) 1 dB [dB /]

The following manipulations are applicable:

\
\
e Mouse/ Touch Screen

\
A W
B Click or press and hold on the appropriate |button|
e Keyboard

B Press <Alt>+<T> on external keyboard = Transfer Loss fore color changes to white - then use

!J, 2] :J !J on front panel keyboard or , , , on external keyboard

e Combined
B Click on Transfer Loss = Transfer Loss fore color changes to white - then use !J 2] :J

!J on front panel keyboard or , , , on external keyboard
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Step 6: Gain

Apply probe to the reference block to get the appropriate echo. There are two methods available:
B K1 or K2 reference block (reference block and reflector are defined in the probe data sheet and
reproduced automatically from the DGS data base upon probe selection)
\ B Inclined reference block (reference reflector — back surface)

\ \
\ \
0.5 Gain o
125 dB ‘ 1
1 Range o
100 mm ‘ 2
5 U5 Yelocity o
3250 m/s ‘ 3
100 Diszplay Delay o
6.23 ps ‘ 4
L] Beject o
, . _ 5
RACICS : . : : : bl ¢ T H Y L B o
| DG5S Setup: MWEB-70-4°/ 1.5 mm
\
[MwB-70-4 = 7\ \
] Trahsfer Loss I \ \\ (]
1.5 mm - I ]
| [ 6 dB L X NG
Material hitenuation ‘
; A
42 d\B" m ¥ 2 avke-+2m Backwall Echo
ki st \ekitmiiin L Setup Step
Close ‘| 38 dE/m ¥~ idB [dE ] & 2dB (dB/m) _ ¢ 1dB([dB/m]
-
A A A A AR A .l................_ \ PP T .s..‘.é.d.’. ................................... .
i Current Gain : \ : Click on Setup Step option or press <Alt>+<1> or .
: dB 1 \ i <Alt>+<2> or <Alt>+<6> on external keyboard to select
T s\ : required value for increment / decrement for increment /
\ : decrement for setting Gain. The last selected value of
\ : increment / decrement is checked: ®
\ : :
............................. | S

The goal of Gain setup is
: obtaining tip of maximized :
: reference echo reaching back :
echo level (blue curve) E
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05 Gain

125 dB ‘

1 Range
Y «
o250mis Rua

3250 mifs

100 Dizplay Delay
ﬁ s ls ‘

BACICG
| DG5S 5etup: H'w'B 70-4 !1 5 mm

T
|HwB-?u-4 J 12.5 dB

Evoint i Tarser e 1
|1_5mm j b6 dB A

;\
42 dB/m

Apply K2 AVgp =+2dB Backwall Echo
Heference Attenuatlun

[ ]

Setup Step

Close [ 38dB/m dB/m r'\ade (B /] @ 2dB(dB/m) ¢ 1dB(dE/m)

The following manipulations are \
applicable for Gain setup: \

\
e Mouse / Touch Screen \

B Click or press and hold on the appropriate

e Keyboard

t »

B Press <Alt>+<G> on external keyboard = Gain fore color changes to white - then use =, ' =/,

‘ , ‘ / on front panel keyboard orI . . Ion external keyboard

e Combined

tT » @& 3

B Click on Gain = Gain fore color changes to white - then use =/, ' =/, J, = on front panel
keyboard or I ._. I on external keyboard
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Step 7: Finalizing DGS curve and return to the main UDS 3-3 / UDS 3-4 window

Before finalizing the DGS curve:

Finalized back echo curve (blue) — depends on : i Finalized FBH echo curve (white) — depends on
Probe and Reference Attenuation Probe, Equivalent Dia, and Material Attenuation

1 Range
«
5 U5 Yelocity
3250 m/s ‘
100 Diszplay Delay
623 s ‘
5

BACICG . .
DGES5 Setup: MWEB-70-4 /1.5 mm

| |MWB-70-4 = 12_5 dB

- Transfer Loss
[15mm ]| 6 dB

42 dBfm

it
Close 38 dB/m

[

Ve
K2 AVgo =+2dB Backwall Echo «f

¢ Bl [dB /m) ¢ 2dB [dB/m) ¢ 1dB [u:IE!; ]

V4

/ /
To finalize the DGS curve the following /7 /
manipulations are applicable: / /
/
Case 1 (K1 or K2 reference block) » Case 2 (Inclined reference block)//
/
e Mouse / Touch Screen , / e Mouse / Touch Screen //

m click or]” n Click

e Keyboard o Keyboard

B Pressing <Alt>+<K> on external B Pressing <Alt>+<B> on external
keyboard keyboard
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The finalized DGS curve appears upon accompanied with Automatic Gain Correction:

: llllllllllllllllllllllllll LY :"""."". """""""""" : E . . :
E Finalized back echo E :..I.:.'...IT...C; .6.é.s. ........... (.j....! : Finalized FBH echo E : au';cl)r;ggtzlgg"y 1
. : ! Finalize curve (re ;i i : i :
E curve (blue)  § el curve (white) : i corrected Gain  :

5 US Velocity

3250 mfs
100 Dizplay Delay

623 s

" || IM *
] LJ ;Y 1 |,'.|f|| ™

. 43.5 dB
| [ 6dB
Modity N
42 dB/m
Apply .
Elu=s 38 dB/m & dB [dB./m) & 2dB [dB/m] 1dB [(dB/m

To accept finalized DGS curve and return to the main operating surface the following manipulations are
applicable:

e Mouse / Touch Screen

m Click on Apply

then

B Click on Close
e Keyboard

§ ESC
B Press <Alt>+<A> on external keyboard, then ESC or <Alt>+<C> or L‘\ on front panel keyboard
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To negate the finalized DGS curve and return to main UDS3-5 window the following manipulations are
applicable:

e Mouse / Touch Screen

B Click on M odify |

then

B Click on Cloze |
o Keyboard

ESC

B Press <Alt>+<0>on external keyboard, then @ or <Alt>+<C> or " X__J on front panel keyboard

To create new DGS curve the following manipulations are applicable:

e Mouse / Touch Screen

B Click on Modify |

e Keyboard

B Press <Alt>+<0> on external keyboard
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Step 8: Work whilst DGS is active

A typical screenshot with active DGS is shown below

UDS3-5 - ISONIC Pulser/Receiver

| +

III+

ot

|
| |I.+ &

) +
Y IIl..Ir|

A
L} ||'II'f"'._.--._.'.'n-"r-"'l

PULSER RECEIVER
ALARM DAC/TCG

O
Cloze EMI

BASICS
GATE B

Freeze

GATE A
MEASURE

Probe and FBH Equivalent Diameter :
corresponding to active DGS are indicated in the :
caption of UDS3-5 window 1

DGS active [MWB-70-4 1.5 mm FEH]

05 Gain
435 dB

pr

1 Range
«

5 U5 Yelocity
3250 mjs ‘
100 Dizplay Delay
6.23 s ‘
I L] 1
Hy -

Selection

- »

=

Print

=
Open

Save

e
DGS

Some parameters and modes may not be modified whilst DGS is active - corresponding messages appear if

attempting to modify:

v Attention!

tadification of thiz parameter is impozzible
while DGES curve iz active

Changing aof thiz mode iz impozzible
while DGS curve iz active

1 Attention!

-
-
7 -
/ -
/ -
-
‘ E{S\C Enl'l’,'r

To continue operation click on the after message appears or press

keyboard or @I or on external keyboard

o
. ) DG5S
To negate the active DGS or create a new one click on

or <Alt>+<D> on external keyboard

or on front panel

%
or press ﬂj on front panel keyboard or
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5.2.12. Sub Menu MEASURE

To select Measured Value
the following manipulations

Value

(]
Meaz Mode
-
0.2 Probe Delay h
5.84 s 4
10 Angle | o
60 ° i1

B uns 3-5

Oy ey iy | =Ty

are applicable: 1/
1/
e Mouse / Touch Screen i
B Click or press and hold on the appropriate
e Keyboard
F
B Press _2 J on front panel keyboard or or <Alt>+<V> on external keyboard = Meas Value fore
color changes to white - then use !_ ?/ « , !' on front panel keyboard or , , , on

external keyboard

Combined

t » &« 3

B Click on Meas Value — Meas Value fore color changes to white - then use —/, '/, —J ' T /

on front panel keyboard or , , , on external keyboard

®

Refer to paragraph 5.2.13 of this Operating Manual for information about values available for automatic
measurement and indication in the Value Box (Digital Readout)
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: Currently Active : Gain

: Measurement Mode \ 3 dB

............................. Hoss Valus
D FF

ap
0.2 Probe Delay
b 84 s
10 Angle

60 °
l

uns

w\'-. DL PRLN INT N P

2-5

To select Measurement Mode

the following manipulations are . /
applicable: Iy
Iy

e Mouse / Touch Screen 17

B Click or press and hold on the appropriate
e Keyboard

-
B Press 3 on front panel keyboard or [F3| or <Alt>+<E> on external keyboard = Meas Mode fore
color changes to white - then use ?_ ‘ ‘ '.' / on front panel keyboard orI . . Ion

external keyboard
e Combined

B Click on Meas Mode — Meas Mode fore color changes to white - then use !_ ? ‘ , '.'
on front panel keyboard or , , , on external keyboard

®

There are four Measurement Modes possible:

¢ Flank

¢ Top

¢ Flank-First
¢ Top-First

Refer to paragraph 5.2.13 of this Operating Manual for further information
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T il
il 4
il

-

To control Probe Delay the following I /
manipulations are applicable: ; /
/
e Mouse / Touch Screen I/
4

B Click or press and hold on the appropriate

e Keyboard

-
B Press _4 ) on front panel keyboard or @ or <Alt>+<R> on external keyboard = Probe Delay

fore color changes to white - then use !J '_’J _J !J on front panel keyboard or , , ,

on external keyboard

e Combined

B Click on Probe Delay = Probe Delay fore color changes to white - then use !J '_’J !J !J
on front panel keyboard or , , , on external keyboard

@ Refer to paragraph 5.2.13 of this Operating Manual for some hints on determining Probe Delay
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05 Gain
3 dB

Meas Yalue

OFF

= by

Ina By

o2
v b4 dh 4

= By

B uns 3;4

To control Incident Angle the following

manipulations are applicable: I /
e Mouse / Touch Screen :,/

B Click or press and hold on the appropriate
e Keyboard

-
B Press' _5 J on front panel keyboard or @ or <Alt>+<N> on external keyboard = Angle fore color

changes to white - then use !J _J _J !J on front panel keyboard or , , , on

external keyboard

e Combined

B Click on Angle = Angle fore color changes to white - then use !J zj :J ij on front
panel keyboard or , , , on external keyboard

®

Refer to paragraph 5.2.13 of this Operating Manual for some hints on determining and / or checking Probe
Angle
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Advanced Measurements Settings Menu

£
. . b . .
Advanced measurement settings are available through button El_l appearing on the UDS 3-5 main
operating surface upon activating submenu MEASURE. Clicking on that button activates Advanced
Measurements Settings Menu:

[1] <=
[2] AUTOCAL
AS
4] X

-
Press ' on front panel keyboard or ﬂ on external keyboard or click on III & |to
activate Advanced Scheme for Reflectors Depth Measurement Whilst Using Angle Beam Probe —
Thickness / Skip / Curved Scanning Surface Correction

Fa

Press 2 on front panel keyboard or on external keyboard or click on

activate Automatic Calibration Procedure

2] autocaL |

-
Press 2 J on front panel keyboard or @ on external keyboard or click on EI AS Ito
activate Dual Ultrasound Velocity Measurement Mode

F ESC
Press % Jor _)‘(\ on front panel keyboard or @ on external keyboard or click on

EI o |to return to main operating surface

®

Refer to paragraph 5.2.13.3 of this Operating Manual to get instructed on:
¢ Advanced Scheme for Reflectors Depth Measurement Whilst Using Angle Beam Probe —
Thickness / Skip / Curved Scanning Surface Correction
¢ Automatic Calibration Procedure
¢ Dual Ultrasound Velocity Measurement Mode
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5.2.13. Time Domain Signal Evaluation - Measurements Guide
5.2.13.1. Values available for Automatic Measurements and Digital Readout

Initisl Pulse Value 1: T(A)
h Time of Flight - ys of an echo matching
&-Scan with Gate A measured with respect to
Probe Delay:

T(A) = Absolute Delay A - Probe Delay
Value 2: T(B)
Time of Flight - ps of an echo matching
with Gate B measured with respect to
Probe Delay:

T(B) = Absolute Delay B - Probe Delay
Value 3: s(A)

Material Travel Distance - mm or in of an
echo matching with Gate A:

s(A) =% - T(A) - US Velocity

Display Delay Value.4: s(B) . .
Material Travel Distance - mm or in of an
Abzolute Delay & - Flank echo matching with Gate B:
Abzolute Delay B - Flank s(B) ="' - T(B) - US Velocity
Value 5: a(A)
Projection Distance - mm or in of reflector
Straight Beam Probe Angle Beam Probe returning an echo matching with Gate A,

measured with respect to Beam Incident
Point:

a(A) = s(A) - sin ( Angle)

I_l Value 6: a(B)

& Projection Distance - mm or in of reflector
returning an echo matching with Gate B,
measured with respect to Beam Incident
Point:

Angle

€@ 0
nn
o W
o

a(B) = s(B) - sin ( Angle )

Value 7: t(A)
Depth - mm or in of reflector returning an
echo matching with Gate A:

t(A) = s(A) - cos ( Angle)

Value 8: t(B)
Depth - mm or in of reflector returning an echo matching with Gate B:

t(B) = s(B) - cos ( Angle)

Value 9: AT - ps:

AT =T(B)-T(A)
Value 10: As - mm or in:

As = s(B) - s(A)
Value 11: Aa - mm orin:

Aa = a(B) - a(A)
Value 12: At - mm or in:

At ={(B) — t(A)

ISONIC 2005 / 2020 / STAR from Sonotron NDT - Operating Manual — Revision 2.38 - Page 88 of 380



ClAbsolute Delay B - Topy  Value 13: H(A)

ClAbsohute Delay & - Top) fizeean Amplitude - % of A-Scan height of an echo
matching with Gate A
Value 14: H(B)
Amplitude - % of A-Scan height of an echo
matching with Gate B
Value 15: V(A)
Amplitude - dB of an echo matching with
Gate A with respect to aThreshold:

V(A) =20 - logso ( H(A) / aThreshold )
Value 16: V(B)
Amplitude - dB of an echo matching with
Gate B with respect to bThreshold:

V(B) =20 - log4o ( H(B) / bThreshold )

a-Threshold b-Threshaold

Value 17: AV - dB:
AV = V(B) - V(A)
Value 18: AVC(A) (dB to DAC) - dB:
AVC(A) = 20 - logy ( H(A) / C (Absolute Delay A_Top) )
Value 19: AVC(B) (dB to DAC) - dB:
AVC(B) = 20 - logo ( H(B) / C (Absolute Delay B_Top))

+ To proceed corresponding Gate or both Gates to be active
¢ AVC(A) (dB to DAC) measurements require active DAC/DGS

+ Amplitude measurements of echoes may be performed provided their heights don't exceed 200% of A-
Scan height

+ For 2 and more echoes matching with a Gate - refer to paragraph 5.2.13.2 of this Operating Manual
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5.2.13.2. Flank, Top, Flank-First, and Top-First Modes of Measurement

The table below represents distinguishing points on an A-Scan, which will be taken for automatic
measurements depending on Meas Mode setting

Meas Mode setting A-Scan

Meaz Mode

Flank

- T(A), T(B), s(A), s(B), t(A), t(B), a(A),
a(B), AT, As, At, Aa
# -V(A), V(B), H(A), H(B), AV, AVC(A),
AVC(B)

Meaz Mode
= T(A)s T(B)! S(A), S(B)! t(A)’ t(B)s a(A),
a(B), AT, As, At, Aa
& - V(A), V(B), H(A), H(B), AV, AVC(A),
AVC(B)

%

| +| 1 |

il

hol 1

J ""” Il'# W | I A
A I'rJ‘L‘|I ]J f | I-Irlﬁrl I|u'||| In’l

Meaz Mode

Flank-First

- T(A), T(B), s(A), s(B), t(A), t(B), a(A),
a(B), AT, As, At, Aa
# -V(A), V(B), H(A), H(B), AV, AVC(A),
AVC(B)

+ l||+|
bl
HY
lII r"‘I;J'L.ll l]Ill II!#

Meaz Mode

Top-First

- T(A), T(B), s(A), s(B), t(A), t(B), a(A),
a(B), AT, As, At, Aa
® -V(A), V(B), H(A), H(B), AV, AVC(A),
AVC(B)

+ 1|| + |
L o, M)y
II I_u"t;ﬁ_‘ll "1 J r#
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®

Distinguishing points of signals are automatically marked on A-Scan whilst measuring:

Gains
51.5 dB
Value: AT+

12.75 ps

+ + + 1
P | Kl
|,I,|||||‘III'|,PJ F|I|I||' full rﬂ

51.5 dB
Value: AV

-3.5dB

+ + + Pll
LT ‘l‘l’lﬁll"ﬂf‘a'i X I‘ll.".,PJIFn'\' full |r|r1
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5.2.13.3. Advanced Scheme for Reflectors Depth Measurement Whilst Using Angle
Beam Probe — Thickness / Skip / Curved Scanning Surface Correction

£
Button III e | becomes available upon clicking on M if Angle setting differs from 0%in
submenu MEASURE. The window as below appears after clicking on III S or pressing
!

_1_J on front panel keyboard or on external keyboard

Object under test may be designated as either

o Flat- ) Flat Object

Or

+  Gurved - [pick hera b a7

»

While scanning above plates, tube wall, and the like the finite

thickness of object under test may be either
) y >

. Ignored—lclick here_l
Or -
+  Entered - [oickrers o 4

¥ Ignore Thickness

Case 1 represents simplest scheme supposing that scanning
is performed above hemi-space whereas coordinates t(A), Apply Cancel

t(B) are determined in accordance with appropriate sketches,

equations, and A-Scans shown in paragraphs 5.2.13.1 and

. | Case 1
5.2.13.2 of this Operating Manual

Case 2 represents scanning above plate, or scanning above
tubular object longitudinally. Reflectors depth for half skip, full
skip, and multi skip insonification will be determined with
respect to actual Thickness value — t(A), t(B) readings will be
in accordance with sketches below:

* Flat Object
wﬂh}' tb) Thickness o THIsE
o

L ‘ 1 »
w—ﬂ?}?t{h} Thickness " Ignore Thickness
1 Thickness
o
JHIL 4
\ vﬂ‘ﬂ‘}‘ tih) f Thickness
Apply Cancel

ho Ry

; - _ Case 2

/

\ N/’_ﬂh} ] Thickness
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Case 3 represents scanning above curved wall surface
circumferentionally. Reflectors depth for half skip, full skip,
and multi skip insonification will be determined with respect to
actual Thickness and Diameter values — t(A), t(B) readings
will be in accordance with sketch below:

™ Flat Object

10 Diameter
o
400 mm ‘

L
1

Thickness

»

HA). tib)

" Ignore Thickness

g a£:»

0.5xDiameter

Thickness Apply Cancel
A, t{h) Case 3
0.5xDiameter.
Case 4 represents scanning above solid cylindrical object
cirmuferentionally or above spherical object. If this is a case
Thickness setting to be: Thickness = 0.5xDiameter and
reflectors depth will be determined with respect tio actual  Flat Object

Diameter value — t(A), t(B) readings will be in accordance
with sketch below:

S e CHLS

" Ignore Thickness

t{ﬁ}.’:{h} E ‘ '; .

Diameter

Apply Cancel

Case 4
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/

J

7
" Flat viect

10 Diameter

400 mm

G

" Ignore Thickness

Apply / Cancel

To control Diameter the following
manipulations are applicable:

¢ Mouse / Touch Screen

B Click or press and hold on the appropriate

e Keyboard

ra
B Press 1 j on front panel keyboard or H on external keyboard = Diameter fore color changes to

white - then use !J '_’J _J !J on front panel keyboard or , , , on external

keyboard

¢ Combined

Click on Diameter = Diameter fore color changes to white - then use !J '_’J :J !J on front panel

keyboard or , , , on external keyboard
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To control Thickness the following
manipulations are applicable:

" Flat O ect
b ?: 2 Diameter ‘
2b4 mm

" Ignore Thickness

e Mouse / Touch Screen

B Click or press and hold on the appropriate
e Keyboard
Fd

B Press LJ on front panel keyboard or @ on external keyboard = Thickness fore color changes
to white - then use !J '_’J gj !J on front panel keyboard or , , , on external
keyboard

e Combined

B Click on Thickness = Thickness fore color changes to white - then use !J '_’J :J !J on

front panel keyboard or , , , on external keyboard

Apply | Enter
¢ Clickon or press i,] on front panel keyboard or on external keyboard to
activate new settings
Cancel | Esc
¢ Click on or press \L] on front panel keyboard or @ on external keyboard to

negate new settings
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5.2.13.4. Dual Ultrasound Velocity Measurement Mode — Typical Example

For some practical applications it is necessary to measure sound path distances in dissimilar materials,
multi-layer structures, and the like. Also it may occur a need in measuring sound path distances for signals
representing various kinds of ultrasonic waves in the same object. Such cases are characterized by variety
of US Velocity values to be used while measuring intervals between signals on the same A-Scan. To
simplify measurement procedure and avoid operator's computations it may be activated Dual Ultrasound
Velocity Measurements Mode, which's use is illustrated by the example below

Supposing it's necessary to measure thickness of each layer of
bi-metallic part made through by means of explosion welding
between regular carbon steel ( US Velocity = 5920 m/s ) and
brass alloy ( US Velocity = 4720 m/s ) plates while probe to be
placed on low carbon steel plate. While placed on the steel side
10 MHz dual element probe with Probe Delay = 5.8 ps receives
two clear echoes 1 and 2 form the steel-to-brass boundary and
from the back surface of the brass layer correspondingly:

Steel

UDS3-5 - ISONIC Pulser/Receiver

05 Gain
2 dB

5 U5 Velocity
H920 mfs

BASICS PULSER RECEIVER GATE A Menu
GATE B ALARM DAC/TCG MEASURE Selection

] Value: OFF PRIPES g | = | -
Cloze EM| Freeze Save | Open DGE5S

Braz=

US Velocity setting is suitable for steel and thickness of steel layer may be found through direct reading
upon placing Gate A above signal 1:

UDS53-5 - ISONMIC Pulser/Receiver

05 Gain

= Ty

12 dB ‘
Betll ¢
Pl ¢
Picrni «

Angle

I
“‘}\5

-
|,a'”'| l'r

BASICS  PULSER  RECEIVER _ GATE A Menu ﬁ| "Ds’ ?_s
GATE B ALARM  DAC/TCG [IITFXIIGIE Selection

4 By

ln By

[ T | = w
Cloze EM| 3.08 mm Freeze ﬁ ﬂ Save | Open I DG5S
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If placing now Gate B above signal 2 and selecting As as Meas Value then interval between signals 1 and 2
will be measured. To obtain proper As readout value of US Velocity valid for brass alloy layer (second
material) must be keyed in

UDS3-5 - ISONIC Pulser/Receiver

0.5 G ain
72 dEﬁ ‘
;
Measz Mode
.
0.5 Fiobe Delay

|
"“I"‘ -| Ill +

BASICS PULSER RECEIVER GATE A Menu
GATE B ALARM DAC/TCG Selection

]
Close | IRy | 2 92 mm

This digital readout was obtained through use of steel

= US Velocity setting (first material) and may not be 3
_ recognized as a thickness of brass alloy layer (second _
matenal)

To obtain proper reading for the thickness of brass layer actlvate Dual UItrasound VeIocnty Measurements
£

Mode - Button AS becomes available upon clicking on M if:

+ Both Gate A and Gate B are active (refer to paragraphs 5.2.5 and 5.2.6 of this Operating Manual)
¢ Meas Value setting is As (refer to paragraph 5.2.12 of this Operating Manual)

05 Gain

=y

Meas Yalue
As ‘

72 dB

Il
-.L

[2] AUTOCAL
| As
BASICS PULSER RECEIVER GATE A Henu E E >
GATE B ALARM DAC/TCG MEASURE Selection
00 PN = [
Cloze Em | 2.92 mm Freeze Save | Open DGES
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Fd

3

AS or pressing 2 __J on front panel

The screen as below appears after clicking on
keyboard or on external keyboard:

UDS3-5 - ISONIC F

05 Gain
72 dB ‘

Meaz Yalue
«

Meaz Mode
«

0.5 Probe Delay

L
5 U5 Velocity
5920 mfs

BASICS PULSER RECEIYER GATE A Henu
GATE B ALARM priwgn gy MEASURE Selectic

[ -
Cloze MI 292 mm Freeze ﬁ ﬂ

Click on this button or press 1 . on front panel

~ -t keyboard or H or <Alt>+<1> on external keyboard

P : to select value of increment/decrement for second
el . : US Velocity setting
- ' 1_ IIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIII
292mm /
()% Tt

Click on appropriate Ibuttonl or press ? ‘_ « , '.' on front panel keyboard or , , , on

external keyboard to setup value of second US Velocity valid for brass alloy layer (second material)

ISONIC 2005/ 2020 / STAR from Sonotron NDT - Operating Manual — Revision 2.38 - Page 98 of 380



05 Gain ‘
2 dB
Meas Yalue ‘
Asg
Meas Mode

Bl «

Flank

0.5 Probe Delay ‘
I'l,l 58 s
| .

+ N
|!";"1 "'Fli" 5 US Velocity
LI

4720 mfs

BASICS PULSER RECEIVER GATE A Menu
GATE B ALARM PEIwa Nty MEASURE Selectic

HE
Close MI 2.92 mm Freeze

-

[Digital readout for actual thickness of the brass alloy layer (second material)] is obtained upon completing
setting for second US Velocity

To return to the main ISONIC Pulser Receiver window click on 0k |or press = or '\ X Jon
front panel keyboard or <Alt>+<K> or or @ on external keyboard

To printout A-Scan accompanied with setup list, measured value of As, and second US Velocity value click

on Erint | or press <Alt>+<P> on external keyboard (printer to be accessible through either USB or
LAN port and defined as default in the ISONIC 2005 / 2020 / STAR)
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5.2.13.5. Determining Probe Delay - Miniature Angle Beam Probes (contact face
width 12.5 mm /0.5 in or less) - Shear or Longitudinal Waves — Typical Example

Activate submenu PULSER then set:

O Pulser Mode to Single or Dual depending
on probe

O Pulse Width to Spike (240 pJ) for probe
having resonant frequency of 8 MHz and
higher or to PW ns, were PW=0.5/F (F
is the probe resonant frequency) for
probes having resonant frequency below 8
MHz

Q Firing Level to 18

a Dampingto 1000 Q

O Tuningto NO

Activate submenu RECEIVER then set:

o Display to Full or RF

a Filter to BB

O Frequency to completely cover probe's
effective bandwidth

Activate submenu BASICS topic then set:

O US Velocity to 5920 m/s (233.1 in/ms) for
longitudinal wave probes or 3255 m/s
(128.1 in/ms) for shear wave probes

0 Range to 50.0 mm (2 in)

a Display Delay to 0 ps

O Rejectto 0%

Stage 1: Manipulate probe over main working
surface of V-2 reference standard and maximize
echo from 25 mm (1 in) radius concave reflector

Stage 2: Fix probe in found position - the center of
25 mm (1 in) radius concave reflector will indicate
incident point while the distance between probe's
frontal edge and incident point is equal to X-
Value

Stage 3: Tune Display Delay while probe is still
fixed in found position until rising edge of
maximized echo will match with 50%-grid of the A-
Scan width. Upon completing the obtained value
of Display Delay will be equal to actual Probe
Delay

¢ It's necessary to setup Gain bringing height of maximized echo to 75-80% of A-Scan height

¢ Itis recommended to optimize Tuning in PULSER submenu upon obtaining maximized echo. The goal of
such optimization is increasing of ultrasonic excitation energy through better matching between firing
output and probe. Level of ultrasonic excitation energy is clearly represented by echo amplitude. Upon
completing Tuning optimization Gain to be adjusted to bring echo to 75-80% of A-Scan height
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5.2.13.6. Determining Probe Delay - Large and Medium Size Angle Beam Probes
(contact face width more than 12.5 mm / 0.5 in) - Shear or Longitudinal Waves —
Typical Example

Activate submenu PULSER then set:

Sequence of 5 while maving probe O Pulser Mode to Single or Dual depending
on probe

O Pulse Width to Spike (240 pJ) for probe
having resonant frequency of 8 MHz and
higher or to PW ns, were PW =0.5/F (F
is the probe resonant frequency) for
probes having resonant frequency below 8
MHz

O Firing Level to 18

a Damping to 1000 Q

Q Tuningto NO

Activate submenu RECEIVER then set:

a Display to Full or RF

Q Filter to BB

0 Frequency to completely cover probe's
effective bandwidth

Activate submenu BASICS topic then set:

Q US Velocity to 5920 m/s (233.1 in/ms) for
longitudinal wave probes or 3255 m/s
(128.1 in/ms) for shear wave probes
O Range to 200.0 mm (8 in)
O Display Delay to 0 ps
O Rejectto 0%
Stage 1: Manipulate probe over main working

surface of V-1 reference standard and maximize
echo from 100 mm (4 in) radius concave reflector

Stage 2: Fix probe in found position - the center of
100 mm (4 in) radius concave reflector will indicate
incident point while the distance between probe's
frontal edge and incident point is equal to X-
Value

Stage 3: Tune Display Delay while probe is still
fixed in found position until rising edge of
maximized echo will match with 50%-grid of the A-
Scan width. Upon completing the obtained value
of Display Delay will be equal to actual Probe
Delay

*

It's necessary to setup Gain bringing height of maximized echo to 75-80% of A-Scan height

<

It is recommended to optimize Tuning in PULSER submenu upon obtaining maximized echo. The goal of
such optimization is increasing of ultrasonic excitation energy through better matching between firing
output and probe. Level of ultrasonic excitation energy is clearly represented by echo amplitude. Upon
completing Tuning optimization Gain to be adjusted to bring echo to 75-80% of A-Scan height
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5.2.13.7. Determining Probe Delay - Straight Beam (Normal) Single Element and Dual
(TR) Probes — Typical Example
Activate submenu PULSER then set:

Q Pulser Mode to Single or
Dual depending on probe

O Pulse Width to Spike (240
pJ) for probe having resonant
frequency of 8 MHz and
higher or to PW ns, were PW
=0.5/F (F is the probe
resonant frequency) for
probes having resonant
frequency below 8 MHz

a Firing Level to 18

O Dampingto 1000 Q

O Tuningto NO

Activate submenu RECEIVER then
set:

a Display to Full or RF

a Filter to BB

O Frequency to completely
cover probe's effective
bandwidth

Activate submenu BASICS topic then
set:

O US Velocity to 5920 m/s
(233.1 in/ms) for longitudinal
= wave probes or 3255 m/s
(128.1 in/ms) for shear wave
probes
O Range to 25.0 mm (1 in)
O Display Delay to 0 ps
O Rejectto 0%

1 US Velocity
b920 m/s

+ o+ o+ o+ o+ o+ o+ o+
+ o+ o+ o+ o+ o+ o+ o+

+
+
+
+
+
+
+
+
+

+ o+ o+ o+ o+ o+ o+ o+ o+
i
L+ 4+ o+ o+ o+ o+ 4+ o+

1 U5 Velocity
5920 m/s

Stage 1: Apply probe to a side surface of V-2 reference standard to receive back echo

Stage 2: Tune Display Delay until rising edge of the back echo will match with the 50%-grid of the A-Scan
width: in such case the obtained value of the Display Delay is equal to the actual Probe Delay

®

¢ It's necessary to setup Gain bringing height of back echo to 75-80% of A-Scan height

¢ Itis recommended to optimize Tuning in PULSER submenu upon obtaining back echo. The goal of such
optimization is increasing of ultrasonic excitation energy through better matching between firing output
and probe. Level of ultrasonic excitation energy is clearly represented by back echo amplitude. Upon
completing Tuning optimization Gain to be adjusted to bring echo to 75-80% of A-Scan height
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5.2.13.8. Automatic Calibration (AUTOCAL) of Probe Delay and US Velocity - Angle
Beam Probes - Shear or Longitudinal Waves — Typical Example

There are 2 maximized reference
echoes from 2 concave reflectors
with different radius 25 mm (1 in)
and 50 mm (2 in) in use for
performing automatic calibration
of Probe Delay and US Velocity.
A-Scan settings (Range, Display
Delay, US Velocity — refer to
paragraph 5.2.2 of this Operating
Manual) must allow observing of
both signals. Gate A to match
with first reference echo received
from concave reflector with
smaller radius (shorter material
travel distance) — refer to
paragraph 5.2.5 of this Operating
Manual. Gate B to match with
second reference echo received
from concave reflector with larger
radius (longer material travel
distance) — refer to paragraph
5.2.6 of this Operating Manual

®

¢ It's necessary to setup
Gain bringing height of
back echo to 75-80% of A-
Scan height

¢ Itis recommended to
optimize Tuning in
PULSER submenu upon
obtaining back echo. The
goal of such optimization is
increasing of ultrasonic
excitation energy through
better matching between
firing output and probe.
Level of ultrasonic
excitation energy is clearly
represented by back echo
amplitude. Upon
completing Tuning
optimization Gain to be
adjusted to bring echo to
75-80% of A-Scan height

ISONIC 2005/ 2020 / STAR from Sonotron NDT - Operating Manual — Revision 2.38 - Page 103 of 380



=

i

Obtain first reference echo, activate submenu MEASURE then click on

05 Gain
16 dB

= Ty

Meas Yalue
OFF
- . Ly

E AUTOCAL %

pr
p™
P

BASICS PULSER RECEIVER GATE A Menu H» IE' b
GATE B ALARM PEIwa Nty MEASURE Selection

Yalue: OFF 3 e
T & B3 I
Close Em Freeze Save | Open DGS
Fa
To activate AUTOCAL procedure click on SAUTDIEL | or press 2_ on front panel keyboard or

@ on external keyboard — the |AUTOCAL Control Surfacel appears

Gain

2 MTD-s[A)
sem K
B

T(A)
21.1 ps

S

GATE B ALARM priwgn gy MEASURE Selection

BASICS ~ PULSER  RECEIVER _ GATE A Eanmﬂk] ‘

0 O =
Cloze EM| Freeze ﬁ ﬂ Save ﬂpe}\ I

Click on this button or press press X" J on front

panel keyboard or or <Alt>+<C> on external
keyboard to interrupt AUTOCAL Procedure and
return to main UDS 3-5 control surface

If necessary Gain may be re-adjusted in the AUTOCAL Control Surface by the same way as it is explained
in paragraph 5.2.2 of this Operating Manual
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: Click on this button or press
. Fa
3 _2_lon front panel
: keyboard or @ or
: <Alt>+<2> on external
: keyboard to select value of
~ increment/decrement for
"

: Current value of :
: increment/decrement for  :
: keying in Material Travel ;

Distance MTD-s(A),
: mm or in

1 Material Travel Distance

: MTD-s(A) in mm or in for the
i first reference echo to be

entered here while the said keying in Materlal Travel

i echo matches with Gate A} 2 MTD-s(A) RIS
S ssssEs s TN EEEEEEEEEEEEEEEEENEEEEEEEEEM 25 mm ‘
T L[ 0] R
: Digital readout box indicating  * 21.1 ps I
: automatically determined delay : 2 MTD-s(B) y
i of the first reference echo ¥ 74 3 i
: relatively firing pulse excitation : -0 mm I
: hs LS &
--------------------------------------- = ﬂ I.I.S | !
4
Eﬂﬂ[:El ’ I ‘ :....................' .................. .:
Ly S & Click on this buttonto  :
To key in Material Travel Distance MTD-s(A) 1/ : confirm entered Material :
the following manipulations are applicable: I : Travel Distance MTD-
e Mouse / Touch Screen [ : s(A)
B Click or press and hold on the appropriate
e Keyboard
Fa

B Press _2_J on front panel keyboard or B or <Alt>+<A> on external keyboard = MTD-s(A) fore
color changes to white - then use '. , » , = , .' on front panel keyboard or , H & on
external keyboard

e Combined

B Click on MTD-s(A) = MTD-s(A) fore color changes to white - then use '. , » , - , .' on

front panel keyboard or ﬂ E g @ on external keyboard

Upon confirming keying in Material Travel Distance MTD-s(A) obtain second reference echo

05 Gain

Yl «

»

= &y

16 dB
Z MTD-sA)
T(A)
21.1 ps
0.1 MTD-s(B)
Rl «

L= By

BASICS PULSER RECEIVER GATE A Menu
GATE B ALARM PEIwa Nty MEASURE Selection

] &
Close Em | Freeze
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2 MTD-zlA)

2b mm

Click on this button if it is Click on this button to

necessary to return backto  :_. N confirm entered Material :
keying in Material Travel

Travel Distance MTD-
: Distance MTD-s(A) s(B)

TO key |n Material Travel Distance MTD'S(B) 'I :--------------------------------------:
the following manipulations are applicable: I

e Mouse / Touch Screen
B Click or press and hold on the appropriate
o Keyboard

-
B Press _4 j on front panel keyboard or @ or <Alt>+<B> on external keyboard = MTD-s(B) fore

color changes to white - then use !J '_’J :J !J on front panel keyboard or (T, , , on

external keyboard
¢ Combined

B Click on MTD-s(B) = MTD-s(B) fore color changes to white - then use !J '_’J :J !J on
front panel keyboard or , , , on external keyboard
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Material Travel Distance MTD-s(B) The screen as below appears upon confirming keying in

GATE A
MEASURE

PULSER RECEIVER
ALARM DAC/TCG

oo
Close | TN |

BASICS
GATE B

Freeze

05 Gain

16 dB

Selection Autocal

p.

L
I DG5S

¢ Clickon J if it is necessary to return back to keying in Material Travel Distance MTD-s(A)

Autocal

[
Enter

¢ Clickon or press

on front panel keyboard or Enter or <Alt>+<U> on external keyboard

to initialize automatic determining of US Velocity and Probe Delay based on above described keying

and echoes delays automatic measurements. As a result the screen as below appears:

Probe Delay

= Ty

05 Gain
16 dB ‘

Meas Yalue

OFF

| 5.82 IS
US Yelocity

Meas Mode

Flank
Probe Delap

.m

3272 mjs

Cancel

[ By

913 ps
10 Angle

ﬂﬁ

»
»
»
»
»

In by

Apply

GATE A
MEASURE

FECEIVER
DAC/TCG

Yalue: OFF

PULSER
ALARM

BASICS
GATE B

Freeze

Meru
Seledtion

p.

5 Uns 2-5

= ‘ 0| =

Save DGS

=
Open

\ 4

ESC
or press 'F_) on front panel keyboard or

Esc| or <Alt>+<C> on external keyboard to negate
AUTOCAL results and return to main operating
surface without modifying Probe Delay and US
Velocity settings

[
Enter

Click on| or press on front panel keyboard or

Enter| or <Alt>+<A> on external keyboard to
accept AUTOCAL results and return to main
operating surface with appropriate modifying Probe
Delay and US Velocity settings
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5.2.13.9. Automatic Calibration of Probe Delay and US Velocity - Straight Beam

(Normal) Single Element and Dual (TR) Probes — Typical Example

05 Gain

33 dB
LT Range
20 US Yelocity
4335 mfs

10 Display Delay
10 ps
5 Reject
1
; 0 2%

There are 2
sequentially
received back
echoes required for
performing
automatic
calibration of
Probe Delay and
US Velocity. A-
Scan settings
(Range, Display
Delay, US Velocity
— refer to
paragraph 5.2.2 of
this Operating
Manual) must allow
observing of both
signals.

Gate A to match with first back echo (shorter material travel distance) — refer to paragraph 5.2.5 of this
Operating Manual. Gate B to match with second back echo(longer material travel distance) — refer to

paragraph 5.2.6 of this Operating Manual

®

¢ It's necessary to setup Gain bringing height of back echo to 75-80% of A-Scan height

¢ Itis recommended to optimize Tuning in PULSER submenu upon obtaining back echo. The goal of such
optimization is increasing of ultrasonic excitation energy through better matching between firing output
and probe. Level of ultrasonic excitation energy is clearly represented by back echo amplitude. Upon
completing Tuning optimization Gain to be adjusted to bring echo to 75-80% of A-Scan height

All further operations to be performed identically to described in paragraph 5.2.13.8 of this Operating Manual

Measz Yalue
H(a)
Meaz Mode
Flank

| 9.13 s
US Yelocity
5952 mfs

0 ps
10 Angle
ﬂ o

Cancel Apply

BASICS PULSER RECEIVER GATE A Henu
GATE B ALARMW DAC/TCG MEASURE Selection

[ [ PRIFES g | =
Cloze Em | 1796 %% Freeze Save | Open

05 Gain
33 dB ‘

Ty

.01 Probe Delay

4= By

len By

B Uns 2-5

DGS

1 Lo
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5.2.13.10. Determining Incidence Angle (Probe Angle)

Caze Iltll

Case 3

L=

CF

Cazeh

-

o

Determining of incidence angle is
based on maximizing echo from
side-drilled hole in reference block
and reading the value of angle from
corresponding scale. Depending on
probe dimensions and angles there
are various reference blocks and
scales applicable:

Case 1: Miniature angle beam

probe, incidence angle 35° to 65°,
V-2 reference block

Case 2: Miniature angle beam

probe, incidence angle 65° to 75°,
V-2 reference block

Case 3: Medium or large size angle
beam probe, incidence angle 40° to
66°, V-1 reference block

Case 4: Medium or large size angle
beam probe, incidence angle 60° to
76°, V-1 reference block

Case 5: Medium or large size angle
beam probe, incidence angle 74° to
80°, V-1 reference block
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5.2.14. Frequency Domain Signal Presentation and Evaluation

Using Range and Delay parameters select a portion of A-Scan for frequency domain (FFT) presentation
then do activate submenu RECEIVER and switch Display to FFT (refer to paragraph 5.2.4 of this Operating
Manual). The screen as below appears:

FFT Graph E.
............................. N
i FFT Measurements |
: Controls : . PR
\\\\ : : : A
N ~N O . . . 0 MHz
N\ UpperFreq
S N 5 MHz
N + + +
* * * Beject
- 0% \‘
\
2l Uns'3-5
rdRd AT R P
Freeze Save | Open| Funt a DGS
A A AR B B e S | VR
: FFT Measurements : : Displayed Frequency
: Indicator 1 ] Range Controls

@ Display may not be switched into the FFT if the Range value is too long or DAC/TCG/DGS is active
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Lower frequency bound (LowerFreq)

To control LowerFreq the following
manipulations are applicable:

I
o Mouse / Touch Screen ’//
B Click or press and hold on appropriate

o Keyboard

-
B Press 2 J on front panel keyboard or @ or <Alt>+<W> on external keyboard = LowerFreq fore

color changes to white - then use !J '_’J _J !J on front panel keyboard or , , , on

external keyboard

e Combined

B Click on LowerFreq = LowerFreq fore color changes to white - then use !J '_’J :J !J
on front panel keyboard or , , , on external keyboard
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Upper frequency bound (UpperFreq)

0.1 LowerFreq

0 MHz
0.1 UpperFreq

5 MHz

To control UpperFreq the following
manipulations are applicable:

e Mouse / Touch Screen /1,
B Click or press and hold on the appropriate Ibuttonl

o Keyboard

Fd
B Press 3 j on front panel keyboard or @ or <Alt>+<U> on external keyboard = UpperFreq fore

color changes to white - then use !J '_’J _J !J on front panel keyboard or , , , on

external keyboard

e Combined

B Click on UpperFreq = UpperFreq fore color changes to white - then use !J " '_’J :J !J on
front panel keyboard or , , , on external keyboard
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Find maximum

Click on J — mouse pointer may be guided then just over FFT graph. FFT Readout Box displays
frequency corresponding to pointer position whilst guiding the cursor. Select first point of interest by mouse

click or through release of touch screen stylus. The appropriate mark 0 appears. Select the second point
of interest by the same way

Selection of Second
point FFT Mark and
corresponding
frequency value

Maximum’s frequency mark @appears and FFT Readout Box displays the found value automatically
upon mouse click or releasing of touch screen stylus:

Maximum’s
frequency mark and
digital readout

n
oo a o n s sy
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Find the —3db / —20db level bounds:

Maximum’s

frequency mark

- 3 dB bounds —
marks and digital
readout

Return to FFT Measurements toolbar:

=
Click on

Find frequency corresponding to selected single point on FFT graph:

Click on J — mouse pointer may be guided then just over FFT graph. FFT Readout Box displays
frequency corresponding to pointer position whilst guiding the cursor. Select first point of interest by mouse

click or through release of touch screen stylus. The appropriate mark n appears and FFT Readout Box
displays corresponding frequency:

Selected point
and
corresponding
freauency

|
+ + + 0+ + +, + + +

[+~ T
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Frequency difference (deviation) between two points:

Click on _I — mouse pointer may be guided then just over FFT graph. FFT Readout Box displays
frequency corresponding to pointer position whilst guiding the cursor. Select first point of interest by mouse

click or through release of touch screen stylus. The appropriate mark n appears. Select second point of

interest by the same way - the appropriate mark e appears and the FFT Readout Box displays difference
(deviation) between corresponding frequencies:

1 Selected points and
:  difference (deviation)
! between corresponding
: frequencies

f2 -1 = 0.85 MHz

Clear FFT Marks:

]
Click on

Exit FFT Mode:

Change Display mode
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5.2.15. Freeze A-Scan / FFT Graph
UD53-5 - ISONIC Pulzer/Receiver

Ty

1 Gain
37dB ‘

Measz Yalue
«
Meaz Mode

.
0.01 Probe Delay
h 13 pus ‘
10 Angle
60 ° ‘

BASICS PULSER  RECEIVER _ GATE A Menu ﬁ| "D" ?_s
GATE B ALARM  DAC/TCG IETTEIGEN Selection

4= By

len By

R @l B|=]|8 =
Cloze EM| 41 .3 mm ErzPe Save | Open | Print DG5S

To freeze / freeze peak / unfreeze the A-Scan click or press i) on front panel keyboard or or
<Alt>+<F> on external keyboard

®

¢ Freeze Peak mode allows representing of Hilbert envelop for sequence of echoes obtained while
manipulating probe over some reflector. This function may be useful for localization of echo maximum
when working in A-Scan mode:

¢ Freeze Peak mode may not be activated for RF and FFT signal presentation
¢ Appearing of at the upper left corner of A-Scan indicates that it is frozen (Freeze)

Appearing of at the upper left corner of A-Scan indicates that Freeze Peak mode is active

The following operations are available when time domain A-Scan is frozen:

0 =6 dB Gain varying according to paragraph 5.2.2 of this Operating Manual

0 Manipulating Gates A and B according to paragraphs 5.2.5, 5.2.6, 5.2.7 of this Operating Manual

o0 Varying Alarm mode according to paragraph 5.2.8 of this Operating Manual

0 Selecting parameter (Meas Value) for automatic measurements and varying settings Probe
Delay and Angle as per paragraph 5.2.12 of this Operating Manual and obtaining corresponding
measurements results in the digital readout box (Value)

¢ The following operations are available while frequency domain FFT Graph is frozen:
0 =6 dB Gain varying according to paragraph 5.2.2 of this Operating Manual
0 All FFT evaluation / measurements as per paragraph 5.2.14 of this Operating Manual

+ Caption of appropriate button changes in the UDS 3-5 Pulser/Receiver window when freeze / freeze
peak / unfreeze A-Scan / FFT Graph

Freeze FrzPeak
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5.2.16. Zoom A-Scan / FFT Graph

Double click on A-Scan / FFT Graph to get it enlarged. Enlarged A-Scan / FFT Graph occupies screen
completely

In upright corner of A-Scan there is a digital readout box indicating current Gain value and digital readout of
automatic measurements provided that corresponding Gate is active

$

To control Gain while A-Scan is enlarged use ' and '~/ on front panel keyboard or , on external
keyboard

To freeze / freeze peak / unfreeze enlarged A-Scan press &J on front panel keyboard or on external
keyboard
If Gate A and / or Gate B is active then:

Parameters V(A), s(A), t(A), a(A) , V(B), s(B), t(B), and Parameters V(A), s(A), V(B), and s(B) are measured and
a(B) are measured and indicated automatically — refer to indicated automatically — refer to paragraph 5.2.13.1 of this
paragraph 5.2.13.1 of this Operating Manual Operating Manual

Parameters V(A), s(A), t(A), and a(A) are measured and Parameters V(A), and s(A) are measured and indicated
indicated automatically — refer to paragraph 5.2.13.1 of automatically — refer to paragraph 5.2.13.1 of this Operating
this Operating Manual Manual

Parameters V(B), s(B), t(B), and a(B) are measured and Parameters V(B), and s(B) are measured and indicated
indicated automatically — refer to paragraph 5.2.13.1 of automatically — refer to paragraph 5.2.13.1 of this Operating
this Operating Manual Manual

To select an additional parameter for automatic measurement and large character indication while A-Scan is

enlarged (Meas Value - refer taragraphs 5.2.12 and 5.2.13 of this Operating Manual) use ‘ and ‘

on front panel keyboard or , on external keyboard. Gate A and Gate B if active may be drag and drop
manipulated on the enlarged A-Scan according to paragraph 5.2.7 of this Operating Manual. To return to
main operating surface window double click on enlarged A-Scan / FFT Graph
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5.2.17. Save an A-Scan and its Calibration Dump into a file

T

=
To save the A-Scan / FFT Graph and Calibration Dump into a file click on ﬂ' or press 32 J on front

panel keyboard or @l or <Alt>+<S> on external keyboard — ISONIC 2005 / 2020 / STAR Save/Open
window becomes active providing automatically created name for a new file in
File name: box:

ISONIC 2005 Save/Open EHE
Save in; I {23 UDS 35 Pulser Receiver j gl
0.par fit1.par P 000005, par P00
00 par hgb. par PUIOODDOE. par PUIOOOO 2 -
000, par PLOO0ODT. par PL000007. par P00 2 »
0000.par PU00000Z. par P00000S. par P00 -
chime defect.par PL000003. par PL00000S. par PLO0OOTE -
chime ok. par PL00000. par PL0000T 0. par PLOOOOTE 2
| | | |

Save I
Save as type: ILIDS 35 Settings [*.par] j Cancel |
Heiye e g

~ el #4566 ||78|93])0 =01
BASICS
GATE B QWi E|R|T|YI|U Il O P [ |
| I_ ANSYHDHWFHNGHHIJIIKIJL ; ) %
Close m

Shit [|Z || X[ CHY || BlN|MI.| .|l

2 JE JE B JE >
s by

ln By

= By
5 o lvvee

+ +
A we

W'
"

E

Del BS

To save a file:
e select disk drive and directory for placing a file using mouse or touch screen

e approve automatically created new file name
OR
mark a file to be replaced from the list appearing in the destination directory
OR
type a new file name using either virtual keyboard generated in ISONIC 2005 / 2020 / STAR Save/Open
window or external keyboard — standard Windows rules for file naming are applicable, long names (up
to 64 characters) are supported
&=
e double click on file to be replaced or click on ﬂl or press ‘=== J or
keyboard or press @ or or <Alt>+<8> on external keyboard

ISONIC 2005 / 2020 / STAR Save/Open window disappears automatically upon completing saving a file
To exit from ISONIC 2005 / 2020 / STAR Save/Open window without saving a file click on ﬂl or

L
Enter

+=1 J on front panel

ESC
press L) on front panel keyboard or @l on external keyboard
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5.2.18. Load an A-Scan and its Calibration Dump from a file

= | =
To load A-Scan/FFT Graph and Calibration Dump from a file click on "8P&R| or press ' &) on front panel

keyboard or or <Alt>+<0> on external keyboard — <Alt>+<0> on the keyboard — ISONIC 2005 / 2020
| STAR Save/Open window becomes active

UDS53-5 - ISONIC

DGS

ISOMIC 2005 5ave/Open EHE ‘ r »
: 1
Look jre | =3 UDS 35 Pulser Receiver =] = -
-
O.par fit1.par PL00000S. par PLO000TT ‘ 2 »
00, par hgb. par PL00000E. par PLO000T 2 =
000, par PLO0O00T . par PL00000T. par PLO000T 2 ‘ 3 »
0000.par PL0000O0Z par PL00000S. par PLO000T4 -
chime defect.par PL000003. par PL00000S. par PLODOOTE ‘ - »
chime ok par PL000004. par P00 0. par PLODOOTE 4
-
J | o ]S |
e e e s —
BASICS Aegme | |_|gpen f ? - 5
GATE B Files of twpe: ILIDS 35 Setlings [*.par] j Cancel |
[ 7 | | -

Close | FETA |

To open a file:

7274 ps

Un[leezel FT- | Save ||_gpen| Print

e select disk drive and directory containing a file required

\ E-‘; Ente.r
e select then file then double click on its name or click on % or press &) or *==*_ on front
panel keyboard or @l or or <Alt>+<0> on external keyboard
ISONIC 2005 / 2020 / STAR Save/Open window disappears automatically upon completing loading a file

ESC

To exit from ISONIC Save/Open window without opening a file click on ___=aMee! |or press X

panel keyboard or @ on external keyboard

on front
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5.2.19. Print A-Scan/FFT Graph and Settings List

Ensure the printer connection is in order (printer to be accessible through either USB or LAN port and

&
. . . Print & }
defined as default in the ISONIC 2005 / 2020 / STAR) then click on |_— or press “Eint J on front panel
keyboard or or <Alt>+<P> on external keyboard

5.2.20. Activate Main Recording Menu

I
Click on _| or press LJ on front panel keyboard or on external keyboard. Refer to Chapter 6 of

this Operating Manual for further instructions

5.2.21. Switch OFF UDS 3-5

ESC
To switch OFF UDS 3-5 click on &I or press L) on front panel keyboard or @ or <Alt>+<C>

on external keyboard
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6. Recording and Imaging
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6.1. Main Recording Menu

Main Recording Menu is shown below:

IfTime Based Recording

[2|True to Location Recording

@Back

There are 2 recording submenus available:

+ Time Based Recording submenu relates to line scanning procedures where probe is
manipulated over object under test with constant speed and defects images are formed from
sequence of A-Scans captured at equal time intervals (real time clock). To open Time Based

= s
. . 1Tl Based R i |
Recording submenu click on| meBesedecer™ _Jor press ' on front panel keyboard or

on external keyboard

¢ True to Location Recording submenu relates to line scanning procedures where coordinate of
probe manipulated over object under test is transferred to ISONIC 2005 / 2020 / STAR
instrument by means of position encoder while defects images are formed from sequence of A-

Scans captured at equal distance intervals. To open True to Location Recording submenu
| -

. | [2]True to Location Record
click on |_2/Te e tesaten Recerdng | - hress 2 on front panel keyboard oron external
keyboard
| — ESC F i
N o[ me | =) (%)
To return to main operating surface click on | or press or <2 Jon front panel

keyboard or @ or @ on external keyboard
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6.2. Time Based and True to Location Recording Submenus

Both Time Based Recording and True to Location Recording submenus allow activating 4 protocols of
data recording:

[1]t-BScan (Th) [1]BScan (Th)

[2]t-ABiscan [2]ABIScan
[8]t-ToFD [8]ToFD
IZ]t—Floarmap 1= z‘ Floormap L
J B &
|?] Back |?] Back

+ Thickness Profile imaging and recording — t-BScan(Th) or BScan(Th) — click on ‘MJ or

[1]BScan (Th) "; | . . .
or press ' _J on front panel keyboard or H on external keyboard — illustrative video

is available at http://www.sonotronndt.com/video.asp?VideolD=1

¢ B-Scan cross-sectional imaging and recording of defects for longitudinal and shear wave

F
t-ABIScan 2 |ABIScan |
l 2] ‘orl 2] ‘orpress 2 Jon

inspection — t-ABIScan or ABIScan — click on
front panel keyboard or @ on external keyboard — illustrative video is available at
http://www.sonotronndt.com/video.asp?VideolD=2

¢ TOFD Inspection — RF B-Scan and D-Scan Imaging — t-TOFD or TOFD - click on ‘&J or

-
3 TOFD |
2 or press 2 on front panel keyboard or EI on external keyboard — illustrative video

is available at http://www.sonotronndt.com/video.asp?VideolD=4

¢ CB-Scan horizontal plane-view imaging and recording of defects for shear, surface, and guided

E‘t-Floormap L ‘ l z‘ Floormap L
or

wave inspection — t-FLOORMAP L or FLOORMAP L click on l
-

_4_J on front panel keyboard or [F4{ on external keyboard — illustrative video is available at
http://www.sonotronndt.com/video.asp?VideolD=3

press

. . . [5Back \ & o
To return to Main Recording Menu click on or press - or —2_ on front panel
keyboard or @l or @ on external keyboard
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6.3. Thickness Profile Imaging and Recording — t-BScan(Th)

and BScan(Th)

6.3.1. Setup Pulser Receiver for Thickness Profile Imaging and

Recording

UDS 3-5 Pulser Receiver window — main operating surface — appears on ISONIC 2005 / 2020 / STAR

l [1]t-BScan (Th)

or’

[1]Bscan (Th)

screen upon clicking on

. The following settings to be provided:

# | Parameter or Submenu Required Settings Note
Mode
1 | aSwitch GATE A ON
2 Gain BASICS Gain and aThreshold settings to
aThreshold GATE A provide receiving an echo from the
minimal area of thickness degradation to
be detected; height of the said echo to
exceed aThreshold; signals from other
reflectors less then defined one not to
exceed aThreshold
3 DAC/TCG DAC/TCG DAC/TCG settings to meet requirements
of the Inspection Procedure
4 Pulser Mode PULSER Dual for dual element probes
Single for single element probes
5 Tuning, Pulse Width, | PULSER Tuning, Pulse Width, Firing Level, To synchronize with Gain
Firing Level, and Damping settings to provide and aThreshold setting
Damping optimal signal to noise ratio procedure
6 Filter, Frequency RECEIVER Filter and Frequency settings to match | To synchronize with Gain
with probe's frequency and aThreshold setting
procedure
7 Display RECEIVER Display mode may be either Full, RF, The same Display mode to
PosHalf, or NegHalf be used for both Probe
Delay determining and
Thickness Profile Imaging
8 USVelocity BASIC USVelocity setting to be equal to actual
value of ultrasound velocity in the object
under test
9 Probe Delay MEASURE Probe Delay setting to be equal to Probe delay may be
actual probe delay determined according to
paragraph 5.2.13.7 or
5.2.13.9 of this Operating
Manual or similarly
10 | Angle MEASURE Angle = 0°
11 | Meas Mode MEASURE Flank
12 | Range, Display BASIC Range, Display Delay, AStart, and
Delay, AStart, GATE A aWidth settings to be performed with
aWidth reference to the Region of Interest for

t-BScan(Th) and BScan(Th) table
below

13 | Settings for other
parameters and
modes have no
significance

I
Upon completing click on J or press LJ on front panel keyboard or on external keyboard
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Region of Interest for t-BScan(Th) and BScan(Th)

. Scanning Surface

Surface to ROI Distance = SRD

ROl = Region of Interest

E;Ek Wall Profile

Initial
Pulze
SRD = aStart
Case 1
—_— RW = aWidth
0
Display Range
" Delay
Initial DisplavDel
ISplaybela .
Pulse SRD = %xUSVelocny
Case 2
-1 RW = aStart + aWidth — SRD
0
Dizplay Range
" Delay
Initial
Pulse SRD = aStart
DisplayDelay .
Case 3 L RW = — 5, xUSVelocity +
0 —
| Display Range + Range — aStart
" Delay
Initial
Pulze
DisplayDela .
SRD = 2iplayoelay USVelocity
Case 4 2
0 RW = Range
Display Range
" Delay
Preferred Initial + aStart and aWidth setting to provide
embodimen Pulse 1t back echo appearance of whole Gate A on the A-Scan
t ¢ aWidth = (0.75...0.95) x Range
¢ First Back Echo at the thickest area of object
under test to be fully matching with Gate A
0 — ¢ First Back Echo at the thickest area of object
Display Range under test to "occupy” 5-10% of the Gate A
" Delay width on the A-Scan
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6.3.2. Thickness Profile Imaging — Implementation

6.3.2.1. t-BScan(Th) — Prior to Scanning

t-BScan(Th) control panel is shown below

Current A-Scan

= By

1 L. mm
-
Time, sec

T K
Time-0Out, sec
3
4 =]

p

Start Save

2y,

UDS3-5 Text Close

289 mm
[ Gate
g Start
E % Empty t-BScan(Th) record field
3 Gate
' End a0 10
< Scan Length / Scan Time

®

Display Delay and Range settings for current A-Scan to be used for the recording are equivalent to the
same setting of UDS 3-5 Pulser Receiver predcessing entering into t-BScan(Th) mode
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Scan Length and Scan Time

Scan Length — L represents length of section of test object to be displayed, over which probe will be
scanning during recording period. Time (Scan Time) is the duration of recording period

To control Scan Length — L the following ,
manipulations are applicable: /7 7

VR
yd
e Mouse / Touch Screen /s

—t
B Click on corresponding |button|
e Keyboard

+
m Press 1! J on front panel keyboard or ﬂ on external keyboard => L fore color changes to white -

then use !J '_’J , _J !J on front panel keyboard or , , , on external keyboard

e Combined

B Click on L = L fore color changes to white - then use !J '_’J :J !J on front panel
keyboard or , , , on external keyboard

®

The value of Scan Length — L is adjustable between 50 and 1000 mm or 2 and 40 in
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: Current value of
: Scan Time — Time

|r.ul|.\ i By | 1= By

To control Scan Time — Time

the following manipulations are applicable:/ /, “
/
e Mouse / Touch Screen ,//
/g

B Click on corresponding

e Keyboard
F
m  Press _2 J on front panel keyboard or @ on external keyboard — Time fore color changes to
white - then use !» !/ « ! on front panel keyboard or [T} , , on external
keyboard

e Combined

B Click on Time = Time fore color changes to white - then use !» . « !

=), _/ on front panel
keyboard or , , on external keyboard

®

The value of Scan Time — Time is adjustable between 5 and 60 sec in 1 sec increment/decrement
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Time-out

Time-Out is waiting time for intermissions predcessing t-BScan(Th) recording, which starts unconditionally
upon Time-Out period is over

lllllllllllllllllllllllllll 1 L' mm
: Currentvalue of : 100 ‘
E Time'out '* TimE‘_ SEC
] sec :
CA ; 10 ‘
Time-Out, sec
3
7
. ¥e
To control Time-out arhd
the following manipulations are applicable: P /’ -
z -
e Mouse / Touch Screen P

B Click on corresponding Jbutton

Keyboard

?
B Press 3 J on front panel keyboard or @ on external keyboard = Time-out fore color changes

to white - then use !» !/ « ! on front panel keyboard or , , , on external
keyboard

Combined

Tt » « 3

B Click on Time-Out = Time-Out fore color changes to white - then use =/, ' =, ./

front panel keyboard or , , , on external keyboard

/ on

®

The value of Time-Out is adjustable between 0 and 15 sec in 1 sec increment/decrements
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Insert Text Note

®

Inserting of text notes is available in the old SW versions only for ISONIC 2005 instruments running under
W’'98SE

A text note may be entered to accompany t-BScan(Th) record. To proceed click on Text | or press
<Alt>+<X> on external keyboard

1 L. mm )
100 ‘ 1
Time, sec ar
1 ‘ 2
_ -
place your comments here ‘ 3
i =
e Open
~prpzl3llallslell7zsao| -|=|1|pg]_Close
qwertyU|up[]|
E allsfidlf fHallhllilNkY!IN: "
zllzllcllvllbin|iml|, !
Del BS
Save Cancel
g
oo
0 o 50 100
| a0

Type notes and comments to accompany scanning files: use either virtual keyboard appeared (touch screen
or mouse) or external keyboard

Save
Click on to store typed note and to return to t-BScan(Th) control panel
Cancel s
Click on or press L‘\ on front panel keyboard or @ on external keyboard to

negate typed note and to return to t-BScan(Th) control panel
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Preview UDS 3-5 Settings

UDS 3-5 Pulser Receiver settings for the t-BScan(Th) record may be previewed through clicking on

UD53-5 | or pressing <Alt>+<D> on external keyboard . The corresponding window appears:

1 L. mm ar
oo KJH

UD53-5: Setup Data

UDS3-5: Setup Data

BASIC: PULSER

Gain = 44 4B Ratge = 41 mum Pulset Mode =DUAL  Tuning=T pH
Reject= 0 % Display Dielay = 6.63 ps PRF = 500 Hz Datrpitig = 1000 £
113 Velocity = 5920 mfs Pulge Width = 110 n3

GATE A: RECEIVER:

afwitch = ON adtart = 0 mm Filter = 4 MHz Diisplay = Full

Mt 25 25

BEEER| o Theeshold= 10 % a-Width= 332 mm Frequency =0.7-13 MHz
ga GATEB: ALARM:
bZwitch = OFF b-3tart = 30 fum afwitch = OFF al.ogic = Positive
b-Threshold = 40 2% b-Width = 25 tmam b3witch = OFF bLogic = Positive
DAC/TCGDGS: MEASTURE:
Mode: OFF Rec=10 FrobeDelay= 873 ps  Angle=0°
Cutve = OFF Measuring Mode = Flank
v

100

o 3Eimm
el | =
==

//

ESC
or press L) on front panel keyboard or <Alt>+<K> or @ on external keyboard to return to
return to t-BScan(Th) control panel
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Start/Stop t-BScan(Th) recording

4
Click on ﬂl or press LJ on front panel keyboard or F8 or <Alt>+<S> on external keyboard to

start t-BScan(Th) recording

4 | | |
Stat | putton becomes invisible since t-BScan(Th) recording starts. __28P | putton occupies its

position. Click on stop | or press LJ on front panel keyboard or or <Alt>+<S> on external
keyboard to terminate t-BScan(Th) recording prior to automatic completion

N 4 |
ﬂ' button becomes invisible after completion / termination of t-BScan(Th) record. __3tam’t | putton

returns to its position

Save record into a file

Click on _38¥8 |or press ﬂ) on front panel keyboard or @I or <Alt>+<A> on external keyboard to
save captured t-BScan(Th) record accompanied with instrument calibration dump and text notes /
comments into a file. Refer to paragraph 5.2.17 of this Operating Manual to proceed with file saving

Open record from a file and starting postprocessing session

= | =
| &
Click on _Open | or press &) on front panel keyboard or m or <Alt>+<0> on external keyboard t-B-

Scan(Th) record accompanied with instrument calibration dump and text notes / comments from a file. Refer
to paragraph 5.2.18 of this Operating Manual to proceed with file opening. Refer to paragraph 6.3.2.5 of this
Operating Manual to proceed with postprocessing

Return to UDS 3-5 main operating surface

ESC
Click on __Elose |or press L) on front panel keyboard or <Alt>+<C> or ESC on external keyboard
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6.3.2.2. t-BScan(Th) — Scanning

Q Apply probe to test object in the start point of selected scanning line

4 |
O Clickon _3tat |or press LJ on front panel keyboard or or <Alt>+<S8> on external keyboard

O Guide probe over the scanning line synchronously with Recording Progress Bar — typical scanning
progress display during is shown and explained below

1 L. mm o
100 ‘ 1
Time, sec o
10 ‘ 2
Time-Out, zec o
3 ‘ 3
| | (i
Stop Save Open
UDS3-5 Text Cloze
0| D-2377mm |
t-BScan(Th) record
Back Wall Profile
0 50 100
TN
Recording Currently
Progress Bar measured wall
thickness
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6.3.2.3. BScan(Th) — Prior to Scanning

BScan(Th) control panel is shown below

I « 7

Encoder:
4 = (=
Start Open Save Cloze

I

Text UD53-5
27.8 mm
g
=
Empty BScan(Th) record field

:

| o

< Total Scan Length for L <1000 mm /40 in >

)41 L ]
g
=

BScan(Th) scrolling controls
20 L. mm %
2270 ‘
E Empty BScan(Th) record field
" eho 1300 1400 1500
1000 mm / 40 in Segment of Scrolled Total Scan Length exceeding 1000 mm / 40 in

®

Display Delay and Range settings for current A-Scan to be used for the recording are equivalent to the
same setting of UDS 3-5 Pulser Receiver predcessing entering into BScan(Th) mode
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Scan Length

Scan Length — L represents length of section of test object to be displayed, over which probe will be
scanning during recording period

To control Scan Length — L the following P 7 i
manipulations are applicable: , -

s .-
e Mouse / Touch Screen 44 -

B Click on corresponding
o Keyboard

-
m Press 1 J on front panel keyboard or H on external keyboard = L fore color changes to white -

then use !J QJ , _J !J on front panel keyboard or , , , on external keyboard

e Combined

B Click on L = L fore color changes to white - then use !J QJ !J !J on front panel
keyboard or , , , on external keyboard

®

The value of Scan Length — L is adjustable between 50 and 20000 mm or 2 and 800 in

Encoder
Select encoder to be used through appropriate box

Encoder:

Drefauilt j

Clamp probe into encoder — refer to Chapter 7 of this Operating Manual

Connect encoder to its input on the rear panel of ISONIC 2005 / 2020 / STAR instrument

Insert Text Note

Refer to paragraph 6.3.2.1 of this Operating Manual

Preview UDS 3-5 Settings

Refer to paragraph 6.3.2.1 of this Operating Manual
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Start/Stop BScan(Th) recording

4
Click on ﬂl or press LJ on front panel keyboard or or <Alt>+<S> on external keyboard to

start BScan(Th) recording

4 | N |
Stat | putton becomes invisible since BScan(Th) recording starts. __ 2P | button occupies its position.

N
Click on _3%P_ | or press _J on front panel keyboard or or <Alt>+<S> on external keyboard to

terminate BScan(Th) recording

H 4

stop | putton becomes invisible after termination of BScan(Th) record. __2tamt | putton returns to its
position

Save record into a file

= |
Click on _38¥€ |or press ﬂ) on front panel keyboard or @I or <Alt>+<A> on external keyboard to

save captured BScan(Th) record accompanied with instrument calibration dump and text notes / comments
into a file. Refer to paragraph 5.2.17 of this Operating Manual to proceed with file saving

Open record from a file and starting postprocessing session

= | =
| &
Click on _Open | or press &) on front panel keyboard or @ or <Alt>+<0> on external keyboard B-

Scan(Th) record accompanied with instrument calibration dump and text notes / comments from a file. Refer
to paragraph 5.2.18 of this Operating Manual to proceed with file opening. Refer to paragraph 6.3.2.5 of this
Operating Manual to proceed with postprocessing

Return to UDS 3-5 main operating surface

ESC
Click on __Elose |or press L) on front panel keyboard or <Alt>+<C> or ESC on external keyboard
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6.3.2.4. BScan(Th) — Scanning

a Apply probe equipped with an encoder to test object in the start point of selected scanning line

4
0 Clickon _2%m®_|or press LJ on front panel keyboard or F8 or <Alt>+<S> on external keyboard

O Guide probe over the scanning line — typical scanning progress display is shown and explained below

1 L. mm )
100 ‘ 1 ’
Encoder:
[ |
Stop
D=2377 mm L=24.0 mm

BScan(Th) record

Current Probe

Position

Back Wall Profile Currently
measured wall
thickness
0 - 50 100
P
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6.3.2.5. t-BScan(Th) / BScan(Th) — Postprocessing
Postprocessing of t-BScan(Th) / BScan(Th) records is featured with:

Q Sizing thickness damages at any location along stored images (remaining thickness, thickness loss,

and length of damage)
Q Play-back and evaluation of A-Scans obtained and captured during thickness profile recording

@ Reconstruction of thickness profile image for various Gain and / or Gate A settings

The screen as below appears upon opening file. All postprocessing procedures are performed through

menu bar| — touch screen stylus or front panel or external mouse to be used
~

| File: v|| Instrument || E dit v|| Measurements v|| A-Scan Recovery v|

£

18 3 mm

30 100 150 200

=

~Inspection Data— [ Thickness Measurements —

5Scan Length: 210 mm |
Encoder Mame: Default I I

Inspector’s Coments: ~Length Measurements

A
ol |

—A-5can Recovery

BScan (Th) |
POSTPROCESSING | |

Menu Bar Functions

e File>0Open — opens new t-BScan(Th) / BScan(Th) file

¢ File>Snapshots>Add Snapshot — stores current postprocessing screen snapshot accompanied with
appropriate settings and measurements into postprocessing session memory stack

e File>Snapshots>Restore Snapshot — recalls earlier stored postprocessing screen snapshot
accompanied with appropriate settings and measurements from postprocessing session memory stack

¢ File>Snapshots>Delete Snapshot — deletes earlier stored postprocessing screen snapshot
accompanied with appropriate settings and measurements from postprocessing session memory stack

¢ File=>Print — prints out postprocessing screen snapshot(s) accompanied with appropriate settings and
measurements

e File>Exit — returns to t-BScan(Th) / BScan(Th) control panel

¢ Instrument — indicates setup of UDS 3-5 Pulser Receiver used for scanning when file was created
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A-Scan Recovery->ON — generates cursor representing sound path of probe's central beam in the
object under test that may be guided over t-BScan(Th) / BScan(Th) image using either touch screen

stylus or mouse or ?/ « on front panel keyboard or , on external keyboard — corresponding
A-Scan is recovered synchronously according to sound path cursor position. In the A-Scan Recovery
field there are indicated coordinate (L) of sound path cursor along t-BScan(Th) / BScan(Th) record and

corresponding remaining thickness value (D)

| File: v|| Instrurment || Edit v|| Meazurements v|| A-Scan Recoverny v|

d

12 Jnm

=

0 110 150 200

~Inspection Data—— [ Thickness Measurements —

Scan Length: 210 mm I
Encoder Name: Default | |

| o+ o+ o 4+ 4+

Inspector’s Coments: ~Length Measurements
iy
ol |
—A-Scan Recovery
BScan (Th) | L-99.9mm
POSTPROCESSING | D =85 mm

To fix position of sound path cursor with corresponding recovered A-Scan and remaining thickness

"
Enter
value left mouse click or release touch screen stylus or press ' *=_J on front panel keyboard or
on external keyboard

ESC
To interrupt recovery of A-Scans and empty A-Scan Recovery field right mouse click or press L‘\
on front panel keyboard or @ on external keyboard

A-Scan Recovery->OFF — erases sound path cursor, switches off recovered A-Scan, and empties A-
Scan Recovery field
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o Edit>Change Gain>ON — generates cursor representing sound path of probe's central beam in the
object under test that may be guided over t-BScan(Th) / BScan(Th) image using either touch screen

stylus or mouse or !/ f on front panel keyboard or , on external keyboard — corresponding
A-Scan is recovered synchronously according to cursor position. To select reference A-Scan release

Ente.r
touch screen stylus or left mouse click or press ' *=_ on front panel keyboard or on external
keyboard — this generates subwindow allowing off-line re-adjusting of Gain for all A-Scans captured
during t-BScan(Th) / BScan(Th) recording in £6dB range with £0.1 dB increments through clicking or

A
t $

pressing and holding on b J or pressing —/, . / on front panel keyboard or , on external

keyboard
ISONIC 2005 |

Select Gain Change:

+4.4 dB il

OK Cancel
b
During Gain re-adjusting reference A-Scan is modified accordingly. Upon completing re-adjusting Gain click
DK Ente.! |
on or press ' *=_ on front panel keyboard or on external keyboard - this applies new

Gain value to all captured A-Scans and redraws t-BScan(Th) / BScan(Th) image accordingly

Cancel e
To interrupt re-adjusting of Gain click on 4| or press L) on front panel keyboard or @ on

external keyboard

Edit>Change Gain>OFF — negates Gain re-adjustment and returns to originally recorded t-BScan(Th) /
BScan(Th) image and original Gain setting

ISONIC 2005/ 2020 / STAR from Sonotron NDT - Operating Manual — Revision 2.38 - Page 140 of 380



Edit>ROI>ON - generates cursor representing sound path of probe's central beam in the object under
test that may be guided over t-BScan(Th) / BScan(Th) image using either touch screen stylus or mouse

r ? ‘ on front panel keyboard or , on external keyboard — corresponding A-Scan is
recovered synchronously according to cursor position. To select reference A-Scan release touch screen

FnTEr
stylus or left mouse click or press ' *=_ on front panel keyboard or on external keyboard — this

generates off-line Gate A controls n n n u m m allowing to redefine Region Of

Interest for t-BScan(Th) / BScan(Th) imaging

| File v|| Instrument || Edit v|| Measurements v|| A-Scan Recovery =

£

1% 3 mm

cinspectionData——— | - hickness Measurements —

Scan Length: 210 mm I
Encoder Name: Default I I

Inspector’s Coments: rLength Measurements

A
iRl |

=h-Scan Becoveny

BScan (Th) |
POSTPROCESSING | |

+ o+
+ o+
+ o+
+ o+
+ o+
+ o+
+ o+
+ o+
+ o+

Upon completing redefining of Region Of Interest click on — this applies new Gate A to alll
captured A-Scans and updates t-BScan(Th) / BScan(Th) image accordingly

ESC
To interrupt selection of reference of A-Scan right mouse click or press L‘\ on front panel keyboard
or @ on external keyboard

To interrupt re-adjustment of Region Of Interest after selection of reference of A-Scan click on

Edit>ROI>OFF — negates Gate A re-adjustment and returns to originally recorded t-BScan(Th) /
BScan(Th) image and original Gate A setting
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Edit>Flip Horizontal — reorders A-Scans captured during t-BScan(Th) / BScan(Th) recording in
reverse succession and redraws t-BScan(Th) / BScan(Th) image accordingly. This service function
may be useful for merging scans of neighboring sections of an object, which were scanned in opposite
direction due to access conditions, etc

| File v|| Instrument || Edit v|| Measurements v|| A-Scan Recovery v|

ROI 4

Change Gain ¥

S

0 50 100

~Inspection Data—— [ Thickness Measurements —
Scan Length: 100 mm I
Scan Time: 10 sec I I
Time-Out: 3 sec
Inspector’s Coments: ~Length Measurements

S

il |

—A-5can Recovery

t-BScan (Th) |
POSTPROCESSING | |

| File v|| Instrument || Edit v|| Measurements v|| A-Scan Recovery -

E

Stimm

0 0 100
~Inspection Data—— [ Thickness Measurements —
Scan Length: 100 mm I
Scan Time: 10 sec
Time-Out: 3 sec I I
Inspector’s Coments: ~Length Measurements
=
<l |
—A-5can Recovery
t-BScan (Th) |
POSTPROCESSING |

®

Applying of Flip Horizontal function empties postprocessing session memory stack
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Measurements—>Length->ON — generates first vertical cursor that may be guided over t-BScan(Th) /

BScan(Th) image using either touch screen stylus or mouse or ?/ « on front panel keyboard or
, on external keyboard . Coordinate of the first vertical cursor along t-BScan(Th) / BScan(Th)
image (Lg) is indicated in the Length Measurements field. To fix position of the first vertical cursor left

Ente‘r
mouse click or release touch screen stylus or press ' *=_/ on front panel keyboard or on
external keyboard . To interrupt vertical cursor manipulations and empty Length Measurements field

ESC
right mouse click or press L) on front panel keyboard or @ on external keyboard
Second vertical cursor appears upon fixing first one, it may be manipulated by the same way. Coordinate
of the second vertical cursor along t-BScan(Th) / BScan(Th) image (Lr) is indicated in the Length

Measurements field along with parameter W = Lr — Lg. Parameter W represents length of defect
provided that vertical cursors are placed appropriately

Measurements>Length-> OFF — erases vertical cursors and empties Length Measurements field
Measurements—=>Thickness=>ON — generates first horizontal cursor that may be guided over t-

Y |

BScan(Th) / BScan(Th) image using either touch screen or mouse or =, T / on front panel
keyboard or , on external keyboard . Coordinate of the first horizontal cursor along t-BScan(Th) /
BScan(Th) image (Dg) is indicated in the Thickness Measurements field. To fix position of the first

"
Enter

horizontal cursor left mouse click or release touch screen stylus or press ' -*=_/ on front panel keyboard
or on external keyboard . To interrupt horizontal cursor manipulations and empty Thickness

ESC
Measurements field right mouse click or press L) on front panel keyboard or @ on external
keyboard
Second horizontal cursor appears upon fixing first one, it may be manipulated by the same way.
Coordinate of the second horizontal cursor along t-BScan(Th) / BScan(Th) image (Dr) is indicated in
the Thickness Measurements field along with parameter H = Dr — Dg. Parameter H represents
thickness loss provided that horizontal cursors are placed appropriately

Measurements—>Thickness> OFF — erases horizontal cursors and empties Thickness
Measurements field

| File v|| Instrurment || Edit v|| Meazurements v|| A-Scan Recavery v|

2

a0 100 150 200

-

123 nm

=

~Inspection Data—— [ Thickness Measurements —

Scan Length: 210 mm I H=53mm
Encoder Name: Default

| Dg=86mm | Dr=13.9mm

Inspector's Coments: ~Length Measurements

B

| W =57.1mm
|Lg=859mm | Lr=143 mm

H
—A-Scan Recovery

BScan (Th) |
POSTPROCESSING | ||
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6.4. B-Scan cross-sectional imaging and recording of defects
for longitudinal and shear wave inspection — t-ABIScan or
ABIScan

6.4.1. Setup Pulser Receiver for t-ABIScan or ABIScan Imaging and
Recording

UDS 3-5 Pulser Receiver window — main operating surface — appears on ISONIC 2005 / 2020 / STAR

[2]t-ABIscan [2]|ABIScan

screen upon clicking on l or’ . The settings as below to be provided

6.4.1.1. Straight Beam Probes

# | Parameter or Submenu Required Settings Note
Mode
1 Gain BASICS Gain setting to be performed according
to inspection procedure providing
required echo heights from defects to be
detected
2 DAC/TCG DAC/TCG DAC/TCG settings to meet requirements
of inspection procedure
3 Pulser Mode PULSER Dual for dual element probes
Single for single element probes
4 Tuning, Pulse Width, | PULSER Tuning, Pulse Width, Firing Level, To synchronize with Gain
Firing Level, and Damping settings to provide setting procedure
Damping optimal signal to noise ratio
5 Filter, Frequency RECEIVER Filter and Frequency settings to match | To synchronize with Gain
with probe's frequency setting procedure
6 Display RECEIVER Display setting may be either Full, RF, The same Display mode to
PosHalf, or NegHalf be used for both Probe
Delay determining and t-
ABIScan / ABIScan
Recording
7 USVelocity BASIC USVelocity setting to be equal to actual
value of ultrasound velocity in the object
under test
8 Probe Delay MEASURE Probe Delay setting to be equal to Probe delay may be
actual probe delay determined according to
paragraph 5.2.13.7 or
5.2.13.9 of this Operating
Manual or similarly
9 Angle MEASURE Angle = 0°
10 | Settings for other
parameters and
modes have no
significance

I
Click on _| or press LJ on front panel keyboard or on external keyboard upon completing
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6.4.1.2. Angle Beam Probes

# | Parameter or Submenu Required Settings Note
Mode
1 Gain BASICS Gain setting to be performed according
to inspection procedure providing
required echo heights from defects to be
detected
2 DAC/TCG DAC/TCG DAC/TCG settings to meet requirements
of inspection procedure
3 Pulser Mode PULSER Dual for dual element probes
Single for single element probes
4 Tuning, Pulse Width, | PULSER Tuning, Pulse Width, Firing Level, To synchronize with Gain
Firing Level, and Damping settings to provide setting procedure
Damping optimal signal to noise ratio
5 Filter, Frequency RECEIVER Filter and Frequency settings to match | To synchronize with Gain
with probe's frequency setting procedure
6 Display RECEIVER Display setting may be either Full, RF, The same Display mode to
PosHalf, or NegHalf be used for both Probe
Delay determining and t-
ABIScan / ABIScan
Recording
7 USVelocity BASIC USVelocity setting to be equal to actual
value of ultrasound velocity in the object
under test
8 Probe Delay MEASURE Probe Delay setting to be equal to Probe delay may be
actual probe delay determined according to
paragraph 5.2.13.5 or
5.2.13.6 or 5.2.13.9 of this
Operating Manual or
similarly
9 Angle MEASURE Angle setting to be equal to actual
probe angle
10 | Settings for other
parameters and
modes have no
significance

I
Click on _| or press LJ on front panel keyboard or on external keyboard upon completing
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6.4.2. B-Scan Cross Sectional Imaging — Implementation
6.4.2.1. t-ABIScan - Prior to Scanning (Straight Beam Probes)

t-ABIScan control panel for straight beam probe is shown below

1 Thickness o Coloring
+ + o+ o+ 43 mm ‘ 1 » I Pseudo
- + o+ o+ _
SRS CHC
+ + o+ o+ 0b 2 Grayscale | %
* vt 5 Length
.+ o+ o+ 200 g ‘ ';. » Thermal | UD53-5
+ \-\i-"- + + o+ mm = piEtam el
+ o+ o+ 1 Time ‘ o » 3 = =
o Ts 4 Start | Open| Save | Cloze
tABIScan || | 26-Jan-2006

u] -0 -100 -150 % -200

Empty t-ABIScan record field

Scan Length not exceeding 600 mm or 24 in / Scan Time

<4
20 Length o
1000 mm ‘ 3 »
0 -100 -Z00 -300 -400 -500 -600
Empty t-ABIScan record field
t-ABIScan scrolling controls -
{ [

Segment of Scrolled Total Scan Length exceeding 600 mm or 24 in / Scan Time
< >

®

Display Delay for current A-Scan to be used for the recording is equal to Probe Delay setting in
submenu MEASURE of UDS 3-5 Pulser Receiver predcessing entering into t-ABIScan mode
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Thickness

Thickness setting defines the region of interest starting from the scanning surface and automatic Range
setting for current A-Scan to be used for the recording: Range = Thickness. For objects whereas back echo
is feasible it may be useful to key in Thickness value slightly exceeding actual thickness of the object under
test — this will allow to record simultaneously defects signals and back echo itself. For the screenshot as
above the actual thickness of the test piece is 40 mm while the Thickness setting is 43 mm thanks to such
setting back echo is clearly resolved at the end of A-Scan

1 Thickness
43 mm

5 Length
200 mm

1 Fime

To control Thickness the following y;
manipulations are applicable: ///
e Mouse / Touch Screen ///

B Click on corresponding
e Keyboard

+
B Press ! J on front panel keyboard or ﬂ on external keyboard = Thickness fore color changes

to white - then use !J 2) :J !J on front panel keyboard or , , , on external

keyboard

e Combined

B Click on Thickness = Thickness fore color changes to white - then use !J '_’J !J !J on
front panel keyboard or , , , on external keyboard

®

The value of Thickness is adjustable between 5 and 300 mm or 0.2 and 12 in (expandable on special
inquire)

Skip #

This setting is ignored while using straight beam probes

ISONIC 2005/ 2020 / STAR from Sonotron NDT - Operating Manual — Revision 2.38 - Page 147 of 380



Scan Length and Scan Time

Length represents length of section of test object to be displayed, over which probe will be scanning during
recording period. Time (Scan Time) is the duration of recording period

1 Thickness

43 inm

=y

I By

3b ‘
oo K

-\

3
r
4
To control Length the following , . 7
manipulations are applicable: P
,.7
7
e Mouse / Touch Screen 4

B Click on corresponding
e Keyboard

Fd
B Press 3 J on front panel keyboard or @ on external keyboard = Length fore color changes to

white - then use !J '_’J _J 4 on front panel keyboard or , =, k=, U on external

keyboard

¢ Combined

B Click on Length = Length fore color changes to white - then use !J '_’J !J ij on front
panel keyboard or , , , on external keyboard

®

The value of Length is adjustable between 50 and 1000 mm or 2 and 40 in
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1 Thickrdess
43 mim

5 Length
209 mm

To control Time
the following manipulations are applicable: 7 -

¢ Mouse / Touch Screen 27
B Click on corresponding
e Keyboard

-
m Press _4 J on front panel keyboard or on external keyboard = Time fore color changes to

white - then use !J '_’J _J ¥ on front panel keyboard or , =, k=, U on external

keyboard

e Combined

B Click on Time = Time fore color changes to white - then use !J '_’J :J ij on front panel
keyboard or , , on external keyboard

®

The value of Time is adjustable between 5 and 60 sec

Time-out

Time-Out is waiting time for intermissions predcessing ABIScan recording, which starts unconditionally
upon Time-Out period is over. Time-Out has fixed duration of 3 sec for t-ABIScan

Insert Text Note

Refer to paragraph 6.3.2.1 of this Operating Manual

Preview UDS 3-5 Settings

Refer to paragraph 6.3.2.1 of this Operating Manual
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t-ABIScan Record Palette

There are four palettes available through click on appropriate button:

— Coloring

Pseudo

Pzeudo? I

Grayscale I

Thermal I

Start/Stop t-ABIScan recording

4
Click on ﬂl or press LJ on front panel keyboard or or <Alt>+<S> on external keyboard to

start t-ABIScan recording

4 |
ﬂ' button becomes invisible since t-ABIScan recording starts. ﬂ' button occupies its position.

-3 e
Click on _3%p | or press _J on front panel keyboard or or <Alt>+<S> on external keyboard to

terminate t-ABIScan recording prior to automatic completion

= | 2.
stop | putton becomes invisible after completion / termination of t-ABIScan record. _ 3%’ | putton

returns to its position

Save record into a file

Refer to paragraph 6.3.2.1 of this Operating Manual

Open record from a file and starting postprocessing session

Refer to paragraph 6.3.2.1 of this Operating Manual

Return to UDS 3-5 main operating surface

Refer to paragraph 6.3.2.1 of this Operating Manual
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6.4.2.2. t-ABIScan — Scanning (Straight Beam Probes)

a Apply probe to test object in the start point of selected scanning line

4
a Clickon ﬂl or press LJ on front panel keyboard or or <Alt>+<S> on external keyboard

O Guide probe over the scanning line synchronously with Probe Icon moving with constant speed above t-
ABIScan record field — typical scanning progress display during is shown and explained below

Current A-Scan 1 Thickness - [ Culusiag

' * 43 mm ‘ 1 » | Pseudo

+ o+ + _

SUSEREEI I o
e " 05 £ Grayscale |

o * 5 Length ) | 7

s i 200 mm ‘ 3 » Thermal UDS3-5
+ o+ + 1 Time o ] i H
__ - J: +1~’n*'q o is ‘ 1 » Open| Save Cloze

|

tABIScan | Scanning... L=42.37 mm | 26-Jan-2006
n] l__._| -E:III -1I|:II:I -'1|5EI % =200

e ——

——

Current Probe
Position

t-ABIScan record
I
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6.4.2.3. ABIScan — Prior to Scanning (Straight Beam Probes)
ABIScan control panel for straight beam probe is shown below

1 Thickness ] ~Coloring——————
43 mm ‘ 1 I Pzeudo
05 - Grayscale |
5 Length o | >
200 mm ‘ 3 Thermal UDS35
Encoder: } = =
I Default j Start | Open| Save Close
| 26-Jan-2006
i — i 120 200

Empty ABIScan record field

Scan Length not exceeding 600 mm or 12 in

>
-’"'.:';
100 Length o
2600 mm ‘ 3 »
0 -200 -400 -E00 -500 -1000
Empty ABIScan record field
p] ABIScan scrolling controls field ¥

< Segment of Scrolled Total Scan Length exceeding 600 mm or 12 in q

®

Display Delay for current A-Scan to be used for the recording is equal to Probe Delay setting in
submenu MEASURE of UDS 3-5 Pulser Receiver predcessing entering into ABIScan mode
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Thickness

Thickness setting defines the region of interest starting from the scanning surface and automatic Range
setting for current A-Scan to be used for the recording: Range = Thickness. For objects whereas back echo
is feasible it may be useful to key in Thickness value slightly exceeding actual thickness of the object under
test — this will allow to record simultaneously defects signals and back echo itself. For the screenshot as
above the actual thickness of the test piece is 40 mm while the Thickness setting is 43 mm thanks to such
setting back echo is clearly resolved at the end of A-Scan

1 Thickness
43 mm

5 Length ~
e
To control Thickness the following /7 7
manipulations are applicable: //
e Mouse / Touch Screen &

B Click on corresponding
e Keyboard

-
m Press 1 J on front panel keyboard or H on external keyboard = Thickness fore color changes

to white - then use !J '_’J _J !J on front panel keyboard or , , , on external

keyboard

e Combined

B Click on Thickness = Thickness fore color changes to white - then use !J '_’J !J !J on
front panel keyboard or , , , on external keyboard

®

The value of Thickness is adjustable between 5 and 300 mm or 0.2 and 12 in (expandable on special
inquire)

Skip #

This setting is ignored while using straight beam probes
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Scan Length

Length represents length of section of test object to be displayed, over which probe will be scanning during
recording period

1 Thickness o
43 inm 1
-
3b 2
~ -~ 5 Length
200 mm 3
To control Length the following , 4 Phg
manipulations are applicable: 7 -
{z"
e Mouse / Touch Screen P %
&
B Click on corresponding
e Keyboard

-
B Press 3 J on front panel keyboard or @ on external keyboard = Length fore color changes to

white - then use !J '_’J _J !J on front panel keyboard or , , , on external

keyboard

e Combined

B Click on Length = Length fore color changes to white - then use !J '_’J !J !J on front

panel keyboard or , , , on external keyboard

®

The value of Length is adjustable between 50 and 20000 mm or 2 and 800 in

Encoder
Select encoder to be used through appropriate box

Encoder:

I Drefauilt j

Clamp probe into encoder — refer to Chapter 7 of this Operating Manual
Connect encoder to its input on the rear panel of ISONIC 2005 / 2020 / STAR instrument

Insert Text Note

Refer to paragraph 6.3.2.1 of this Operating Manual

Preview UDS 3-5 Settings

Refer to paragraph 6.3.2.1 of this Operating Manual
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ABIScan Record Palette

There are four palettes available through click on appropriate button:

— Coloring

Pseudo

Pzeudo? I

Grayscale I

Thermal I

Start/Stop ABIScan recording

4
Click on ﬂl or press LJ on front panel keyboard or or <Alt>+<S> on external keyboard to

start ABIScan recording

4 |
ﬂ' button becomes invisible since ABIScan recording starts. ﬂ' button occupies its position.

-3 e
Click on _3%p | or press _J on front panel keyboard or or <Alt>+<S> on external keyboard to

terminate ABIScan recording

- KA
stop | putton becomes invisible after termination of ABIScan record. __ 3tait | putton returns to its

position

Save record into a file

Refer to paragraph 6.3.2.1 of this Operating Manual

Open record from a file and starting postprocessing session

Refer to paragraph 6.3.2.1 of this Operating Manual

Return to UDS 3-5 main operating surface

Refer to paragraph 6.3.2.1 of this Operating Manual
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6.4.2.4. ABIScan — Scanning (Straight Beam Probes)

a Apply probe equipped with an encoder to test object in the start point of selected scanning line

4 |
O Click on 3t |or press LJ on front panel keyboard or or <Alt>+<S> on external keyboard

O Guide probe over the scanning line — typical scanning progress display during is shown and explained
below

' : —Coloring——————————
Current A-Scan 1 Thickness o
— 42 mm 1 I Pzeudo
+ o+ W+ + o+ o+ - — |
: : : + : : : ‘ ! PSEUdDZ TE!t
—. 7 ot 0.5 2 Grayscale |
+ 4+ ﬁ-x__.__;;\ + o+ o+ 5 Length - — : | 7
+ o+ o+ ¥ O+ erma
P P 200 mm ‘ 3 UDS3-5
+ o+ + 4 o+t Encoder: [ ] a [
___ .+ J: +1~’n*'q+ _, IDefauIt j Stop | Open| Save| Cloze
|
ABIScan | Scanning... L=43.50 mm | 26-Jan-2006
] [ 140 -100 -150 -200
— Current Probe
Position
L\ |
ABIScan record %
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6.4.2.5. t-ABIScan - Prior to Scanning (Angle Beam Probes)
t-ABIScan control panel for angle beam probe is shown below

5 Thickness - Coloring
Tl own RJEIL IR
5 O —
" 0.5 Grayscale |
* 5 Length r | -
N 80 mm ‘ 3 » Thermal UDS3-5
Current A-Scan 1 Time ‘ - » > 2 =
e . _ _ 10s 4 Start | Open| Save Cloze
t-ABIScan 2b-Jan-2006
50 g 40
g
Full Scan Length / Scan Time

For Total Length of t-ABIScan Record
Not Exceeding 600 mm or 24 in

Empty ABIScan record field

Total Length of t-ABIScan Record
Not Exceeding 600 mm or 24 in

»

5 Length o
640 mm ‘ 3
=100 -2||:Il:l -SIIIIEI -400 -5||:I|:I -Ell:ll:l

Empty ABIScan record

ABIScan scrolling controls field

Segment of Scrolled Total Scan Length / Scan Time and t-ABIScan Record For Total
Length of ABIScan Record Exceeding 600 mm or 24 in

®

0 Display Delay for current A-Scan to be used for the recording is equal to Probe Delay setting in submenu
MEASURE of UDS 3-5 Pulser Receiver predcessing entering into t-ABIScan mode

O Total Length of t-ABIScan Record is determined automatically according to:
Total Length of t-ABIScan Record = Total Scan Length + 2 * Skip # * Thickness * Tan (Angle)
whereas
¢ Thickness, Skip #, and Total Scan Length = Length are the settings of t-ABIScan control panel

¢ Angle is setting in submenu MEASURE of UDS 3-5 Pulser Receiver predcessing entering into t-
ABIScan mode
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Thickness and Skip #

Thickness and Skip # settings define the region of interest starting from the scanning surface and automatic
Range setting for current A-Scan to be used for the recording:

Range = 2 x Skip # x Thickness x Cos (Angle)
whereas

+ Thickness and Skip # are the settings of t-ABIScan control panel

¢ Angle is setting in submenu MEASURE of UDS 3-5 Pulser Receiver predcessing entering into
t-ABIScan mode

For objects with parallel surfaces the actual Thickness value to be entered for full skip inspection (Skip # =

1)

3
1

5 Thickness
40 mm

5 Length
80 mm

To control Thickness the following /7
manipulations are applicable: ///
e Mouse / Touch Screen ///

B Click on corresponding
e Keyboard

-
m Press 1 J on front panel keyboard or H on external keyboard = Thickness fore color changes

to white - then use y '_’J !J ¥ on front panel keyboard or [f, 53}, [, U on external

keyboard

e Combined

B Click on Thickness = Thickness fore color changes to white - then use !J 2) :J !J on
front panel keyboard or , , , on external keyboard

®

The value of Thickness is adjustable between 5 and 300 mm or 0.2 and 12 in (expandable on special
inquire)
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5 Thickness

pr

40 mm
Current value of = Skiplt
............................. S Tength

oy 1o B[ |1y

To control Skip # the following
manipulations are applicable: 7

e Mouse / Touch Screen px
B Click on corresponding Jjbutton

e Keyboard

-
m Press _2 J on front panel keyboard or @ on external keyboard = Skip # fore color changes to

white - then use !_ ?/ . ! on front panel keyboard or , , , on external
keyboard

e Combined

LIRCIRAI NG 4

B Click on Skip # = Skip # fore color changes to white - then use =, ' = = / on front

panel keyboard or , , , on external keyboard

®

The Skip # setting may be 0.5 — half skip insonification or 1 — full skip insonification
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Scan Length and Scan Time

Length represents length of section of test object to be displayed, over which probe will be scanning during
recording period. Time (Scan Time) is the duration of recording period

5 Thickness
40 mm

=y

I By

3b ‘
J oo &

-\

3
r
4
To control Length the following , . 7
manipulations are applicable: P
,.7
7
e Mouse / Touch Screen 4

B Click on corresponding
e Keyboard

Fd
B Press 3 J on front panel keyboard or @ on external keyboard = Length fore color changes to

white - then use !J '_’J _J ¥ on front panel keyboard or , =, k=, U on external

keyboard

¢ Combined

B Click on Length = Length fore color changes to white - then use !J '_’J :J ij on front
panel keyboard or , , , on external keyboard

®

The value of Length is adjustable between 50 and 1000 mm or 2 and 40 in
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1 Thickrdess
43 mim

5 Length
209 mm

To control Time
the following manipulations are applicable: 7 -

¢ Mouse / Touch Screen 27
B Click on corresponding
e Keyboard

-
m Press _4 J on front panel keyboard or on external keyboard = Time fore color changes to

white - then use !J '_’J _J ¥ on front panel keyboard or , =, k=, U on external

keyboard

e Combined

B Click on Time = Time fore color changes to white - then use !J '_’J :J ij on front panel
keyboard or , , on external keyboard

®

The value of Time is adjustable between 5 and 60 sec

Time-out

Time-Out is waiting time for intermissions predcessing ABIScan recording, which starts unconditionally
upon Time-Out period is over. Time-Out has fixed duration of 3 sec for t-ABIScan

Insert Text Note

Refer to paragraph 6.3.2.1 of this Operating Manual

Preview UDS 3-5 Settings

Refer to paragraph 6.3.2.1 of this Operating Manual
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t-ABIScan Record Palette

There are four palettes available through click on appropriate button:

— Coloring

Pseudo

Pzeudo? I

Grayscale I

Thermal I

Start/Stop t-ABIScan recording

4
Click on ﬂl or press LJ on front panel keyboard or or <Alt>+<S> on external keyboard to

start t-ABIScan recording

4 |
ﬂ' button becomes invisible since t-ABIScan recording starts. ﬂ' button occupies its position.

-3 e
Click on _3%p | or press _J on front panel keyboard or or <Alt>+<S> on external keyboard to

terminate t-ABIScan recording prior to automatic completion

= | 2.
stop | putton becomes invisible after completion / termination of t-ABIScan record. _ 3%’ | putton

returns to its position

Save record into a file

Refer to paragraph 6.3.2.1 of this Operating Manual

Open record from a file and starting postprocessing session

Refer to paragraph 6.3.2.1 of this Operating Manual

Return to UDS 3-5 main operating surface

Refer to paragraph 6.3.2.1 of this Operating Manual
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6.4.2.6. t-ABIScan - Scanning (Angle Beam Probes)

a Apply probe to test object in the start point of selected scanning line

4
a Clickon ﬂl or press LJ on front panel keyboard or or <Alt>+<S> on external keyboard

O Guide probe over the scanning line synchronously with Probe Icon moving with constant speed above t-
ABIScan record field — typical scanning progress display during is shown and explained below

Current A-Scan :
5 Thickness o  Lolonng
+ o+ ror 40 mm ‘ 1 » |  Pseudo ﬂ
+ + o+ o+ _ — |
T LT 05 £ Grayscale |
+ o+ + o+ 5 Length ‘ r » — | | -~
+ 4+ + o+ o+ Ermad
. P 80 mm 3 UDS3-5
+ o+ + o+ o+ 1 Time o i E
Y o, " .;rlh,:_m,,,-}',n“r 10s ‘ 4 » : : Open| Save Cloze
N |
| 26-Jan-2006

Current Probe
Position

t-ABIScan record
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6.4.2.7. ABIScan — Prior to Scanning (Angle Beam Probes)
ABIScan control panel for angle beam probe is shown below

1 Thickness i Coloring
40 mm ‘ 1 » | Pseudo

+ o+ +
+ +
¥ * Grayzcale |
ot * 5 Length o Th : | i
o X 160 mm ‘ 3 » == UDS3-5
+ o+ Current A-Scan Encoder: 3 = =
. _ | J Start | Open| Save Cloze
ABlScan Z2b-Jan-2006
Full Scan Length
For Total Length of ABIScan Record
L< Not Exceeding 600 mm or 24 in »‘
100 & -0 -00 150

Empty ABIScan record field

Total Length of ABIScan Record
Not Exceeding 600 mm or 24 in [%

5 Length -
640 mm ‘ 3
=100 =200 =200 -0 -EIIIIEI -BIIZII:I

»

Empty ABIScan record

ABIScan scrolling controls field

>

Segment of Scrolled Total Scan Length and ABIScan Record For Total Length of ABIScan
Record Exceeding 600 mm or 24 in

®

0 Display Delay for current A-Scan to be used for the recording is equal to Probe Delay setting in submenu
MEASURE of UDS 3-5 Pulser Receiver predcessing entering into ABIScan mode

O Total Length of ABIScan Record is determined automatically according to:
Total Length of ABIScan Record = Total Scan Length + 2 * Skip # * Thickness * Tan (Angle)
where
¢ Thickness, Skip #, and Total Scan Length = Length are the settings of ABIScan control panel
¢ Angle is setting in submenu MEASURE of UDS 3-5 Pulser Receiver predcessing entering into
ABIScan mode
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Thickness and Skip #

Thickness and Skip # settings define the region of interest starting from the scanning surface and automatic
Range setting for current A-Scan to be used for the recording:

Range = 2 x Skip # x Thickness x Cos (Angle)
whereas

+ Thickness and Skip # are the settings of ABIScan control panel

¢ Angle is setting in submenu MEASURE of UDS 3-5 Pulser Receiver predcessing entering into
ABIScan mode

For objects with parallel surfaces the actual Thickness value to be entered for full skip inspection (Skip # =

1)

1 Thickness

40 mm

5 Length
160 mm

To control Thickness the following /7 7
manipulations are applicable:

e Mouse / Touch Screen 4

B Click on corresponding
e Keyboard

-
m Press 1 J on front panel keyboard or H on external keyboard = Thickness fore color changes

to white - then use !J '_’J _J !J on front panel keyboard or , , , on external

keyboard

e Combined

B Click on Thickness = Thickness fore color changes to white - then use !J '_’J !J !J on
front panel keyboard or , , , on external keyboard

®

The value of Thickness is adjustable between 5 and 300 mm or 0.2 and 12 in (expandable on special
inquire)
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Current value of .
Skip # o~

1 Thickness

5 Length
R «

To control Skip # the following
manipulations are applicable:

e Mouse / Touch Screen

B Click on corresponding

e Keyboard
m Press ‘2: ~ on front panel keyboard or @ on external keyboard — Skip # fore color changes to
white - then use !» !/ « ! on front panel keyboard or [T} , , on external
keyboard
e Combined
B Click on Skip # = Skip # fore color changes to white - then use .!» !/ « ! on front

panel keyboard or , , , on external keyboard

®

The Skip # setting may be 0.5 — half skip insonification or 1 — full skip insonification
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Scan Length

Length represents length of section of test object to be displayed, over which probe will be scanning during
recording period

1 Thickness o
40 im 1
-
1 2
~ -~ 5 Length
160 mm 3
To control Length the following , 4 Phg
manipulations are applicable: 7 -
<’./
e Mouse / Touch Screen P %
&
B Click on corresponding
e Keyboard

-
B Press 3 J on front panel keyboard or @ on external keyboard = Length fore color changes to

white - then use !J '_’J _J !J on front panel keyboard or , , , on external

keyboard

e Combined

B Click on Length = Length fore color changes to white - then use !J '_’J !J !J on front
panel keyboard or , , , on external keyboard

®

The value of Length is adjustable between 50 and 1000 mm or 2 and 40 in

Encoder
Select encoder to be used through appropriate box

Encoder:

Drefault j

Clamp probe into encoder — refer to Chapter 7 of this Operating Manual
Connect encoder to its input on the rear panel of ISONIC 2005 / 2020 / STAR instrument

Insert Text Note

Refer to paragraph 6.3.2.1 of this Operating Manual

Preview UDS 3-5 Settings

Refer to paragraph 6.3.2.1 of this Operating Manual
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ABIScan Record Palette

There are four palettes available through click on appropriate button:

— Coloring

Pseudo

Pzeudo? I

Grayscale I

Thermal I

Start/Stop t-ABIScan recording

4
Click on ﬂl or press LJ on front panel keyboard or or <Alt>+<S> on external keyboard to

start ABIScan recording

4 |
ﬂ' button becomes invisible since ABIScan recording starts. ﬂ' button occupies its position.

-3 S
Click on _3%p | or press _J on front panel keyboard or or <Alt>+<S> on external keyboard to

terminate ABIScan recording prior to automatic completion

- KA
stop | putton becomes invisible after termination of ABIScan record. __ 3tait | putton returns to its

position

Save record into a file

Refer to paragraph 6.3.2.1 of this Operating Manual

Open record from a file and starting postprocessing session

Refer to paragraph 6.3.2.1 of this Operating Manual

Return to UDS 3-5 main operating surface

Refer to paragraph 6.3.2.1 of this Operating Manual
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6.4.2.8. ABIScan — Scanning (Angle Beam Probes)

a Apply probe equipped with an encoder to test object in the start point of selected scanning line

4 |
O Click on 3t |or press LJ on front panel keyboard or or <Alt>+<S> on external keyboard

O Guide probe over the scanning line — typical scanning progress display during is shown and explained
below

Current A-Scan :
1 Thickness o [ S
* 40 mm ‘ 1 » | Pseudo
.
LT HESSS
" 2 Grayscale |
* 5 Length - | 7
X 160 mm ‘ 3 » Thermal UDS3-5
+ Encoder: a [
Y lﬁ IDefauIt j Open| Save Cloze
|
ABIScan | Scanning... L=25.00 mm | 26-Jan-2006

Current Probe
Position

=50 -100 - 150

ABIScan record
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6.4.2.9. t-ABIScan / ABIScan - Postprocessing
Versatile postprocessing of t-ABIScan / ABIScan records is featured with:

Q Sizing defects at any location along stored images (coordinates, projection size, amplitude-based
evaluation)

Q Play-back and evaluation of A-Scans obtained and captured during t-ABIScan / ABIScan defects
imaging and recording

a Defects outlining and pattern recognition based on A-Scan sequence analysis — Echo Dynamic
Pattern Analysis

O Reconstruction of B-Scan defects images for various Gain, Reject, and off-line Gate level settings

o DAC/DGS t-ABIScan / ABIScan normalization

The screen as below appears upon opening file. All postprocessing procedures are performed through
— touch screen stylus or front panel or external mouse to be used

—_—
*File v|| Wiew v|| Edit v|| Measurements v|| A-Scan Recovery v|

— Length Measurements

t-ABIScan |
POSTPROCESSING | | | |

—Depth Measurements

|' Filtering: I
|
| |
IVA-Scan Recovery
|

Menu Bar Functions

e File>Open - opens new t-ABIScan / ABIScan file
e File>Snapshots>Add Snapshot — stores current postprocessing screen snapshot accompanied with
appropriate settings and measurements into postprocessing session memory stack

o File>Snapshots>Restore Snapshot — recalls earlier stored postprocessing screen snapshot
accompanied with appropriate settings and measurements from postprocessing session memory stack

¢ File>Snapshots>Delete Snapshot — deletes earlier stored postprocessing screen snapshot
accompanied with appropriate settings and measurements from postprocessing session memory stack

¢ File=>Print — prints out postprocessing screen snapshot(s) accompanied with appropriate settings and
measurements
e File>Exit — returns to t-ABIScan / ABIScan control panel

e View~>Instrument — indicates setup of UDS 3-5 Pulser Receiver used for scanning when file was
created

¢ View~>Inspection Data — indicates operator's comments entered prior to scanning
o View—>Coloring — selects palette for t-ABIScan / ABIScan image
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e A-Scan Recovery 2ON (straight beam inspection record) — generates cursor representing sound path
of straight beam probe's central beam in the object under test that may be guided over t-ABIScan /

ABIScan image using either touch screen stylus or mouse or ?/ « on front panel keyboard or ,
on external keyboard — corresponding A-Scan is recovered synchronously according to sound path
cursor position. Starting position of cursor (L) corresponding to probe's center is indicated in the A-Scan
Recovery field. On the recovered A-Scan there is red Off-line Gate presented. Initially Off-line Gate
covers whole A-Scan range

| File v|| Wiew v|| E dit v|| I easurements v|| A-Scan Recovery v|

— Length Measurements

t-ABIScan |
POSTPROCESSING | ||

— Depth Measurements
" Filtering: I
|
| |

A-5can Recovery
ﬁ L =-26.2 mm b D0

I
B e

I I I I

-_—

|Automatic Measurements Display| accompanies recovered A-Scan and indicates (refer to
paragraphs 5.1.12, 5.2.13.1 and 5.2.13.2 of this Operating Manual):

o depth t of reflector (measurement mode - Flank)
o amplitude H of the maximal signal in the Off-line Gate expressed in % of full A-Scan height

o AVC (dB to DAC) of the maximal signal in the Off-line Gate provided that DAC was active
whilst recording t-ABIScan / ABIScan data

To fix position of sound path cursor with corresponding recovered A-Scan and Automatic
Ente'r

Measurements Display data left mouse click or release touch screen stylus or press ' *=_ on front
panel keyboard or on external keyboard

ESC
To interrupt recovery of A-Scans and empty A-Scan Recovery field right mouse click or press L)
on front panel keyboard or @ on external keyboard

¢ A-Scan Recovery>OFF (straight beam inspection record) — erases sound path cursor with recovered
A-Scan and Automatic Measurements Display and empties A-Scan Recovery field
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¢ A-Scan Recovery >ON (angle beam inspection record) — generates cursor representing sound path of
angle beam probe's central beam in the object under test that may be guided over t-ABIScan / ABIScan

image using either touch screen stylus or mouse or 2/, « on front panel keyboard or , on
external keyboard — corresponding A-Scan is recovered synchronously according to sound path cursor
position. Starting position of cursor (L) corresponding to probe's incidence point is indicated in the A-
Scan Recovery field. On the recovered A-Scan there is red Off-line Gate presented. Initially Off-line
Gate covers whole A-Scan range

| File v|| Wiew v|| E dit v|| I easurements v|| A-Scan Recovery v|

— Length Measurements

ABIScan l
POSTPROCESSING | ||

— Depth Measurements
" Filtering: I
|
| |

"A—S can Recovery

o I
e N

S I
B R S S S ST S

t=0.2mm a=03mm
H=200% AVC=92dB

L =-24.4 mm
=~

|Automatic Measurements Display| accompanies recovered A-Scan and indicates (refer to
paragraphs 5.1.12, 5.2.13.1 and 5.2.13.2 of this Operating Manual):

o depth t of reflector (measurement mode - Flank)

o0 distance a between probe incidence point and reflector taken along scanning surface
(measurement mode - Flank)

o amplitude H of the maximal signal in the Off-line Gate expressed in % of full A-Scan height
o AVC (dB to DAC) of the maximal signal in the Off-line Gate provided that DAC was active
whilst recording t-ABIScan / ABIScan data

To fix position of sound path cursor with corresponding recovered A-Scan and Automatic

"
Enter

Measurements Display data left mouse click or release touch screen stylus or press ' *=_/ on front
panel keyboard or m on external keyboard

ESC
To interrupt recovery of A-Scans and empty A-Scan Recovery field right mouse click or press L‘\
on front panel keyboard or @ on external keyboard

A-Scan Recovery>OFF (angle beam inspection record) — erases sound path cursor with recovered A-
Scan and Automatic Measurements Display and empties A-Scan Recovery field
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o Edit>Change Gain>0ON - (straight beam and angle beam inspection records) generates cursor
representing sound path of probe's central beam in the object under test that may be guided over t-

ABIScan / ABIScan image using either touch screen stylus or mouse or !/ f on front panel
keyboard or , on external keyboard — corresponding A-Scan is recovered synchronously
according to sound path cursor position. To select reference A-Scan release touch screen stylus or left

Ente’r
mouse click or press +4 _ on front panel keyboard or on external keyboard — this generates
subwindow allowing off-line re-adjusting of Gain for all A-Scans captured during t-ABIScan / ABIScan

ﬂ
recording in £6dB range with £0.1 dB increments through clicking or pressing and holding on ‘ or

pressing —/, . / on front panel keyboard or , on external keyboard

ISONIC 2005 |

Select Gain Change:

+4.4 dB il

0K Cancel

by
During Gain re-adjusting reference A-Scan is modified accordingly. Upon completing re-adjusting Gain click

DK EﬂTE.! _'
on or press +4 _ on front panel keyboard or on external keyboard - this applies new

Gain value to all captured A-Scans and redraws t-ABIScan / ABIScan image accordingly

Cancel | g
To interrupt re-adjusting of Gain click on or press L) on front panel keyboard or @ on

external keyboard

Edit>Change Gain>OFF — negates Gain re-adjustment and returns to originally recorded t-ABIScan /
ABIScan image and original Gain setting
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o Edit>ROI2>ON (straight beam inspection record) — generates cursor representing sound path of
straight beam probe's central beam in the object under test that may be guided over t-ABIScan /

ABIScan image using either touch screen stylus or mouse or 2/, « on front panel keyboard or ,
on external keyboard — corresponding A-Scan is recovered synchronously according to sound path
cursor position. To select reference A-Scan release touch screen stylus or left mouse click or press

Ente'!
*+= J on front panel keyboard or on external keyboard - this generates Off-line Gate controls

n, n n n H n allowing to redefine Region Of Interest for t-ABIScan / ABIScan

imaging

| File: v|| Wiew v|| Edit v|| Measurements v|| A-Scan Recovery -

— Length Measurements

ABIScan |
POSTPROCESSING | |

— Depth Measurements

Filtering: I
| |
IVA-Scan Recovery

|

ESC
To interrupt selection of reference of A-Scan right mouse click or press L) on front panel keyboard
or @ on external keyboard

. . . . b4
To interrupt re-adjustment of Region Of Interest after selection of reference of A-Scan click on .
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Upon completing redefining of Region Of Interest click on — this applies new Off-line Gate to all
captured A-Scans and updates t-ABIScan / ABIScan image accordingly — only segment of t-ABIScan /
ABIScan image covered by newly adjusted Off-line Gate remains visible

| File v|| Wiew v|| E dit v|| M easurements v|| A-Scan Recovery v|

— Length Measurements

ABIScan l
POSTPROCESSING | | /

— Depth Measurements

Filtering: I
’—A—S can Recovery
|

It is possible then to perform A-Scan signals evaluation using newly adjusted Off-Line Gate through A-
Scan Recovery >ON

| File: v|| Wiew v|| E dit v|| M easurements v|| A-Scan Recovery v|
a 50 100
[ —_— T — . —— e - |
- e e — e e n
- pr—— e —
—Length Measurements
ABIScan | .
POSTPROCESSING | N
— Depth Measurements +
Filtering: I *
| :
| | N
4
A-S5can Recovery N - +N
ﬁ L = E0.8 mm t=16.2mm H=76% i

o Edit>ROI>OFF (straight beam inspection record) — negates Off-line Gate re-adjustment and returns
to originally recorded t-ABIScan / ABIScan image and initial Off-line Gate setting
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e Edit>ROI>ON (angle beam inspection record) — generates cursor representing sound path of angle
beam probe's central beam in the object under test that may be guided over t-ABIScan / ABIScan

image using either touch screen stylus or mouse or 2/, « on front panel keyboard or , on
external keyboard — corresponding A-Scan is recovered synchronously according to sound path cursor

"
Enter

position. To select reference A-Scan release touch screen stylus or left mouse click or press ' *=_/ on

front panel keyboard or on external keyboard - this generates Off-line Gate controls n

n, n u u n allowing to redefine Region Of Interest for t-ABIScan / ABIScan

imaging

| File: v|| Wiew v|| Edit v|| Measurements v|| A-Scan Recovery -

— Length Measurements

t-ABIScan |
POSTPROCESSING | ||

— Depth Measurements

Filtering: I
| |
IVA-Scan Recovery

|

ESC
To interrupt selection of reference of A-Scan right mouse click or press L) on front panel keyboard
or @ on external keyboard

. . . . >
To interrupt re-adjustment of Region Of Interest after selection of reference of A-Scan click on .

ISONIC 2005/ 2020 / STAR from Sonotron NDT - Operating Manual — Revision 2.38 - Page 176 of 380



Upon completing redefining of Region Of Interest click on — this applies new Off-line Gate to all
A-Scans captured during t-ABIScan / ABIScan recording and updates t-ABIScan / ABIScan image
accordingly — only segment of t-ABIScan / ABIScan image covered by newly adjusted Off-line Gate
remains visible: in the present example there was under surface crack detected using full skip
insonification and Off-line Gate was readjusted by such a way that only full skip segment of t-ABIScan /
ABIScan image remained visible — this allowed to eliminate disturbing presence of initial pulse
reverberations on the t-ABIScan / ABIScan image

| File v|| Wiew v|| E dit v|| M easurements v|| A-Scan Recovery v|
g o
=
R T . il =
— Length Measurements
t-ABIScan |
POSTPROCESSING | |
— Depth Measurements
Filtering: I
| |
’—A—Scan Recovery [%
|

It is possible then to perform A-Scan signals evaluation using newly adjusted Off-Line Gate through A-
Scan Recovery >ON

| File: v|| Wiew v|| E dit v|| M easurements v|| A-Scan Recovery v|

—Length Measurements

t-ABIScan |
POSTPROCESSING | ||

— Depth Measurements

" Filtering: —‘ I
A-Scan Recovery t=3.8mm a = 36.2mm
ﬁ L =-55.2 mm

H=126% AVC=6.0dB
e Edit>ROI>OFF (angle beam inspection record) — negates Off-line Gate re-adjustment and returns to
originally recorded t-ABIScan / ABIScan image and initial Off-line Gate setting

N
I S et S I
!
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Edit->Filtering>ON — (straight beam and angle beam inspection records) generates amplitude palette
bar with sliding cursor, which may be controlled using either touch screen stylus or mouse or ' -/, f
on front panel keyboard or , on external keyboard . Position of the sliding cursor on the amplitude
palette bar determines filtering level, which is indicated in the Filtering field. All elements of t-ABIScan /
ABIScan image representing signal amplitude below filtering level are suppressed:

| File v|| Wiew v|| Edit v|| Measurements v|| A-Scan Recovery v|

— Length Measurements E

t-ABIScan |
POSTPROCESSING | | | |

—Depth Measurements

Filtering: I
ﬁ 6.6dB
| |
IVA-Scan Recovery
|

Edit>Filtering>OFF (straight beam and angle beam inspection records) — returns to originally
recorded t-ABIScan / ABIScan image and empties Filtering field
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o Edit>Normalize to DAC->ON (straight beam and angle beam inspection records) — applies DAC/DGS
normalized color palette to t-ABIScan / ABIScan image, which was recorded with active DAC/DGS and
redraws t-ABIScan / ABIScan image correspondingly (dB to DAC/DGS normalization)

| File v|| Wiew v|| Edit v|| Measurements v|| A-Scan Recovery v|
Change Gain 4
ROI 4
Filtering 4

Momalize to DAC M
= [F|

— Length Measurements

t-ABIScan |
POSTPROCESSING | | | |

—Depth Measurements

|' Filtering: I
|

I I
A-Scan Recovery t=45mm a=355mm
{I L =-57.2 mimn H=166% AVC=8.6dB

ht
T+ o+ N+t + 4
5 \

— Length Measzurements

t-ABIScan |
POSTPROCESSING | | | |

— Depth Meazurements

|' Filtering: I
|

| |
A-Scan Recovery t=4.5mm a=355mm
|_| L = 57.2 mm H=166% AVC=8.6dB

e Edit>Normalize to DAC->OFF (straight beam and angle beam inspection records) — negates dB to
DAC/DGS normalization and returns to originally recorded t-ABIScan / ABIScan image

®

Applying of Edit->Normalize to DAC—>ON or Edit->Normalize to DAC-> OFF negates Filtering
(Edit>Filtering—> OFF)

kN
T+ + W+ o+ o+ o+
1 \
\
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Measurements—>Length->ON — generates first vertical cursor that may be guided over t-ABIScan /

ABIScan image using either touch screen stylus or mouse or ?/ « on front panel keyboard or ,

on external keyboard . Coordinate of the first vertical cursor along t-ABIScan / ABIScan image (Lr)

is indicated in the Length Measurements field. To fix position of the first vertical cursor left mouse click
Ente‘r

or release touch screen stylus or press + J on front panel keyboard or on external keyboard .

To interrupt vertical cursor manipulations and empty Length Measurements field right mouse click or

ESC
press L) on front panel keyboard or @ on external keyboard
Second vertical cursor appears upon fixing first one, it may be manipulated by the same way. Coordinate
of the second vertical cursor along t-ABIScan / ABIScan image (Lg) is indicated in the Length

Measurements field along with parameter W = Lg — Lr. Parameter W represents projection length of
defect provided that vertical cursors are placed appropriately

Measurements>Length-> OFF — erases vertical cursors and empties Length Measurements field
Measurements—>Depth->ON — generates first horizontal cursor that may be guided over t-ABIScan /

Y |

ABIScan image using either touch screen or mouse or =/, _T_ / on front panel keyboard or , on

external keyboard . Coordinate of the first horizontal cursor along t-ABIScan / ABIScan image (Dr) is
indicated in the Depth Measurements field. To fix position of the first horizontal cursor left mouse click

"
Enter

or release touch screen stylus or press ' *=_J on front panel keyboard or on external keyboard .
To interrupt horizontal cursor manipulations and empty Depth Measurements field right mouse click or

ESC
press L) on front panel keyboard or ESC on external keyboard
Second horizontal cursor appears upon fixing first one, it may be manipulated by the same way.
Coordinate of the second horizontal cursor along t-ABIScan / ABIScan image (Dg) is indicated in the

Depth Measurements field along with parameter H = Dg — Dr. Parameter H represents thickness
loss provided that horizontal cursors are placed appropriately

Measurements—>Depth>OFF — erases horizontal cursors and empties Depth Measurements field

| File v|| Wiew v|| Edit v|| Measurements v|| A-Scan Recovery v|

o
n
[=]

— Length Measurements

t-ABIScan [ w-z25mm
POSTPROCESSING | | [Li=-173mm [Lg=206mm

—Depth Measurements

|'Fi|lering: —‘ I H=4mm

I | Dr=0mm | Dg=4mm
A-Scan Recovery t=45mm a=355mm
{I L = &7.2mm H=166% AVC=85 dB
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6.5. TOFD Inspection — RF B-Scan and D-Scan Imaging and
Recording — t-TOFD or TOFD

6.5.1. Setup Pulser Receiver for t-TOFD and TOFD

UDS 3-5 Pulser Receiver window — main operating surface — appears on ISONIC 2005 / 2020 / STAR

L l [3]t-ToFD l [3]ToFD ‘ . . .
screen upon clicking on or . The following settings to be provided:
# | Parameter or Submenu Required Settings Note
Mode
1 Pulser Mode PULSER Dual
2 Tuning, Pulse Width, | PULSER Tuning, Pulse Width, Firing Level, To synchronize with Gain
Firing Level, and Damping settings to provide setting procedure
Damping optimal signal to noise ratio
3 Filter, Frequency RECEIVER Filter and Frequency settings to match | To synchronize with Gain
with probe's frequency setting procedure
4 Display RECEIVER RF
5 USVelocity BASIC USVelocity setting to be equal to actual
value of ultrasound velocity in the object
under test
6 Probe Delay MEASURE Probe Delay setting to be equal to Accumulated Probe Pair
actual Accumulated Probe Pair Delay may be determined
Delay according to paragraph
6.5.1.1 of this Operating
Manual
7 Display Delay BASICS Display Delay and Range to provide Display Delay and Range
Range clear A-Scan representing: will be determined
o0 Lateral Wave and Longitudinal according to paragraph
Wave Back Echo Signals at the 6.5.1.2 of this Operating
beginning and at the and of A-Scan | Manual
correspondingly
OR
o Lateral Wave, Longitudinal Wave
Back Echo, and Mode Conversion
Back Echo at the beginning, middle,
and at the end of A-Scan
correspondingly
OR
o0 Other combination of signals
required by Inspection procedure
8 Gain BASICS Gain setting to be performed according Refer to paragraph 6.5.1.3
to inspection procedure providing of this Operating Manual
required amplitude of signals from
defects to be detected
9 | Settings for other

parameters and
modes have no
significance

I
Click on _| or press LJ on front panel keyboard or on external keyboard upon completing
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6.5.1.1. Accumulated Probe Pair Delay

Two probes to be used in order to capture the TOFD Map. The Probe Delay to be precisely measured for
each of them.

Measuring Probe Delay - Miniature Probes (contact face width 12.5 mm / 0.5 in or less) — Pulse Echo
Technique

" Longitudinal Wave Echo Activate submenu PULSER then set:
+ + + + +

Q Pulser Mode to Single

O Pulse Width to Spike (240 pJ) for probe
having resonant frequency of 8 MHz and
higher or to PW ns, were PW=0.5/F (F
is the probe resonant frequency) for
probes having resonant frequency below 8
MHz

a Firing Level to 18

a Damping to 1000 Q
Stage 2

Stagel Incidence @ Tuningto NO
Fagnt Avaiue Activate submenu RECEIVER then set:
a Display to Full or RF
a Filter to BB
Q Frequency to completely cover probe's
effective bandwidth

Activate submenu BASICS topic then set:
O US Velocity to 5920 m/s (233.1 in/ms)
0 Range to 50.0 mm (2 in)
0 Display Delay to 0 ps
O Rejectto 0%

Stage 1: Manipulate probe over main working
surface of V-2 reference standard and maximize
echo from 25 mm (1 in) radius concave reflector

Stage 2: Fix probe in found position - the center of
25 mm (1 in) radius concave reflector will indicate
incident point while the distance between probe's
frontal edge and incident point is equal to X-

Incidence Value

Faint

Stage 3: Tune Display Delay while probe is still
fixed in found position until rising edge of
maximized echo will match with 50%-grid of the A-
Scan width. Upon completing the obtained value
of Display Delay will be equal to actual Probe
Delay

It's necessary to setup Gain bringing height of maximized echo to 75-80% of A-Scan height

e

It is recommended to optimize Tuning in PULSER submenu upon obtaining maximized echo. The goal of
such optimization is increasing of ultrasonic excitation energy through better matching between firing
output and probe. Level of ultrasonic excitation energy is clearly represented by echo amplitude. Upon
completing Tuning optimization Gain to be adjusted to bring echo to 75-80% of A-Scan height

Supposing that Probe Delay values found for probes of the pair are PD1 and PD2
Accumulated Probe Pair Delay = 0.5¢(PD, + PD;)
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Measuring Probe Delay - Large and Medium Size Probes (contact face width more than 12.5 mm /0.5
in) — Pulse Echo Technique
N N N N N Activate submenu PULSER then set:
Longitudinal Wave Echo, O Pulser Mode
T 0 Pulse Width to Spike (240 pJ) for probe
having resonant frequency of 8 MHz and
higher or to PW ns, were PW =0.5/F (F
is the probe resonant frequency) for
probes having resonant frequency below
8 MHz
O Firing Levelto 18
0 Damping to 1000 Q
Q Tuningto NO
Activate submenu RECEIVER then set:
O Display to Full or RF
O Filter to BB
0 Frequency to completely cover probe's
effective bandwidth
Activate submenu BASICS topic then set:
O US Velocity to 5920 m/s (233.1 in/ms)
0 Range to 200.0 mm (8 in)
0 Display Delay to 0 us
O Rejectto 0%

Stagel
— Incidence

o1t

Stage 1: Manipulate probe over main working
surface of V-1 reference standard and maximize
echo from 100 mm (4 in) radius concave reflector

Stage 2: Fix probe in found position - the center
of 100 mm (4 in) radius concave reflector will
indicate incident point while the distance
between probe's frontal edge and incident point
is equal to X-Value

Stage 3: Tune Display Delay while probe is still
fixed in found position until rising edge of
maximized echo will match with 50%-grid of the
A-Scan width. Upon completing the obtained
value of Display Delay will be equal to actual
Probe Delay

Incidence
Foint

*

It's necessary to setup Gain bringing height of maximized echo to 75-80% of A-Scan height

¢ Itis recommended to optimize Tuning in PULSER submenu upon obtaining maximized echo. The goal of
such optimization is increasing of ultrasonic excitation energy through better matching between firing
output and probe. Level of ultrasonic excitation energy is clearly represented by echo amplitude. Upon
completing Tuning optimization Gain to be adjusted to bring echo to 75-80% of A-Scan height

Supposing that Probe Delay values found for probes of the pair are PD1 and PD3

Accumulated Probe Pair Delay = 0.5¢(PD, + PD;)
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Direct Measurement of Accumulated Probe Pair Delay - All Sizes of Probes — Through Transmission

Technique

Prake 1

Prohe 2

Proke 1

Probe 2

Probe 1

A/

Activate submenu PULSER then set:

O Pulser Mode to Dual
O Pulse Width to Spike (240 pJ) for probe
having resonant frequency of 8 MHz and
higher or to PW ns, were PW =0.5/F (F
is the probe resonant frequency) for
probes having resonant frequency below
8 MHz
O Firing Levelto 18
O Damping to 1000 Q
O Tuningto NO
Activate submenu RECEIVER then set:
O Displayto RF
a Filter to BB
O Frequency to completely cover probe's
effective bandwidth
Activate submenu BASICS topic then set:
O Display Delay to 0 ps

Stage 1: Manipulate probes over each other and
setup of Gain, Range, and USVelocity providing
firm indication of the signal propagating in the
probes wedges from emitting to receiving crystal
then maximize said signal

4 Stage 2: Fix the probe in the found position

corresponding to highest signal amplitude

¢ It's necessary to setup Gain bringing height
of maximized echo to 75-80% of A-Scan
height

¢ Itis recommended to optimize Tuning in
PULSER submenu upon obtaining
maximized echo. The goal of such
optimization is increasing of ultrasonic
excitation energy through better matching
between firing output and probe. Level of
ultrasonic excitation energy is clearly
represented by echo amplitude. Upon
completing Tuning optimization Gain to be
adjusted to bring echo to 75-80% of A-
Scan height
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I Probe 1

Probe 2

Stage 3: Increase Gain to provide height of first
half wave of received signal reaching 20 % of total
A-Scan height

Stage 4: Decrease Range to provide ~ 50% of
| the A-Scan width occupied by the signal

Probe 2

Stage 5: Start increasing of Display Delay aiming
displacement of signal's start point to beginning of
A-Scan horizontal base

Stage 6: Stop Display Delay manipulation upon
reaching the target — at this moment value of
Display Delay will represent Accumulated Delay
of the Probes Pair

UDS3-5 - ISONMIC Pulzer/Receiver

BASICS PULSER RECEIVER GATE A Menu
GATE B ALARM DAC/TCG MEASURE Selection

] Value: OFF PRIPES | = | -
Cloze EM| Freeze Save | Open DG5S
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6.5.1.2. Display Delay and Range
Display Delay depends on Accumulated Probe Pair Delay, Probe Separation, and USVelocity:

Display Delay = Probe Delay + Probe Separation / USVelocity

whereas:

O USVelocity is the actual value of longitudinal wave velocity in the material, of which the object
under test is made

Q Probe Separation is the distance between incidence points of the emitting and receiving TOFD probes
measured along the lateral wave trace:

Probe Separation

Emitting Receiving
Probe Frobe

-Lateral Wave

%————- Longitudinal Wave Back Echo

Probe Separation should be optimized according to Inspection procedure and probes positions in the TOFD
fixture to be fixed upon. Display Delay and Range to be adjusted then to provide representing of signals
according to Inspection procedure — the typical examples are given below for 40 mm thickness welded
plates.

UDS53-5 - ISONMIC Pulser/Receiver

0.5 Gain

715 dB
0.2 Range

= Ty

Mo By

pr
13.4 mm ‘
1 U5 Velocit
o0 mn R
0.01 Display Dela
W -
RBeject
Yl «

o By

4 By

ln By

PULSER RECEIVER GATE A Menu "Df ? - 5
ALARM DAC/TCG MEASURE Selection
H | & | & L
Save | Open | Frnt DG5S

y A

/
Lateral Wave Longitudinal Wave
Signal Back Echo
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UD53-5 - ISONMIC Pulser/Beceiver

Gain

= Ty

715 dB
I‘ * T Range
\

Ino Ry

36.8 mm

1 U5 Velocity ‘

5920 mfs

0.01 Display Delay
2? 84 ps ‘

Beject ‘

0 %

[FHEAN FULSER  RECEIVER  GATE A Menu "D" 2_5
GATE B ALARM DAC/TCE  MEASURE  Selection

I by

e

[ By

In by

Yalue: OFF & * = = =3 e
Close Alaim I \EIEEZE Save \Open| Fnnt DGS
N\ \
\ \ \
Lateral Wave Longitudinal Wave Mode Conversion
Signal Back Echo Wave Back Echo
6.5.1.3. Gain

Depending on Inspection procedure (Inspection specs) Gain may be setup with the reference to:

Representative flaw sample

Artificial diffractors in the form of EDM notches or V-shaped notches
Side drilled holes

Grain noise

Lateral wave signal amplitude

0Oo0O0O0oOo

For both examples above the typical procedure of Gain setting was provided through bringing height of
lateral wave signal to 30% of A-Scan height
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6.5.1.4. Probe Separation

Probe Separation must be properly defined and entered to have the ability of precise defects sizing at
posprocessing stage. Most widely used way of Probe Separation determining is mechanical measuring of
distance between TOFD probes excitation points by using a scaled ruler. However mechanical

measurements are not accurate and their implementation becomes quite complicate for objects with curved
surfaces:

E mittin Receivin R y
Frobe g Frobe g Eﬁﬁtﬁgﬂg Ef.gg;"g

| ateral Wave Trace

Lateral Wave ]"1".;7«::«3=

Probe Separation Probe Saparation

Emitting Reaceaiving
Probe Probe

Lateral Wave Trace

Probe Separation

Probe Separation may be defined more precisely through the way as below:

UDS53-5 - ISOMIC Pulser/Receiver

. Gain ‘ o »
88 b dB 1
Meaz Yalue o
s{A) ‘ 2
Meaz Mode ‘ o
Flank 3
1 Probe Delay ‘ o »
? 54 ps 4
A_qle o
: |
BASICS PULSER RECEIVER  GATE A Menu ﬁ "D" ? - 5
GATE B ALARM DAC/TCG MEASURE Selection
B Value:-siA) | H| = | = -
7 Eluse m»‘ 60. 25 mm Freeze & * Save | Open | Pont DG5S
/
/ O Increase Gain to provide height of first half wave of lateral wave signal reaching 10-20 % of total A-
I Scan height
I O Activate Gate A, setup aThreshold to 5%(submenu GATE A)
O Select s(A) as Meas Value and set Meas Mode as Flank (submenu MEASURE)
I O Provide rising edge of first half wave of lateral wave will cross Gate A
| a Define Probe Separation as Probe Separation = 2 x s(A) whereas s(A) is the digital readout taken
| from box
\ P s
\ 7’
N - -
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6.5.2. t-TOFD and TOFD - Implementation
6.5.2.1. t-TOFD - Prior to Scanning

t-TOFD control panel is shown below

Current A-Scan
+ + + + o+

+
20.30 ps

+ + + + + +
|| _‘.‘.‘.."'-1..|_-—-.Fn.._p..--1p—..a..q._.-u._+-\J
l

+ 4+ + o+ o+

+
+
B
I

- |r‘I
4.
+
+
+

+
+
+
+

+
+
+
+

+ + o+
+ + +

+ o+ o+
+ o+ o+
+ o+ o+

5 Length
«
1 Time

s K

10s
Time-'% ait
«
5 Base
«
Averaging
.
4 =
Start

@)

UD535| Text

Scan Length not exceeding 400 mm or 16 in / Scan Time

<

Empty t-TOFD record field

2983 ps

100 150 200

=k

+ ottt + +
20.20 ps

t-TOFD scrolling controls field

++++-;++++
]
+ o+ o+ o+ + o+ 4+
!
|
}
I
4
£

20 Length -~
Ele:» .
T Time - Empty t-TOFD record field
«i»
Time-Wait r
«»
5 Base o
‘ i ’ Segment of Scrolled Total Scan Length
‘ 5 * < exceeding 400 mm or 16 in / Scan Time >
4 = = 3
Start Open Save g
b a 5:3 '10‘0 15‘0 20‘0 25‘0 SCIID 35‘0 400
ups3-5 Text Close [x
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Scan Length and Scan Time

Length represents length of section of test object to be displayed, over which probe will be scanning during
recording period. Time (Scan Time) is the duration of recording period

o

|Lu?. SRS

I+~ gy

len By

To control Length the following
manipulations are applicable:

e Mouse / Touch Screen
B Click on corresponding
e Keyboard

-
B Press 1 J on front panel keyboard or H on external keyboard = Length fore color changes to

white - then use !J '_’J !J !J on front panel keyboard or , , , on external

keyboard

e Combined

B Click on Length = Length fore color changes to white - then use !J 2) !J !J on front
panel keyboard or , , , on external keyboard

®

The value of Length is adjustable between 50 and 1000 mm or 2 and 40 in
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5 Lerigth
220 mm

Averaging

OFF

To control Time
the following manipulations are applicabIE}://

/4
e Mouse / Touch Screen V/4

B Click on corresponding
e Keyboard

'l
s Press LJ on front panel keyboard or @ on external keyboard = Time fore color changes to

white - then use !J _J _J ij on front panel keyboard or , , , on external

keyboard

e Combined

B Click on Time = Time fore color changes to white - then use !J '_’J !J !J on front panel
keyboard or , , on external keyboard

®

The value of Time is adjustable between 5 and 60 sec
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Time-Wait

Time-Wait is waiting time for intermissions predcessing t-TOFD recording, which starts unconditionally upon
Time-Wait period is over

5 Length ar
220 mm ‘ 1 »
1 Time o
10s ‘ 2 »
A AR AR AR . Time-W ait o
: Currentvalueof § 3s 3
: Time-Out - 7 »
] sec ] 4
tsssssssssEssssEEEEEEEEEEEE - =
Averaging ar
OFF 5 »
/7 7
To control Time-Wait the following ’, 4
manipulations are applicable: //
/
7/
¢ Mouse / Touch Screen y/

— -
B Click on corresponding |button|

e Keyboard

?
B Press 3 on front panel keyboard or B on external keyboard = Time-Wait fore color changes

to white - then use !_ ?/ « !' on front panel keyboard or , , , on external
keyboard

e Combined

LINCIAIINS

B Click on Time-Wait = Time-Wait fore color changes to white - then use =/,

front panel keyboard or , , , on external keyboard

®

The value of Time-Wait is adjustable between 0 and 15 sec
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Base

Base represents Probe Separation

To control Base the following
manipulations are applicable:

5 Length
220 mm

Time-' ait
35

b db 4

Averaging

|r.h},\|-ﬁ-l|. oo By f e By | (= By

A 4

Mouse / Touch Screen
B Click on corresponding
Keyboard

-
B Press _4 ) on front panel keyboard or H on external keyboard — Base fore color changes to

white - then use !J '_’J _J !J on front panel keyboard or , , , on external

keyboard

Combined

B Click on Base = Base fore color changes to white - then use !J '_’J !J !J on front panel
keyboard or , , , on external keyboard

®

The value of Base is adjustable between 25 and 500 mm or 1 and 20 in
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Averaging
Averaging of sequential A-Scans is required sometimes to improve signal to noise ratio of the t-TOFD

record
5 Length
220 mm ‘
1 Time
10s ‘
L . _ _
:  Current setting of Time-¥ ait ‘
i Averaging ‘l 3s
] mm or in ] h Base
s s e s e raaaaaes N
. <

Averaging

OFF

To control Averaging the following
manipulations are applicable:

e Mouse / Touch Screen

B Click on corresponding

e Keyboard
F
B Press _3 _ on front panel keyboard or @ on external keyboard = Averaging fore color changes

to white - then use !_ ?/ « !' on front panel keyboard or , , , on external
keyboard

¢ Combined

LINCIAAIARS

B Click on Averaging = Averaging fore color changes to white - then use —/,
front panel keyboard or , , , on external keyboard

®

Averaging may be either inactive (OFF) or setup for factor 2 or 4 or 8

Insert Text Note

Refer to paragraph 6.3.2.1 of this Operating Manual

Preview UDS 3-5 Settings

Refer to paragraph 6.3.2.1 of this Operating Manual

ISONIC 2005 /2020 / STAR from Sonotron NDT - Operating Manual — Revision 2.38 - Page 194 of 380



Start/Stop t-TOFD recording

4
Click on ﬂl or press LJ on front panel keyboard or F8 or <Alt>+<S> on external keyboard to

start t-TOFD recording

4 | u |
Stat | putton becomes invisible since t-TOFD recording starts. __28P | button occupies its position.

-0
Click on 3P | or press _J on front panel keyboard or or <Alt>+<S8> on external keyboard to

terminate t-TOFD recording prior to automatic completion

= A
stop | button becomes invisible after completion / termination of t-TOFD record. __ 3%t | putton returns

to its position

Save record into a file

Refer to paragraph 6.3.2.1 of this Operating Manual

Open record from a file and starting postprocessing session

Refer to paragraph 6.3.2.1 of this Operating Manual

Return to UDS 3-5 main operating surface

Refer to paragraph 6.3.2.1 of this Operating Manual
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6.5.2.2. t-TOFD - Scanning

a Apply probes pair to test object in the start point of selected scanning line

4 | |
O Click on 3%t |or press LLJ on front panel keyboard or or <Alt>+<8> on external keyboard

O Guide probe pair over the scanning line synchronously with Position Icon moving with constant speed
above t-TOFD record field — typical scanning progress display during is shown and explained below

|
=]
™
o
™

20 Length
«

-
1
1 Time o
s
Time-W ait o
s KR
5 Baze o
| oonm [l
Averaging o
o R
1 = "
Open Save
u] a0 100 150 2I:IIEI
Text Cloze
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6.5.2.3. TOFD - Prior to Scanning

TOFD control panel is shown below

| " 1 »
Current A-Scan =
o+ o+ + o+ 4+ =
+ o+ o+ 4+ o+ .
L wrapesrs e _rpeen| |
L I-]
+ 0+ o+ o+ o+
+ o+ o+ + o+
+ o+ o+ + o+
+ o+ o+ + o+
20 Length o
220 mm ‘ 1
5 Basze o
Scan Length not exceeding 400 mm or 16 in
120 mm ‘ 2 g g
A - <
Yeraging ao
"E
Encoder:
Drefault -
I J Empty TOFD record field
4 = = )
Start Open Save £
) ;
/ 0 50 100 150 200
UuDs53-5 Text Cloze
‘ [

20.30 ps

+ o+
+ o+
+ o+
+ o+

o
25 o+ o+ o+

TOFD scrolling controls field

3

i

£
PO A

i

=N

S
++++-h-++++

.
PN - S S

1

—_— 4+

o+ o+ o+
o+ o+ o+
o+ o+ o+
o+

R
20 Length
1540 mm ‘
5 Base
.
Averaging
.

Empty TOFD record field

oty |1y
adh b4

Encoder:
ID";:ulf' = Segment of Scrolled Total Scan Length
< exceeding 400 mm or 16 in >
| 2 = = 4
Start Open Save 2
’ a a0 100 150 200 2a0 200 260 400
uDs3-h Text Close

ISONIC 2005/ 2020 / STAR from Sonotron NDT - Operating Manual — Revision 2.38 - Page 197 of 380




Scan Length

Length represents length of section of test object to be displayed, over which probe will be scanning during
recording period

/
20" Length

o
> 1540 mm &
il
2
Averaging a
OFF 3
To control Length the following /o,
manipulations are applicable: 7.7
4
e Mouse / Touch Screen v
B Click on corresponding
e Keyboard

-
B Press' 1 J on front panel keyboard or ﬂ on external keyboard = Length fore color changes to

white - then use !J _J _J !J on front panel keyboard or , , , on external

keyboard

¢ Combined

B Click on Length = Length fore color changes to white - then use !J '_’J :J !J on front
panel keyboard or , , , on external keyboard

®

The value of Length is adjustable between 50 and 20000 mm or 2 and 800 in
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Base
Base represents Probe Separation

20 Léngth
1540 mm

= By

=

[ l|“

To control Base the following
manipulations are applicable:

o Mouse / Touch Screen
B Click on corresponding

o Keyboard

-
B Press 2 J on front panel keyboard or @ on external keyboard = Base fore color changes to

white - then use !J 2J _J !J on front panel keyboard or , , , on external

keyboard

e Combined

B Click on Base = Base fore color changes to white - then use !J 2J :J !J on front panel
keyboard or , , , on external keyboard

®

The value of Base is adjustable between 25 and 500 mm or 1 and 20 in

ISONIC 2005 /2020 / STAR from Sonotron NDT - Operating Manual — Revision 2.38 - Page 199 of 380



Averaging
Averaging of sequential A-Scans is required sometimes to improve signal to noise ratio of the TOFD record

............................ . 20 Length
Current setting of 1540 mm ‘ »
Averaging % N
......... LTI N »
Averaging

OFF

To control Averaging the following
manipulations are applicable:

e Mouse / Touch Screen

B Click on corresponding
e Keyboard
-
B Press 3 Jon front panel keyboard or on external keyboard = Averaging fore color changes
to white - then use !» !/ « ! on front panel keyboard or , , , on external
keyboard

e Combined

t» .3

B Click on Averaging = Averaging fore color changes to white - thenuse =, ' =J, ~J ' T

front panel keyboard or , , , on external keyboard

®

Averaging may be either inactive (OFF) or setup for factor 2 or 4 or 8

Encoder
Select encoder to be used through appropriate box

Encoder:

Drefault j

Clamp fixture holding TOFD probe pair into encoder — refer to Chapter 7 of this Operating Manual
Connect encoder to its input on the rear panel of ISONIC 2005 / 2020 / STAR instrument

Insert Text Note

Refer to paragraph 6.3.2.1 of this Operating Manual

Preview UDS 3-5 Settings

Refer to paragraph 6.3.2.1 of this Operating Manual
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Start/Stop TOFD recording

4
Click on ﬂl or press LJ on front panel keyboard or F8 or <Alt>+<S> on external keyboard to

start TOFD recording

4 | H |
Stat | putton becomes invisible since TOFD recording starts. __S¥P__| button occupies its position. Click

-
on _ 3P | or press _J on front panel keyboard or or <Alt>+<S> on external keyboard to

terminate TOFD recording

N EA
atop | button becomes invisible after termination of TOFD record. __2tait | hutton returns to its position

Save record into a file

Refer to paragraph 6.3.2.1 of this Operating Manual

Open record from a file and starting postprocessing session

Refer to paragraph 6.3.2.1 of this Operating Manual

Return to UDS 3-5 main operating surface

Refer to paragraph 6.3.2.1 of this Operating Manual
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6.5.2.4. TOFD - Scanning

a Apply probes pair to test object in the start point of selected scanning line

4 |
O Click on 3%t |or press Ll) on front panel keyboard or or <Alt>+<S> on external keyboard

O Guide probe pair over the scanning line — typical scanning progress display during is shown and
explained below

20 Length o
1540 mm 1
5 Base o
120 mm ‘ 2
Averaging o
OFF ‘ 3
Encoder:
IDefauIt j
[ =
Open Save
UD53-5 Text Close
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6.5.2.5. t-TOFD / TOFD - Postprocessing
Versatile postprocessing of t-TOFD / TOFD records is featured with:

O Improvement of near to surface resolution through removal of lateral wave and back echo records
from t-TOFD / TOFD Map, zooming t-TOFD / TOFD Map accompanied with appropriate A-Scan
expanding

O Linearization and straightening of t-TOFD / TOFD Map

O Increasing contrast of t-TOFD / TOFD images through varying Gain and rectification

O Defects pattern recognition and sizing

The screen as below appears upon opening file. All postprocessing procedures are performed through
Imenu baFl — touch screen stylus or front panel or external mouse to be used

—
*File v|| Wiew v|| Parameters v|| Edit v|| Measurements v|| A-5can Recavery v|

t-TOFD
POSTPROCESSING

Menu Bar Functions

e File>Open — opens new t-TOFD / TOFD file

¢ File>Snapshots>Add Snapshot — stores current postprocessing screen snapshot accompanied with
appropriate settings and measurements into postprocessing session memory stack

¢ File>Snapshots>Restore Snapshot — recalls earlier stored postprocessing screen snapshot
accompanied with appropriate settings and measurements from postprocessing session memory stack

¢ File>Snapshots>Delete Snapshot — deletes earlier stored postprocessing screen snapshot
accompanied with appropriate settings and measurements from postprocessing session memory stack

¢ File=>Print — prints out postprocessing screen snapshot(s) accompanied with appropriate settings and
measurements

e File>Exit — returns to t-TOFD / TOFD control panel

e View~>Instrument — indicates setup of UDS 3-5 Pulser Receiver used for scanning when file was
created

¢ View~>Inspection Data — indicates operator's comments entered prior to scanning

e View—>Coloring>Grayscale / View->Coloring=>Thermal — selects base color for t-TOFD / TOFD
image

e View>TOFD~->Logic>Negative / View>TOFD->Logic>Positive — selects black / white tones for

representation of positive/negative half waves components of RF A-Scan on the TOFD Map — refer also

to paragraph 8.2.2 of this Operating Manual

¢ View>TOFD->Contrast->Natural / View>TOFD->Contrast> Soft / View>TOFD-> Contrast->Sharp

— selects contrast of the TOFD Map — refer also to paragraph 8.2.2 of this Operating Manual
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e A-Scan Recovery>ON — generates cursor corresponding to A-Scan base line that may be guided over

t-TOFD / TOFD image using either touch screen stylus or mouse or '_'J !J on front panel keyboard
or , on external keyboard — corresponding A-Scan is recovered synchronously according to A-

Scan base line cursor position. Indication of starting position of cursor (L) corresponding to the position
of TOFD probes pair accompanies recovered A-Scan

File v|| Wiew v|| Parameters v|| Edit v|| Measurements v|| A-Scan Recovery v|

L=73.7 mm

t-TOFD
POSTPROCESSING

To fix position of A-Scan base line cursor with corresponding recovered A-Scan left mouse click or
Enter
release touch screen stylus or press _“iJ on front panel keyboard or on external keyboard

ESC
To interrupt recovery of A-Scans right mouse click or press @ on front panel keyboard or @ on
external keyboard

e A-Scan Recovery>OFF - erases A-Scan base line cursor, indicator of its position, and recovered A-
Scan
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View->Coloring~>Rectified — switches between rectified and RF presentation of t-TOFD / TOFD image

File v|| Wiew v|| Parameters v|| Edit v|| Measurements v|| A-Scan Recovery v|

Colaring m Grayzcale

Zoam ¥ Themnal

Inspection Data
R

Instrument

oL _——

POSTPROCESSING 50 100 150 200 280

File v|| Wig v|| Farameters v|| Edit v|| Measurements v|| A-Scan Recovery

L=737 mm

22.09 ps

s

t-TOFD
POSTPROCESSING
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e View>Zoom->Zoom Factor% — expands t-TOFD / TOFD image along time line (vertically)

File v|| Wigw v|| Parameters v|| Edit v|| Measurements v|| A-Scan Recoverny v|

Calaring » |
Zoom =100%
Inspection Data 200%
Instrumnent

t-TOFD
POSTPROCESSING 0 50 100 150 200 250 300 350
File v|| Wiew v|| Parameters v|| Edit v|| Measurements v|| A-Scan Recovery -
L=2781 mm

t-TOFD
POSTPROCESSING

Expanded t-TOFD / TOFD image may be scrolled it vertically using appropriate
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Green background highlights segment of recovered A-Scan corresponding to visible part of t-TOFD /
TOFD image. Said segment moves over recovered A-Scan background while scrolling t-TOFD / TOFD

image vertically

File: v|| Wiew v|| Parameters v|| Edit v|| Measurements v|| A-Scan Recovery v|

L=2781 mm

Start of visible
part of t-TOFD /
TOFD image

F — — — — —
End of visible part
of t-TOFD / TOFD

I image |

t-TOFD .
POSTPROCESSING | ° s 0 s 200

250 200 250

Segment of recovered A-Scan corresponding to visible part of t-TOFD / TOFD image may be expanded
through double click on it — whole A-Scan background is green for the expanded segment. Vertical
scrolling of t-TOFD / TOFD image causes appropriate varying of Display Delay for recovered A-Scan
File: v|| Wiew v|| Parameters v|| Edit v|| Measurements v|| A-Scan Recovery v|

L=2781 mm

Start of visible :
part of t-TOFD /

I "ToFDimage |

e S U —

F — — — — —
End of visible part
of t-TOFD / TOFD

I image |

t-TOFD .
POSTPROCESSING | ° s a0 e

To return to complete recovered A-Scan visibility double click on A-Scan area

®

¢ Zoom function is available for t-TOFD / TOFD image composed of A-Scans longer

than 5 ps
¢ Possible zoom factors are defined by ISONIC 2005 / 2020 / STAR software

automatically
¢ Maximal possible Zoom factor is 400%
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o Parameters>Change... — allows re-adjusting of basic parameters (USVelocity, Base, Probe Delay)
for computation of defects depth and linearization of t-TOFD / TOFD image

File v|| Wigw v|| Parameters v|| Edit v|| Measurements v|| A-Scan Recoverny v|

L = 23| Change..
Mark Zero

t-TOFD
POSTPROCESSING

=1

a0 100 1580 200 250 300 350

File: v|| Wiew v|| Parameters v|| Edit v|| Measurements v|| A-Scan Recovery -
L=2781 mm

gz
US Yelocity, mis

1
5020 Ol

Base, mm

1
131 Ol

Probe Delay, ps 0.01

r—
592 ﬂ
ok |

t-TOFD
POSTPROCESSING

| Enter
On completing click LI or press :J on front panel keyboard or on external

keyboard

To negate re-adjustments click on ﬂl or press \L) on front panel keyboard or @ on

external keyboard
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Parameters—>Mark Zero Line — allows re-adjusting of Probe Delay for computation of defects depth
and linearization of t-TOFD / TOFD image through mark of start point of lateral wave signal on the
recorded t-TOFD / TOFD image with reference to recovered A-Scan. Initially this function generates
cursor corresponding to A-Scan base line that may be guided over t-TOFD / TOFD image using either

touch screen stylus or mouse or '_’J , !J on front panel keyboard or , on external keyboard —
corresponding A-Scan is recovered synchronously according to A-Scan base line cursor position

File =|| “iew =[| Parameters «|| Edit = | Measurements v|| A-Scan Recovery v|

Upon selecting reference A-
Scan with clear lateral wave
left mouse click or press

"
| Enter

=1 on front panel
keyboard or on

external keyboard — this
generates horizontal cursor,
which may be be guided over
t-TOFD / TOFD image using
either touch screen stylus or

mouse or !J !Jon front

panel keyboard or , on
external keyboard

t-TOFD
POSTPROCESSING

o

a0 100 180 200 2480 =00 260

File =|| “iew =[| Parameters «|| Edit = | Measurements v|| A-Scan Recovery -

To mark the beginning of
lateral wave signal
corresponding to zero depth
left mouse click or press

"
| Enter

+=4 J on front panel
keyboard or on

external keyboard

22.04 ps

To interrupt function at any
moment right mouse click or

&)
press <) on front panel
n

keyboard or o]
external keyboard

2515 ps

t-TOFD
POSTPROCESSING

=1

S0 100 150 200 250 200 250
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Edit>Linearization>ON — recalculates depth for each point of t-TOFD / TOFD image and redraws it

L]
as Longitudinal Coordinate — Depth map
| File v|| Wiga v|| Farameters v|| E dit v|| I easurements v|| A-Scan Recovery v|
Linearization OW
Femove Lateral Wave » = OF|
Straightening 4
Change Gain 4
Flip Honzontal
t-TOFD | @
POSTPROCESSING o 50 100 150 200 250 200 250
—| File v|| Wiew v|| Parameters v|| Edit v|| Measurements v|| A-Scan Recoverny v|
t-TOFD
POSTPROCESSING
o Edit>Linearization>OFF — returns to original t-TOFD / TOFD image - Longitudinal Coordinate —

Time map
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Edit>Remove Lateral Wave>ON — removes rectangle segment designated by an operator from t-
TOFD / TOFD image. Most frequently this function is applied to lateral wave record, which is recorded
continuously during line scanning and allows to better resolve defects located closely to scanning
surface. Also this function may be applied to other signals continuously recorded during line scanning for
example, backwall echo, mode conversion backwall echo, etc. - this allows to better resolve defects
located closely to bottom surface. In addition to modifying of rectangle segment selected by an operator
this function automatically straightens t-TOFD / TOFD image in order to compensate deviations caused
by various factors during recording, for example, coupling instability, unevenness of scanning or bottom
surface, etc. The described function is based on selecting reference signal and defining a rectangle
segment on the t-TOFD / TOFD image. All signals corresponding to selected rectangle segment of t-
TOFD / TOFD image are equalized by straightening function and then removed; appropriate changes do
occur on t-TOFD / TOFD image above and under selected rectangle segment after its removal. Initially
cursor corresponding to A-Scan base line is generated; it may be guided over t-TOFD / TOFD image

using either touch screen stylus or mouse or '_’J :J on front panel keyboard or , on external
keyboard - corresponding A-Scan is recovered synchronously according to A-Scan base line cursor
Erlte.r

position. To select reference A-Scan left mouse click or release touch screen stylus or press *=_/ on
front panel keyboard or on external keyboard

| File: v|| Wiew v|| Parameters v|| E dit v|| Measurements v| A-Scan Recovery v|

Linearization L4
| Remove Lateral Wave | 0N

Straightening F mOFF

Change G ain L4

Flip Horizontal

File =|| “iew =|| Parameters «|| Edit - | Measurements v|| A-Scan Recovery -

2204 ps

t-TOFD
POSTPROCESSII

2515 ps

t-TOFD
posTPn ocessl " G o a0 100 150 200 280 300 350
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First horizontal cursor appears on the t-TOFD / TOFD image upon selecting reference A-Scan. It may

be guided over t-TOFD / TOFD image using either touch screen stylus or mouse or y A on front
panel keyboard or , on external keyboard . To fix position of the first horizontal cursor and designate

L
Enter
start of reference signal left mouse click or release touch screen stylus or press _‘iJ on front panel
keyboard or on external keyboard . Second horizontal cursor appears upon fixing first one; it may
be manipulated by the same way and allows designating end of reference signal
View «|| Parameters - | Measurements 'H &-Scan Recovery v‘

View ~|| Parameters ~ | Measurements ][ A-5can Recovery ~

t-TOFD
POSTPROCESSIN

t-TOFD
POSTPROCESSING

®

Horizontal cursors are accompanied with appropriate time cursors moving over reference A-
Scan
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First vertical cursor appears upon designating end of reference signal. Its length corresponds to duration
of reference signal and it is located between first and second horizontal cursors. First vertical cursor may

be manipulated over t-TOFD / TOFD image using either touch screen stylus or mouse or '_’J - on
front panel keyboard or , on external keyboard . To designate first border of rectangle segment

| Erlte.r
left mouse click or release touch screen stylus or press ij on front panel keyboard or on
external keyboard . Second vertical cursor completing defining a rectangle appears upon fixing first one;
it may be manipulated by the same way and allows to designate second border of rectangle segment

View «|| Parameters - | Measurements 'H &-Scan Recovery v‘

Wiew =[] Parameters - ‘ Measurements 'H A:5can Recovery -
u

t-TOFD
POSTPROCESSII

t-TOFD
POSTPROCESSING
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As a result:
0 Signs of reference signal and corresponding signals in the selected rectangle segment are
removed from t-TOFD / TOFD image
o t-TOFD / TOFD image is straightened above and under selected and modified rectangle
segment to compensate deviations caused by various factors during recording, for example,
coupling instability, unevenness of scanning or bottom surfaces, etc

| File: v|| Wiew v|| Parameters v|| Edit v|| Measurements v|| A-Scan Recovery v|

t-TOFD
POSTPROCESSING

Esc.
To interrupt function at any moment right mouse click or press w on front panel keyboard or @
on external keyboard

+ Edit->Remove Lateral Wave-> OFF — negates modification of selected rectangle segment of t-TOFD /
TOFD image
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Edit->Straightening=> ON — straightens t-TOFD / TOFD image in order to compensate deviations
caused by various factors during recording, for example, coupling instability, unevenness of scanning or
bottom surfaces, etc. It is based on selecting reference signal (either lateral wave, or backwall echo, or
mode conversion backwall echo, etc) and defining a rectangle segment on the t-TOFD / TOFD image.
All signals corresponding to selected rectangle segment of t-TOFD / TOFD image are equalized by
straightening function and appropriate changes do occur on t-TOFD / TOFD image above and under
modified rectangle segment. Initially cursor corresponding to A-Scan base line is generated; it may be

guided over t-TOFD / TOFD image using either touch screen stylus or mouse or '_’J !J on front

panel keyboard or , on external keyboard — corresponding A-Scan is recovered synchronously
according to A-Scan base line cursor position. To select reference A-Scan left mouse click or release

Erlte.r
touch screen stylus or press _‘ij on front panel keyboard or on external keyboard

| File: v|| Wiew v|| Parameters v|| Edit v|| Measurements v| A-Scan Recovery v|

Linearization L4

Remove Lateral Wave #

Straightening ]
Change Gain LA R
Flip Horizontal

File =|| “iew -|| Parameters =f| Edit = | M easurements Y|| A-Scan Recovery -

2204 ps

t-TOFD
POSTPROCESSII

t-TOFD
PosTP“o CESSING o a0 100 150 200 280 300 350

2515 ps
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First horizontal cursor appears on the t-TOFD / TOFD image upon selecting reference A-Scan. It may

be guided over t-TOFD / TOFD image using either touch screen stylus or mouse or y !J on front
panel keyboard or , on external keyboard . To fix position of the first horizontal cursor and designate

L
Enter
start of reference signal left mouse click or release touch screen stylus or press :J on front panel

keyboard or on external keyboard . Second horizontal cursor appears upon fixing first one; it may
be manipulated by the same way and allows to designate end of reference signal

| File: v|| Wiew v|| Farameters v|| Edit v|| Meazurements v|| A-Scan Recoverny v|

File =|| Yiew =|| Parameters =[| Edit = | Measurements v|| A-Scan Recovery -

2204 ps

t-TOFD
POSTPROCESSI!

2515 ps

t-TOFD
POSTPROCESSING

a0 100 150 200 280 300 350

o
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First vertical cursor appears upon designating end of reference signal. Its length corresponds to duration
of reference signal and it is located between first and second horizontal cursors. First vertical cursor may
be manipulated over t-TOFD / TOFD image using either touch screen stylus or mouse or '_’J - on
front panel keyboard or , on external keyboard . To designate first border of rectangle segment

"
Enter
left mouse click or release touch screen stylus or press ij on front panel keyboard or on

external keyboard . Second vertical cursor completing defining a rectangle appears upon fixing first one;
it may be manipulated by the same way and allows to designate second border of rectangle segment

| File: v|| Wiew v|| Farameters v|| Edit v|| Meazurements v|| A-Scan Recoverny v|

File =|| “iew =[| Parameters =|| Edit - | Measurements v|| A-Scan Recovery -

22.09 ps

t-TOFD
POSTPROCESSIP

2515 ps

t-TOFD
POSTPROCESSING

50 luls} 150 200 250 00 FE0

=1
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As aresult t-TOFD / TOFD image is straightened in, above, and under selected rectangle segment to
compensate deviations caused by various factors during recording, for example, coupling instability,
unevenness of scanning or bottom surfaces, etc

| File v|| Wiew v|| Parameters v|| Edit v|| Measurements v|| A-Scan Recovery -

t-TOFD
POSTPROCESSING

—
To interrupt function at any moment right mouse click or press m on front panel keyboard or @
on external keyboard

o Edit->Straightening-> OFF — negates modification of selected rectangle segment of t-TOFD / TOFD
image
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Edit>Change Gain>ON — generates cursor corresponding to A-Scan base line that may be guided

over t-TOFD / TOFD image using either touch screen stylus or mouse or '_’J !J on front panel
keyboard or , on external keyboard — corresponding A-Scan is recovered synchronously
according to A-Scan base line cursor position. To select reference A-Scan release touch screen stylus

Erlte.r
or left mouse click or press ij on front panel keyboard or on external keyboard - this
generates subwindow allowing off-line re-adjusting of Gain for all A-Scans captured during t-TOFD /

ﬂ
TOFD recording in £6dB range with £0.1 dB increments through clicking or pressing and holding on ‘

or pressing !J !J on front panel keyboard or , on external keyboard

Filz v|| Wigw v|| Parameters v|| E dit v|| M easurements v|| A-Scan Recovery v|
L=1272 mm

ISONIC 2005

Select Gain Change:

“ioswe

OK Cancel |
L&

File v|| Wiew v|| Parameters v|| Edit v|| Measurements v|| A-Scan Recovery -
L=1272 mm

t-TOFD
POSTPROCESSII

s

t-TOFD
POSTPROCESSING o 50 100 150 200 250 300 350

During Gain re-adjusting reference A-Scan is modified accordingly. Upon completing re-adjusting Gain

DK | Enter
click on or press ij on front panel keyboard or on external keyboard — this

applies new Gain value to all captured A-Scans and redraws t-TOFD / TOFD image accordingly

ISONIC 2005/ 2020 / STAR from Sonotron NDT - Operating Manual — Revision 2.38 - Page 219 of 380



Cancel esc |
To interrupt re-adjusting of Gain click on 4' or press @ on front panel keyboard or @

on external keyboard

Edit->Change Gain>OFF — negates Gain re-adjustment and returns to originally recorded t-TOFD /
TOFD image and original Gain setting

Edit=>Flip Horizontal — reorders A-Scans captured during t-TOFD / TOFD recording in reverse
succession and redraws t-TOFD / TOFD image accordingly. This service function may be useful for
merging scans of neighboring sections of an object, which were scanned in opposite direction due to
access conditions, etc

| File v|| Wiew v|| Parameters v|| E dit v|| Measurements v| A-Scan Recovery v|

Linearization L4
Remove Lateral Wave ¥
Straightening 4
Change Gain »
Flip Horizon

t-TOFD
POSTPROCESSING 0 A0 100 150 200 250 300 250

| File: v|| Wiew v|| Parameters v|| Edit v|| Measurements v|| A-Scan Recovery v|

3447 ps

t-TOFD
POSTPROCESSING

®

Applying of Flip Horizontal function empties postprocessing session memory stack
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Measurements>Add Measure—>Height — generates cursor corresponding to A-Scan base line that

may be guided over t-TOFD / TOFD image using either touch screen stylus or mouse or '_’J :J on
front panel keyboard or , on external keyboard — corresponding A-Scan is recovered
synchronously according to A-Scan base line cursor position. Indication of starting position of cursor (L)
corresponding to the position of TOFD probes pair accompanies recovered A-Scan. A-Scan base line
cursor to be positioned over defect image to minimize displacement of defect's signal with regard to
starting point of A-Scan. To fix position of A-Scan base line cursor release touch screen stylus or left

Erlte.r
mouse click or press ' *=_J on front panel keyboard or on external keyboard . Indication of
starting position of cursor (L) corresponding to probe's center accompanies recovered A-Scan

| File v|| Wiga v|| Farameters v|| E dit v|| M easurements v|| A-Scan Recovery v|
Add Measure Length

Clear Lazt Heig
Clear Al

22.09 ps

File v|| Wiew v|| Parameters v|| Edit v|| Measurements v|| A-Scan Recovery -

L=119.3 mm

t-TOFD
POSTPROCESSII

t-TOFD
POSTPROCESSING

50 400 150 200 250 200 250

=]
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First horizontal cursor appears upon fixing A-Scan base line cursor, it may be guided over t-TOFD /

TOFD image using either touch screen stylus or mouse or y !J on front panel keyboard or , on
external keyboard . First horizontal cursor is accompanied with first time cursor synchronously moving

over reference A-Scan. Coordinate of the first horizontal cursor - depth (H) and corresponding time of
flight (t) are indicated synchronously. To fix position of the first horizontal cursor left mouse click or

Erlte.r
release touch screen stylus or press :J on front panel keyboard or on external keyboard .
Second horizontal cursor appears upon fixing first one, it may be manipulated by the same way. Second
horizontal cursor is accompanied with second time cursor synchronously moving over reference A-
Scan. Coordinate of the second horizontal cursor measured relatively to position of first horizontal cursor

(dH) and corresponding delay of second time cursor relatively to first time cursor (dt) are indicated
synchronously. Provided the horizontal cursors are placed properly:

o H represents defect depth

o t represents time of flight for first diffracted signal

o dH represents defect's height

o dtrepresents delay of second diffracted signal relatively first diffracted signal

Filz v|| Wigw v|| Parameters v|| E dit v|| M easurements v|| A-Scan Recovery v|
L=119.3 mm
H =199 mm

2204 ps

t- 23.0 |Is

| File v|| Wiew v|| Parameters v|| Edit v|| Measurements v|| A-Scan Recavery -
L=119.3 mm

H=199 mm | dH=4.1 mm

t=23.0 s dt=0.4ps

22.04 ps

t-TOFD
POSTPROCESSIE

t-TOFD
POSTPROCESSING o 50 100 150 200 250 200 250

28.26 ps

ESC
To interrupt width measurement procedure at any moment right mouse click or press @ on front
panel keyboard or @I on external keyboard
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Vertical |[depth/height measurement mark| appears on the t-TOFD / TOFD image upon fixing position of

second horizontal cursor \
| File v|| Wig v|| Parameters v|| E dit v|| Mea&ements v|| A-Scan Recovery v|

File =|| “iew =|| Parameters «|| Edit = | Measurements v|| A-Scan Recovery -

Point 1:
L=119.3 mm
— =23.04 5, dt=0.44 is
t-TOFD H=19.9 mm, dH=4.1 mm

POSTPROCESSII

t-TOFD
POSTPROCESSING o Y 100 150 200 250 300 350

Depth measurement results may be recalled into accompanied with corresponding A-Scan
through double click on the depth measurement mark

In the subwindow appearing:
o L is coordinate of depth measurement mark along scanning line
o H represents defect depth
o trepresents time of flight for first diffracted signal
o dH represents defect's height
o dtrepresents delay of second diffracted signal relatively first diffracted signal

Clicking on = will print current screen snapshot accompanied with depth measurement mark data

Clicking on v will hide subwindow with depth measurement mark data

Clicking on X will hide subwindow with depth measurement mark data and erase corresponding
depth measurement mark
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Measurements>Add Measure—-> Length — generates left parabolic cursor that may be guided over t-

TOFD / TOFD ima using either touch screen stylus or mouse or !J ij, '_’J !J on front panel

keyboard or , , , «— on external keyboard . A-Scan, corresponding to coordinate (L) of tip of left
parabolic cursor along scanning line is recovered synchronously. Left parabolic cursor to be placed over
left defect's end providing shape matching. To fix position of left parabolic cursor left mouse click or

| Enter
release touch screen stylus or press ij on front panel keyboard or on external keyboard

| File v|| Wig v|| Parameters v|| E dit v|| M easurements v|| A-Scan Recovery v|

| Add Measure | Length
Height

Clear Last
i| Clear Al

File v|| Wiew v|| Parameters v|| Edit v|| Meazurements v|| A-Scan Recovery v|
L=106.1 mm |

t-TOFD
POSTPROCESSII

t-TOFD
POSTPROCESSING

[u]

50 400 150 200 250 200 250
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Right parabolic cursor appears upon fixing left parabolic cursor. It may be manipulated by the same way
and must be placed over right defect's end providing shape matching. Coordinate of right parabolic
cursor along t-TOFD / TOFD image measured relatively to position of left parabolic cursor (dL) is
indicated synchronously, it represents length of defect area provided that both parabolic cursors are

placed properly

| File v|| Wigw v|| Parameters v|| Edit v|| Meazurements v|| A-Scan Fecovery v|

|[L=106.1 mm | dL=43.9 mm

22.04 p=

t-TOFD
POSTPROCESSING | © 0

2826 p=

100 180 200 2a0 200 280

ESC
To interrupt length measurement procedure at any moment right mouse click or press m on front

panel keyboard or on external keyboard
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Horizontal {length measurement mark{ appears on t-TOFD / TOFD image upon fixing position of right
parabolic cursor
| File v|| Wi v|| Farameters v|| Edit v|| Measkments v|| A-Scan Recovery v|

22.04 ps

| File v|| Wiew v|| Parameters v|| Edit v|| Measurements v|| A-5can Recovery -

Point 2:
L=106.1 mm
dL=43.9 mm

t-TOFD
POSTPROCESSI!

S |

t-TOFD
POSTPROCESSING

Length measurement results may be recalled into through double click on the length
measurement mark
In the subwindow appearing:

o L is coordinate of left end of the length measurement mark

o dL is length of defect area covered by length measurement mark

o His distance between scanning line and length measurement mark

Clicking on = will print current screen snapshot accompanied with length measurement mark data

Clicking on ¥ will hide subwindow with length measurement mark data

Clicking on x will hide subwindow with length measurement mark data and erase corresponding

length measurement mark

Measurements—>Clear Last — erases last length or depth/height measurement mark placed on the t-t-
TOFD / TOFD image

Measurements—>Clear All — erases all length and depth/height measurement marks placed on the t-
TOFD / TOFD image
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6.6. CB-Scan horizontal plane-view imaging and recording of
defects for shear, surface, and guided wave inspection — t-
FLOORMAP L or FLOORMAP L

6.6.1. Setup Pulser Receiver for t-FLOORMAP L and FLOORMAP L

UDS 3-5 Pulser Receiver window — main operating surface — appears on ISONIC 2005 / 2020 / STAR

Z‘t-Floormap L l IiFIoormap L
or

screen upon clicking on l ‘ The settings as below to be provided
6.6.1.1. Angle Beam Inspection — Shear and Longitudinal Waves

# | Parameter or Submenu Required Settings Note
Mode
1 Gain BASICS Gain setting to be performed

according to inspection procedure
providing required echo heights
from defects to be detected

2 DAC/TCG DAC/TCG DAC/TCG settings to meet
requirements of inspection
procedure
3 Pulser Mode PULSER Dual for dual element probes
Single for single element probes
4 Tuning, Pulse Width, | PULSER Tuning, Pulse Width, Firing To synchronize with Gain
Firing Level, Level, and Damping settings to setting procedure
Damping provide optimal signal to noise ratio
5 Filter, Frequency RECEIVER Filter and Frequency settings to To synchronize with Gain
match with probe's frequency setting procedure
6 Display RECEIVER Display setting may be either Full, | The same Display mode to be
RF, PosHalf, or NegHalf used for both Probe Delay
determining and t-FLOORMAP L
/| FLOORMAP L Recording
7 USVelocity BASICS USVelocity setting to be equal to

actual value of ultrasound velocity
in the object under test

8 Probe Delay MEASURE Probe Delay setting to be equal to | For shear wave / longitudinal
actual probe delay wave angle beam inspection
probe delay may be determined
according to paragraph 5.2.13.5,
5.2.13.6 or 5.2.13.8 of this
Operating Manual or similarly

9 Display Delay BASICS Display Delay setting to be equal Recommend

to actual probe delay Display Delay = Probe Delay
10 | Angle MEASURE Angle setting to be equal to actual

probe angle

11 | Settings for other
parameters and
modes have no
significance

I
Click on _| or press LJ on front panel keyboard or on external keyboard upon completing
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6.6.1.2. Guided, Surface, Creeping, and Head Wave Inspection

# | Parameter or Submenu Required Settings Note
Mode
1 Gain BASICS Gain setting to be performed For guided / surface / creeping /
according to inspection procedure head wave inspection Gain
providing required echo heights setting may be implemented
from defects to be detected according to paragraph 6.6.1.4
of this Operating Manual or
similarly
2 DAC/TCG DAC/TCG DAC/TCG settings to meet For guided / surface / creeping /
requirements of inspection head wave inspection DAC may
procedure be created according to
paragraph 6.6.1.4 of this
Operating Manual or similarly
3 Pulser Mode PULSER Dual for dual element probes
Single for single element probes
4 Tuning, Pulse Width, | PULSER Tuning, Pulse Width, Firing To synchronize with Gain
Firing Level, Level, and Damping settings to setting procedure
Damping provide optimal signal to noise ratio
5 Filter, Frequency RECEIVER Filter and Frequency settings to To synchronize with Gain
match with probe's frequency setting procedure
6 Display RECEIVER Display setting may be either Full, | The same Display mode to be
RF, PosHalf, or NegHalf used for both Probe Delay
determining and t-FLOORMAP L
| FLOORMAP L Recording
7 USVelocity BASICS USVelocity setting to be equal to For guided / surface / creeping /
actual value of ultrasound velocity head wave inspection
in the object under test ultrasound velocity may be
determined according to
paragraph 6.6.1.3 of this
Operating Manual or similarly
8 Probe Delay MEASURE Probe Delay setting to be equal to | For guided / surface / creeping /
actual probe delay head wave inspection probe
delay may be determined
according to paragraph 6.6.1.3
of this Operating Manual or
similarly
9 Display Delay BASICS Display Delay setting to be equal Recommend
to actual probe delay Display Delay = Probe Delay
10 | Angle MEASURE 90°
11 | Settings for other

parameters and
modes have no
significance

I
Click on _| or press LJ on front panel keyboard or on external keyboard upon completing
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6.6.1.3. Determining Probe Delay and Ultrasound Velocity for Guided / Surface /
Creeping / Head Wave Inspection

The following procedure is recommended for finding Probe Delay and US Velocity settings necessary to
perform guided wave inspection:

(a)
(b)

(©

(d)
(e)

(®
(9)
(h)
(i)

)

==
= L)
I
L]
— Pos 2
300 mm
12in J—
600 mm
24in

In the UDS 3-5 Pulser Receiver window — submenu BASICS setup Range = 750 mm (or 30 in)

In the UDS 3-5 Pulser Receiver window — submenu BASICS setup US Velocity = 3000 m/s (or 120
in/ms)

Place guided wave probe into position Pos 1 on a reference plate providing 300 mm (or 12 in) distance
between probe's frontal surface and plate end

Tune Gain to provide plate end echo reaching 80-90% of A-Scan screen height

Tune Display Delay (submenu BASICS) to provide rising edge of plate end echo matching with 40%
grid on horizontal A-Scan screen scale

Place guided wave probe into position Pos 2 on a reference plate providing 600 mm (or 24 in) distance
between probe's frontal surface and plate end

Tune the US Velocity (submenu BASICS) to provide rising edge of plate end echo matching with 80%
grid on horizontal A-Scan screen scale

Place again guided wave probe into position Pos 1 on a reference plate providing 300 mm (or 12 in)
distance between probe's frontal surface and plate end

Repeat steps (e) through (h) as above until further tuning will not be necessary, i.e. placement of guided
wave probe into positions Pos 1 and Pos 2 causes rising edge of plate end echo appearing at 40% and
80% on horizontal A-Scan screen scale correspondingly. Since that Display Delay and US Velocity
settings are proper

In the submenu MEASURE provide Probe Delay = Display Delay whereas Display Delay value to be
found according to above steps (a) through (i)

®

a
a

Probe Delay and US Velocity for surface / creeping / head wave inspection may be found similarly
Automatic Calibration (AUTOCAL) procedure according to paragraph 5.2.13.8 of this Operating Manual
is also applicable
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6.6.1.4. Setting Gain and DAC for Guided / Surface / Creeping / Head Wave
Inspection
For setting up Gain and DAC a reference plate containing artificial defects is required; said reference plate

must have acoustical properties (longitudinal and shear wave propagation velocity, attenuation) thickness
and curvature differing from the same properties of the plate to be inspected in not more than +10%.

Gain setting to be performed through providing sure detection of artificial defect from selected distances
according to required inspection range
Optional DAC setting for guided wave inspection to be performed as below:

Place guided wave probe into position on reference plate providing receiving of an echo from a reflector

(a) Place guided wave probe into position on reference plate providing receiving of an echo from a reflector
passing minimal travel distance

(b) Follow instructions of paragraph 5.2.10 of this Operating Manual to record first DAC echo

(c) Move the probe away from the reflector keeping it's echo maximized for each new DAC echo recording
paragraph 5.2.10 of this Operating Manual
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16.6.2. t-FLOORMAP L and FLOORMAP L - Implementation
6.6.2.1. t-FLOORMAP L - Prior to Scanning

t-FLOORMAP L control panel is shown below

(]

a0 100 150 200 250 200 260
1 1 1 1 1 1

QO0.0 mm

20 Length
370 mm
1 Time

s K

= By

Mo gy

Scan Length not exceeding 400 mm or 16 in / Scan Time

105

Time-Ww ait
B «

Coloring:

I Pzeuda j

4 =
Start Open Save

5%

ups3-5 Text

<

(¥ 8

Empty t-FLOORMAP record field

0 mm

250 300 350 400 450 500 550 GO0
1 I 1 I I I 1 I

400.0 mm

+
+
+
+
+
+
.
+

S+ o+ o+ o+ A+ o+ 4

Empty t-FLOORMAP record field
20 Length g
CE
1 Time r )
Tk
-

3

Time-W ait
.

Segment of Scrolled Total Scan Length
exceeding 400 mm or 16 in / Scan Time

»
P < >
»

Coloring: t-FLOORMAP scrolling controls
IPseudo j
> = =
Start Open Save
/ £
[
UDS3-5 Text Close 4 b
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Scan Length and Scan Time

Length represents length of section of test object to be displayed, over which probe will be scanning during
recording period. Time (Scan Time) is the duration of recording period

/

20" Length
- 290 mm

e By |r§{|. NS

3
»

To control Length the following

. . . /7 7
manipulations are applicable: 7.7
4
e Mouse / Touch Screen '//
B Click on corresponding
e Keyboard

-
B Press 1 J on front panel keyboard or ﬂ on external keyboard = Length fore color changes to

white - then use !J _J _J !J on front panel keyboard or , , , on external

keyboard

e Combined

B Click on Length = Length fore color changes to white - then use !J '_’J :J !J on front
panel keyboard or , , , on external keyboard

®

The value of Length is adjustable between 50 and 1000 mm or 2 and 40 in
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20 Lehgth

290 mm

Time-w ait
B «

To control Time P // Ve
the following manipulations are applicable: , “»
7
v/
e Mouse / Touch Screen & “

B Click on corresponding
e Keyboard

'l
s Press LJ on front panel keyboard or @ on external keyboard = Time fore color changes to

white - then use !J _J _J !J on front panel keyboard or , , , on external

keyboard

e Combined

B Click on Time = Time fore color changes to white - then use !J 2J :J !J on front panel
keyboard or , , on external keyboard

®

The value of Time is adjustable between 5 and 60 sec
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Time-Wait

Time-Wait is waiting time for intermissions predcessing t-TOFD recording, which starts unconditionally upon
Time-Wait period is over

20 Length

200 R

Current value of 290 mm

o o »

Time-Out 1 Time

N o CHL
S .

e
Y -

\1 e By

To control Time-Wait the following -

manipulations are applicable:

7 -
7 7
z -
Mouse / Touch Screen A -

B Click on corresponding

Keyboard

-
B Press 3 on front panel keyboard or @ on external keyboard = Time-Wait fore color changes

to white - then use !» !/ « ! on front panel keyboard or [f, , , on external
keyboard

Combined

t» .3

B Click on Time-Wait = Time-Wait fore color changes to white - thenuse =/, ' =, J ' _T_

front panel keyboard or , , , on external keyboard

s on

®

The value of Time-Wait is adjustable between 0 and 15 sec

t-FLOORMAP L Record Palette

There are four palettes available through — select

N
N

Coloring:
Pzeudo - I

Insert Text Note

Refer to paragraph 6.3.2.1 of this Operating Manual

Preview UDS 3-5 Settings

Refer to paragraph 6.3.2.1 of this Operating Manual
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Start/Stop t-FLOORMAP L recording

4
Click on ﬂl or press LJ on front panel keyboard or F8 or <Alt>+<S> on external keyboard to

start t-FLOORMAP L recording

4 | N |
Stat | putton becomes invisible since t-FLOORMAP L recording starts. __ 2P| button occupies its

[ |
position. Click on ﬁ' or press LJ on front panel keyboard or or <Alt>+<S> on external

keyboard to terminate t-FLOORMAP L recording prior to automatic completion

N 4 |
ﬂ' button becomes invisible after completion / termination of t-FLOORMAP L record. Start

button returns to its position

Save record into a file

Refer to paragraph 6.3.2.1 of this Operating Manual

Open record from a file and starting postprocessing session

Refer to paragraph 6.3.2.1 of this Operating Manual

Return to UDS 3-5 main operating surface

Refer to paragraph 6.3.2.1 of this Operating Manual
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6.6.2.2. t-FLOORMAP L - Scanning

a Apply probes pair to test object in the start point of selected scanning line

4 |
O Click on 3t |or press LJ on front panel keyboard or or <Alt>+<S> on external keyboard

O Guide probe over the scanning line synchronously with Position Icon moving with constant speed above
t-FLOORMAP L record field — typical scanning progress display during is shown and explained below

Current A-Scan

+
+
¥
+

+ o+
P
+ o+
+ o+
+ o+

+ o+ o+ A4+ o+

|
h+
H'Eﬂ"rll"ﬂl'ﬂﬂ‘llwh E'I!"-II'I”UM

+
+
+
+
+
+

ri:-ﬂ

+ o+ + F o+ o+ o+
k

i

20 Length o
«
1 Time o
«
Time-'w ait o
«
Colonng:
I Pzeuda j

N (i
Stop Open Save
uD53-5 Text Cloze

200 240
- ‘B
= |

Current Probe

Position

=& .
_._.
=
o

t-FLOORWAP L record
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6.6.2.3. FLOORMAP L - Prior to Scanning
FLOORMAP_L control panel is shown below

] 50 100 150 200 250 200 250
Current A-Scan E
+ + + + o
. ]
. F
+
I
illi’lt'""""“';-'l'r :ﬂ.\\.:WﬂhH\J.t,t\f'n]]Iv
10 Length o
370 mm ‘ 1
. Scan Length not exceeding 400 mm or 16 in
Colonng:
IF'seuu:h:u j <
Encoder:
IDefault j
2 [ [ Empty FLOORMAP L record
Start Open Save
iy E
UDS3-5| Text | Close | |E

41000 1100 1200 1300 1400 1500 1600 4700
I I I I I I I 1

+ o4+ o+ o+ S+

+ o+ o+ o+ o+ o+

4 o+ F o+ o+ o+ o+ o+
400.0 mm

+

T +
i w lt,"u pr\f-.ﬁ‘a'u\;u*u‘

ke Empty FLOORMAP L record
Segment of Scrolled Total Scan Length

200 Length ) a
‘ < exceeding 400 mm or 16 in >

+ o+ o+ o+ K+ o+ o+t

+
+
+
+
+
+
+
+
+

Colonng:
IGrayscaIe j
Encoder: FLOORMAP L scrolling controls
IDefauIt j
> = =]
Start Open Save
b g]
UDS35| Test | Close | |5
4 [
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Scan Length

Length represents length of section of test object to be displayed, over which probe will be scanning during
recording period

To control Length the following 7 PR
manipulations are applicable: P /’ -
o Mouse / Touch Screen 4/’ -

B Click on corresponding

o Keyboard

-
B Press 1 J on front panel keyboard or ﬂ on external keyboard = Length fore color changes to

white - then use !J 2J _J !J on front panel keyboard or , , , on external

keyboard

¢ Combined

B Click on Length = Length fore color changes to white - then use !J 2J :J !J on front
panel keyboard or , , , on external keyboard

®

The value of Length is adjustable between 50 and 20000 mm or 2 and 800 in

FLOORMAP L Record Palette

There are four palettes available through — select
S
N

Coloring:
IPseudD vI

Select encoder to be used through appropriate box

Encoder

Encoder:

IDehuh _:J

Clamp probe into encoder — refer to Chapter 7 of this Operating Manual

Connect encoder to appropriate input on the rear panel of ISONIC 2005 / 2020 / STAR instrument

Insert Text Note

Refer to paragraph 6.3.2.1 of this Operating Manual

Preview UDS 3-5 Settings

Refer to paragraph 6.3.2.1 of this Operating Manual
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Start/Stop FLOORMAP L recording

4
Click on ﬂl or press LJ on front panel keyboard or F8 or <Alt>+<S> on external keyboard to

start FLOORMAP L recording

4 | N |
Stat | putton becomes invisible since FLOORMAP L recording starts. __StP | button occupies its

[ |
position. Click on ﬁ' or press LJ on front panel keyboard or or <Alt>+<S> on external

keyboard to terminate FLOORMAP L recording

| 4 |
ﬂ' button becomes invisible after termination of FLOORMAP L record. __3tait | putton returns to its

position

Save record into a file

Refer to paragraph 6.3.2.1 of this Operating Manual

Open record from a file and starting postprocessing session

Refer to paragraph 6.3.2.1 of this Operating Manual

Return to UDS 3-5 main operating surface

Refer to paragraph 6.3.2.1 of this Operating Manual
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6.6.2.4. FLOORMAP L - Scanning

a Apply probes pair to test object in the start point of selected scanning line

4 | |
O Click on 3%t |or press llj on front panel keyboard or or <Alt>+<8> on external keyboard

O Guide probe over the scanning line — typical scanning progress display during is shown and explained
below

280 300 340
1 1 1

10 Length
Rl <

Coloring:
IPseudDE
Encoder:
IDehuﬂ
i
Open
ups3-5 Text
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6.6.2.5. t-FLOORMAP L / FLOORMAP L - Postprocessing
Versatile postprocessing of t-FLOORMAP L/FLOORMAP L (CB-Scan) records is featured with:

a Sizing of the defects at any location along stored images (coordinates, projection size,
amplitude-based evaluation)

O Play-back and evaluation of A-Scans obtained and captured during t-FLOORMAP L /
FLOORMAP L (CB-Scan) defects imaging and recording

O Defects outlining and pattern recognition based on A-Scan sequence analysis — Echo
Dynamic Pattern Analysis

O Reconstruction of t-FLOORMAP L / FLOORMAP L (CB-Scan) defects images for various
Gain, Reject, and off-line Gate level settings

o DAC/DGS t-FLOORMAP L / FLOORMAP L (CB-Scan) normalization

The screen as below appears upon opening file. All postprocessing procedures are performed through
— touch screen stylus or front panel or external mouse to be used

—y
*File v|| Wiew v|| Edit v|| Measurements v|| A-Scan Recovery v|

t-FloorMap L
POSTPROCESSING

Menu Bar Functions

e File>Open - opens new t-FLOORMAP L / FLOORMAP L (CB-Scan) file

e File>Snapshots>Add Snapshot — stores current postprocessing screen snapshot accompanied with

appropriate settings and measurements into postprocessing session memory stack
o File>Snapshots>Restore Snapshot — recalls earlier stored postprocessing screen snapshot

accompanied with appropriate settings and measurements from postprocessing session memory stack

¢ File>Snapshots>Delete Snapshot — deletes earlier stored postprocessing screen snapshot

accompanied with appropriate settings and measurements from postprocessing session memory stack
¢ File=>Print — prints out postprocessing screen snapshot(s) accompanied with appropriate settings and

measurements
e File>Exit — returns to t-FLOORMAP L / FLOORMAP L (CB-Scan) control panel

e View~>Instrument — indicates setup of UDS 3-5 Pulser Receiver used for scanning when file was
created

o View~>Inspection Data — indicates operator's comments entered prior to scanning
o View—>Coloring — selects palette for t-FLOORMAP L / FLOORMAP L (CB-Scan) image
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e A-Scan Recovery 2ON — generates cursor representing sound path of probe's central beam in the
object under test that may be guided over t-FLOORMAP L / FLOORMAP L (CB-Scan) image using

either touch screen stylus or mouse or : : on front panel keyboard or , on external
keyboard — corresponding A-Scan is recovered synchronously according to sound path cursor position.
Indication of starting position of cursor (L) corresponding to probe's center accompanies recovered A-
Scan. On the recovered A-Scan there is red Off-line Gate presented. Initially Off-line Gate covers
whole A-Scan range

File v|| Wiew v|| E dit v|| I easurements v|| A-Scan Recovery v|
L=129.3 mm

IR T
S S S

s =0.0mm H=55%
AVC= 3.14dB

FloorMap L e B
POSTPROCESSING a 50 100 150 200 250 300

/
|Automatic Measurements Display| accompanies recovered A-Scan and indicates (refer to
paragraphs 5.1.12, 5.2.13.1 and 5.2.13.2 of this Operating Manual):

0 sound path S between reflector and probe's center (measurement mode - Flank)

o amplitude H of the maximal signal in the Off-line Gate expressed in % of full A-Scan height

o AVC (dB to DAC) of the maximal signal in the Off-line Gate provided that DAC was active
whilst recording t-FLOORMAP L / FLOORMAP L (CB-Scan) data

To fix position of sound path cursor with corresponding recovered A-Scan and Automatic

L
Enter |

Measurements Display data left mouse click or release touch screen stylus or press ' *=_ on front
panel keyboard or on external keyboard

ESC
To interrupt recovery of A-Scans and empty A-Scan Recovery field right mouse click or press L)
on front panel keyboard or @ on external keyboard

A-Scan Recovery>OFF - erases sound path cursor with recovered A-Scan, indicator of sound path
cursor position, and Automatic Measurements Display
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Edit>Change Gain>ON — generates cursor representing sound path of probe's central beam in the
object under test that may be guided over t-FLOORMAP L / FLOORMAP L (CB-Scan) image using

either touch screen stylus or mouse or !/ f on front panel keyboard or , on external

keyboard — corresponding A-Scan is recovered synchronously according to sound path cursor position.
Ente.r |

To select reference A-Scan release touch screen stylus or left mouse click or press ' *=_ on front

panel keyboard or on external keyboard — this generates subwindow allowing off-line re-

adjusting of Gain for all A-Scans captured during t-FLOORMAP L / FLOORMAP L (CB-Scan)

ﬂ
recording in £6dB range with £0.1 dB increments through clicking or pressing and holding on ‘ or

pressing —/, . / on front panel keyboard or , on external keyboard

ISONIC 2005 |

Select Gain Change:

+4.4 dB il

0K Cancel

by
During Gain re-adjusting reference A-Scan is modified accordingly. Upon completing re-adjusting Gain

DK Ente’r |
click on or press *=_J on front panel keyboard or on external keyboard — this

applies new Gain value to all captured A-Scans and redraws t-FLOORMAP L / FLOORMAP L (CB-
Scan) image accordingly

Cancel | g
To interrupt re-adjusting of Gain click on or press L) on front panel keyboard or @

on external keyboard

Edit>Change Gain>OFF — negates Gain re-adjustment and returns to originally recorded t-
FLOORMAP L / FLOORMAP L (CB-Scan) image and original Gain setting
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¢ Edit>ROI>ON - generates cursor representing sound path of probe's central beam in the object under
test that may be guided over t-FLOORMAP L / FLOORMAP L (CB-Scan) image using either touch

screen stylus or mouse or : : on front panel keyboard or , on external keyboard —
corresponding A-Scan is recovered synchronously according to sound path cursor position. To select
L
Enter |

reference A-Scan release touch screen stylus or left mouse click or press - *=_ on front panel
keyboard or on external keyboard — this generates Off-line Gate controls n n n

n, u n allowing to redefine Region Of Interest for t-FLOORMAP L / FLOORMAP L (CB-
Scan) imaging

| File: v|| Wiew v|| Edit v|| Measurements v|| A-Scan Recovery v|

+
+
+
+
+
+
+
+

FloorMap L
POSTPROCESSING

ESC
To interrupt selection of reference of A-Scan right mouse click or press L) on front panel keyboard
or @ on external keyboard

To interrupt re-adjustment of Region Of Interest after selection of reference of A-Scan click on
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Upon completing redefining of Region Of Interest click on — this applies new Off-line Gate to all
captured A-Scans and updates t-FLOORMAP L / FLOORMAP L (CB-Scan) image accordingly — only
segment of t-FLOORMAP L / FLOORMAP L (CB-Scan) image covered by newly adjusted Off-line
Gate remains visible

| File v|| Wiew v|| E dit v|| M easurements v|| A-Scan Recovery v|

425.0 mm

E
E

FloorMap L | ¢
POSTPROCESSING 0 &0 100 150 200 260 300

It is possible then to perform A-Scan signal evaluation using newly adjusted Off-Line Gate through A-
Scan Recovery >ON

File: v|| Wiew v|| E dit v|| M easurements v|| A-Scan Recovery v|
L=1286 mm

435.0 mm

+
+
+
+
+
+
+
+
+

Flov v v+ 4+«

i
3
€

s=2268mm H 1, m——
AVC= 79 dB o :

FloorMap L
POSTPROCESSING a 50 100 150 200 250 300

amm

o Edit>ROI>OFF — negates Off-line Gate re-adjustment and returns to originally recorded t-
FLOORMAP L / FLOORMAP L (CB-Scan) image and initial Off-line Gate setting
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Edit>Filtering>ON — generates amplitude palette bar with sliding cursor, which may be controlled

using either touch screen stylus or mouse or 2» tj on front panel keyboard or , on external
keyboard . Position of the sliding cursor on the amplitude palette bar determines filtering level, which is
indicated as Filtering. All elements of t-FLOORMAP L / FLOORMAP L (CB-Scan) image representing

signal amplitude below filtering level are suppressed:

| File v|| Wigw v|| Edit v|| Measurements v|| A-Scan Recavery v|

435.0 mm

||1

Filtering:
>33.b dB
FloorMap L
POSTPROCESSING

e Edit>Filtering>OFF — returns to originally recorded t-FLOORMAP L / FLOORMAP L (CB-Scan)
image and removes Filtering indication
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Edit>Normalize to DAC>ON - applies DAC/DGS normalized color palette to t-FLOORMAP L /
FLOORMAP L (CB-Scan) image, which was recorded with active DAC/DGS and redraws t-
FLOORMAP L / FLOORMAP L (CB-Scan) image correspondingly (dB to DAC/DGS normalization)

File v|| Wiew v|| Edit v|| Measurements v|| A-Scan Recovery v|

L=8 Filering
ROI
Change Gain

3
4
»

| Momalize to DAC

Flip Horizontal

(o
= OFF

s=948mm  H=159% --E :
AVC= 1.7 dB . 5
B - 2
| -
FloorMap L | £
= T T T T
POSTPROCESSING o 50 150 200 50 00
File v|| Wigw v|| Edit v|| Measurements v|| A-Scan Recavery -
L =827 mm

o+ o+ 4 H o+ o+t

=

s=94.8mm H=59%

AVC=-17dB

+
+
+
+
+
+
s
+

P,

FloorMap L

POSTPROCESSING

E
E
=
w
¥
- — ==
2B = o= = s
L e o 1
=" _— X5 L
- "i
el e
e =1
- c i
= = -
= =
= = =

E
E
(=]

T T T T T

o a0 100 150 200 250 200

Edit>Normalize to DAC->OFF — negates dB to DAC/DGS normalization and returns to originally
recorded t-FLOORMAP L / FLOORMAP L (CB-Scan) image

®

Applying of Edit->Normalize to DAC—>ON or Edit->Normalize to DAC-> OFF negates Filtering
(Edit>Filtering—> OFF)
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_ — reorders A-Scans captured during t-FLOORMAP L / FLOORMAP L (CB-Scan)
recording in reverse succession and redraws t-FLOORMAP L / FLOORMAP L (CB-Scan) image
accordingly. This service function may be useful for merging scans of neighboring sections of an object,
which were scanned in opposite direction due to access conditions, etc

Filterirg »
ROl 4
Change Gain 4
Momnalize to DAC » |

FloorMap L (Am T e e
POSTPROCESSING 200

FloorMap L
POSTPROCESSING
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Measurements>Add Measure-> Length — generates horizontal cursor that may be guided over t-

FLOORMAP L / FLOORMAP L (CB-Scan) image using either touch screen stylus or mouse or !.«

_'.'_/ on front panel keyboard or , on external keyboard . Horizontal cursor to be positioned over
defect area, which's length along the scanning line to be evaluated. Position of horizontal cursor

characterizes its coordinate (H) relatively scanning line. To fix position of horizontal cursor left mouse

L
Enter |
click or release touch screen stylus or press *=_/ on front panel keyboard or on external
keyboard
File v|| Wiew v|| Edit v|| Measurements v|| A-Scan Recovery v|
H=2159 mm
I £
[=]
[
g
& = e =".:."
Ll ot — -_—
= [} = i
— :
= e
il =
= i = = E
FloorMap L | ¢
POSTPROCESSING o 50 100 180 200 250 300
File: v|| Wiew v|| Edit v|| Measurements v|| A-Scan Recovery v|
H=217.0 mm
— _; — = L= [
L=68mm | s e
el e : H‘E;;;r ™=
o
= - =
-
L = = -
= =i
-
N s
Ef e =
FloorMap L | £}
o
POSTPROCESSING o

First vertical cursor appears upon fixing horizontal cursor, it may be guided over t-FLOORMAP L /

|

FLOORMAP L (CB-Scan) image using either touch screen stylus or mouse or : ¥ on front panel
keyboard or , on external keyboard . Coordinate of the first vertical cursor along t-FLOORMAP L /
FLOORMAP L (CB-Scan) image (L) is indicated synchronously. To fix position of the first vertical cursor

Enter |
left mouse click or release touch screen stylus or press *=_ on front panel keyboard or on
external keyboard
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Second vertical cursor appears upon fixing first one, it may be manipulated by the same way. Coordinate
of the second vertical cursor along t-FLOORMAP L / FLOORMAP L (CB-Scan) image measured with

relatively first vertical cursor (dL) is indicated synchronously, it represents projection length of defect
area provided that vertical cursors are placed properly

ESC
To interrupt length measurement procedure at any moment right mouse click or press L) on front

panel keyboard or on external keyboard
File v|| Wiew v|| Edit v|| Measurements v|| A-Scan Recovery v|
H=2159 mm

L=68mm [dL=406 mm

435.0 mm

A

i
i
A
| @]‘h

I
FE
‘-
L.,‘w

|
|
i

i

0 mm

FloorMap L
POSTPROCESSING |  ° 0 100

| File: v|| Wiew v|| Edit v|| Measurements v|| A-Scan Recovery -

T T T
1460 200 2480 200

435.0 mm

mﬁ

"

1% !
iy

FloorMap L
POSTPROCESSING | °

T T T T T
50 100 150 200 250 200

Horizontal [length measurement markl appears on the t-FLOORMAP L / FLOORMAP L (CB-Scan)
image upon fixing position of second vertical cursor
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Length measurement results may be recalled through double click on the length measurement mark

| File v|| Wig v|| Edit v|| Meazurements v|| A-Scan Recoverny v|

435.0 mm

Point 1:
L=6.8 mm
dL=40.6 mm
H=2159 mm

s |

0mm

Floophlap L
P PROCESSING ] 5|0 10|0 15|0 20|0 25|0 200
&
In the appearing:

o L is coordinate of left end of the length measurement mark
o dL is length of defect area covered by length measurement mark
o His distance between scanning line and length measurement mark

Clicking on = will print current screen snapshot accompanied with length measurement mark data

Clicking on ¥ will hide subwindow with length measurement mark data

Clicking on x will hide subwindow with length measurement mark data and erase corresponding

length measurement mark
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Measurements>Add Measure>Width — generates cursor representing sound path of probe's central
beam in the object under test that may be guided over t-FLOORMAP L / FLOORMAP L (CB-Scan)
image using either touch screen stylus or mouse or ? . on front panel keyboard or , on
external keyboard — corresponding A-Scan is recovered synchronously according to sound path cursor
position. Indication of starting position of cursor (L) corresponding to probe's center accompanies
recovered A-Scan. Sound path cursor to be positioned over defect area, which's width along the sound
path line to be evaluated. To fix position of sound path cursor left mouse click or release touch screen

Enre'r
stylus or press ' *=_J on front panel keyboard or on external keyboard
File v|| Wigw v|| Edit v|| Measurements v|| A-Scan Recavery v|

L=278 mm

435.0 mm

+ o+ o+

I+ o+ o+ o+ o+ o+ o+ o+ +

y
:
.
.
.
:
.

A

'“"“m'ffiih"mﬁx =
B - - — _-d'l
s=807mm  H=40% b= = - =
o _— ";:_:—_ -
AVC= 25 dB = =
-
'E JE— -
= - =
= i = = F
FloorMap L | ¢
POSTPROCESSING 0 & 100 180 200 250 200
File v|| Wiew v|| Edit v|| Measurements v|| A-Scan Recovery -
L=278 mm
E
E
S E
| *)
Hiui'\\ML J: iu"i\p, " J\:‘ T '-,:“,_“;n'l I'wLJ
- - . _"f"
s=80.7mm  H=40% 1= = -
= el =
AVC= 25 dB = ==
% ﬂiEsL
== = =
'E JE- I -_ =]
| - =
= ) = =B
FloorMap L | ¢
POSTPROCESSING o 50 100 180 200 250 200
First horizontal cursor appears upon fixing sound path cursor, it may be guided over t-FLOORMAP L /
FLOORMAP L (CB-Scan) image using either touch screen stylus or mouse or ?_ , '.' / on front panel

keyboard or , on external keyboard . Coordinate of the first horizontal cursor along sound path (H) is
indicated synchronously
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L
Enter

To fix position of the first horizontal cursor left mouse click or release touch screen stylus or press =)
on front panel keyboard or on external keyboard . Second horizontal cursor appears upon fixing
first one, it may be manipulated by the same way. Coordinate of the second horizontal cursor along

sound path measured with relatively first horizontal cursor (dH) is indicated synchronously, it represents
projection with of defect area provided that horizontal cursors are placed properly. To interrupt width

ESC
measurement procedure at any moment right mouse click or press L) on front panel keyboard or
on external keyboard

File v|| Wiew v|| Edit v|| Measurements v|| A-Scan Recovery v|
L=27.8 mm
H=189.7 mm | dH=61.1 mm

435.0 mm

+
+
+
+
+
+
+
+

£ o+ ok o+ o+ o+ o+ o+

|f‘tl + o+
e
- =
s=80.7mm  H=40% =g % = == _
= .
AVC= 25 dB = %ﬁ
=
= R
il e
= ==
B —
= = = E
FloorMap L | £
= T T T T T
POSTPROCESSING 0 50 100 180 200 250 300
| File: v|| Wiew v|| Edit v|| Measurements v|| A-Scan Recovery v|
3
E
ol
w
¥
FloorMap L | ¢
o

POSTPROCESSING

Vertical jwidth measurement mark{ appears on the t-FLOORMAP L / FLOORMAP L (CB-Scan) image
upon fixing position of second horizontal cursor
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Width measurement results may be recalled through double click on the width measurement mark This
causes appearance of corresponding A-Scan and subwindov-vl

| File v|| Wiew v|| Edit v|| Measurements v|| A-Scan Recovery v|

+ o+ o+ 4+ o+ o+
435.0 mm

+ o+ 4

AT e

;
:
:
:
:
:
:

)

=

&7

s=80.7mm H = 40% Point 2:
AVC= 25 dB o™ L=27.8 mm -
0= V' etzs7mm ==
= dH=61.1 mm ==
v | &| x|
: 'E = -
e —
B -
5 = <= B
3
FloorMap L | ¢
= T T T T T
POSTPROCESSING 0 50 100 180 200 250 300

In the subwindow appearing:

o L is coordinate of the width measurement mark along scanning line
o H is distance between scanning line and width measurement mark
o dH is width of defect area covered by width measurement mark

Clicking on = will print current screen snapshot accompanied with width measurement mark data

Clicking on ¥ will hide subwindow with width measurement mark data

Clicking on x will hide subwindow with width measurement mark data and erase corresponding

width measurement mark

Measurements—>Clear Last — erases last length or with measurement mark placed on the t-
FLOORMAP L / FLOORMAP L (CB-Scan) image

Measurements—>Clear All — erases all length and with measurement marks placed on the t-
FLOORMAP L / FLOORMAP L (CB-Scan) image
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7. Incremental Encoders
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7.1. Standard Encoder SK 2001108 ABI

Encoder SK 2001108 ABI is originally designed for BScan(Th) and ABISCan recording with ISONIC 2001,
ISONIC 2005/ 2020 / STAR, and ISONIC 2006 instruments. It does not require calibration for using with
these instruments (recognized as default encoder)

To start with encoder follow simple guidance as below
Step 1

Fit probe into appropriate probe holder and connect
signal cable(s) to probe

Step 2

Fit probe holder with probe into encoder

Step 3

Connect probe signal cable(s) to appropriate coaxial
socket on ISONIC 2005 / 2020 / STAR instrument —
refer to paragraph 4.2 of this Operating Manual

Connect encoder data cable to the appropriate D-
Type connector on rear panel pf ISONIC 2005/ 2020 /
STAR instrument — refer to paragraph 4.2 of this
Operating Manual
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7.2. Standard Encoder SK 2001108 FM

Encoder SK 2001108 FM is originally designed for TOFD and FLOORMAP L recording with ISONIC 2001,
ISONIC 2005/ 2020 / STAR, and ISONIC 2006 instruments. It does not require calibration if using with
these instruments (recognized as default encoder). To start with encoder follow simple guidance as below

7.2.1. TOFD

Insert ultrasonic probes into their probe holders then:

Q Fit probe holders with probes on TOFD bar and fix them at at necessary separation distance

a Fix twister S 904050 on the TOFD bar

Q Fit encoder SK 2001108 FM into twister S 904050 and provide necessary orientation of encoder's
wheel — it must be oriented at parallel to the desired probes' trace either along or across the weld —
refer to the sketch and photos below

Basze

77
O 70w

Encoder

Encoder Wheel

TOFD Fixture and encoder positioning
for scanning along the weld

TOFD Fixture and encoder positioning
for scanning across the weld
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7.2.2. FLOORMAP L

Encoder SK 2001108 FM allows 2 ways of direct fitting of S 544 series guided wave probes or other probes
fitted into appropriate probe holders:

O Both encoder's wheel and probe contact face are situated on scanning surface:

Fitting probe into encoder Ready to scan

a Encoder's wheel is situated on surface, which is rectangular to scanning surface:

Fitting probe into encoder Ready to scan
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7.3. Customized Encoders for Proprietary Inspection Tasks

Various custom made encoders for proprietary inspection tasks may be used with ISONIC 2005 / 2020 /
STAR. For appropriate encoder data cable and connector pinout contact

O Nearest Sonotron NDT representative
OR

O Directly to Sonotron NDT — mail to support@sonotronndt.com with subject ISONIC 2005 /
2020 / STAR encoder connection

®

Improper cable out-coming from custom made encoder for proprietary inspection tasks may lead to
warranty exempted damaging ISONIC 2005 / 2020 / STAR instrument

7.4. Encoder Calibration

Every encoder to be calibrated prior to use with ISONIC 2005 / 2020 / STAR

[1]|operate

[ 2 |settings

[ 3 |Exit To Windows

|4 |shut Down

F
To proceed with the calibration in the ISONIC 2005 / 2020 / STAR start screen or press 2 Jon

front panel keyboard or @ on external keyboard

[ 1 ]international

[2|pisplay Settings

[8]Encoders

lz‘ Printer SElection

’#ﬂck

/

Ca
In the appeared ISONIC 2005 / 2020 / STAR Settings Menu or press _3 J on front panel
keyboard or F 3 on external keyboard
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In the appeared ISONIC Encoder Settings window or press <Alt>+<A> on external keyboard

ISONIC Encoder Settings |

Fiegiztered Encoders:

.......

Eemame
Tiesf
[Ealitarate..

Hemave

[Fns
T
=
=

aE, | Cancel

The Calibrate Encoder window appears; it contains simple instructions to follow:

Cahbrate Encoder I Cahbrate Encoder I

= Place the Encoder &t Zera Pairt and click on Step 1 \/ Place the Encoder at Zero Point and click on Step 1
Mowe the Encoder to End Poirt and click on Step 2 = hiove the Encoder to End Point and click on Step 2

Fero Point End Point Fero Point End Point
{+300 mm} {+300 mm}

Hestart | StEp Z | StEp 1J Bestart |
Caticel | - Caticel |

Encoder’s wheel while calibrating must pass linearly the distance of 300 mm (12 in) between Zero Point
designated through clicking on Step 1 or pressing <Alt>+<1> on external keyboard and End Point along
scale bar attached to flat surface

Upon reaching End Point and clicking on Step 2 or pressing <Alt>+<2> on external keyboard new Encoder
Test window appears

®

If it's necessary to re-designate Zero Point click on Restart or press <Alt>+<R> on external keyboard
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In the Encoder Test window:

Q Click on Reset or press <Alt>+<R> on
external keyboard to designate local zero

point o contnng s ercoerten

L ]
Enter |

O Click on Yes or press - *=_ on front panel Emzereey el il
keyboard or * or <Alt>+<Y> on I =-3.0 mm Beset

external keyboard to name the selected
encoder — Key in the Encoder Name

window appears Click an ez if the shown coardinate is comect.
ESC Click on Mo to recalibrate the Encoder.

Q Click on No or press - X" _J on front panel
keyboard or press @l or <Alt>+<N> on
external keyboard to recalibrate the

encoder — return to Calibrate Encoder
window

K.ey in the Encoder Hame |

IMyNewEncnder

~Nrlle@l s e~ Halz1cl) il [

o/lwlE[R[THyllulltllolrP] ]}

m FlIUX|CHHVYIB|IHNIM
iﬂve Cancel

Upon keying in new Encoder name ISONIC Encoder Settings window returns upon

.
W
~

Del BS

ISONIC Encoder Settings

Fiegiztered Encoders:

iul ewE neoder

Fiename
Test. ..

Calibrate. ..

G,

Bemowve

aE, | Cancel
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L
Enter

To update the registry of ISONIC 2005 / 2020 / STAR with new encoder data click on the OK or press <

on front panel keyboard or or <Alt>+<Y> on external keyboard — this will automatically return to
ISONIC 2005/ 2020 / STAR Settings Menu

ISONIC Encoder Settings |

Reqistered Encoders:

b yuM ewE ncader

dd

Rename

Test...

[l

Bemove |

E, | Cancel |

While running encoder calibration next time:

Q Click on Add... or press <Alt>+<A> on external keyboard to proceed with next new encoder by the
same way as described above

O Click on Rename or press <Alt>+<N> on external keyboard to rename the selected encoder

O Click on Test or press <Alt>+<T> on external keyboard to check the accuracy of selected encoder
calibration

a Click on Calibrate or press <Alt>+<L> on external keyboard to recalibrate selected encoder

a Click on Remove or press <Alt>+<R> on external keyboard to remove selected encoder from the
registry of ISONIC 2005/ 2020 / STAR

ESC
Q Click on the Cancel or press L) on front panel keyboard or press @I or <Alt>+<C> on external
keyboard to negate all changes and return to ISONIC 2005 / 2020 / STAR Settings Menu
Ente.r i
O Click on the OK or press ' *=_ on front panel keyboard or or <Alt>+<K> on external keyboard
to update the registry of ISONIC 2005 / 2020 / STAR and return to ISONIC 2005 / 2020 / STAR
Settings Menu
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8. Miscellaneous
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8.1. International Settings

[1|operate

[ 2 |settings

[ 3 |Exit To Windows

|4 |shut Down

F
|
In the ISONIC 2005 / 2020 / STAR start screen or press _2_J on front panel keyboard or @ on
external keyboard

[ 1 ]international

[2]pisplay setings

@Em{rs
lz‘ Printe r/elec‘lion

’%ack
/ £ )

In the appeared ISONIC 2005 / 2020 / STAR Settings Menu or press ' on front panel
keyboard or H on external keyboard, the International Settings screen appears:

E‘Language [3

[ 2|measurement Unit

[ 3 |Back

| ESC

-
To return to ISONIC 2005 / 2020 / STAR Settings Menu orpress 2 or \"¢_J on front panel
keyboard or @ or @ on external keyboard
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8.1.1. Language

3

In the International Settings screen or press ' on front panel keyboard or F1] on external

keyboard

ISONIC Language Selection |

Englizh

ISONIC Language

English

Select language then

®

Standard languages of ISONIC 2005 / 2020 / STAR ate English and German. Other languages are available
on request
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8.1.2. Metric and Imperial Units

E‘Language [3

[ 2|measurement Unit

/ [ 3 |Back

F
|
In the International Settings screen or press 2 on front panel keyboard or @ on external
keyboard

Measurement Unit:
1 | © Metric

2 | 2 Imperial

Cancel |

/

Select measurement units then |c|ick onl
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8.2. Display Settings

‘ [ 1 ]international

[2]pisplay settings

@ Encoders

‘ IZ‘Printer Selection

‘ |?]Back

-,
In the ISONIC 2005 / 2020 / STAR Settings Menu or press _2_J on front panel keyboard or @
on external keyboard

8.2.1. A-Scan Color Scheme

[1]A-scan Colors

| 2 |ToFD Display

’Eﬂack

o )
In the Display Settings Menu or press ' on front panel keyboard or H on external keyboard

Select A-S5can Color Scheme:

Black =]

Black

then mark the selected color scheme

then

Select A-5can Color Scheme:

|Black =

Save |

To negate new selection
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®

There are 4 A-Scan Color Schemes available:

Gain% 5 Gain%
28.5 dB - 28.5 dB
Value: Ao Value: Ao

-10.7 dB -10.7 dB

Gains Gains

28.5dB 28.5dB

Value: AV 4 Value: AV 4

-10.7 dB -10.7 dB
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8.2.2. TOFD Display Settings

[1]A-scan Colors

| 2 |ToFD Display

@Bauk

F
In the Display Settings Menu or press LJ on front panel keyboard or @ on external keyboard
then check the selected options:

Imaging Settings |

— TOFD Imaging
~ Logic — Contrast
) Negative > Natural
 Soft
= Positive @® Sharp

[ Save Cancel
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®

Natural Contrast TOFD Display

Negative

256 brightness levels of TOFD Map from absolutely white to absolutely black are distributed for RF signals,
which's half waves do vary from minus 100% to plus 100% of A-Scan display height. Positive half wave
signals equal or exceeding plus 100% of A-Scan display height are represented by absolutely black color.
Negative half wave signals equal or exceeding minus 100% of A-Scan display height are represented by
absolutely white color

Positive

256 brightness levels of TOFD Map from absolutely black to absolutely white are distributed for RF signals,
which's half waves do vary from minus 100% to plus 100% of A-Scan display height. Positive half wave
signals equal or exceeding plus 100% of A-Scan display height are represented by absolutely white color.
Negative half wave signals equal or exceeding minus 100% of A-Scan display height are represented by
absolutely black color

Negative Positive
+200% +200%

+ 100% + 100%
# #

& &
i # i #
5 5
P base line 0% »"  base line 0%
4 4
Jiﬁip Jiﬁip
- 100% - 100%
- 200% - 200%
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®

Soft Contrast TOFD Display

Negative

256 brightness levels of TOFD Map from absolutely white to absolutely black are distributed for RF signals,
which's half waves do vary from minus 200% to plus 200% of A-Scan display height. Positive half wave
signals equal or exceeding plus 200% of A-Scan display height are represented by absolutely black color.
Negative half wave signals equal or exceeding minus 200% of A-Scan display height are represented by
absolutely white color

Positive

256 brightness levels of TOFD Map from absolutely black to absolutely white are distributed for RF signals,
which's half waves do vary from minus 200% to plus 200% of A-Scan display height. Positive half wave
signals equal or exceeding plus 200% of A-Scan display height are represented by absolutely white color.
Negative half wave signals equal or exceeding minus 200% of A-Scan display height are represented by
absolutely black color

Negative Positive

+200% +200%

+ 100% + 100%
# i

& &

; o ; o
éag éa‘a
p base line 0% p’ base line 0%
|3 |3
4
Jiﬁip \;ifii

- 100% - 100%

- 200% - 200%
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®

Sharp Contrast TOFD Display

Negative

256 brightness levels of TOFD Map from absolutely white to absolutely black are distributed for RF signals,
which's half waves do vary from minus 50% to plus 50% of A-Scan display height. Positive half wave
signals equal or exceeding plus 50% of A-Scan display height are represented by absolutely black color.
Negative half wave signals equal or exceeding minus 50% of A-Scan display height are represented by
absolutely white color

Positive

256 brightness levels of TOFD Map from absolutely black to absolutely white are distributed for RF signals,
which's half waves do vary from minus 50% to plus 50% of A-Scan display height. Positive half wave
signals equal or exceeding plus 50% of A-Scan display height are represented by absolutely white color.
Negative half wave signals equal or exceeding minus 50% of A-Scan display height are represented by
absolutely black color

Negative Positive
+200% +200%
+ 100% + 100%
A A
¢ é
g i
@[1 +50% 9[1 +509,
5° 5
. [ base line 0% , p base line 0%
I [
Ji?ip \;iﬁil:r
50% -50%
- 100% - 100%
- 200% - 200%
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8.3. Printer Selection

This option is available if there are more than 1 printer drivers installed in ISONIC 2005 / 2020 / STAR

[1]|operate

[ 2 |settings

[ 3 |Exit To Windows

|4 |shut Down

F
In the ISONIC 2005 / 2020 / STAR start screen or press ~2_J on front panel keyboard or @ on

external keyboard

[ 1 ]international

[2]A-scan Colors

E‘Encoders

lz‘ Printer Selection

5 Back

S

- |
In the appeared ISONIC 2005 / 2020 / STAR Settings Menu or press 4 _J on front panel

keyboard or F4 on external keyboard

Select Printer:
HP Laserlet bGP

Save Cancel | 2

-

Select printer then

ISONIC 2005 /2020 / STAR from Sonotron NDT - Operating Manual — Revision 2.38 - Page 273 of 380



8.4. Time of Sale Option — Analogue RF Output Terminal

Optional analogue RF Output Terminal is available in the new ISONIC 2005 / 2020 / STAR instrument at
time of sale — refer to paragraph 4.2 of present Operating Manual

Signal on RF output is available all the time while A-Scan is present at the instrument screen in all modes of
operation

RF output is terminated with LEMO 00 socket. The load parameters of RF output are:

Input impedance 21 MQ
Input Capacity <30 pF
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8.5. Time of Sale Option — Triggering In / Out

Optional analogue Triggering In / Out Terminals are available in the new ISONIC 2005 / 2020 / STAR
instrument at time of sale — refer to paragraph 4.2 of present Operating Manual

Triggering-Out Terminal

The default mode of ISONIC 2005 / 2020 / STAR is internal synchronization. Synchronization pulse appears
on the Triggering-Out Terminal (LEMO 00 Socket) all the time while A-Scan is present at the instrument
screen in all modes of operation. Parameters of synchronization pulse are:

Polarity Positive
Amplitude 5V
Duration 600 ns

The load parameters of Triggering-Out Terminal are:
Triggering-In Terminal
The default mode of ISONIC 2005 / 2020 / STAR is internal synchronization. Triggering-In Terminal (Lemo

00 Socket) to be used as an input for external triggering pulse. Required parameters of the external
triggering pulse delivered to Triggering-In Terminal of ISONIC 2005 / 2020 / STAR are:

Polarity Positive
Amplitude Not lower than 2 V
Not higher than 5.5 Volt
Pause DC Level Not lower than Minus 0.5 Volt
Not higher than 0.4 Volt
Duration Not shorter than 100 ns

Not longer than 2 us

The input parameters of Triggering-In Terminal are:

Input impedance 210 MQ
Input Capacity <15 pF

If there is a need to synchronize firing receiver mode of ISONIC 2005 / 2020 / STAR from an external
source:

e Connect external source to Triggering-In Terminal of ISONIC 2005 / 2020 / STAR instrument
e Start UDS 3-5 Pulser Receiver (refer to paragraph 5.1 of present Operating Manual)
e Enter submenu PULSER (refer to paragraph 5.2.3 of present Operating Manual)
e Refer to the table below:
Triggering Mode Control Mode

Button Appearance

External Triggering

Clicking on turns to External Triggering; if triggering pulse will not
appear on the Triggering-In Terminal during an interval of approximately 20
seconds then instrument will return to internal synchronization mode of
operation
Internal Synchronization

. TRG o
Clicking on turns to Internal Synchronization mode
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8.6. Exit to Windows

[1]|operate

[ 2 |settings

[ 3 |Exit To Windows

|4 |Bhut Down

F

In the ISONIC 2005 / 2020 / STAR start screen Iclick onI or press _3 J on front panel keyboard or on
external keyboard

ZII]
To return to ISONIC 2005 / 2020 / STAR Operation double click on icon 71”9 jocated in the Windows

Desktop

®

Exit to Windows is required for:
O Connection to network
0 Printing inspection results to network printer
o Transferring data to / from remote PC

O Installing printer driver(s)
O Installing USB memory stick (disk on key) driver (for ISONIC 2005 / 2020 / STAR instruments

running under Windows 98 SE Operating System)
O Quasi-disk management
In order to prevent overloading of ISONIC 2005 / 2020 / STAR quasi-disk and memory with data and non
ISONIC 2005 / 2020 / STAR software that may affect instrument performance it's not allowed to install non
ISONIC 2005 / 2020 / STAR software except drivers noted above. Affecting of instrument performance
through installing on non ISONIC 2005 / 2020 / STAR software except drivers noted above is the warranty

exemption damage

8.7. Connection to Network

To connect ISONIC 2005 / 2020 / STAR to local area network using Ethernet connector (refer to paragraph
4.2 of this Operating Manual) and standard Windows rules

ISONIC 2005/ 2020 / STAR from Sonotron NDT - Operating Manual — Revision 2.38 - Page 276 of 380



8.8. External USB Devices
8.8.1. Mouse

Use one of 2 USB Connectors (refer to paragraph 4.2 of this Operating Manual). ISONIC 2005 / 2020 /
STAR founds and registers external USB mouse automatically through standard Windows routine. Microsoft
optical mouse is recommended

8.8.2. Keyboard

Use one of 2 USB Connectors (refer to paragraph 4.2 of this Operating Manual). ISONIC 2005 / 2020 /
STAR founds and registers USB keyboard automatically through standard Windows routine. Microsoft
keyboard is recommended

8.8.3. Memory Stick (Disk on Key)

Use one of 2 USB Connectors (refer to paragraph 4.2 of this Operating Manual)

ISONIC 2005 / 2020 / STAR running under Windows XP Embedded founds and registers USB memory stick
(disk on key) automatically through standard Windows routine.

For ISONIC 2005/ 2020 / STAR instruments running under Windows 98 SE preliminary driver setup is
required. To install driver use network connection (refer to paragraph 8.5 of this Operating Manual)

8.8.4. Printer

Use one of 2 USB Connectors (refer to paragraph 4.2 of this Operating Manual). Preliminary driver setup is
required. To install driver use network connection (refer to paragraph 8.5 of this Operating Manual) or USB
memory stick (disk on key) if it's already registered in ISONIC 2005 / 2020 / STAR
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8.8.5. ISONIC Alarmer

For a variety of manual and automatic inspection applications it may be necessary:

genrating sound alarm on defect detection

controlling some external devices, such as sorters, multi-element go/no go display panels, etc
starting inspection and recording process upon receiving triggering signal from an external device
etc

A variety of above tasks is resolved by simple ISONIC Alarmer (part # SE 554780987), which is interfaced
to ISONIC 2005 / 2020 / STAR, 2006, 2007, 2008 instrument through USB port

e ISONIC Alarmer may be connected to the instrument at any moment since ISONIC 2005 / 2020 /
STAR Start Screen became active (refer to paragraph 4.3 of this Operating Manual)

e ISONIC Alarmer may be disconnected from the instrument at any moment prior to shut down (refer
to paragraph 4.3 of this Operating Manual)
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ISONIC Alarmer includes:

Internal Speaker, which is switched ON / OF according to alarm logic settings of UDS 3-5 Pulser
Receiver in the ISONIC 2005 / 2020 / STAR, 2006, 2007 instruments / UDS 3-6 Pulser Receiver of
ISONIC 2008 Instrument

Speaker Volume Control Wheel

Headphone Connector

Input / Output Control chip

25-pin programmable Input / Output interface

Input / Output 25-pin programmable Input
Controller Chip [ Output interface

Internal
Speaker

USB Port for Headphone Speaker Volume
connection to ISONIC Connector Control Wheel
2005, 2006, 2007,

2008 Instrument

Initially ISONIC Alarmer is configured to deliver sound through speaker and headphone connector (standard
configuration)

25-pin input / output interface is configured according to the duty book, which is agreed with the customer
(optional configuration)
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Standard configuration pin-out of 25-pin input / output interface D-Type connector is shown below:

3
_ 0
GBI o 27_GND
GB2__15
~GB3 3| _Oo 26 GND
— T .°
—Tme T °
—GB 5 1.°
J
GAD 18 °
GAL__6 0
GAr 101 °
GA3 7 0
—_——0
—GasgT©
—Ga6 o1 1 °
Al o 1.°
— > [ °
o O
PR
11 0
P
P PR
%510
E] O
_o
/ ~
D Comnector 25
Pin Function

Numbe

Ground

Alarm Gate B — Channel 1 (Only Channel for ISONIC 2005 / 2020 / STAR, 2006)

Alarm Gate B — Channel 3

Alarm Gate B — Channel 5

Alarm Gate B — Channel 7

Alarm Gate A — Channel 1 (Only Channel for ISONIC 2005 / 2020 / STAR, 2006)

Alarm Gate A — Channel 3

Alarm Gate A — Channel 5

Alarm Gate A — Channel 7

NC

NC

NC

NC

Alarm Gate B — Channel 0

Alarm Gate B — Channel 2

Alarm Gate B — Channel 4

Alarm Gate B — Channel 6

Alarm Gate A — Channel 0

Alarm Gate A — Channel 2

Alarm Gate A — Channel 4

Alarm Gate A — Channel 6

NC

NC

NC

NINNNNN (R (R (R(R PR Rk
g~ W|N|P|O|o|m|~N|o|o|r|w|N|k|o|©R (N o0~ IWIN -

NC
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8.9. External VGA screen / VGA projector

Connect to appropriate connector (refer to paragraph 4.2 of this Operating Manual) while at least one of 2
devices either ISONIC 2005 / 2020 / STAR or external screen / projector is switched OFF then switch on one
or both devices

8.10. Software Upgrade

Refer to http://lwww.sonotronndt.com/support.htm in the Internet

8.11. ISONIC Office and ISONIC Office 2005 Software packages
for office PC

ISONIC Office and ISONIC Office 2005 software packages allow performing of all-function postprocessing
for all types of inspection files captured using ISONIC 2005 / 2020 / STAR in an office PC. All
postprocessing procedures are identical to the postprocessing procedures and menus inside the unity itself.
If Microsoft Word is installed in an office PC then at any moment postprocessing snapshots including all
graphics and accompanying setup and / or measurement data may be converted into the MS Word® *.doc
file
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8.12. ISONIC Par2Txt Converter Software package
®

Contents of this chapter is valid for the ISONIC Par2Txt Converter SW Package version 2.0.0.1 or higher

ISONIC Par2Txt Converter converts variously configured *.PAR files created by ISONIC 2001 and ISONIC
2005 /2020 / STAR instruments into *.txt files. Both pure A-Scans and A-Scans accompanied with
frequency domain (FFT) graphs are presented in ASCII format in *.txt files. This allows further off-line signal
analysis using popular software packages Mathlab®, Labview®, and the like

Click on Start then select Programs => ISONIC 5> ISONIC Par2Txt Converter or click on

in the desktop to run ISONIC Par2Txt Converter - window as below appears:
E

w AEG]

=) ISOMIC 2005 Backup Disk A || File Mame | File Type |~
) ISONIC 2005 Results 22 PLIODD034.PAR ISOMIC 2005 FAR File
) ABIScan Inspection 22 PUIOO0035.PAR ISOMIC 2005 PAR File
) B5can(Th) Inspection a2 PLIOOO03E PAR ISOMIC 2005 F&R File
) Floormapl Inspection a9 PLIOOONA7 PAR ISOMIC 2005 PAR File
) t-ABISean Inspection 22 PUO0003E PAF ISOMIC 2005 PAR, File
) tB5can(Th) Inspection 22 PLONO033 PAR ISONIC 2005 PAR File
— ;'gfgrlrl:jp;;t?;g“t"jn 20 p000040.PER ISONIC 2005 PAR File
j L TORD Inpspectim EE PLIO00041.PAR < ISOMIC 2005 PAR File
o T o5 PUDOODA2PAR ISONIC 2005 PAR Fie
) ISONIC 2006 92 PLI000043 PAFy ISONIC 2005 PAR Fie
) TSONIC Biackup Disk 93 PLOO0D44 AR ISONIC 2005 PAR Fie
) ISOMIC Hardware and Firmaware o | [ 05 PUOD004ZRAR ISONIC 2005 PAR File
: o3 PLIO0OZ4E PAR ISOMIC 2005 PAR File

£ *

20 rimgemam ma e et R e a a St

— W’ Convert to Text

E xit

Select the [file of interest] then |click on|
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As a result the corresponding |*.txt file} appears

5) I50MIC 2005 Backup Disk,
0) I50MIC 2005 Results
() ABIScan Inspection
\5) BScan(Th) Inspection
\.5) Floormapl Inspection
() t-ABIScan Inspection
() t-BScan{Th) Inspection
) t-FloormapL Inspection
) TOFD Inspection
) E-TOFD Inspection
) UDS 3-5 Pulser Receiver
) I5ONIC 2006
[5) 150MIC Backup Disk:

L& ISONIC Par2Txt Convertor

[[5) I50MIC Hatdware and Firmaware ..

59 PUIOO0034. PAR
32 PUDNON3E PR
59 PLIOON0O3E PAR
&2 PLIO00037. PAR
o PLIO0O03E PAR
32\ U000039 PAR
32 Qhnnn4n PR
00041, FAR
PUIOOO04T. TiT
59 PUIODDD4Z PAR
32 PUIDOON43 PR
32 PUDNON44 PR
52 PUODDD4S PAR

ISOMIC 2005 PAR File
ISOMIC 2005 PAR File
ISONIC 2005 P4R File
ISOMIC 2005 PAR File
ISOMIC 2005 PR File
ISOMIC 2005 PAR File
ISOMIC 2005 PR File

Text File
ISONIC 2005 PAR File
ISOMIC 2005 F4R File
ISONIC 2005 PAR File
ISOMIC 2005 P4R File

File: M arne File Type ~

< > T R P M
+ |‘|
.
g
" ||1|r " LI | i
y ‘1, ¥ [™ ||r_|| II_‘I‘.\f"-'.'l E xit
To preview the contents of *.txt file [double click on its name] or mark it and |click on
& (] bE 0 E L
) [SOMIC 2005 Backup Disk. - File: Type: -

0 ISOMIC 2005 Results
) ABIScan Inspection
5) BScan(Th) Inspection
=) Floormapl Inspection
) t-ABIScan Inspection
5) t-BScan(Th) Inspection
() t-Floormapl Inspection
() TOFD Inspection
) E-TOFD Inspection
) UDS 3-5 Pulser Receiver

() ISOMIC 2008

5 ISOMIC Backup Disk

£

0 ISOMIC Hardware and Firmaware o

3

Fill Hame

Looo0a, . Te=T
22 PUIOOO04Z. PAR
22 PLIODDD43.PAR
29 PUODON44.PAR
29 PLO0ODUS. PAR

20~ mnenae ma e

ISOMIC 2005 PAR File
ISOMIC 2005 PAR File
ISONIC 2005 PAR File
ISOMIC 2005 PAR File
ISONIC 2005 PAR File
ISOMIC 2005 PAR File
ISONIC 2005 PAR File
ISONIC 2005 PAR File

ISONIC 2005 PAR File
ISOMIC 2005 PAR File
ISONIC 2005 PAR File
ISONIC 2005 PAR File

[Tt R nintn n it s ]

To end ISONIC Par2Txt Converter session
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8.13. ISONIC D-Line and ISONIC D-Spreadsheet Creator
Software packages

ISONIC D-Line and ISONIC D-Spreadsheet Creator software packages for office computer equipped with
Microsoft®Office allow converting of t-BScan(Th)/BScan(Th) files (special format *.bsi) into Microsoft® Excel
(.xIs) spreadsheet file

ISONIC D-Line

Click on Start then select Programs => ISONIC =* ISONIC D-Line or click on E icon located in the
desktop to run ISONIC D-Line

¢ File > Open allows selection and loading of *.bsi format t-BScan(Th)/BScan(Th) data file

L ISONIC D-Linuk

% ISONIC D-Line
File RiOI

File Name:

Scanned Region Leng

Required L-Resolutiof| ¢ E) 100

File Name:

B500001 bsi

Scanned Region Length: 100 mm

Required L-Resolution:
| ctual (0.2 mm)

—1L —

Create Excel® File
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On completing download:

e ROI > ON - generates cursor representing sound path of probe's central beam in the object under test
that may be guided over t-BScan(Th) / BScan(Th) image using either mouse or , buttons on
keyboard — corresponding A-Scan is recovered synchronously according to cursor position. To select

reference A-Scan left mouse click or press on external keyboard — this generates off-line Gate

A controls n n n n u n allowing to redefine Region Of Interest for t-BScan(Th)

/ BScan(Th) imaging

“%: ISONIC D-Line
File ROI

File Name:

BS00001 bsi

Scanned Region Length: 100 mm

+ o+ o+ o+ o+ o+ o+
+ o+ ok o+ o+ o+ o+
+ o+ o+ o+ o+ o+ o+

Required L-Resolution:
| ctual 0.2 mm) ~|

RS

Create Excel® File

Upon completing redefining of Region Of Interest click on — this applies new Gate A to all
captured A-Scans and updates t-BScan(Th) / BScan(Th) image accordingly

To interrupt selection of reference of A-Scan right mouse click or press @ on keyboard

To interrupt re-adjustment of Region Of Interest after selection of reference of A-Scan click on

¢ ROI>OFF - negates Gate A re-adjustment and returns to originally recorded t-BScan(Th) / BScan(Th)
image and original Gate A setting
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“%; ISONIC D-Line

File ROI

File Name:

BS00001 bsi

Scanned Region Length: 100 mm

Required L-Resolution:
| sctual (~0.2 mm) |
Actual [~0.2 mm)]
0.5

Create Excel® File

4

. |Required L-ResolutionI — this control allows selecting of necessary longitudinal scanning coordinate

increments for depth spreadsheet to be created. Best possible resolution (actual) corresponding to
minimal possible increment is default — it corresponds to single depth reading per each coordinate. On
selecting coordinate increment larger than actual ISONIC D-Line software will analyze all depth

readings with actual resolution for each interval covered by selected increment and place minimal values
into corresponding cells

#

5

—
1 Lancel

File Name:

BS00001. bsi
Scanned Region Length: 100 mm

Required L-Resolution:
|1 mm ﬂ

Create Excel® File

o Create Excel® File — clicking on this button will initiate automatic creation of spreadsheet followed by
starting Microsoft® Excel software

e File>Exit — quits ISONIC D-Line software
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ISONIC D-Spreadsheet Creator

Click on Start then select Programs = ISONIC = ISONIC D-Spreadsheet Creator or click on E icon
located in the desktop to run ISONIC D-Spreadsheet Creator

File > Open allows selection and loading of *.bsi format t-BScan(Th)/BScan(Th) data file

i ISONIC D-Spreadsheet Creator;
File:

File Name:

i ISONIC D-Spreadsheet Creator;

Scanned Region L

Required L-Resol

Scanned Region W

Required X-Resol

File Name:

Example 01.bsi

Scanned Region Length: 100 mm

Required L-Resolution:
| ictual (0.2 mm) |

Create Excel® File

¢ File > Open allows selection and loading of *.bsi format t-BScan(Th)/BScan(Th) data file

All further operations are identical to above described for ISONIC D-Line
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8.14. Charging Battery

Battery of ISONIC 2005 / 2020 / STAR may be charged while disconnected from the unit. The special
charger is required (refer to Chapter 3 of this Operating Manual). Connect charger to the battery as it is
shown below

There is Charge LED on the charger. While charging the battery this LED emits solid light. Charge LED
starts flashing upon charge is completed

®

If a battery is new and almost completely discharged then "boiling" effect in the electrolyte may start earlier
than battery is fully charged. In order to prevent battery charger stops on detecting boiling "boiling" effect:

O |If temperature inside battery does not exceed 60°C deg limit then Charge LED starts flashing — for
such case it is necessary to disconnect charger from mains for few minutes and to connect it to
mains again. The normal charging will continue

Q If temperature inside battery exceeds 60°C deg limit then Temp LED starts flashing — for such case
it is necessary to disconnect charger from mains for at least 2 hours and to connect it to mains
again. The normal charging will continue

After few charge / discharge cycles battery becomes "trained" and probability of "boiling" effect decreases to
almost zero
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8.15. Silicone Rubber Jacket

1. Establishing Image:

POWER®@ LOW-BAT®

Sonotron NDT 7

2. Push the gray buttons of the handle on both sides, and rotate the handle until it is released:

POWER® LOW-BAT®
Sonotron NDT

&
& @®
&) @)=
& @
i)

(%) somiczo0s (] (A
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3. Lift-up and remove the handle:
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5. Slip the Silicone Rubber Jacket around the machine until it fits properly and covers all edges:

POWER® LOW-BAT®

Sonotron NDT

g

(3 ) (%) 1sonic 2005 kL) (&)

6. A view from the back:
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7. Put the handle back in position and twist it until it locks in place:

8. DONE!

POWER® LOW-BAT®
Sonotron NDT
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9. Optional Software Package: ISONIC
Data Logger
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9.1. About ISONIC Data Logger

ISONIC Data Logger is optional software package providing comprehensive data recording, on-site and off-
site editing, importing, exporting, and reporting for routine point-by-point wall thickness gauging. Thanks to
automatic MS Excel® thickness spreadsheet creating ISONIC Data Logger is compliant with various Risk
Based Inspection and Maintenance procedures

ISONIC Data Logger software package includes two utilities:

e ISONIC Data Logger — Instrument for running in ISONIC 2005 / 2020 / STAR and ISONIC 2006
instruments
e ISONIC Data Logger — Office for running in office PCs

ISONIC Data Logger — Instrument utility provides comprehensive data recording for routine point-by-point
wall thickness gauging. At each point operator ads record into selected location in currently open database
file (job) or edits or overwrites record already existing at selected location in the said file. Each record
includes:

e Complete ISONIC 2005/ 2020 / STAR or ISONIC 2006 Instrument setup
e Complete A-Scan obtained in point of gauging

e Corresponding wall thickness (distance) reading either S(A) or As (refer to paragraphs 5.2.12 and
5.2.13 of this Operating Manual)

Each record is equivalent to single *.PAR file (refer to paragraphs 5.2.17 and 5.2.18 of this Operating
Manual) additionally accompanied with corresponding wall thickness (distance) reading

Special *.DLI format is used for database files managed by ISONIC Data Logger. Each *.DLI database file
(job) is organized as two-dimensional matrix whereas each record has unique address. Address is defined
by:

e Row number (may vary from 1 to 999)

e Column number (may vary from 1 to 255 whereas 255 is typical limitation of MS Excel®)

Each *.DLI database file (job) may contain up to 999 X 255 = 254 745 records

For early created *.DLI database file located in ISONIC 2005 / 2020 / STAR or ISONIC 2006 instrument
each record may be recalled, previewed, compared with newly obtained A-Scan and wall thickness
(distance) reading, and either replaced with a new one or untouched — this allows uploading of earlier
obtained results into instrument just before next inspection of the same object and performing point-by-point
comparative testing permanently keeping wall thickness and A-Scan database up to date

ISONIC Data Logger — Office utility processes *.DLI database files imported into office PC. ISONIC Data
Logger — Office utility allows:
e Previewing of captured A-Scans and corresponding wall thickness (distance) readings and
instrument setup
e Editing records in *.DLI database files through off-line Gates and/or Gain readjustment and taking
new wall thickness (distance) reading
e Automatic creating of MS Excel® wall thickness spreadsheet file as it is required by various Risk
Based Inspection and Maintenance procedures (office PC must be equipped with MS Excel®)
e Other functions (refer to paragraph 9.4 of this Operating Manual)
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9.2. Start ISONIC Data Logger - Instrument
1. Switch on ISONIC 2006
[ISONIC 2006 start screen| becomes active automatically upon boot up is completed

[ 1 |operate

[ 2 |settings

[ 3 |Exit To Windows

|4 |shut Down

: Fa
3. Click on | >"™Wn orpress 3 on front panel keyboard or press @ on external keyboard

2.0
s

5. ISONIC 2006 start screen becomes active again - Click on | ™ |or press
panel keyboard or press [F1] on external keyboard . The screen as below appears:

4. Double click on icon at Windows desktop

UDS3-5 - ISONIC Pulser/Receiver

F 2
_J on front

ee K

-y

Range '

23 mm

Ina By

10 US Velocity
5920 mis ‘

e By

0.1 Display Delay
894 us ‘

= Ry

: 3 Reject
0 % ‘

1 by

BASICS PULSER RECEIVER GATE A Menu

uns 2-5

GATE B ALARM DAC/TCG MEASURE Selection
N “|m| = 5 .
Cloze MI ﬂThI’EShCﬂd Freeze Save | Open | Print 0Gs
MNew Job Open Existing Job

I

@pen Record

1]

Save Record
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9.3. Operating ISONIC Data Logger - Instrument
9.3.1. General

Operating surface of ISONIC Data Logger includes main operating surface of UDS 3-5, which may be
controlled in full compliance with chapter 5 of this Operating Manual and 6 (six) additional controls; said
additional controls allow:

Creating new *.DLI database file (job)

Opening existing *.DLI database file (job)

Placing new record into currently open *.DLI database file (job)

Uploading and previewing record from currently open *.DLI database file (job)
Replacing existing record in currently open *.DLI database file (job) with a new one

Yl «
R
ange ‘

28 mm
10 US Velocity

ol «
0.1 Display Delay

el «
: 5 Reject

BASICS PULSER  RECEIVER GATE A Menu "Ds' 3_5

GATE B ALARM  DAC/TCG  MEASURE  Selection

“wBss] ]|

Save Print DGS

UDS53-5 - ISONIC Pulser/Receiver

= Ry

Lo

I By

I By

Ien Ry

[~ [~ I

ciose | I <Thresho|d Freeze Open

”ﬂwﬂ New Job Open Existing Job
! v 1 v Open Record [1]

Save Record
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9.3.2. Creating new *.DLI database file (job)

New Job
Click on then type name of *.DLI database file (job) to be created and click on

Save |or press or press | Save )on front panel keyboard or @ or <Alt>+<S> on external keyboard
m Open Hew Job HE
Saye irt | 'l ISONIC Data Logger = =4

DLO0000T . di

+ |+ + + + + + + +

I B |k B f e B f e By | By

2 ok dk dk ok &

File: narme: ||:Iata logger file dii Save .

Save az lupe: IISEINIE Drata Logager Jaob [=.dli] J Cancel
T 23]l s ][e = |
Gose (BB o JTw]le L e[y 1] || ||E|| l |
alls ||E|| f ||EI| h " j |IE|| | ||Z|| Fxisting Job
Lshitt [z [[x ][ e|[w][n]n][m] |[.]/] = D%

| | |De|| |BS| ,;,;F Record

5

e
DGS

-L[

—[

ESC
To quit above window without creating new *.DLI database file (job) click on ﬂl orpress ' X _Jon
front panel keyboard or @ on external keyboard

®

New *.DLI database file (job) appears physically after adding of first record into
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9.3.3. Opening existing *.DLI database file (job)

Open Existing Job
Click on then select file name and double click on it or click on Upen | or

E-‘; Ente‘r
press | Open )or +=4_J on front panel keyboard or @l or or <Alt>+<0> on external keyboard

UD53-5 - ISONIC P

Look i |l ISONIC Data Logger =] =3

data logger file. dli

+ ’ +
T
BASICS I

|_ File name:  |0LO00O0T i Open |
Close m

Filez of twpe: IISDNIE Drata Logger Jaob [~ di) j Cancel |
A

e o —perrRisting Job
1 ;W A [T
1 1 Open Record | L1]

Save Record

ESC
To quit above window without opening data base file click on ﬂl or press X ) on front panel
keyboard or Esc on external keyboard
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9.3.4. Managing records in currently open *.DLI database file (job)

Address of record is defined through settings of row number and column number, said numbers may be

incremented / decremented through clicking on appropriate button v

Alternatively it is possible to select number for increment / decrement through pressing ' =*1_J on front panel
keyboard or on external keyboard - this highlights sequentially UDS 3-5 Main Menu topics and ROW /
COLUMN controls as well

If one of ROW / COLUMN controls is highlighted then its name is indicated using white characters:

There is no one of ROW / COLUMN controls highlighted

B
_——

It is possible to increment / decrement number for highlighted control through pressing !_ » on front
panel keyboard or [T/ ¥ on external keyboard

If one of ROW / COLUMN controls is highlighted then it is possible to select another one of them through

pressing on 2/ / . on front panel keyboard or —{/ «— on external keyboard

It is also possible to click on either ROW or COLUMN control name or value to highlight one and then to
operate as it is described above
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Since address of record is selected:

UDS53-5 - ISONIC Pulser/Receiver

2 Gain
52 dB ‘

[

Bl +

Meas Mode
Flank-First ‘

0.1 Probe Delay
8.94 us ‘

-
4

10 Angle '
i U [w}

-
5

BASICS PULSER RECEIVER GATE A Henu

B Uns 3-5

GATE B ALARM DAC/TCG MEASURE Selection
[ [ = =)
ciose | | 18.6 mm Freeze ﬁ w Save | Open | Print
-EE-A COLUMN A New Job Open Existing Job
h 4 1 hd n
Save Record

is disabled then there is no record identified by selected address — record cell is

(1]

Save Record

empty. To fill cell identified by selected address with a record click on or press

I J on front panel keyboard or B on external keyboard

@ Saving of a record is possible if:
e There is either s(A) or As reading selected (refer to paragraph 5.2.12 of this Operating Manual)
e First back wall echo signal exceeds Gate A level provided that s(A) reading is selected

e First back wall echo signal exceeds Gate A level and second back wall echo signal exceeds Gate
B level if As reading is selected

ISONIC 2005/ 2020 / STAR from Sonotron NDT - Operating Manual — Revision 2.38 - Page 300 of 380



UDS53-5 - ISONIC Pulser/Receiver

= Ry

2 Gain
P «

Meas Value
s K

Meas Mode
Ee «
0.1 Probe Delay
T
il «
BASICS PULSER  RECEIVER _ GATE A Menu "Ds' ? 5
GATE B ALARM  DAC/TCG  [ICIZGILIEN  Selection

[~ [ T || " & “

Close MI 186mm Freeze Save | Open | Print DGSs

MNew Job Open Existing Job
B
3 v 1 v Open Record L1}

Save Record

Ine By

I By

I By

In By

Open Record

is enabled then cell identified by selected address is filled with a record. Clicking

Open Record

on will upload instrument setup and A-Scan; Freeze mode of operation becomes
active allowing to preview / process uploaded record completely according to paragraph 5.2.15 of this
Operating Manual

To replace existing record in the cell identified by selected address with a new one click on

1]

Save Record

or press I J on front panel keyboard or on external keyboard

9.3.5. Export of *.DLI database file (job)

*.DLI database file (job) may be exported at any moment either through copying onto USB memory stick

Alternatively it may be copied directly onto disk of remote computer provided that both ISONIC 2005 / 2020 /
STAR or ISONIC 2006 instrument and remote computer are connected to LAN and the appropriate sharing
is possible
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9.4. Operating ISONIC Data Logger — Office PC

2.0

To start ISONIC Data Logger Office double click on ?T‘;IE icon at Windows desktop or go through Start >
Programs - ISONIC - ISONIC Data Logger Office

@ ISONIC Data Logger. Office

Open Job

——

mﬂ CoLum fI
Y b

Open Job

In the appeared window click on or go through File > Open — this allows to specify
location of *.DLI database file (job) through standard Windows™ procedures and to open *.DLI database file
(job) then
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Upon opening *.DLI database file (job) file first available valid record is uploaded

[ ISONIC Data Logger Office\\ Job: Example - Data Base. dli =]

-

o B
p

Ira By

1 aStart
srmm R

oo By

2 awidth
215 K

= By

1 aThreshold

o By

Gain:. 52 dB

—ow Y A
1w 1 ¥ Open Record Save Record Open Joh
UDS3.5: Setup Data

BASICS: RECEIVER: GATE A: MEASURE:

Gain = 52 dB Filter = 4 MHz aSwitch = Ok Probe Delay = 8 94ps

Fange = 28 mm Freguency = 0.7-13 MHz aStart = 5.1 mm Angle = 0°

Reject =0 % Display = FULL aThreshold =15 % Measuring Mode = Flank-First

Dizplay Delay = 5.94ps aticth = 21 .5 mm

Us Welocity = 5920 mis DAC/TCGDGS:

hode = OFF

PULSER: ALARM: GATE B: Rec =20

hfode = DUAL aSwitch = OFF hSwitch = OFF Curve = OFF

Pulze WWidth = 103 n= alogic = POSITIVE bStart = 15.4 mm

PRF =315 Hz bSwitch = OFF bThreshold = 46 %

Darmping = 1000 £2 blLogic = POSITIVE kiidth = 259 mim

Tuning = 2 pH

Itis Eossible to upload another record through defining its address in the record address bar

L coLumn N

l— Open Record
8 ¥ 2 ¥ continued by clicking on I » Which is enabled if the

address of record in not empty

Its is possible to readjust Gates and/or Gain in £6dB range for uploaded record as well as to perform A-
Scan signals evaluation in accordance with Chapters 5.2.5, 5.2.6, 5.2.7, 5.2.12, and 5.2.13 of this Operating

Manual
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To correct reading record S(A) or AS in open *.DLI database file (job) off-line readjustment of Gate A or
both Gates A and B, or changing Gain if necessary. Such need may occur if wrong reading was detected
off-line as it is illustrated by screenshot below — while in the field there was al disturbance signal appearing in
the Gate A before back wall echo and wrong thickness reading of 5.9 mm was taken into data base cell
defined by row # 8 and column # 2. To replace wrong reading in the database cell it is sufficient to readjust
position and width of Gate A to avoid its matching with disturbance signal. As a result correct reading of 18.6
mm is obtained

[ ISONIC Daia Logger Office\\s Job: Example - Data Base. dli

Active Gate
.

a5 h
.

1 aStart
.

2 awidth
.
|‘ < 1 aThreshold
Illgl'l~.;:||'||ll1|lr'|'U‘u,, * " i " y 15 %

Ino By

hdh dh dh 4) 4

Gain: 52 dB g Measurements:  s(A): 5.9 mm EI]

—ow IV cotm PN
lfiI lfiI

Active Gate
BASICS: RECEIVER: Gate A ‘
Gain=52dB Fitter = 4 hH:
Range = 28 mm Frequency ‘
Reject =0 % Dizplay = FU
Display Delay = 8.94pz 1 aStart
Us Welocity = 5920 mis aver ‘

4 mm

PULSER: ALARM: 2 idth
Mode = DAL aSwitch = 0) ‘
Pulse Width = 105 nS aLogic = PO T . 14.3 mm
PRF =315 Hz bSwitch = O i ||l1|‘ —_—i : 1 aThreshold
Damping = 1000 bLogic = PO Ilg+ 4t \
Tuning = 2 pH o AT, . 15 %5
Gain: 52 dB g Measurements:  s(A): 18.6 mm nl}
_Row ___F]__coumn___}X 0 R 1 S R 1 0 Jol
’# .' ’f .' pen Record ave Recorid penJob
UDS3-5: Setup Data
BASICS: RECEIVER: GATE A: MEASURE:
Gain =52 dB Fitter = 4 MHz aSwwitch = CN Frobe Delay = 59443
Range = 26 mm Frecuency = 0.7-13 MHz aStart = 5.1 mm Angle = 0°
Reject = 0% Display = FULL aThreshold =15 %  Measuring Mode = Flank-First
Display Delay = § S4ps avicth = 21 .5 mm
US Welocity = 5320 miz DAC TCGDGS:
Mode = OFF
PULSER: ALARM: GATE B: Rec =20
tlode = DUAL aSwitch = OFF hSwitch = CFF Curve = OFF
Pulse Width = 103 nZ alogic = POSITIVE bStart = 15.4 mm
FRF =315 Hz bSwitch = OFF kThreshold = 46 %
Damping = 1000 £2 hLogic = PCSITIVE bhvicth = 25.9 mm
Tuning = 2 pH
o Save Record ) . ) ] o
Clicking on will modify record in the database cell with a new one containing proper
reading
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Open
Records List

Convert to Par File
Convert A-Scan to Txk File
Export Database

Prink Ta
Prink

Gain:

N
62 dB v

.y f"Il“’ ||||||| 'II'1J'I'1|,'| +

Active Gat
Rl «
Switch
Bl «
1 aStart
R «
2 a'w'ldth
B «

aT hrezhold

— row I A
8wl 2 ¥ COpen Record Save Record Open Joh
UDS3-5: Setup Data

BASICS: RECEIVER: GATE A: MEASURE:

Gain =352 dB Fitter = 4 MHz aSwitch = Okl Probe Delay = 8.94ps

Fangs = 28 mm Freguency = 0.7-13 MHz aStart =124 mm Angle = 0°

Reject =0 % Display = FULL aThreshold =15 %  Measuring Mode = Flank-First

Dizplay Delay = §.94ps avvicth = 14.3 mm

IS Yelocity = 5920 mis DAC TCG/IMGS:

Mode = OFF

PULSER: ALARM: GATEE: Rec =20

hode = DAL aSwitch = OFF bSwitch = COFF Curve = OFF

PulzeWidth = 105 ns alogic = POSITIVE hStart = 15 4 mm

PRF =313 Hz bSwitch = OFF bThreshold = 45 %

Darmping = 1000 £ blLogic = POSITIVE Eivicth = 25 .9 mim

Tuning = 2 pH
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File > Records List opens complete list of valid records in the database:

[
o
X)

-
il 2
DLNE s ) ppper 0 iﬂ »
Row Colurmn Thickness ~ B
am om 227 mm =
am 00z 14.6 mm fl »
a0z om 227 mm =
oz ooz 18.6 mm "8
ooz om 18.7 mm ] .
ooz 0oz 18.7 mm E
Qo4 om 14.6 mm
7 o4 0oz 14.7 mm
o5 om 18.6 mm
iTh 05 (e 6.9 mm
3 006 001 10.7 mim ob
goee....._____ |02 | 107mm |
ooy oo £.9
BASICS: ooy 0oz 14.6 mm
ain = 52 ofl|| 002 om 227 mm
Range = zal nos ooz 5.9 mm P
RE]EDt=|:|° nnoa nrd U7 T rnrn St
Display Del =
LIS Velocit Open Record E xit ‘
PULSER: ALARIT: GAIEB: Tec = o
Mode = DUAL aSwitch = OFF hSwitch = OFF Curve = OFF
Pulze Width = 103 n% alogic = POSITIVE bStart = 184 mm
PRF = 315 Hz hSwitch = OFF bThreshold = 45 %
Damping = 1000 £ bLogic = POSITIVE Kiyicth = 25.9 mm
Tuning = 2 pH

. L . . Open Record ‘
To upload record double click on it in the popup records list or click on

To return to main ISONIC Data Logger Office operating surface without uploading record click on ﬂ oron

or press [Esd

File > Convert to PAR File converts uploaded record into single *.PAR file for ISONIC 2005 / 2020 / STAR or
ISONIC 2006

File > A-Scan to Txt File converts A-Scan from uploaded record into ASCII code *.TXT file for further
processing by various software, for example Mathlab®, Labview®, etc or some proprietary software package
— this function is equivalent to Par2Txt Converter software package performance (refer to paragraph 8.10 of
this Operating Manual)

Exit
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File > Export Data Base takes all S(A) and As wall thickness (distance) readings existing in the records of

*.DLI database file (job) and converts them into MS Excel® spreadsheet provided that MS Excel® is installed
in the office PC

For example there are two MS Excel® spreadsheets shown:

Ed Microsoft Excel - Book1 Ed Microsoft Excel - Book?2

File Edit Wiew Insert Format Tools Data  Windc @ File Edit Miew Insert Format Tools Data  Windc
eSS &Y §BRT « DS LY 8BRS ©
Arial -0 - |\B I O E = Arial -0 - B I U = =
| B9 | = £ 5E999956645559 | B9 | = | 18.60000038 14657

A, B C D &, B C O

1 Coll Col2 1 Coll Col2

2 2267 14 5 2 2267 14.6

3 22 BT 186 3 22 BT 18.6

4 18.67 18.67 4 18.67 18.67

5 146 14 67 5 146 14 67

5] 186 B.95 5 186 £.95

7 10.67 10.74 7 1067 10.74

o £.88 14 6 g F.88 14.6

9 22 67 I 589 1 9 2267 I 18.6 _|

10| 2267 22 BT 10 2267 22 BT

11 22 BT 22 BT 11 22 BT 22 EF

12 12

12 12

First spreadsheet (Book 1) was created directly from *.DLI database file (job) without measurement
correction for cell corresponding to row # 8 and column # 2 as in the example above. Second spreadsheet
(Book 2) was created from database file where record corresponding to row # 8 and column # 2 was
corrected as in the example above

File > Print To defines default printer among plurality of available printers. MS Word® may be designated
as default printer provided it installed in the PC. If MS Word® is defined as default printer then *.doc file is
created instead of plotting on a paper sheet

File > Print prints out A-Scan accompanied with instrument setup and automatic measurements data
corresponding to uploaded record

File > Exit or clicking on ﬂquits ISONIC Data Logger — Office
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10. Optional Software Package:
MULTISCAN COMBO S ME
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10.1. Introduction into ISONIC MULTISCAN COMBO S ME

ISONIC MULTISCAN COMBO S ME is optional software package featuring ISONIC 2005 / 2020 / STAR
instrument with the ability of mechanically encoded manual XY-scanning using straight beam single element
or dual probes with 100% raw data recording and real time C-, B-, D-Scan imaging. Refer to paragraph 3 of
this Operating Manual for brief characteristics of MULTISCAN COMBO S ME is optional software package

®

O To perform mechanically encoded scanning probe to be mounted into scanning mechanism driven either
manually or automatically

O Scanning mechanism to be equipped with 2 incremental encoders

O Interface between scanning mechanism and ISONIC 2005 / 2020 / STAR instrument is provided by Dual
Axis Encoder USB Interface — order code S 808440
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10.2. Setup of ISONIC MULTISCAN COMBO S ME Optional SW
Package and Activation of SW Driver for Dual Axis Encoder
USB Interface

If MULTISCAN COMBO S ME optional software package was ordered at the time of sale of new instrument
then ISONIC 2005 / 2020 / STAR Instrument comes pre-installed

To setup MULTISCAN COMBO S ME optional software package into ISONIC 2005/ 2020 / STAR
instrument or to upgrade existing version with a new one

10.2.1. From CD Through Network

o Exit to Windows (refer to paragraph 8.4 of this Operating Manual)
o0 Connect the ISONIC 2005 / 2020 / STAR to your local network
o Switch on the local computer, which is also connected to the local network and equipped with the CD
drive
0 Provide sharing for the CD drive, i.e. the CD drive must become accessible from the ISONIC 2005 /
2020 / STAR via the local network
o0 Insert the CD into the drive
0 Onthe ISONIC 2005/ 2020 / STAR double click Network Neighborhood icon and then find the shared
CD drive in the network and double click on its icon
o Double click the icon of Software Package Setup folder
o For each application to be upgraded perform the following sequence of operations:
a Double click the icon of the corresponding folder
O Run setup.exe program placed in this folder
O The prompt to delete previous installation of application will appear. Click on Yes and follow the
instructions appearing on the screen, confirming all requests by clicking on Yes, OK or other
corresponding buttons
O Upon uninstall procedure completed run setup.exe program again
O Follow the instructions appearing on the screen, confirming all requests by clicking on Yes, OK or
other corresponding buttons

10.2.2. From USB Memory Stick (Disk on Key)

If memory stick (disk on key) is already registered in ISONIC 2005 / 2020 / STAR — copy contents of ISONIC
2005 /2020 / STAR backup CD to memory stick (disk on key) then

o Exit to Windows (refer to paragraph 8.4 of this Operating Manual)

Connect USB memory stick (disk on key) to one of 2 USB Connectors (refer to paragraph 4.2 of this

Operating Manual)

Double Click on My Computer icon

Find icon related to connected memory stick (disk on key) and explore it

Double click the icon of Software Package Setup folder

For each application to be upgraded perform the following sequence of operations:

O Double click the icon of the corresponding folder

O Run setup.exe program placed in this folder

a The prompt to delete previous installation of application will appear. Click on Yes and follow the
instructions appearing on the screen, confirming all requests by clicking on Yes, OK or other
corresponding

O Upon uninstall procedure completed run setup.exe program again

O Follow the instructions appearing on the screen, confirming all requests by clicking on Yes, OK or
other corresponding buttons

o

O 00O
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10.2.3. Activation of SW Driver for Dual Axis Encoder USB Interface

®

Activation of SW Driver for Dual Axis Encoder USB Interface is necessary after first installation of
MULTISCAN COMBO S ME optional software package only

Dual Axis Encoder USB Interface has 3 terminals:

Terminal 1

Terminals 2 and 3

Terminal 1 to be connected to USB socket of ISONIC 2005 / 2020 / STAR instrument via standard USB
cable, included into scope of delivery

Terminals 2 and 3 to be connected to encoders incorporated into scanning mechanism, both are 9-pin D-
Type female connectors. For pin-out of terminals 2 and 3 and recommendation for connecting to encoders
send your inquire to support@sonotronndt.com
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0 Switch ISONIC 2005 / 2020 / STAR Instrument on and wait until ISONIC 2005 / 2020 / STAR start
screen becomes active automatically upon boot up is completed

o0 Exit to Windows (refer to paragraph 8.4 of this Operating Manual)

o]

Connect Dual Axis Encoder USB Interface to USB socket of ISONIC 2005 / 2020 / STAR instrument

POWER @ LOW.BATS

Sonotron NDT

&)
@ @ |
(5) ([w)(=h)m)
® @
o

@ ISONIC 2005

o New hardware wizard starts automatically - click on Next

Add Hew Hardware Whizard

Thiz wizard zearches for new drivers far;

#17 Encoderz Interface - Sonotron NDT

& device driver iz a software program that makes a
hardware device work.

Cancel |
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0 Select Search for the best driver... then click on Next>

Add Hew Hardware Whizard

(EIEETH A e
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0 Select C:\Isonic\Multime\XYSetup then click on OK

Browse for Folder

H-=) Removable Disk [&:]
= [

1 lsonic
El@ Fuiltirne

T aetup
{71 Pulrec3
@ My Docurments
{1 Program Files
H-] Windows
2= (]
- 3350

o Click on Next>

(EIEETH A e

CAISOMICWMULTIME NS etup v
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o Click on Next>

Add HNew Hardware Wizard

“Windowes driver file zearch far the device:

Sonatron DT Mechanical =Y Encoder

Windows ig now ready bo inztall the best driver far this

device. Click Back to zelect a different driver. or click Mest
to continue.

Location of driver;

C:ASONICYMULTIME S0Y SETUPASLABBUS |
=J

Cancel |

o Click on Finish

Add Hew Hardware Wizard

% Sonotron NDT Mechanical #% Encoder

Windaws has finizshed installing the software that your new
hardware device requires.

¢ Harh

Cancel |

®

O New hardware wizard may appear few times in sequence — if so then just repeat it as it is just described
O After completing activation of driver connect Dual Axis Encoder USB Interface to another USB socket of
ISONIC 2005 / 2020 / STAR instrument. If New hardware wizard will appear then just repeat it again
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10.3. Running MULTISCAN COMBO S ME
10.3.1. Preparations

0 Switch ISONIC 2005/ 2020 / STAR Instrument on and wait until ISONIC 2005 / 2020 / STAR start
screen becomes active automatically upon boot up is completed

o0 Exit to Windows (refer to paragraph 8.4 of this Operating Manual)

0 Connect Dual Axis Encoder USB Interface to USB socket of ISONIC 2005 / 2020 / STAR instrument and
to encoders of XY scanning mechanism

POVER & LOW-BAT® Sonotron NDT

|_ﬂ
@) @
@) @)=
&9

L‘!'_nj ISONIC

To Scanning
Mechanism

o Connect probe(s) to appropriate sockets on the top cover of ISONIC 2005 / 2020 / STAR instrument
¥
o Double click on [l

this

icon at Windows desktop
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10.3.2. MULTISCAN COMBO S ME Start Screen
[MULTISCAN COMBO S ME start screen| is identical to

[ 1 |operate

[ 2 |settings

[ 3 |Exit To Windows

|4 |shut Down

N

- -
Click on Lo Jorpress 1 on front panel keyboard or press El on external keyboard to run
MULTISCAN COMBO S ME inspections

= F
Click on &J or press 2 on front panel keyboard or press @ on external keyboard to proceed
with general settings of ISONIC 2005 / 2020 / STAR — refer to Chapters 7 and 8 of this Operating Manual
and with calibration of encoders incorporated into scanning mechanism — refer to paragraph 10.3.3 of this of
this Operating Manual

: -
| 3 |Exit To Windows
Click on —J or press _3 Jon front panel keyboard or press on external keyboard if it is
necessary to fulfill some general purpose Windows procedures such as setting up drivers for external

devices (printers, USB memory card, and the like), connecting to LAN, quasi-disk management, etc — refer
to Chapter 8 of this Operating Manual

T ' -
To turn ISONIC 2005 / 2020 / STAR off click on """ Jor press on —%_ on front panel keyboard or

press on external keyboard — the screen as below appears

ISONIC
is
shutting dovvn

followed by the shut down completion screen:

It's now safe to turn off
the ISONIC

Set power switch into (0] position upon

®

After turning ISONIC 2005 / 2020 / STAR OFF wait at least 10...30 seconds before switching it ON again
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10.3.3. Calibration of Encoders Incorporated into Scanning Mechanism

It is necessary to calibrate encoders encoder incorporated into scanning mechanism for each new scanning
mechanism prior to running of MULTISCAN COMBO S ME inspections

[1]|operate

[ 2 |settings

[ 3 |Exit To Windows

|4 |shut Down

F
in the MULTISCAN COMBO S ME start screen or press 2 on front

panel keyboard or @ on external keyboard

To proceed with calibration

| 1 ]Language

[2|measurement Unit

@ Encoders

rinter Selection

\5 Back L‘\
\ o

In the appeared ISONIC 2005 / 2020 / STAR Settings Menu or press _3 J on front panel
keyboard or @ on external keyboard
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10.3.1.1. List of Scanning Mechanisms

-t

Add

-t

Edit

Delete

;

- N
| Close

N

bl
. Add . . . .
a Clickon l_, to start new calibration of encoders of new scanning mechanism

0 Select name identifying scanning mechanism already existing in the memory of ISONIC 2005 / 2020 /

bl
STAR instrument and click on | et , to edit selected name and to recalibrate / recheck if necessary

0 Select name identifying scanning mechanism already existing in the memory of ISONIC 2005 / 2020 /

b
STAR instrument and click on lﬁ, to erase data about said scanning mechanism from the memory
of ISONIC 2005 / 2020 / STAR instrument

( ] ESC
O Click on | cose_ or press L) on front panel keyboard or Esc| on external keyboard to return to
ISONIC 2005/ 2020 / STAR Settings Menu
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10.3.1.2. Name of Scanning Mechanism

Type / edit |name identifying scanning mechanis

Encoder Name

MyNewEncoder]

(=L el Il L [~ JLa = [LedD [T L= 1L ]
AN EEnnoERn
[alls [0l F]leln[slrflL]l:]["]

IR (2 | |[c[v[e][w][m] <][> ]z ] [Enter]

| I

Cancel Next

*

then click on [E Or press or press LJ on front panel keyboard or on external keyboard to

proceed with calibration / recalibration / recheck of encoders incorporated into scanning mechanism

C 1 \ ESC
To return to previous screen click on [E or press Lj on front panel keyboard or @ on external
keyboard

ISONIC 2005 /2020 / STAR from Sonotron NDT - Operating Manual — Revision 2.38 - Page 320 of 380



10.3.1.3. Encoders Calibration Data - Manual Key-In

Check Manual option, select mm / inch units then key-in value of Ticks (per Unit) generated by X-Axis / Y-
Axis encoders:

100

Calibrate
¥ - AXis

Fy
i+ Manual 2 000 ﬂ Per H

« Auto | 100 :I |mm 'I
- Calibrate

[ES | 0.0 mm | 0.0 mm

F I‘I o F
{ < Back[Esc]J l Restore Defaults { Finish J{ Cancel J
&

- |

( ESC
Clicking on l {BaCKIESCIJ pressing ' & )on front panel keyboard or ESC on external keyboard will return to
previous screen

A
Clicking on [ Restore Dm""s, will reset calibration data to defaults

Clicking on l Finish Jwill store new calibration data and return to list of names identifying scanning
mechanisms in the memory of ISONIC 2005 / 2020 / STAR instrument

Clicking on l Cancel Jwill return to list of names identifying scanning mechanisms in the memory of ISONIC
2005 / 2020 / STAR instrument without storing new calibration data

Clicking on l Test Jallows to perform motion of probe fitted into scanning mechanism for checking

functionality and precision of incorporated encoders (X and Y axis). l Reswsmpj button occupies place of

Test upon pressing on it andprobe coordinates are indicated in the X and Y boxes. Click on

| Reset /st . .
e o complete checking and reset X,Y readings to 0
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10.3.1.4. Encoders Calibration Data - Automatic Acquisition

Check Auto option, select mm / inch units then key-in value of (Reference) Distance to be passed by
probe for automatic calibration of X-Axis / Y-Axis encoder.

For each axis:

a Click on Calibrate

A
@ Auto 100 il mm .

Ao A
0 ;nutu¥ 100 ﬂ mm v

- Calibrate
Test
[ES ] | 0.0 mm | 0.0 mm

o F I‘I
{ < Back[Esc]Jl Restore Defaults { Finish J{ Cancel
&

e /
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a Perform motion of probe fitted into scanning mechanism for each axis providing that probe will pass

Enter
keyed-in (Reference) Distance then click on OK or press ' *=_ on front panel keyboard or
on an external keyboard upon completing

i~ Manual A

| 2.000 II Per |mm v|
F'y
¥ mim -

* Auto 100

Calibrate

ISONIC Multiscan Combo-5 ME

Flease move the probe an the = axiz for 100 mm and perzs 0K when done.

| Calibrate
Test
] | 0.0 mm | 0.0 mm

{‘:Back[Esc]Jl Restore Defaults { Finish J{ Cancel J
&

( ESC
Clicking on l <Ba°k[ES°]J pressing X ) on front panel keyboard or ESC on external keyboard will return to
previous screen

3
Clicking on l Restore Dm""s, will reset calibration data to defaults

Clicking on l Finish Jwill store new calibration data and return to list of names identifying scanning
mechanisms in the memory of ISONIC 2005 / 2020 / STAR instrument

Clicking on l Cancel Jwill return to list of names identifying scanning mechanisms in the memory of ISONIC
2005 / 2020 / STAR instrument without storing new calibration data

Clicking on l Test Jallows to perform motion of probe fitted into scanning mechanism and to check

functionality and precision of incorporated encoders (X and Y axis). l Reswsmpj button occupies place of

Test upon pressing on it andprobe coordinates are indicated in the X and Y boxes. Click on

| Reset /St . :
oo complete checking and reset X,Y readings to 0
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10.3.4. Start MULTISCAN COMBO S ME Inspections

[1]|operate
With reference to paragraph 10.3.2 of this Operating Manual in
the MULTISCAN COMBO S ME Start screen click on

| 2 |Set1|ngs = -
1 |Operate N
or press ' _J on front panel keyboard or press

ﬂ on external keyboard to run MULTISCAN COMBO S ME
inspections — this will enter next stage related to calibration of
UDS 3-5 pulser receiver

[ 3 |Exit To Windows

|4 |shut Down

10.3.4. Pulser Receiver Settings

Calibration of UDS 3-5 Pulser Receiver to be provided with reference to Chapter 5 and paragraphs
10.3.4.1, 10.3.4.2, and 10.3.4.1 of this Operating Manual

UDS53-5 - ISONIC Pulser/Receiver

Yl «
Bl «
2 Start
e K

01  awidth
19.3 mm

[P
uns 3-5

I By | e By | no By f = By
vdh dh 4h b 4

I By

BN B=|a N
Cloze ml Freeze ﬁ é Save | Open | Print DG5S

ESC
To return to previous screen click on &' or press L) on front panel keyboard or @ or

<Alt>+<C> on external keyboard

I
On completing calibration click on _| or press L on front panel keyboard or on external

keyboard
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10.3.4.1. Pulse Echo - Flaw Detection

# | Parameter or Submenu Required Settings Note
Mode
1 | aSwitch GATE A ON
2 Gain BASICS Gain setting to be performed according
to inspection procedure providing
required echo heights from defects to be
detected
3 aThreshold GATE A aThreshold settings to provide echo
heights from defects to be detected
exceeding aThreshold; signals from
other reflectors — not exceeding
aThreshold
4 DAC/TCG DAC/TCG DAC/TCG settings to meet requirements
of inspection procedure
5 Pulser Mode PULSER Dual for dual element probes
Single for single element probes
6 Tuning, Pulse Width, | PULSER Tuning, Pulse Width, Firing Level, To synchronize with Gain
Firing Level, and Damping settings to provide and aThreshold setting
Damping optimal signal to noise ratio procedures
7 Filter, Frequency RECEIVER Filter and Frequency settings to match | To synchronize with Gain
with probe's frequency and aThreshold setting
procedures
8 Display RECEIVER Display setting may be either Full, RF, The same Display mode to
PosHalf, or NegHalf be used for both Probe
Delay determining and
MULTISCAN COMBO S
Recording
9 USVelocity BASIC USVelocity setting to be equal to actual
value of ultrasound velocity in the object
under test
10 | Probe Delay MEASURE Probe Delay setting to be equal to Probe delay may be
actual probe delay determined according to
paragraph 5.2.13.7 or
5.2.13.9 of this Operating
Manual or similarly
11 | Angle MEASURE Angle = 0°
12 | Meas Mode MEASURE Flank
13 | Range, Display BASIC Range, Display Delay, aStart, and
Delay, AStart, GATE A aWidth settings to be performed with
aWidth reference to below table Region of
Interest for MULTISCAN COMBO S
14 | Settings for other

parameters and
modes have no
significance
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Region of Interest for MULTISCAN COMBO S

. Scannin

Surface to ROI Distance

Surface

ROl Width -~ ROl = Region of Interest
Defect
Initial
Pulze
SRD = aStart
Case 1 -
preferred —_— RW = aWidth
embodiment !
| Dizplay Range
" Delay
Initial DisplavDel
Pulse SRD = Mx USVelocity
Case 2
N RW = aStart + aWidth — SRD
]
Display Range
" Delay
Initial
Pulze SRD = aStart
Case 3 B RW = w xUSVelocity +
Tmsplw Range + Range — aStart
" Delay
Initial
Pulze ]
SRD = DISPIYDelay e e 1ocity
Case 4 2
0 RW = Range
| Display Range
" Delay
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10.3.4.2. Back Wall Echo Attenuation and Through-Transmission

# | Parameter or Submenu Required Settings Note
Mode
1 Gain BASICS Gain setting to be performed according
to inspection procedure providing
required amplitude of back wall echo or
through-transmitted signal
2 | aSwitch GATE A ON
3 Range, Display BASIC Range, Display Delay, aStart, and
Delay, aStart, aWidth | GATE A aWidth settings to be performed to
provide presence of back wall echo or
though-transmitted signal on the A-Scan
and time coincidence of evaluated signal
with Gate A
4 DAC/TCG DAC/TCG DAC/TCG settings to meet requirements
of inspection procedure
5 Pulser Mode PULSER Dual for dual element probes and for
through-transmission inspection with
use of two probes
Single for single element probes
6 Tuning, Pulse Width, | PULSER Tuning, Pulse Width, Firing Level, To synchronize with Gain
Firing Level, and Damping settings to provide setting procedures
Damping optimal signal to noise ratio
7 Filter, Frequency RECEIVER Filter and Frequency settings to match | To synchronize with Gain
with probe's frequency setting procedures
8 Display RECEIVER Display setting may be either Full, RF,
PosHalf, or NegHalf
9 Settings for other

parameters and
modes have no
significance
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10.3.4.3. Pulse Echo - Thickness Profiling

# | Parameter or Submenu Required Settings Note
Mode
1 | aSwitch GATE A ON
2 Gain BASICS Gain and aThreshold settings to
aThreshold GATE A provide receiving an echo from the
minimal area of thickness degradation to
be detected; height of the said echo to
exceed aThreshold; signals from other
reflectors less then defined one not to
exceed aThreshold
3 DAC/TCG DAC/TCG DAC/TCG settings to meet requirements
of the Inspection Procedure
4 Pulser Mode PULSER Dual for dual element probes
Single for single element probes
5 Tuning, Pulse Width, | PULSER Tuning, Pulse Width, Firing Level, To synchronize with Gain
Firing Level, and Damping settings to provide and aThreshold setting
Damping optimal signal to noise ratio procedure
6 Filter, Frequency RECEIVER Filter and Frequency settings to match | To synchronize with Gain
with probe's frequency and aThreshold setting
procedure
7 Display RECEIVER Display mode may be either Full, RF, The same Display mode to
PosHalf, or NegHalf be used for both Probe
Delay determining and
Thickness Profile Imaging
8 USVelocity BASIC USVelocity setting to be equal to actual
value of ultrasound velocity in the object
under test
9 Probe Delay MEASURE Probe Delay setting to be equal to Probe delay may be
actual probe delay determined according to
paragraph 5.2.13.7 or
5.2.13.9 of this Operating
Manual or similarly
10 | Angle MEASURE Angle = 0°
11 | Meas Mode MEASURE Flank
12 | Range, Display BASIC Range, Display Delay, AStart, and
Delay, AStart, GATE A aWidth settings to be performed with
aWidth reference to the Region of Interest for
CORROMAP table below
13 | Settings for other

parameters and
modes have no
significance
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Region of Interest for CORROMAP

. Scanning Surface

Surface to ROI Distance = SRD

ROl = Region of Interest

E;Ek Wall Profile

Initial
Pulze
SRD = aStart
Case 1
—_— RW = aWidth
0
Display Range
" Delay
Initial DisplavDel
ISplaybela .
Pulse SRD = %xUSVelomty
Case 2
-1 RW = aStart + aWidth — SRD
0
Dizplay Range
" Delay
Initial
Pulse SRD = aStart
DisplayDelay .
Case 3 L RW = — 5, xUSVelocity +
0 —
| Display Range + Range — aStart
" Delay
Initial
Pulze
DisplayDela .
SRD = 2iplaybetay USVelocity
Case 4 2
0 RW = Range
Display Range
" Delay
Preferred Initial + aStart and aWidth setting to provide
embodimen Pulse 1t back echo appearance of whole Gate A on the A-Scan
t ¢ aWidth = (0.75...0.95) x Range
¢ First Back Echo at the thickest area of object
under test to be fully matching with Gate A
0 — ¢ First Back Echo at the thickest area of object
Display Range under test to "occupy” 5-10% of the Gate A
" Delay width on the A-Scan
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10.3.5. Operating Modes

Operating mode to be selected on completing calibration of UDS 3-5 Pulser Receiver

| 1 |Cormmap

[ 2 |Multiscan

&7

[ 3 |Postprocessing

[4 |Back

— ¥
Clickon ™™ Jor press ' on front panel keyboard or press IEI on external keyboard to run
thickness profiling mode
F

Jor press _2_J on front panel keyboard or press El on external keyboard to run

|2 |Multiscan

Click on l
flaw detection mode

E===3 3

. | 3 |Postprocessing 3 |

Click on or press 2 __J on front panel keyboard or press B on external keyboard to start
postprocessing of MULTISCAN COMBO S ME inspection results

=z, F
. 4 |Back | .
Click on o or press on _4_J on front panel keyboard or press to return to previous screen
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10.3.6. Flaw Detection — Pulse Echo / Back Wall Echo Attenuation or
Through Transmission

10.3.6.1. Inspection Setup

Layout of [T KT Ie screen depends on option selected — it is necessary to check Pulse Echo or
Attenuation in the Inspection Method field (click on). Attenuation mode is suitable for both back wall echo
attenuation and through-transmission inspection

Inzpection Setup

p

[l

‘ Region Depth (RD)
’ 120mm j | lg ﬂ | Omm
Region Width (RW) Region Thick (RT)
|1 - Pseudo !" | 120mm ﬂ | 19.3mm

Encoder Type Inspection Type

|Default =] " Pulse Echo  Attenuation
Humber of Colors: 255 | Origin Start | Interval |
il 16 2.2 43 6.4 80 a6 L] 145 161 177 193
| P S PSS SR S S S S N PR S S I S SR S RS S |
N e
dB
-+ rr T T r T T T T T T T T
12 10 g g 4 -2 2 10 12

Inzpection Setup
< Back [E

’ 120mm j | Smm
Region Width {rm-,
1 - Pzeudo 120mm

Encoder Type Inspection Type

| Default =| ¢ Pulse Echo & Attenuation

Number of Colors: 255 | Origin Start | Interval |

| .

T - 1

<Back[ESC]] " Coarse  Medium ¢ Fine l Next > ]

In the LXK (e SCreen it is necessary to key in:

O Length of rectangular scanning area

QO Region Width which defines width of rectangular scanning area

O Scan Index — value of Scan Index defining coverage of scanning area to be selected and entered
according to inspection procedure
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ﬂ
Setting of said parameters to be performed through clicking / pressing corresponding spin button ¥ with
Fine, Medium, or Coarse increments according to checked option (click on) in the Setup Step field

pa—
Alternatively parameter for setting to be selected through pressing ' = Jon front panel keyboard or on
external keyboard or through clicking on its label. Label indicating name of selected parameter changes it's

T » @

fore color from yellow to white — since that moment parameter may be modified using =/, ' - =/, u../',

_'!;, on front panel keyboard or , , , on external keyboard

Values of Region Depth (RT) and Region Thick (RT) for pulse echo mode indicated in the Inspection
Setup screen are defined by Gate A settings of UDS 3-5 Pulser Receiver:

Region Depth (RD) = aStart

Region Thick (RT) = aWidth

Color scale (palette) representing signal amplitudes and defects coordinates may consist of up to 255

grades. Customizing is possible through corresponding (click on)
- 7 ~

-

-
- N
Humber of Colors: 255 | Origin Start: 0.01 mm, 11.91dB Interval: 0.01 mm, 0.09 dB |

oo 0.3 0.5 Dﬁ 1” 1ﬂ 1P 1@ 2? 25 27 3.0 3.3
P TS A P P S W |

. S
dB

0 & 5 B & o -1z

=
()
ey
o
.
]
ha

Style of palette (Pseudo, Thermal, or Gray) is selectable through clicking :
/

/
2 - Pseudo 2

Encoders calibration data corresponding to scanning mechanism in use is selectable through cIicking
—

Encoder Type - -
—
Drefault -

( EsC
. . < Back [ESC
To return to previous screen click on M or press L) on front panel keyboard or @ on

external keyboard

To continue click on M or press LJ on front panel keyboard or |F&| on external keyboard
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10.3.6.2. Imaging Principles: Pulse Echo

#t Sketch
Al B1
w2
1 L2 Scanning Ares
L1
A Dl Ea—
=
=
a
=
. =
. i
Fedion Wicth
_______ D [ B
E s
k&
=
—
. 5
-, G 6]:5_1"
H
Lencth
Top Yiew
A B

I

|

|

|

|

e ___Dr———————C ’ C
E F.
End View A
.,
.,
A s
H G
Side Yiew

o Q1 (L1, X1, Y1) — Internal Reflector 1
0 Q2 (L2, X2, Y2) - Internal Reflector 2

Note
General

(a) Volume Under Test
(Region of Interest) is
located between two
parallel rectangles namely
ABCD and EFGH

(b) Scanning is provided
above surface of
rectangle A1B1C1D1

(c) With reference to
screen
— Pulse Echo Mode
(paragraph 10.3.6.1 of
this Operating Manual):

0 A1A =Region Depth

o AB =Length

o0 AD = Region Width

o0 DH = Region Thickness

(d) In the present example it
is supposed that there are
two reflectors Q1 and Q2
in Region of Interest,
said reflectors have
different dimensions and
coordinates
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H#Ht Sketch Note

A Top View B Global Top, Side, and End View

Supposing that scanning is well completed
reflectors Q1 and Q2 will be detected and

.Q2 represented in global Top, Side, and End

View according to sketch # 2

Global Top View is obtained through
superimposing of parallel planes between
Q1 rectangles ABCD and EFGH. Global Top
View may be presented in two modes:
Depth Map and Amplitude Map. Amplitude
Map represents distribution of echo
amplitude above scanning surface. Depth
D - - C Map represents distribution of minimum

Side View reflector depth above scanning surface.
Thanks to complete raw data storing

. Q2 technology implemented in ISONIC 2005 /
o1 2020/ STAR it is possible to switch
between Depth Map and Amplitude Map
b while scanning

: Global Side View and End View are

A End View D orthogonal images composed through
. superimposing of corresponding cross

Q2 sectional views along and across of whole
Region of Interest. Side View and End
ey View images represent distribution of
highest echo amplitudes, depth of reflectors
E H and their cross-sectional locations

Acquired data is converted into 3D-matrix
allowing sectional presentation of Top View,
Side View and End View during scanning —
refer to below sketches ## 3 through 8
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H#Ht Sketch Note

Sectional Top View
Al B1 (Horizontal Slice)
L2 w2

Sketches ## 3 and 4 illustrate
composing of sectional Top
X1 View

C1
A D1 - B

Top View section currently
represented on ISONIC 2005

|
T / 2020 / STAR screen
: “ corresponds to:
|
]

D | C Q current probe coordinates
E~ 7T - —.— —————— F"\ . on scanning surface

. O depth of reflector closest

. to probe on A-Scan

. obtained for current probe
. coordinates on scanning
H G surface — Top View
section represents
horizontal slice at depth
corresponding to reflector
closest to probe

Top View
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Sketch

B1

»e

Hit
4
Al
L2
L1
A____ D1 __
——— DL
E
H

ci

Note

Sectional Top View
(Horizontal Slice)

Sketches ## 3 and 4 illustrate
composing of sectional Top
View

Top View section currently
represented on ISONIC 2005
/2020 / STAR screen
corresponds to:

Q current probe coordinates
on scanning surface

O depth of reflector closest
to probe on A-Scan
obtained for current probe
coordinates on scanning
surface — Top View
section represents
horizontal slice at depth
corresponding to reflector
closest to probe
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H#Ht Sketch
> B1
Al Lo w3
L1
x1
Ye
F- N b ) I — '_—I\\E
I
|
Y1 @ |
[
|
0O }
_____ I iy
E 9 Fo~.
H
D
&
H
A
L
E

ci

Note

Sectional Side and End
View (Vertical Cut Slices)

Sketches ## 5, 6, 7, and 8
illustrate composing of
sectional Side View and End
View

Side View section currently
represented on ISONIC 2005
/2020 / STAR screen
corresponds to current X-
coordinate of probe

End View section currently
represented on ISONIC 2005
/2020 / STAR screen
corresponds to current L-
coordinate of probe

ISONIC 2005 /2020 / STAR from Sonotron NDT - Operating Manual — Revision 2.38 - Page 337 of 380



H#Ht Sketch
6
Al X2 B1
L2
L1 -
x1
Ye
F- N © ) I E— _—I\\B
[
Y1 N
| ~
I N
0O }
_____ N iy
E ® F.

D C
L

H G

A D

E H

ci

Note

Sectional Side and End
View (Vertical Cut Slices)

Sketches ## 5, 6, 7, and 8
illustrate composing of
sectional Side View and End
View

Side View section currently
represented on ISONIC 2005
/2020 / STAR screen
corresponds to current X-
coordinate of probe

End View section currently
represented on ISONIC 2005
/2020 / STAR screen
corresponds to current L-
coordinate of probe
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##
7
Al
A
E

Sketch

L2
L1
x1
Ye
SR B.) RS A -
—I\\
|
1
Y1 @ |
|
|
|
——— D —————— o
® F~
H

i

Note

Sectional Side and End
View (Vertical Cut Slices)

Sketches ## 5, 6, 7, and 8
illustrate composing of
sectional Side View and End
View

Side View section currently
represented on ISONIC 2005
/2020 / STAR screen
corresponds to current X-
coordinate of probe

End View section currently
represented on ISONIC 2005
/2020 / STAR screen
corresponds to current L-
coordinate of probe
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H#Ht Sketch

8
Al X2 B1
L2
™,
L1 "
*1
b
F- N b ) I — '_—I\\E
[
| ~
1 . I e
| .
I N
0O }
_____Bb I g
E @ F~.
\'\
.,
.,
\\.
H
D C
H G
A D
E H

10.3.6.3. Imaging Principles: Attenuation

i

Note

Sectional Side and End
View (Vertical Cut Slices)

Sketches ## 5, 6, 7, and 8
illustrate composing of
sectional Side View and End
View

Side View section currently
represented on ISONIC 2005
/2020 / STAR screen
corresponds to current X-
coordinate of probe

End View section currently
represented on ISONIC 2005
/2020 / STAR screen
corresponds to current L-
coordinate of probe

In attenuation mode it is generated Amplitude Map representing distribution of back wall echo amplitude or

through transmission signal amplitude above scanning surface
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10.3.6.4. Scanning: Pulse Echo

ISONIC Multiscan Combo-S InspectionECERREIVAEIiEdInspection SetuplEGEERE

Top Yiew - Depth
o

2 4 & g 10 12

dB

1z 0 2 6 4 -2 o

S
4

0 mm 120 mm

Side Yiew

120

a
o

19.317.7 161 145129113 96 80 64 48 32 16 00
mm

i}
@

Section I Distance  Amplitude | Side End
L < Back [ESC]J { Start [I] J { Clear [Z]J { Save

On opening IONIC [ TIEer Ty oYy Yo SR I Y elYe3 i [e]g) Screen place probe onto zero point of scanning area

then click on Lﬂj or press I Jon front panel keyboard or on external keyboard

| f_,Zero Point .
Al

Scanning Area

c1

A D1 B
—I\- - Ly
N £
| . [
| ~ 2
[ ~ =]
[ . E

",
Region Width !
D T
5 U - cC
F i
LS C
, =
[a]
“ £
b [
", [y
. I
., ]
G ¢
H
Lencth
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During scanning @]\ 1{of\/[V]iEYe-Ts ) ofeT1 0] L R M [§ETeLeTe i{e]3] SCreen is accompanied with A-Scan

Current Probe position

ISONIC Multiscan Combo-5 Inspection
T

-5
. op Yiew - Depth ~ a
N e 7 - 2
+ / 9 -
: ’ g 3
. . 7/ ® =
s s kss
O mm 120 mm : g
o Side View ‘ f
- I—
Global Section I Distance  Amplitude | Side End
{ < Back [ESC]J { Stop [3] J t Clear [Z]J t Save |
ISONIC Multiscan Combo-S Inspectiong{eIIaREET o CEIEICH
Q Current Probe Position
Q Top View:
Amplitude .
o for P pressed down — Global Amplitude Map
Distance
o for pressed down — Global Depth Map
Top Section . . . .
o for pressed down — Horizontally Sliced Amplitude Map according to

sketches ## 3 and 4 — paragraph 10.3.6.2 of this Operating Manual

a Side View for Side | pressed down or End View for End |pressed down or press

pa—
jJ on front panel keyboard or on external keyboard to switch between Side and End View

Global | Section
or

Depending on which button is pressed — — Side View and End View
are presented either in global mode according to sketch # 2 — paragraph 10.3.6.2 of this Operating
Manual or in sectional mode according to sketches ## 5, 6, and 7 — paragraph 10.3.6.2 of this
Operating Manual

®

O All A-Scans are captured during scanning unconditionally however projection images Top View, Side
View, and End View are updated only with signals exceeding threshold of Gate A presented on A-Scan
however

O Highest amplitude and minimal sound path are dominant while recording data into Top View — Amplitude
and Top View — Distance correspondingly

O Map Repair Function is active while keeping pressed LJ on front panel keyboard or on external

keyboard — new readings will overwrite already recorded data unconditionally; this allows record correction
after finding some non-relevant data recorded with dominance
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f F
To cleanup Top View, Side View, and End View fields click on @ or press _2_ on front panel

keyboard or H on external keyboard

. )
To stop scanning click on @ or press 3 on front panel keyboard or ﬁ on external keyboard

( =
To save MULTISCAN record into a file click on lE or press &j on front panel keyboard or @l
on external keyboard. Refer to paragraph 5.2.17 of this Operating Manual to proceed with file saving

. Back [ESC] e
To return to I Iy screen click on | , Or press \_)‘(\ on front panel keyboard or @ on

external keyboard
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10.3.6.5. Scanning: Attenuation
ISONIC Multiscan Combo-S InspectionfeGERRIMEECIdInspection SetupfEEE)H

ISONIC Multizcan Combo-5 Inspection

Scanning Pattem - Top View <=0db
] Length, rom 120

<=2 db

Width, mm

<=4 db

120

<=6 db

<=8 db

<=12db

N =

<= 20db

<= 40 db

[coooniesal] | s | [ cearra | [ s |

On opening [E1e)\1 (eI IETz:T N ofel1y] T RSH I EToIIHAL])] Screen place probe onto zero point of scanning area
then click on Lﬂj or press I Jon front panel keyboard or on external keyboard

| fﬂ__,Zero Point

Scanning Area
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During scanning [Sle]\[(exe] BRI, W I1iETe[I3le] Screen is accompanied with A-Scan and Digital Display box

NS SESEEEsEsSsESEEEAEAEEEREEEEEE

i Current Probe position

:..............7...............:

ISONIC Multiscan Combo-5 Inspection

Scanning Pattem - Top View P d =>0db
[ Length, mom . i

7
e
e
yd => -2 dh

=> 4db

=

7’
7’

Width, mm

120

=> -6 db

== -8 db

% =>_12 db

=>-20 db

=> 40 db

{ < Back [ESC]J { Stop [3] J { Clear IZ]J { Save J
screen represents:

Q Current Probe Position

a Top View as Amplitude Map representing distribution of back wall echo amplitude or through
transmission signal amplitude above scanning surface

p =
To cleanup Top View field click on lﬂj or press _2_ on front panel keyboard or @ on external
keyboard

. )
To stop scanning click on lﬂj orpress 3 on front panel keyboard or B on external keyboard

i =
To save MULTISCAN COMBO S ME record into a file click on llj or press === J on front panel

keyboard or @ on external keyboard. Refer to paragraph 5.2.17 of this Operating Manual to proceed with
file saving

1 ESC
To return to [E IS BT screen click on e 'ESC], or press L) on front panel keyboard or @ on

external keyboard
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10.3.6.6. Postprocessing

Postprocessing of MULTISCAN ME records may be performed directly in the instrument or in external
computer using IOFFICE 2005 or IOFFICE or MULTIPP SW package. User interface and operations are

practically identical except two features listed below:

Off-line analysis directly
in ISONIC 2005 / 2020 /
STAR instrument

Off-line analysis in
external computer using
MULTIPP SW Package

Off-line analysis in
external computer using
IOFFICE 2005 or
IOFFICE SW Package

Off-line re-adjustment
of Gain for
MULTISCAN COMBO S
ME record

Automatic creation of
Inspection report in
MS Word® format

NO

NO

Menu Bar Functions on Opening File

YES

NO

dB

0mm

120 mm
Side View

120 mm

o4 6 8 10 1%

B P [ - R B S A |

YES

YES

mm

193 17.7 161 145 129 113 96 80 64 48 32 16 00

e File 2 Print To

Q selection of printer among available for printing out inspection report
o selection of MS Word® as printer to create inspection report as doc file (IOFFICE and IOFFICE 2005

SW Packages only)
Q selection of paper sheet size either A4 or Letter

e File > Print > Whole Report — prints out complete inspection report including UDS 3-5 Pulser
Receiver settings, inspection setup and scanning parameters, and recorded maps

¢ File > Print > Graphics Only — prints out scanning recorded maps
e File > Exit — ends postprocessing session
¢ View 2> Primary Information — previews UDS 3-5 Pulser Receiver settings, inspection setup and

scanning parameters

¢ View = ISONIC Image Processing — activates menu for detailed off-line analysis of the record
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ISONIC Image Processing Menu Bar Functions

| File v|| Wiew v|| Measurements v|| ROl v|| Filtering vH Profiling v‘

Amplitude Filtration Level:
OFF

Distanse Filtration Level:
OFF

[I;r:rﬁling ]

Top Yiew - Depth

o —

4 & 8§ 10 12

L-Coordinate
[ 0 mm ]

de

mm

120

Projection Length

193177161 145129 113 96 80 64 43 32 16 00

o
Ll
+
0 mm ] 0mm 120 mm -
- Side View )
X-Coordinate o -
(0 mm ) =
Projection Width o B o o
@ .
[ 0 mm ] - .
o End Yiew
Y¥_Coordinate - Depth D
[ 0 mm ] _
- ,
Projection Height '@'
[ 0mm ] 0 mm 120 mm

e File > Print To
O selection of printer among available for printing out inspection report
o selection of MS Word® as printer to create inspection report as doc file (IOFFICE and IOFFICE 2005
SW Packages only)
O selection of paper sheet size either A4 or Letter

e File = Print — prints current postprocessing page

e File > Exit — ends postprocessing session

¢ View > ISONIC Image Processing — returns to initial postprocessing screen appearing on opening file
e View 2> Top View Mode — represents Top View C-Scan image as either Amplitude or Distance Map
e View 2 Zoom — zooms either Top, or Side, or End View image as per operator's selection

e View > Coloring — allows to edit color scale (palette) applied to Top, Side, and End View images
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e Measurements > L-Coordinate, Projection Length — generates first vertical cursor that may be

guided over Top and Side View images using either touch screen stylus or mouse or 2) :J on
front panel keyboard or , on external keyboard; coordinate of the first vertical cursor along Top and
Side View images is indicated in the L-Coordinate field. To fix position of the first vertical cursor left

Enter

mouse click or release touch screen stylus or press :J on front panel keyboard or on
external keyboard. Second vertical cursor appears upon fixing the first one; it may be manipulated by the
same way. Coordinate of the second vertical cursor along Top and Side View images measured
relatively first vertical cursor is indicated in the Projection Length field. Provided that vertical cursors
are placed properly:

o0 L-Coordinate represents distance between left border of scanning area and left defect's end

o0 Projection Length represents appropriate size of defect
To interrupt L-Coordinate and Projection Length measurement procedure at any moment right mouse

| EsC
click or press ﬁj on front panel keyboard or @l on external keyboard
| Yiew -|[ Measurements ~|[ ROl <[ Fitesing ~][ Profiing ~]

Amplitude Filtration Level:
OFF

Top Yiew - Depth

= T

Distanse Filtration Level:
OFF

Profiling

L-Coordinate

o
2

Projection Length -

o
3
3
i
5]
3
3

Side View

X-Coordinate =

T @
@

Omm | Yiew -|[ Measurements ~|[ ROl +|[ Fitesing ~][ Profiing ~]

y-coorc, Amplitude Filtration Level:

(omm  oFf
Projecti

193 177 161 145129113 96 80 64 48 32 16 0D

Top Yiew - Depth

o S—
0 7 oo

Distanse Filtration Level: .
OFF i o

Profiling

0mm

I
(]
o
El
2
=
H
ES
@

120

Projection Length
76.1mm

o
El
E]

120 mm

Side View

o0

X-Coordinate

Projection Width B -

=
=
o
)
o
o
+
=+
o
=
=
o
=
<t
-
o
o
o+
o
e
-
]
-

19.3

o End Yiew

¥_Coordinate - Depth ° ‘
o . -
Projection Height 9’

o
El
3
5]
o
El
3
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¢ Measurements > X-Coordinate, Projection Width — generates first horizontal cursor that may be

4

| /
guided over Top View image using either touch screen stylus or mouse or 3.) —_/ on front panel
keyboard or , on external keyboard; coordinate of the first horizontal cursor along Top View image is
indicated in the X-Coordinate field. To fix position of the first horizontal cursor left mouse click or release

Enter

touch screen stylus or press :J on front panel keyboard or on external keyboard. Second
horizontal cursor appears upon fixing first one; it may be manipulated by the same way. Coordinate of
the second horizontal cursor along Top View image measured relatively first horizontal cursor is
indicated in the Projection Width field. Provided that horizontal cursors are placed properly:

o X-Coordinate represents distance between zero line of scanning area and closest defect end

o Projection Width represents appropriate size of defect
Horizontal cursors generated and manipulated over Top View image are accompanied with
synchronous vertical cursors over End View image
To interrupt X-Coordinate and Projection Width measurement procedure at any moment right mouse

| ESC
click or press &j on front panel keyboard or I@' on external keyboard
| Yiew -|[ Measurements ~|[ ROl <[ Fitesing ~][ Profiing ~]

Amplitude Filtration Level:
FF

Top Yiew - Depth

= T ——r——

(=]

Distanse Filtration Level:
OFF

Profiling

L-Coordinate

]

Projection Length =

764 mm 0 mm 120 mm
Side View

X-Coordinate

0.0

Projection Width N e

¥-Coordinate - Depth ° ‘
i )
Projection Height a

[l]mm | Wiew v|| Measurements v|| ROl v|| Filtering v|| Profiling v|

Amplitude Filtration Level:
FF

193177 161 145129113 96 80 64 48 32 16 0D
mm

19.3
m
2
a
=
o
£

Top View - Depth

T —

=]

Distanse Filtration Level:
FF

=]

dB

mm

120

Projection Length

76.1 mm omm 120 mm
Side Yiew

oo

X-Coordinate

193177160 145129 113 96 &0 64 48 33 16 00

Projection Width . B -

¥-Coordinate - Depth ° ‘
. _
Projection Height @

19.3

o
3
3
&
[=]
3
3
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e Measurements > Y-Coordinate - Depth, Projection Height — generates first horizontal cursor that
|'
may be guided over Side and End View images using either touch screen stylus or mouse or !J

!J on front panel keyboard or , on external keyboard; coordinate of the first horizontal cursor along
Side and End View images is indicated in the Y-Coordinate-Depth field. To fix position of the first

Enter

horizontal cursor left mouse click or release touch screen stylus or press :J on front panel keyboard
or on external keyboard. Second horizontal cursor appears upon fixing first one, it may be
manipulated by the same way. Coordinate of the second horizontal cursor along Side and End View
images measured relatively first horizontal cursor is indicated in the Projection Height field. Provided
that horizontal cursors are placed properly:

0 Y-Coordinate - Depth represents depth of defect

o0 Projection Height represents appropriate size of defect
To interrupt Y-Coordinate - Depth and Projection Height measurement procedure at any moment right

ESC
mouse click or press &j on front panel keyboard or @I on external keyboard
| Wiew v|| Measurements v|| ROl v|| Filtering v|| Profiling v|

Amplitude Filtration Level:
FF

Top View - Depth

o e —

(=]

Distanse Filtration Level:
OFF

Profiling

L-Coordinate

mm

Projection Length -
76.1 mm o mm 120 mm
Side Yiew

X-Coordinate o

Projection Width

193I3FF 161145129113 96 80 64 48 32 16 00

¥-Coordinate - Depth

i
|

Projection Height =1

Cﬂ.n mm | View -|[ Measurements ~|[ ROl <[ Fitesing <] [ Profiing ~]

Amplitude Filtration Level:
FF

Top Yiew - Depth

o S—
f ¥

=]

Distanse Filtration Level:
OFF

Profiling

L-Coordinate

de

mm

bl
=

=
]

2

]

3

=

]

-]

E
ES

1

2 mm 120

Side View

: :

End View
¥-Coordinate - Depth
Projection Height i é

0 mm 120 mm

0.0

X-Coordinate

193177 161 145 129113 96 80 64 48 32 16 00

Projection Width

193

o0

19.3
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Measurements > Point TOF & Echo Amplitude > Set Points — generates pointing cursor that may
be guided over Top View image using either touch screen stylus or mouse or L) , L :’, - on
front panel keyboard or , , , on external keyboard; by means of said pointing cursor representing
probe's central point virtual off-line scanning is performed with recovering of recorded A-Scans, which
are accompanied with appropriate Gate A measurements — refer to paragraph 5.2.13 of this Operating
Manual for measurements legend. To memorize A-Scan related to current cursor pointing cursor for

Enter |
further printing out release touch screen stylus or left mouse click or press ‘_"J on front panel
\ ESC

keyboard or external keyboard. To interrupt virtual off-line scanning press X" _J on front

panel keyboard or @ on external keyboard
View «|| Measurements «|| ROl «|| Filtering =|| Profiing =

Top Yiew - Depth

mm

8113 96 8D 64 48 32 16 00

4 -1 0 X 4 & & 10 1%

‘iew «|| Measurementz =|| ROl || Filteing =[| Prafiing =

Top Yiew - Depth

o S—
7 7 T

L=40.8 mm
X=T74.4 mm
D=12.9 mm

o mm 120 mm

A=73db
x| &
i - —

o End View
) |
@

0 mm 120 mm

]

Az -0 3 -5 4 20 X o4 6 & 10 1%

=
=
=
)
o
o
o+
=+
=
=
o«
o
3
el
i
=
o
o+
=)
g
-~
o
=3

19.3

I\

Points with memorized A-Scans and measuring results are highlighted by appropriate numbered marks
on Top View image; to preview a point double click on it — this will generate popup box as below:

x|

0 To erase highlighted mark click on

0 To print out individual point report click on

0 To return to main menu operation click on

Measurements > Point TOF & Echo Amplitude > Remove Last Point — erases last pointed mark
from Top View image

Measurements 2> Point TOF & Echo Amplitude > Remove All Points — erases all marks from Top
View image
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Measurements - Polygon — activates procedure of enveloping of area of interest on Top View image
by polygon, each apex of polygon is appointed through touch screen stylus or left mouse click; last apex

"
Enter

of polygon is appointed throuih double touch screen stylus or left mouse click or pressing ' *=_/ on

front panel keyboard or on external keyboard. To interrupt creating of polygon right mouse click

ESC
or press &j on front panel keyboard or @I on external keyboard

| Yiew -|[ Measurements ~|[ ROl +|[ Fitesing ~][ Profiing ~]

Amplitude Filtration Level: Top View - Depth N 5
o — = =
OFF ' = o
Distanse Filtration Level: = o
OFF - ®
Profiling -+ ;
I ls
L-Coordinate 2 E
"
o =
Projection Lenath - =
0 mm | View ][ Measuremerts <[ ROI +|[ Fieting +|[ Profiing -] [%
- Amplitude Filtration Level: . Top View - Depth - =
0mm OFF = o
Projecti| Distence Ciltration | aual- o
omm | OFF £
¥-Coorc I 5 2 s
0mm @ E g: - ]
Projecti L-Cla | o] =
on ]
0mm [: =l _2
Pra =] F=
(on 21 o
=] P
—_ ke =] -
(on 1 &
Pra = _é
(on =] % -
Y.C = T T T =
0 0. a4 b 11.8 15.4 18.3
" D, mm
Pr TreTgTIT o
omn 120 mm

Provided that polygon is placed properly:

o D represents the average value of informative parameter (amplitude or distance) represented by
colors in the area of polygon

0 © represents dispersion of informative parameter (amplitude or distance) represented by colors
in the area of polygon; statistical distribution is presented by appropriate graph
o S represents area occupied by defect

To printout polygon analysis click on ; to close polygon analysis window click on
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ROI > ON (ISONIC 2005 / 2020 / STAR instrument) or EDIT - ROI = ON (IOFFICE, IOFFICE 2005,
and MULTIPP SW Packages for external computer) — generates pointing cursor that may be guided

T § » @&

over Top View image using either touch screen stylus or mouse or =/, = ' _ZJ = J on front
panel keyboard or , , , on external keyboard; by means said pointing cursor representing probe's
central point virtual off-line scanning is performed with recovering of recorded A-Scans, which are
accompanied with appropriate Gate A measurements — refer to paragraph 5.2.13 of this Operating
Manual for measurements legend. To select reference A-Scan release touch screen stylus or left mouse

Em‘er

click or press ' *=_J on front panel keyboard or on external keyboard — — this generates off-line
Gate A controls n n n n m n allowing to redefine Region Of Interest for

MULTISCAN COMBO S imaging. Upon completing redefining of Region Of Interest click on -
this applies new Gate A to all captured A-Scans and updates Top, Side, and End View images
accordingly
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View || Measurements ~|[ ROl =|| Filtering ~|| Profiing -|

Top Yiew - Depth

113 96 30 64 48 3.2 18 00

o
&
“iew || Measurements «|[ ROl =|| Filtering =|| Profiing «|

Top Yiew - Depth

mm

R

View || Measurements ~|[ ROl =|| Filtering ~|| Profiing -|

Top Yiew - Depth

120 mm

Cidn Wi

193177 16,1 145129 113 96 80 6.4 48 32 16 00

145129113 96 80 64 438 32 16 00

&

0 mm 120 mm

¥-Coordinate

Projection Width

Side View
| Wiew v|| feazurements 'H ROl v|| Filtering v|| Prafiling «|

Amplitude Filtration Level: Top View - Depth N o
o = pt
OFF B - - -
Distanse Filtration Level: L g . = s
OFF IR = pid
| s - | o
Profiling : -+ b
- — -
- . . =

L-Coordinate Bl =a E E
__ aloial - = -
9 e m— o =
Projection Length k - - @
@
*
2
2
~
LS
=

¥-Coordinate - Depth

Projection Height

0 mm 120 mm
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ESC
To interrupt selection of reference of A-Scan right mouse click or press L‘\ on front panel keyboard
or @ on external keyboard

To interrupt re-adjustment of Region Of Interest after selection of reference of A-Scan click on

ROI > OFF (ISONIC 2005 / 2020 / STAR instrument) or EDIT > ROI > OFF (IOFFICE, IOFFICE 2005,
and MULTIPP SW Packages for external computer) — negates Gate A re-adjustment and returns to
originally recorded Top, Side, and End View images and original Gate A setting

Edit>Change Gain>ON — (IOFFICE, IOFFICE 2005, and MULTIPP SW Packages for external
computer) — generates pointing cursor that may be guided over Top View image either mouse or , ,
, on external keyboard; by means said pointing cursor representing probe's central point virtual off-
line scanning is ierformed with recovering of recorded A-Scans. To select reference A-Scan left mouse

click or press — this generates popup window allowing off-line re-adjusting of Gain for all A-
Scans captured during MULTISCAN COMBO S Scanning in £6dB range with £0.1 dB increments

ﬂ
through clicking or pressing and holding on ‘ or pressing , on keyboard

ISONIC 2005 |

Select Gain Change:

+4.4 dB il

0K Cancel
ks
During Gain re-adjusting reference A-Scan is modified accordingly. Upon completing re-adjusting Gain
0K
click on or press on keyboard — this applies new Gain value to all captured A-

Scans and updates Top, Side, and End View images accordingly

To interrupt selection of reference of A-Scan right mouse click or press @l on keyboard

] o ) Cancel
To interrupt re-adjusting of Gain click on or press @l on keyboard

Edit=>Change Gain=>OFF (IOFFICE, IOFFICE 2005, and MULTIPP SW Packages for external

computer)— negates Gain re-adjustment and returns to originally recorded Top, Side, and End View
images and original Gain setting
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e Filtering > Amplitude > Filtering ON — generates amplitude palette bar with sliding cursor, which may

LIRS 4

be controlled using either touch screen stylus or mouse or =/, ' =/ on front panel keyboard or , on
external keyboard. Position of sliding cursor on the amplitude palette bar determines Amplitude
Filtration Level, which is appropriately indicated. All elements of Top, Side, and End View images
representing signal amplitude below filtering level are suppressed

ESC
To interrupt filtering procedure right mouse click or press Lj on front panel keyboard or @ on
external keyboard

| File v|| Wieww v|| teasurements v|| ROI v|| Filtering vH Prafiling v‘

Amplitude Filtration Lewvel: Top View - Amplitude
(=]
= 1.4 dB

g 10 1z

Distanse Filtration Level:
OFF
Profiling
(o ) "
L-Coordinate
omm ]

mm

120

Projection Length

0 mm ] 0mm 120 mm
Side View

K

11.8

X-Coordinate

[ 0 mm ]
Projection Width
[ 0 mm

14.7 145 142 140138 135133 130128126123 121 1.8

A% -0 -3

14.7

End View

118

¥-Coordinate - Depth _
[ 0 mm ] —

147

Projection Height

[l] mm ] 0 mm 120 mm

e Filtering > Amplitude - Filtering OFF — returns to originally recorded Top, Side, and End View
images

o Filtering > Distance > Filtering ON — generates sliding horizontal cursor above Side and End View

LIS 4

images, which may be controlled using either touch screen stylus or mouse or =/, _T_J on front panel
keyboard or , on external keyboard. Position of the sliding horizontal cursor determines Distance
Filtration Level, which is appropriately indicated. All elements of Top, Side, and End View images
related to distances exceeding Distance Filtration Level are suppressed

ESC
To interrupt filtering procedure right mouse click or press Lj on front panel keyboard or @ on
external keyboard

| File v|| Wiew v|| Measurements v|| ROl v|| Filtering v|| Profiling v|

Amplitude Filtration Level: Top Yiew - Depth
=1
OFF

Distanse Filtration Level:
< 13.5 mm

Profiling
(o ] -
L-Coordinate a

(amm )

g 1 13

-
&

4

dB

-2

120

Projection Length

[ 0mm ] omm 120 mm
Side View

-4

-6

o

X-Coordinate

(omm ]
Projection Width

[ 0mm ]

164160 15.7 153 149 145 141 137 124130 126 122 1.8
mm

-1z -0 -8

End View

1.8

¥-Coordinate - Depth
0 mm ]

Projection Height

[ 0 mm ] 0 mm 120 mm
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e Filtering > Distance - Filtering OFF — returns to originally recorded Top, Side, and End View
images

e Profiling 2> L,X Profiling — generates sliding horizontal and vertical cursors above Top View, which

| / |
may be controlled usi either touch screen stylus or mouse or !J !) 2) :J on front panel

keyboard or , , , on external keyboard . Positions of both sliding cursors are appropriately
indicated in the Profiling box. Horizontal cursor determines sectional cut (vertical slice) represented as
Side View image; vertical cursor determines sectional cut (vertical slice) represented as End View
image

| ESC
To interrupt profiling procedure right mouse click or press &j on front panel keyboard or @ on
external keyboard

| File v|| Wiew v|| Measwements v|| ROl v|| Filtering v|| Profiling v|

Amplitude Filtration Level: Top Yiew - Depth

o ———

OFF
Distanse Filtration Level: .
OFF i L
Profiling e =o7.1 mm: x-as.0 mm
(L-57.A mm, x-866mm | | : 'I R
L-Coordinate . -] E
0mm ]
]

Projection Length

193177 161 145129 113 96 80 64 48 32 16 00

[ 0mm ] omm 120 mm
a Side View
X-Coordinate o
[ 0mm ]
Projection Width @ —
o
[ 0 mm ] - )
o End Yiew
Y¥-Coordinate - Depth e
[ 0mm ]
- | e Srswe |
Projection Height 'cg'
[ 0mm ] O mm 120 mm

ISONIC 2005/ 2020 / STAR from Sonotron NDT - Operating Manual — Revision 2.38 - Page 357 of 380



o Profiling 2 Y Profiling — generates sliding horizontal cursor above Side and End View images, which

r §

may be controlled using either touch screen stylus or mouse or =/, ' = on front panel keyboard or ,
on external keyboard. Position of sliding horizontal cursor is appropriately indicated in the Profiling
box. Horizontal cursor determines sectional cut (horizontal slice) represented as Top View image

ESC
To interrupt profiling procedure right mouse click or press L) on front panel keyboard or @ on
external keyboard

| File v|| Wiew v|| Measurements v|| ROl v|| Filtering v|| Profiling v|

Amplitude Filtration Level: Top View - Amplitude
=1
OFF

Distanse Filtration Level:
OFF

g 1 13

1
&

4

Profiling [ e e
(v-137mm ] g ma - N

L-Coordinate o @ o

mm

(amm )

120

Projection Length

0mm ] omm 120 mm
Side View

-4

-6

0.0

X-Coordinate
omm ]
Projection Width

(o )

1W3IIFTF 161145129 113 96 80 64 48 32 16 0D

-1z -0 -8

19.3

o End View

Y¥.Coordinate - Depth e
[ 0 mm ] B
Projection Height g

[ 0 mm ] 0 mm 120 mm

¢ Profiling > Profiling Off — returns to global Top, Side, and End View images
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10.3.7. Thickness Profiling
10.3.7.1. Inspection Setup

Inspection Setup

= [
| 5

i Pl Region Depth (RD)
120mm ¥ S5mm  J Omm
Region Thick (RT)
3 - Thamal hd 16.5mm

Region Witth (RV) i
120mm
Encotier Type [ setwstep |

Default »| ¢ Coargse (¥ Medium (" Fine

< Back [ESC] Next >

In the (& LXK (e Screen it is necessary to key in:

O Length of rectangular scanning area

O Region Width which defines width of rectangular scanning area

O Scan Index — value of Scan Index defining coverage of scanning area to be selected and entered
according to inspection procedure

ﬂ
Setting of said parameters to be performed through clicking / pressing corresponding spin button ¥ with
Fine, Medium, or Coarse increments according to checked option (click on) in the Setup Step field

pa—
Alternatively parameter for setting to be selected through pressing ' = Jon front panel keyboard or on
external keyboard or through clicking on its label. Label indicating name of selected parameter changes it's

T » @

fore color from yellow to white — since that moment parameter may be modified using =, =, ~ _,',

!L, on front panel keyboard or , , , on external keyboard

Values of Region Depth (RT) and Region Thick (RT) for pulse echo mode indicated in the Inspection
Setup screen are defined by Gate A settings of UDS 3-5 Pulser Receiver:

Region Depth (RD) = aStart
Region Thick (RT) = aWidth

Style of palette (Pseudo, Thermal, or Gray) is selectable through clicking E:
/

/
2 - Pseudo 2

Encoders calibration data corresponding to scanning mechanism in use is selectable through clicking
—

Encoder Type - -
—
Drefault -

( ESC
. . < Back [ESC
To return to previous screen click on L;J or press L) on front panel keyboard or @ on

external keyboard

To continue click on M or press LJ on front panel keyboard or on external keyboard
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10.3.7.2. Imaging Principles
## Sketch Note

B1
1 Al L2 X2 General

Scanning Area

L1 (a) Volume Under Test
w1 (Region of Interest) is
Y2 - C1 located between the two

parallel rectangles
namely ABCD and EFGH
(b) Scanning is provided
above surface of
rectangle A1B1C1D1
I b (c) With reference to
screen
— paragraph 10.3.7.1 of
this Operating Manual;

-
—
Ira
Vo
=
-
-~
Redion Depth

Region Width

0 A1A =Region Depth

o
Redion Thickness

H o0 AB = Region Length
Lencth

o0 AD = Region Width
0 DH = Region Thickness

) 0o A1E = Normal Material
Top View Thickness

(d) Inthe example itis
supposed that there are

A B two flat bottom drills in
the object under test, said
drills have different
diameters, coordinates
and depths of penetration
into Region of Interest

End Yiew -

\'\.
H G
Side View

o Q1 (L1, X1, Y1) — Center of the Drill # 1's Bottom Surface
0 Q2 (L2, X2, Y2) - Center of the Drill # 2's Bottom Surface
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H#Ht Sketch
2 A Top View B

Side View

End View

Note
Top View, Global Side and End View

Supposing that scanning is well completed
drills bottoms Q1 and Q2 will be detected
and represented in Top View, and global
Side View and End View

Top View is obtained through superimposing
of parallel planes between rectangles ABCD
and EFGH and represents distribution of
minimum thickness above scanning surface

Global Side View and End View are
orthogonal images composed through
superimposing of the corresponding cross
sectional profiles along and across the whole
Region of Interest, said superimposing is
performed by overwriting of high value of
remaining material thickness with lower
value and provides representation of least
remaining thickness values

Acquired data is converted into 3D-matrix
allowing sectional presentation of Side and
End View during scanning — refer to below
sketches ## 3, 4, and 5
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H#Ht Sketch

B1
Al L2 g X2

g
L1 -
x1
Y2
R o) N — B C1
N
v1 FAZ_ 30 .
I 1 .,
o
| ! A c
s
Qi) e N
I | o K
- \“\
S
H G
A Top View B
D C

Side View

End View

Note

Sectional Side and End View (Vertical
Cut Slice)

Sketches ## 3, 4, and 5 illustrate
composing of sectional Side View and End
View

Side View section currently represented on
ISONIC 2005 / 2020 / STAR screen
corresponds to current X-coordinate of
probe

End View section currently represented on
ISONIC 2005 / 2020 / STAR screen
corresponds to current L-coordinate of
probe
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H#Ht Sketch

4
B1
Al Lo w7
N I _g
1
e
A___ DV __ 1 ] _—I\\E
|
Y1 IFQZ_JII
Il
I I
: |
D - s
—_— __F___'I____""\F
: i
|
|
E::J
H
Top View
A
D Side View

End View

c1

Note

Sectional Side and End View (Vertical
Cut Slice)

Sketches ## 3, 4, and 5 illustrate
composing of sectional Side View and End
View

Side View section currently represented on
ISONIC 2005/ 2020 / STAR screen
corresponds to current X-coordinate of
probe

End View section currently represented on
ISONIC 2005/ 2020 / STAR screen
corresponds to current L-coordinate of
probe
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H#Ht Sketch

Al

Top View

End View

Side View

ci

Note

Sectional Side and End View (Vertical
Cut Slice)

Sketches ## 3, 4, and 5 illustrate
composing of sectional Side View and End
View

Side View section currently represented on
ISONIC 2005/ 2020 / STAR screen
corresponds to current X-coordinate of
probe

End View section currently represented on
ISONIC 2005/ 2020 / STAR screen
corresponds to current L-coordinate of
probe
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10.3.7.3. Scanning
ISONIC 2005 / 2020 / STAR Corromap InspectionfSeERislloW N CdInspection SetuplEEEK

o Scanning Pattern - Top View =0mm

% ==14mm

==2 Gmm

==4.1mm

==5.5mm

==E Smm

==G.2mm

1z0

==9 Gmm
0mm 120 mm

Side View =<=11mm

==12.4mm

==13.8mm

16.5

==15.1mm

==16.5mm
I Global Section | I Side End

fema| (o | (Ew| |1

On opening [Ele)\| (e EYP I PINESIVAGE T Tk A E]II1[])] screen place probe onto zero point of

scanning area then click on Lﬂj or press I Jon front panel keyboard or on external keyboard

. Zero Point

le’”_/ B1

Scanning Area

[ |

A_____D0U__ B
_I\ Y =
| N E
| . [N}
| - 2

"
| g
[ ™ E
S
Redion Width !
D +
U -, cC a
F 4
- C
. —_
&}
“ £
" —
" =
- 2
\ fan]
G &
H
Lenigth
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During scanning [Sel\ (eI VYL IRV oL T i (I 1T M1 F el-Yeq1[e]y) SCreen is accompanied with A-Scan

ISONIC 2005 Corromap Ingpection 0 0 o )

o Scanning Pattern - Top View 2 <=0mm

% 7 s ==1_4mm
_ 7’

==2.8mm

==4.1mm
f ==5 5mm

==G.9mm

-5
¥
"
¥
¥
¥
¥
"

==5.2mm

1z0

== 6mm
Omm 120 mm
Side View ==11mm

==12.4mm

==13.8mm

==13.1mm

==16.5mm

I Global Section | I Side End | E—
{ < Back [ESC]J { Stop [3] J { Clear [Z]J { Save

ISONIC 2005 / 2020 / STAR Corromap InspectionfeCERREIJERERIE

Q Current Probe Position
Q Top View

Sid End
a Side View for LI pressed down or End View for ;lpressed down or press

fa—

= Jon front panel keyboard or on external keyboard to switch between Side and End View

Global | Section
or

Depending on which button is pressed — — Side View and End View
are presented either in global mode according to sketch # 2 — paragraph 10.3.7.2 of this Operating
Manual or in sectional mode according to sketches ## 3, 4, and 5 — paragraph 10.3.7.2 of this
Operating Manual

®

a All A-Scans are captured during scanning unconditionally however projection images Top View, Side
View, and End View are updated only with signals exceeding threshold of Gate A presented on A-Scan
however

Q Minimal thickness is dominant while recording data into Top View

O Map Repair Function is active while keeping pressed LJ on front panel keyboard or on external
keyboard — new readings will overwrite already recorded data unconditionally; this allows record correction
after finding some non-relevant data recorded with dominance

( F
To cleanup Top View, Side View, and End View fields click on | Glar 2 ] or press 2 on front panel

keyboard or @ on external keyboard

' -
To stop scanning click on l Stop 3l J or press 3 on front panel keyboard or ﬁ on external keyboard

' =
To save CORROMAP ME record into a file click on { Save Jor press ‘22 J on front panel keyboard or
on external keyboard. Refer to paragraph 5.2.17 of this Operating Manual to proceed with file saving

1 ESC
To return to [E IS BT screen click on e 'ESC], or press L‘\ on front panel keyboard or @ on

external keyboard
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10.3.7.4. Postprocessing

Postprocessing of CORROMAP ME records may be performed directly in the instrument or in external
computer using IOFFICE 2005 or IOFFICE or MULTIPP SW package. User interface and operations are
practically identical except two features listed below:

Off-line analysis directly
in ISONIC 2005 / 2020 /
STAR instrument

Off-line analysis in
external computer using
MULTIPP SW Package

Off-line analysis in
external computer using
IOFFICE 2005 or
IOFFICE SW Package

Off-line re-adjustment
of Gain for
CORROMAP ME record

Automatic creation of
Inspection report in
MS Word® format

NO

NO

Menu Bar Functions on Opening File

YES

NO

Scanning Pattern - Top Yiew

120

120 mm

End Yiew

YES

YES

==0mm

==1.4mm

==2.9mm

==4 3mm

==0.8mm

==7.2mm

==5 6mm

==10.1mm

==11.5mm

==13mm

==14.4mm

==13.9mm

==17.3mm

e File 2 Print To

O selection of printer among available for printing out inspection report
o selection of MS Word® as printer to create inspection report as doc file IOFFICE and IOFFICE 2005

SW Packages only)

O selection of paper sheet size either A4 or Letter

e File > Print > Whole Report — prints out complete inspection report including UDS 3-5 Pulser
Receiver settings, inspection setup and scanning parameters, and recorded maps

¢ File > Print > Graphics Only — prints out scanning recorded maps
e File > Exit — ends postprocessing session
e View 2> Primary Information — previews UDS 3-5 Pulser Receiver settings, inspection setup and

scanning parameters

e View > ISONIC Image Processing — activates menu for detailed off-line analysis of the record
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ISONIC Image Processing Menu Bar Functions

| File v|| Wiew v|| Measurements v|| ROl v|| Filtering vH Profiling v‘
: . ; : Scanning Pattern - Top Yiew _
Filtration Level: No Filtration o ==0mm
==1.4mm
[L-Coordlnate ] =3 0mm
0.0 mm
==4 3mm
Projection Length
[ 0.0 mnm ] ==5.8mm
==7.2mm
X-Coordinate
[ 0.0 mm ] o ==0.6mm
I
Projection Width ==10.1mm
[ 0.0 mm ] O mm 120 mm
. End View ==11.5mm
Y-Coordinate - Depth = ==13mm
[ 0.0 mm ] ==14 4mm
Projection Height o
[ o0 ] = ==15.9mm
L0 mm o

o ——‘ ==17.3mm
[
r

e File > Print To
a selection of printer among available for printing out inspection report
0 selection of MS Word® as printer to create inspection report as doc file (IOFFICE and IOFFICE 2005
SW Packages only)
O selection of paper sheet size either A4 or Letter

¢ File 2> Print — prints current postprocessing page

e File > Exit — ends postprocessing session

¢ View > ISONIC Image Processing — returns to initial postprocessing screen appearing on opening file
e View 2> Top View Mode — represents Top View C-Scan image as either Amplitude or Distance Map
e View 2 Zoom — zooms either Top, or Side, or End View image as per operator's selection

e View > Coloring — allows to edit color scale (palette) applied to Top, Side, and End View images
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¢ Measurements > L-Coordinate, Projection Length — generates first vertical cursor that may be

guided over Top and Side View images using either touch screen stylus or mouse or !/ f on
front panel keyboard or , on external keyboard; coordinate of the first vertical cursor along Top and
Side View images is indicated in the L-Coordinate field. To fix position of the first vertical cursor left
Enter

mouse click or release touch screen stylus or press +4 _ on front panel keyboard or on
external keyboard. Second vertical cursor appears upon fixing the first one; it may be manipulated by the
same way. Coordinate of the second vertical cursor along Top and Side View images measured
relatively first vertical cursor is indicated in the Projection Length field. Provided that vertical cursors
are placed properly:

o0 L-Coordinate represents distance between left border of scanning area and left end of

corrosion damage

o0 Projection Length represents appropriate size of corrosion damage

To interrupt L-Coordinate and Projection Length measurement procedure at any moment right mouse

ESC
click or press L) on front panel keyboard or @ on external keyboard

| Yiew -|[ Measurements ~|[ ROl +|[ Fitesing ~][ Profiing ~]
. . . . Scanning Pattern - Top Yiew %
Filtration Level: No Filtration o ==0mim
==1.4mm
L-Coordinate 2 8mm
==4.3mm
Projection Length
==3.8mm
==7.2mm
X-Coordinate
0.0 mm = ==3.6mm
=]
Projection Width ==10.1mm
0 mm 120 mm
o End View ==11.3mm
¥-Coordinate - Depth = ==13mm
<eta 4
Projection Height E
— ==15 Crrun
[l].l] ™M ["Fie +][ view +][ Measurements <[ ROI <] [ Fiteing ~| [ Prafiing -]
. . . . Scanning Pattern - Top Yiew
Filtration Level: No Filtration o <=0mim
==1_4mm
L-Coordinate =2 amm
==4.3mm
Projection Length
67.92 mm ==5.8mm
==7 .2mm
X-Coordinate
2]
Projection Width ==10.1mm
o End View ==11.3mm
¥-Coordinate - Depth e ==13mm
<cta amn
Projection Height o
- e
o
d —_‘ <:1?3mm
o
=
0omm 120 mm

ISONIC 2005/ 2020 / STAR from Sonotron NDT - Operating Manual — Revision 2.38 - Page 369 of 380



¢ Measurements > X-Coordinate, Projection Width — generates first horizontal cursor that may be

guided over Top View image using either touch screen stylus or mouse or L ! on front panel
keyboard or , on external keyboard; coordinate of the first horizontal cursor along Top View image is

indicated in the X-Coordinate field. To fix position of the first horizontal cursor left mouse click or release
Enter |

touch screen stylus or press *=_ on front panel keyboard or on external keyboard. Second
horizontal cursor appears upon fixing first one; it may be manipulated by the same way. Coordinate of
the second horizontal cursor along Top View image measured relatively first horizontal cursor is
indicated in the Projection Width field. Provided that horizontal cursors are placed properly:

o0 X-Coordinate represents distance between zero line of scanning area and closest end of

corrosion damage

o Projection Width represents appropriate size of corrosion damage
Horizontal cursors generated and manipulated over Top View image are accompanied with
synchronous vertical cursors over End View image
To interrupt X-Coordinate and Projection Width measurement procedure at any moment right mouse

ESC
click or press L) on front panel keyboard or @ on external keyboard

| Yiew -|[ Measurements ~|[ ROl +|[ Fitesing ~][ Profiing ~]
. . . . Scanning Pattern - Top Yiew %
Filtration Level: No Filtration o <=0mim
==1_4mm
L-Coordinate <=2 9mm
==4.3mm
Projection Length
% ==5.8mm
N ==7.2mm
%-Coordinate
63.3 mm o ==3.6mim
o
Projection Width - =101 mm
. End View ==11.5mm
¥-Coordinate - Depth = <=13mm
<eta 4
Projection Height 2
- e
o
d —_‘ _—
o

N
| Yiew -|[ Measurements ~|[ ROl +|[ Fitesing ~][ Profiing ~]

. . . . Scanning Pattern - Top View
Filtration Level: No Filtration o ==0mm
==1_4mm
L-Coordinate —
==d4 3mm
Projection Length
67.92 mm ==5.8mm
) [% ==7 21mim
X-Coordinate
o
Projection Width ==10.1mm
o End View ==11.5mm
¥-Coordinate - Depth 2 ==13mm
<t4.4mm
Projection Height o
- e
o

d —_‘ o
o
=

o mm 120 mm
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¢ Measurements > Y-Coordinate - Depth, Projection Height — generates first horizontal cursor that

may be guided over Side and End View images using either touch screen stylus or mouse or .!/

4

_~_/ on front panel keyboard or , on external keyboard; coordinate of the first horizontal cursor along
Side and End View images is indicated in the Y-Coordinate-Depth field. To fix position of the first
Enter |

horizontal cursor left mouse click or release touch screen stylus or press + J on front panel keyboard
or on external keyboard. Second horizontal cursor appears upon fixing first one, it may be
manipulated by the same way. Coordinate of the second horizontal cursor along Side and End View
images measured relatively first horizontal cursor is indicated in the Projection Height field. Provided
that horizontal cursors are placed properly:

0 Y-Coordinate - Depth represents remaining thickness

o0 Projection Height represents appropriate depth of corrosion damage
To interrupt Y-Coordinate - Depth and Projection Height measurement procedure at any moment right

ESC
mouse click or press L) on front panel keyboard or @ on external keyboard

| Wiew v|| Measurements v| | ROl v| | Filtering v| | Profiling v|
. . . . Scanning Pattern - Top View %
Filtration Level: Mo Filtration o ==0mim
==1.4mm
L-Coordinate <=2 8mm
==4.3mm
Projection Length
==5.8mm
==7 .2mm
X-Coordinate
63.3 mm o ==8.6mm
™
Projection Width - ==101mm
:. End View ==11.5mm
¥-Coordinate - Depth e ==13mm
<eta 4
Projection Height o
- A e
=1
D —:I e
o
=

| Wiew v|| Measurements v|| ROl v|| Filtering v|| Profiling v|

Scanning Pattern - Top View

Filtration Level: No Filtration o ==0mm
==1.4mm
L-Coordinate -
==4 3mm
Projection Length
67.92 mm ==3.8mm
==7.2mm
X-Coordinate
(2gmm ] 5 <6
&
Projection Width ==10.1mm
o End View ==11.3mm
¥_Coordinate - Depth = ==13mm
<t4.4mm
Projection Height o
L g [ L@ ==15.9mm

d m o
"
r

0 mm 120 mm
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Measurements > Point — generates pointing cursor that may be guided over Top View image using

either touch screen stylus or mouse or ?_ '.' ? ‘ on front panel keyboard or , , , on
external keyboard; by means of said pointing cursor representing probe's central point virtual off-line
scanning is performed with recovering of recorded A-Scans, which are accompanied with appropriate
Gate A measurements — refer to paragraph 5.2.13 of this Operating Manual for measurements legend.
To memorize A-Scan related to current cursor pointing cursor for further printing out release touch

"
Enter
screen stylus or left mouse click or press ' *=J on front panel keyboard or on external

ESC
keyboard. To interrupt virtual off-line scanning press L) on front panel keyboard or @ on external
keyboard

| Wiew -|| Measurements v|| ROl v|| Filtering v|| Profiling v|

[l o Scanning Pattern - Top View =0mmim %

==1.4mm

==2.9mm

==4 3mm

" ==3.8mm

L% ==7.2mm

- o ==8.Bmm
D =12.98 mm H=164% 5]
==10.1mm

| View -|[ Measurements ~|[ ROI =] [ Fitering =] [ Profiing ~]

o Scanning Pattern - Top View <=0rmm

==1.4mm
==2.9mm

==4 3mim

U.L ==5.8mm
Point 1: ==7.2mm
L =453 mm == Bimm
D=1298mm  H=164% & X =752 mm
==10.1mm
omm D=12.93 mm 120 mm
H=184% ==11.5mm

0.0

x| &

==1 3%
==14/3km

==13.9mm

o
d m o
1]
=

0mm 120 mm

732

Points with memorized A-Scans and measuring results are highlighted by appropriate numbered marks
on Top View image; to preview a point double click on it — this will generate popup box as below:

0 To erase highlighted mark click on

0 To print out individual point report click on

v

0 To return to main menu operation click on

Measurements > Point > Clear Last — erases last pointed mark from Top View image
Measurements - Point > Clear All — erases all marks from Top View image
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Measurements - Polygon — activates procedure of enveloping of area of interest on Top View image
by polygon, each apex of polygon is appointed through touch screen stylus or left mouse click; last apex
Enfe.r |

of polygon is appointed through double touch screen stylus or left mouse click or pressing - *=_/ on
front panel keyboard or on external keyboard. To interrupt creating of polygon right mouse click

ESC
or press &) on front panel keyboard or @ on external keyboard

| Yiew -|[ Measurements ~|[ ROl <[ Fitesing ~][ Profiing ~]
R . . . Scanning Pattern - Top Yiew %
Filtration Level: No Filtration o ==0mim
==1.dmm
L-Coordinate <=2 amm
==4.3mm
Projection Length
. ==7.2mm
X-Coordinate
0.0 mm =) ==3.6mm
o
Projectior ——
File «|| View «|| Measurementz [ ROl =[| Filtering «|| Profiing =
(oomm eI Ve ] | (R0 <] [Fitrng <] [ Prfing <
_ - . B Scanning Pattern - Top View
v.Coordir Filtration Level: No Filtration o ==0mm
0.0 mm ‘ ==1.4mm
ot L-Cion e
Projectior gmm
Proje|™ 4 7 04f B
(onl ) s o
g I & N
o - =] 2mm
%-Co|® D=131mm =y
0on =003 =d Gmm
Proje §=5.32cm’ g: 0.1 mm
@ F 3 [1.5mm
=]
¥-Con =] Smm
=]
0.on =l
C =1 4.4mim
Proje ™
=] [5.9mim
0.on =8
=] T T T V 7.3mim
0. 34 6.9 10.4 13.8 17.3
D, mm
omm 120 mm

Provided that polygon is placed properly:
o D represents average remaining thickness represented by colors in the area of polygon

0 © represents dispersion of remaining thickness represented by colors in the area of polygon;
statistical distribution is presented by appropriate graph

o S represents area occupied by corrosion damage

To printout polygon analysis click on ; to close polygon analysis window click on
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e ROI > ON (ISONIC 2005/ 2020 / STAR instrument) or EDIT - ROI > ON (IOFFICE, IOFFICE 2005,
and MULTIPP SW Packages for external computer) — generates pointing cursor that may be guided

)8 (») e

over Top View image using either touch screen stylus or mouse or =/, , —/ on front
panel keyboard or , , , on external keyboard; by means said pointing cursor representing probe's
central point virtual off-line scanning is performed with recovering of recorded A-Scans, which are
accompanied with appropriate Gate A measurements — refer to paragraph 5.2.13 of this Operating
Manual for measurements legend. To select reference A-Scan release touch screen stylus or left mouse

Fm‘er

click or press + J on front panel keyboard or on external keyboard — — this generates off-line

Gate A controls n n n n m n allowing to redefine Region Of Interest for

CORROMAP imaging. Upon completing redefining of Region Of Interest click on — this applies
new Gate A to all captured A-Scans and updates Top, Side, and End View images accordingly
| Wiew v|| Measurements 'H ROI v|| Filtering v|| Profiling v|

o Scanning Pattern - Top View =0mm %

==1.4mm
==2.9mm
==4.3mm

==5 &mm
[% ==7.2mm

==8.6mm

D=1293mm H=169% ]

| Wigw v|| Meazuraments 'H RO v|| Filtering v|| Prafiling -|

o Scanning Pattern - Top Yiew <=0mm

==1.4mm

==2.9mm

==4.3mm

==3.6mm

==7 2mm

==8.6mm

1z0

==10.1mm
amm 120 mm

End View ==11.5mm

==13mm

| | o
a

==14.4mm
o
=

| Wiew vH teazurements 'H ROI 'H Filtering v|| Profiling v|

==15.8mm

==17.3mm
Scanning Patt